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Overview

The HP V1910 Switch Series can be configured through the command line interface (CLI), web interface,
and SNMP/MIB. These configuration methods are suitable for different application scenarios.

e The web interface supports all V1910 Switch Series configurations.

e The Cll provides some configuration commands to facilitate your operation. To perform other
configurations not supported by the CLI, use the web interface.



Configuration through the web interface

Web-based network management operating
environment

HP provides the web-based network management function to facilitate the operations and maintenance on
HP’s network devices. Through this function, the administrator can visually manage and maintain network
devices through the web-based configuration interfaces.

a. Web-based network management operating environment

’\-—

PC Device

Logging in to the web interface

Default login information

The device is provided with the default Web login information. You can use the default information to log
in fo the web interface.

1. The default web login information

Information needed at login Default value
Username admin
Password None

Default IP address of the device, depending on the status

IP address of the device (VIAN-interface 1) of the network where the device resides.

Table 1 The device is not connected to the network, or no DHCP server exists in the subnet where the device
resides

If the device is not connected to the network, or no DHCP server exists in the subnet where the device resides,
you can get the default IP address of the device on the label on the device, as shown in b. The default subnet
mask is 255.255.0.0.

b. Default IP address of the device

Default IP Address:169.254.52.86



Table 2 A DHCP server exists in the subnet where the device resides

If @ DHCP server exists in the subnet where the device resides, the device will dynamically obtain its default
IP address through the DHCP server. You can log in to the device through the console port, and execute the
summary command to view the information of its default IP address.

<Sysname> summary

Select menu option: Summary
IP Method: DHCP
IP address: 10.153.96.86
Subnet mask: 255.255.255.0
Default gateway: 0.0.0.0
<Omitted>

Example

Assuming that the default IP address of the device is 169.254.52.86, follow these steps to log in to the
device through the web interface.

e  Connect the device to a PC

Connect the GigabitEthernet interface of the device to a PC by using a crossover Ethernet cable (by default,
all interfaces belong to VLAN 1).

e  Configure an IP address for the PC and ensure that the PC and device can communicate with each
other properly.

Select an IP address for the PC from network segment 169.254.0.0/16 (except for the default IP address
of the device), for example, 169.254.52.86.

e Open the browser, and input the login information.

On the PC, open the browser (IE 5.0 or later), type the IP address http://169.254.52.86 in the address bar,
and press Enter to enter the login page of the web interface, as shown in a. Input the username admin and
verification code, leave the password blank, and click Login.

a. login page of the web interface

Web User Login
User Mame

Fassward

Werify Code cégz

Login




/\ CAUTION:

o The PC where you configure the device is not necessarily a web-based network management terminal.
A web-based network management terminal is a PC used to log in to the web interface and is required
to be reachable to the device.

o After logging in to the web interface, you can select Device > Users from the navigation tree, create
a new user, and select Wizard or Network - VLAN interface to configure the IP address of the VLAN
interface acting as the management interface. For more information, see the corresponding
configuration guides of these modules.

o Ifyou click the verification code displayed on the web login page, you can get a new verification code.

o Up to five users can concurrently log in to the device through the web interface.

Logging out of the web intertace

Click Logout in the upper-right corner of the web interface, as shown in a to quit the web console.

The system does not save the current configuration automatically. Therefore, it is recommended to save the
current configuration before logout.

Introduction to the web interface

The Web interface is composed of three parts: navigation tree, title area, and body area, as shown in a.

a. Web-based configuration interface

Sunrany
HR 1910 Switch

Device Information
4 wiead
+ IF
System Resource Stale
o CPU Usage 1%
Metwirk Denice Nams
Memory Usage % 7]
Authentication L HP ¥1810-166 Switch JEODSA
Secuity - A Product Infarmation
05 Racent System Operation Logs HP1810-156 Swiich
Time e Descripion Somware Version Alpha 1108
More Logs On Deviceldoie... ® Device Location
Retosh Pariod | Wanual 56| IS Refash & Contactinformation
10 g Senaliium
21023541150000000002
@ Sofware Version
520 Mlpha 1108
Hardware Varsion
REV.B
dp Bootom Version
138
Running Time:
0 days & hours 56 minules 17
secands
(1) Navigation tree (2) Body area (3) Title area

e Navigation tree—Organizes the web-based NM functions as a navigation tree, where you can select
and configure functions as needed. The result is displayed in the body area.

e Body area—Allows you to configure and display features.

o Title area—Displays the path of the current configuration interface in the navigation tree; provides the

Help button to display the web related help information, and the Logout button to log out of the web
interface.



/\ CAUTION:

The web network management functions not supported by the device are not displayed in the navigation
tree.

Web user level

Web user levels, from low to high, are visitor, monitor, configure, and management. A user with a higher
level has all the operating rights of a user with a lower level.

Introduction to the web-based NM functions

Visitor—Users of this level can only use the network diagnostic tools ping and Trace Route. They can
neither access the device data nor configure the device.

Monitor—Users of this level can only access the device data but cannot configure the device.

Configure—Users of this level can access device data and configure the device, but they cannot
upgrade the host software, add/delete/modity users, or back up/restore configuration files.

Management—Users of this level can perform any operations to the device.

NOTE:

User level in 1 indicates that users of this level or users of a higher level can perform the corresponding
operations.

1.

Description of Web-based NM functions

Function menu Description User level
Wizard P Setup A||o'ws you to perform quick configuration of the Management
device.
Displays global seftings and port settings of a Configure
stack.
etop ! figure global d
Allows you to contigure global parameters an Management
stack ports.
IRF |
Topology . :
Summary Displays the topology summary of a stack. Configure
Device Displays the control panels of stack members. Configure
Summary
System Displays the basic system information, system Monitor
Information resource state, and recent system operation logs.
Summary
Device . . . . .
. Displays the port information of the device. Monitor
Information
System Name Displays and allows you to configure the system Configure
Devi name.
Basic
ce Web Idle Displays and allows you to configure the idle .
: . . . Configure
Timeout timeout period for logged-in users.




Function menu

Description

User level

Software Allows you fo configure to upload upgrade file Management
Upgrade from local host, and upgrade the system software. ¢
Device Reboot Allows you fo configure to reboot the device. Management
Maintenan
ce Electronic Label  Displays the electronic label of the device. Monitor
Diagnostic Generates diagnostic information file, and allows
. . ) Management
Information you to view or save the file to local host.
S}/stem System Time Displays ohd allows you to configure the system Configure
Time date and fime.
| Displays and refreshes system logs. Monitor
Loglist
Allows you fo clear system logs. Configure
Syslog Loghost Displays and allows you to configure the loghost. ~ Configure
log Setup Displa}ls and qllows you to configure the buffer Configure
capacity, and interval for refreshing system logs.
Allows you to back up the configuration file to be
Backup used at the next startup from the device to the host Management
of the current user.
. . Allows you to upload the configuration file to be
Configurati  Restore used at the next startup from the host of the current  Management
on user to the device.
Allows you to save the current configuration fo the .
Save ' L Configure
configuration file to be used at the next startup.
Initialize Allows you to restore the factory default settings. ~ Configure
File . Allows you to manage files on the device, such as
File . k 0 ) )
Managem displaying the file list, downloading a file, Management
Management . . . ;
ent uploading a file, and removing a file.
Summary Displays port information by features. Monitor
Port . . . . .
or Detail Displays feature information by ports. Monitor
Managem
ent Set Allows you to create, modify, delete, and Confiqure
P enable/disable a port, and clear port statistics. 9
Summary Di'splo_ys the configuration information of a port Monitor
mirroring group.
Port Create Allows you fo create a port mirroring group. Configure
Mirroring  Remove Allows you to remove a port mirroring group. Configure
. Allows you to configure ports for a mirroring )
Modify Port Configure
group.
Summary Displays the brief information of FTP and Telnet Monitor
users.
Allows you to configure a password for a
Users .
Super Password  lower-level user to switch from the current access ~ Management
level to the management level.
Create Allows you to create an FTP or Telnet user. Management
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Function menu Description User level
Modify Allows you to modify FTP or Telnet user Management
information.
Remove Allows you to remove an FTP or a Telnet user. Management
Switch To Allows you to switch the current user level to the Visitor
Management management level. !
loopback  Loopback Allows you to perform loopback tests on Ethernet Configure
interfaces.
VT VT Allows you to check the status of the cables Configure
connected to Ethernet ports.
Port Traffic Dlsp!cys the average rate at \A./hI.Ch the |nTe.rfc1c§ .
- receives and sends packets within a specified time  Monitor
Flow Statistics interval.
Interval
Interval Allows you to set an interval for collecting traffic '
! . L ) Configure
Configuration  statistics on inferfaces.
Displays and allows you to set the interval for
Storm collecting storm constrain statistics.
. Storm Constrain Configure
Constrain Displays, and allows you to create, modify, and
remove the port traffic threshold.
- Displays, and allows you to create, modify, and .
Stafisics clear RMON statistics. Configure
. Displays, and allows you to create, modify, and .
History clear RMON history sampling information. Configure
RMON Alarm Allows you to view, create, modify, and clear Configure
alarm entries.
Event A||o.ws you to view, create, modify, and clear event Configure
entries.
Log Displays log information about RMON events. Configure
Ene.rgy Energy Saving Dlsplcys ohd allows you to configure the energy Configure
Saving saving settings of an interface.
Dlsquys ,a?d refr'eshes SNMP configuration and Monitor
Setup statistics intormation.
Allows you fo configure SNMP. Configure
Displays SNMP community information. Monitor
Community Allows you to create, modify and delete an SNMP .
. Configure
community.
SNMP
Displays SNMP group information. Monitor
Group Allows you to create, modify and delete an SNMP .
Configure
group.
Displays SNMP user information. Monitor
User Allows you to create, modify and delete an SNMP .
Configure

user.




Function menu Description User level
!D|sp|cys' the status of the SNMP trap function and Monitor
information about target hosts.

Trap
Allows you to enable or disable the SNMP trap Confiqure
function, or create, modify and delete a target host. 9v
Displays SNMP view information. Monitor
View Allows you to create, modify and delete an SNMP .
. Configure
view.
Interface Interface Displays and allows you to clear the statistics Confiqure
Statistics Statistics information of an interface. 9
Select VIAN Allows you to select a VLAN range. Monitor
Create Allows you fo create VLANS. Configure
Port Detail Displays the VLAN-related details of a port. Monitor
Detail Displays the member port information of a VLAN.  Monitor
VLAN
. Allows you to modify the description and member .
Modify VLAN ports of a VIAN. Configure
Modify Port Allows you to change the VLAN to which a port Configure
belongs.
Remove Allows you to remove VLANE. Configure
Summary Displays information about VLAN interfaces by Monitor
address type.
Creafe Allows you to create VLAN interfaces and Confiaure
VIAN configure IP addresses for them. J
Interface | e " J f
. Allows you to modity the IP addresses and status o .
Modiy VLAN interfaces. Configure
v,\vlz:k Remove Allows you to remove VLAN interfaces. Configure
Summary Displays voice VLAN information globally or on a Monitor
port.
Setup Allows you to configure the global voice VLAN. Configure
Port Setup Allows you to configure a voice VLAN on a port.  Configure
Voice Displays the add f th
plays the addresses of the OUls that can be .
VIAN OUI Summary identified by voice VLAN. Monitor
Allows you to add the address of an OUI that can .
OUI Add be identified by voice VLAN. Configure
Allows you to remove the address of an OUI that .
OUl Remove can be identified by voice VLAN. Configure
Displays MAC address information. Monitor
MAC
MAC Allows you to create and remove MAC addresses.  Configure
Sefup D|s,.p|oy.s and allows you to configure MAC address Configure
aging time.
MSTP Region Displays information about MST regions. Monitor
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Function menu Description User level
Allows you to modify MST regions. Configure
Global Allows you to set global MSTP parameters. Configure
Port Summary Displays the MSTP information of ports. Monitor
Port Setup Allows you to set MSTP parameters on ports. Configure
Summary Displays information about link aggregation Monitor
groups.
Link
Aggregati Create Allows you to create link aggregation groups. Configure
on Modify Allows you to modify link aggregation groups. Configure
Remove Allows you to remove link aggregation groups. Configure
Summary D|sp|ay§ information about LACP-enabled ports Monitor
LACP and their partner ports.
Setup Allows you to set LACP priorities. Configure
Displays the LLDP configuration information, local
information, neighbor information, statistics Monitor
Port Sefup information, and status information of a port.
Allows you to modify LLDP configuration on a port. ~ Configure
Displays global LLDP configuration information. Monitor
LLDP Global Setup
Allows you to configure global LLDP parameters.  Configure
Global Dlsplgys global LLDP local information and Monitor
Summary statistics.
Neighbor . . . . .
Summary Displays global LLDP neighbor information. Monitor
Displays global IGMP snooping configuration
information or the IGMP snooping configuration Monitor
' information in a VLAN, and allows you to view the " " *
Basic IGMP snooping multicast entry information.
IGMP Allows you to configure IGMP snooping globall
. you to configure snooping globally or .
Snooping in a VLAN. Configure
Plsplcys' the IGMP snooping configuration Monitor
Advanced information on a port.
Allows you to configure IGMP snooping on a port.  Configure
Summary Displays the IPv4 active route table. Monitor
lPV4. Create Allows you fo create an IPv4 static route. Configure
Routing
Remove Allows you to delete the selected IPv4 static routes. ~ Configure
Displays information about the DHCP status,
advanced configuration information of the DHCP
DHCP DHCP Relay relay agent, DHCP server group configuration, Monitor

DHCP relay agent inferface configuration, and the
DHCP client information.




Function menu Description User level
Allows you to enable/disable DHCP, configure
advanced DHCP relay agent settings, configure a Confiqure
DHCP server group, and enable/disable the DHCP 9
relay agent on an interface.
Displays the status, trusted and untrusted ports and Monitor
DHCP client information of DHCP snooping.
DHCP
Snooping Allows you to enable/disable DHCP snooping,
and configure DHCP snooping trusted and Configure
untrusted ports.
Displays the states of services: enabled or .
disabled. Configure
Service Service
Allows you to enable/disable services, and set
Management
related parameters.
Diagnostic Ping Allows you fo ping an IPv4 address. Visitor
Tools Trace Route Allows you to perform trace route operations. Visitor
Displays ARP table information. Monitor
ARP Table Allows you to add, modify, and remove ARP .
ARP : Configure
entries.
Managem
ent Displays the configuration information of gratuitous .
Monitor
Gratuitous ARP _ARP.
Allows you to configure gratuitous ARP. Configure
ARP _ Displays ARP detection configuration information.  Monitor
Anti-Attack ARP Detection ' ' '
nh-Afiac Allows you to configure ARP detection. Configure
Displays 802.1X configuration information Monitor
globally or on a port.
802.1X 802.1X I ; ohall
Allows you to contigure 802.1X globally or on a Configure
port.
Displays ISP domain configuration information. Monitor
Domain Setup
Allows you to add and remove ISP domains. Management
Auth Plsp|oys. the authentication F:onflgurohon Monitor
. information of an ISP domain.
entic Authentication
ation Allows you to specify authentication methods for an
ISP domain Management
AAA ;
Plsplcys. the authorization ni1eihod configuration Monitor
information of an ISP domain.
Authorization
Allows you to specify authorization methods for an
: Management
ISP domain.
Accounting Displays the accounting method configuration Monitor

information of an ISP domain.

10



Function menu

Description

User level

Allows you to specify accounting methods for an

ISP domain. Management
RADIUS Server Dlsplo)./s and 0.||ows you to configure RADIUS Management
server information.
RADIUS '| I .
RADIUS Setup Displays and allows you to configure RADIUS Management
parameters.
Displays configuration information about local Monitor
users.
Local User
Allows you to create, modify and remove a local
Management
user.
Users o : - ]
Displays configuration information about user Monitor
groups.
User Group
Allows you to create, modify and remove a user
Management
group.
Displays information about PKI entities. Monitor
Entity
Allows you to add, modify, and delete a PKl entity. ~ Configure
Displays information about PKI domains. Monitor
Domain Allows you to add, modify, and delete a PKI .
. Configure
domain.
PKI Displays the certificate information of PKI domains .
. I Monitor
and allows you to view the contents of a certificate.
Certificate Allows you to generate a key pair, destroy a key
pair, refrieve a certificate, request a certificate, and ~ Configure
delete a certificate.
Displays the contents of the CRL. Monitor
CRL
Allows you to receive the CRL of a domain. Configure
Port Isolate ~ Summary Displays port isolation group information. Monitor
Group Modify Allows you to configure a port isolation group. Configure
S.ecu Displays the configurations of authorized IP, the
rity Authorized ~ Summary associated IPv4 ACL list, and the associated IPvé6 ~ Management
IP ACL list.
Setup Allows you to configure authorized IP. Management
Summary Displays time range configuration information. Monitor
Time Create Allows you to create a time range. Configure
Range
Remove Allows you to delete a time range. Configure
QoS Summary Displays IPv4 ACL configuration information. Monitor
Create Allows you fo create an IPv4 ACL. Configure
ACL IPv4 Basic Setup Allows you to configure a rule for a basic IPv4 ACL.  Configure
Advanced Allows you to configure a rule for an advanced Confiqure
Setup IPv4 ACL. 'gv
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Function menu Description User level
Link Setup Allows you to create a rule for a link layer ACL. Configure
Remove Allows you to delete an IPv4 ACL or its rules. Configure
Summary Displays the queue information of a port. Monitor
Queue
Setup Allows you to configure a queue on a port. Configure
Summary Displays line rate configuration information. Monitor
Line Rate
Setup Allows you to configure the line rate. Configure
Summary Displays classifier configuration information. Monitor
Create Allows you fo create a class. Configure
Classifier g, Allows you to configure the classification rules for a Confiqure
P class. 9
Allows you to delete a class or its classification .
Remove Configure
rules.
Summary Displays traffic behavior configuration information.  Monitor
Create Allows you to create a traffic behavior. Configure
Allows you to configure actions for a traffic .
Behavior Sefup behavior. Configure
Allows you to configure traffic mirroring and traffic .
Port Setup redirecting for a traffic behavior Configure
Remove Allows you to delete a traffic behavior. Configure
Summary Displays QoS policy configuration information. Monitor
Create Allows you to create a QoS policy. Configure
QoS Policy Sefup Allow's you fo configure thg classifier-behavior Configure
associations for a QoS policy.
Remove Al|on§ you to d.elete a Qo$ policy or its Configure
classifierbehavior associations.
Summary Displays the QoS policy applied to a port. Monitor
Port Policy  Setup Allows you to apply a QoS policy to a port. Configure
Remove Allows you to remove the QoS policy from the port. ~ Configure
Priority Priority Displays priority mapping table information. Monitor
Mapping  Mapping Allows you to modify the priority mapping entries.  Configure
Displays port priority and trust mode information.  Monitor
Port Priority ~ Port Priority
Allows you to modify port priority and trust mode. ~ Configure
Summary Plfsplc:ys. PSE information and PoE interface Monitor
PoE PoE information.
Setup Allows you to configure a PoE interface. Configure

12



Intfroduction to the common items on the web pages

Buttons and icons

1. Commonly used buttons and icons

Button and icon Function
Anply Used to apply the configuration on the current page.
Used to cancel the configuration on the current page, and return to the
Cancel S .
corresponding list page or the Device Info page.
Refresh Used to refresh the information on the current page.
Clear Used to clear all the information on a list or all statistics.
Add Used to enter a page for adding an item.
Rermove
! Used to remove the selected items.
Del Selected
Selact All Used to select all the entries on a list, or all the ports on the device panel.
Select Mone Used to deselect all the entries on a list, or all the ports on the device panel.
Generally present on the configuration wizard; used to buffer but not apply
PMext= ) . . .
the configuration of the current step and enter the next configuration step.
Generally present on the configuration wizard; used to buffer but not apply
=Back the configuration of the current step and return to the previous configuration
step.
Firieh Generally present on the configuration wizard; used to apply the
s configurations of all configuration steps.
Generally present on the “Operation” column on a list; used to enter the
modification page of an item so that you can modify the configurations of
the item.
il Generally present on the “Operation” column on a list; used to delete the
item corresponding to this icon.
Click the plus sign before a corresponding item. You can see the collapsed
| +Advanced s =19 P E P
contents.
Page display

The web interface can display a long list by pages, as shown in a. You can set the number of entries
displayed per page, and use the First, Prev, Next, and Last links to view the contents on the first, previous,
next, and last pages, or go to any page that you want to view.
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a. Content display by pages

b Search ttern| IP Address % Keyvwords: Search
[Fi IP Address MAC Address WLAR D Fort Twpe Cperation
] 192.168.1.11 Q0od-2afr-f536 il ]| GigabitEthernet1/019 Dynamic m
[] 192168116 0019-2146-ca29 999 GigabitEthernet1/019 Dynamic m
[]/192.168.1.40 Qooo-0oof-000s il GigahitEthernet1/019 Dynamic m
[]192.168.1.41 00ao0-000f00045 945 GigahitEthernet1/019 Dynamic m
[] 192.168.1.42 Q0oo-000fF0011 9445 GigabhitEthernet10/19 Dynamic m
[] 192.168.1.43 000f-e23e-haaa iz le] GigabitEthernet1 /019 Dynamic m
[] 192.168.1.45 000f-e23e-9cah 449 GigahitEthernet1/0M18  Dynamic m
[] 192168.1.46 00of-e240-3144 il ] GigabitEthernet1/019 Dynamic m
[]192.168.1.47 00of-e?3e-fa3d 955 GigabitEthernet1/019 Dynamic m
[]192.168.1.49 00oo0-000f000t6 945 GigahitEthernet1/019 Dynamic m
[]/192.168.1.95 00of-e2a3-76h3 9445 GigabhitEthernet10/19 Dynamic m
[] 192.168.1.56 N00f-elba-58ee 589 GigahitEthernet1M 8 Dynamic m
[] 1921681.57 00of-e249-2048 il ]| GigabitEthernet1/0M19 Dynamic m
[] 192.168.1.58 00of-e258-h140 il ] GigabitEthernet1/019 Dynamic m

14 records, 19 % |per page | page 171, record 1-14 | 1

Search function

On some list pages, the web interface provides basic and advanced search functions. You can use the
search function to display those entries matching certain search criteria.

e Basic search function—Select a search item from the drop-down list as shown in g, input the keyword,
and click the Query button to display the entries that match the criteria.

e  Advanced search function—Click P before Search ltem, as shown in a. You can select Match case
and whole word, that is, the item to be searched must completely match the keyword, or you can select
Search in previous results. If you do not select exact search, a fuzzy search is performed.

a. Advanced search

wSearch ltern) 1P Address % lkeyvwords: Search

[IMatch case and whole word
[1searchin previous results

Sorting function
On some list pages, the web interface provides the sorting function to display the entries in a certain order.

As shown in g, you can click the blue heading item of each column to sort the entries based on the heading
item you selected. Then, the heading item is displayed with an arrow beside it. The upward arrow indicates
the ascending order, and the downward arrow indicates the descending order.
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a.

Sort display (based on MAC address in the ascending order)

Fi IF Address mMAC Address R-fll_DAN Fort Type Ciperation
[] 192.168.1.41 0000-000f-0005 999 GigabitEthernet!/0M9  Dynamic Il
[] 192.168.1.40 0000-000f-0008 999 GigabitEthernet!/0M9  Dynamic Il
[] 192168.1.449 0ooo-000f-000p 999 GigabitEthernet10A19  Dynamic m
[] 192168.1.42 00o00-000f-0011 4995 GigabitEthernet1/0A19  Dynamic m
[] 192168.1.11 000d-2817-f536 4995 GigabitEthernet10A19  Dynamic m
[] 192168.1.44 000fe23e-9can 999 GigabitEthernet1/0M8 Dynamic m
[] 192168.1.43 00o0f-e23e-h583 9499 GigabitEthernet1/0M19  Dynamic m
[] 192168.1.47 000f-e23e-fa3d 4995 GigabitEthernet1/0f19  Dynamic m
[] 192168146 0oof-e240-a189 999 GigabitEthernet1/0M19  Dynamic m
[] 192168157 0oof-e2449-2048 999 GigabitEthernet1/0f19  Dynamic m
[] 192168.1.58 00of-e258-h140 999 GigabitEthernet1/019  Dynamic m
[] 192.168.1.56 000fe2Ea-58ee 999 GigahitEthernet/oMy  Dynamic m
[] 192168.1.54 00o0f-e2a3-TEh3 999 GigabitEthernet1/019  Dynamic m
[] 192168116 0019-2146-ca29 999 GigabitEthernet1/0M19  Dynamic m

Contiguration guidelines

The web console supports Microsoft Internet Explorer 6.0 SP2 and higher.

The web console does not support the Back, Next, Refresh buttons provided by the browser. Using
these buttons may result in abnormal display of web pages.

When the device is performing the spanning tree calculation, you cannot log in to or use the web
interface.

The Windows firewall limits the number of TCP connections, so when you use IE to log in to the web
interface, sometimes you may be unable to open the web interface. To avoid this problem, turn off the
Windows firewall before login.

If the software version of the device changes, when you log in to the device through the web interface,
delete the temporary Internet files of IE; otherwise, the web page content may not be displayed
correctly.
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Configuration at the CLI

NOTE:

o The HP V1910 Switch Series can be configured through the CLI, web interface, and SNMP/MIB,
among which the web interface supports all V1910 Switch Series configurations. These configuration
methods are suitable for different application scenarios. As a supplementary to the web interface, the
CLI provides some configuration commands to facilitate your operation, which are described in this
chapter. To perform other configurations not supported by the CLI, use the web interface.

o You will enter user view directly after you log in to the device. Commands in the document are all
performed in user view.

Getting started with the CLI

As a supplementary to the web interface, the CLI provides some configuration commands to facilitate your
operation. For example, if you forget the IP address of VLAN-interface 1 and cannot log in to the device
through the web interface, you can connect the console port of the device to a PC, and reconfigure the IP

address of VLAN-interface 1 at the CLI.

This section describes using the CLI to manage the device.

Setting up the configuration environment

To set up the configuration environment, connect a terminal (a PC in this example) to the console port on the
switch with a console cable.

A console cable is an 8-core shielded cable, with a crimped RJ-45 connector at one end for connecting to
the console port of the switch, and a DB-9 female connector at the other end for connecting to the serial port
on the console terminal.

a. Console cable

A side

T Pos.9 Main label

Pos.1A

Use a console cable to connect a terminal device to the switch, as follows:
Table 3 Plug the DB-9 female connector to the serial port of the console terminal or PC.

Table 4 Connect the RJ-45 connector to the console port of the switch.
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b.

Network diagram for configuration environment setup

Console port

Console cable

/\ CAUTION:

Verify the mark on the console port to ensure that you are connecting to the correct port.

NOTE:

The serial port on a PC does not support hot swapping. When you connect a PC to a powered-on
switch, connect the DB-9 connector of the console cable to the PC before connecting the RJ-45
connector to the switch.

When you disconnect a PC from a powered-on switch, disconnect the DB-9 connector of the console
cable from the PC after disconnecting the RJ-45 connector from the switch.

Setting terminal parameters

To configure and manage the switch, you must run a terminal emulator program on the console terminal, for
example, a PC. This section uses Windows XP HyperTerminal as an example.

The following are the required terminal settings:

Bits per second—38400
Data bits—8
Parity—None

Stop bits—1

Flow control—None
Emulation—VT100

Follow these steps to set terminal parameters, for example, on a Windows XP HyperTerminal:

Table 5 Select Start > All Programs > Accessories > Communications > HyperTerminal, and in the

Connection Description dialog box that appears, type the name of the new connection in the Name text
box and click OK.
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b. Connection description of the HyperTerminal

Connection Description ﬂﬂ

' Mew Connection
Enter a name and chooge an icon for the connection;

M ame:
ISwitcH

lcan:

ok I Cancel |

Table 6 Select the serial port to be used from the Connect using drop-down list, and click OK.

c. Set the serial port used by the HyperTerminal connection

Enter detailz far the phone nurmber that yow want ta dial:

Countiyfregion: ILlniteu:I States of America [1] j

Arga code; ]

Phone number: I

Connect using:  |[ME]Eh

] I Cancel |

Table 7 Set Bits per second to 38400, Data bits to 8, Parity to None, Stop bits to 1, and Flow control to
None, and click OK.
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d. Set the serial port parameters

Fort Settingz |

Bitz per zecond: I 38400 j

[ ata bitz: IE j

Farity: I Maone j

Stop bitz: I'I j

Flowy contral: | {g=hE il

Festore Defaulkz |

0k, I Cancel | Smply |

Table 8 Select File > Properties in the HyperTerminal window.
e. HyperTerminal window

& Switch - HyperTerminal —

File Edit WYiew Call Transfer Help

C
[
Connected 0:00:03 Auto detect Auto detect SCROLL |CAPS |NL|M |Capture Print echo Y
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Table 9 Click the Settings tab, set the emulation to VT100, and click OK in the Switch Properties dialog box.

f.  Set terminal emulation in Switch Properties dialog box

Switch Properties ilﬁl
Connect To  Settings I

— Furnction, arrovw, and ctrl keys act az

0  Terminal keys  Windows keps

— Backzpace key sends
o Chl+H © Del & Cil+H, Space, Chl+H

Ermulation:

YT100 | Teminal Setup... |

Telnet terminal ID: ~ [¥T100

Backscroll buffer lines: IEEIEI :I

[T Play sound when conrecting or disconnecting

Irput Translatior... | ASCI Setup... |

| k. I Cancel |

logging in to the CLI

The login process requires a username and password. The default username for first time configuration is
admin, no password is required. Usernames and passwords are case sensitive.

To log in to the CLI:

Table 10 Press Enter. The Username prompt displays:
Login authentication

Username:

Table 11 Enter your username at the Username prompt.
Username:admin

Table 12 Press Enter. The Password prompt display
Password:

The login information is verified, and displays the following CLI menu:
<HP V1910 Switch>

If the password is invalid, the following message appears and process restarts.
% Login failed!
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CLl commands

This Command section contains the following commands:

To do... Use the command...
Display a list of CLI commands on the device ?
Reboot the device and run the default configuration initialize

Specify VLAN-interface 1 to obtain an IP address through
DHCP or manual configuration

ipsetup { dhep | ip address ip-address { mask
| mask-length } [ default-gateway
ip-address | }

Modity the login password of a user

password

Download the Boot ROM image or system software image file
from the TFTP server and specify as the startup configuration
file

upgrade server-address source-filename
{ bootrom | runtime }

Reboot the device and run the main configuration file reboot
View the summary information of the device summary
Ping a specified destination ping host

initialize

Syntax

initialize

Parameters

None

Description

Use the initialize command to delete the current configuration file and reboot the device with the default

configuration file.

Use the command with caution because it deletes the configuration file to be used at the next startup and

restores the factory default settings.

Examples

# Delete the configuration file to be used at the next startup and reboot the device with the default

configuration being used during reboot.
<Sysname> initialize

The startup configuration file will be deleted and the system will be rebooted.Continue?

[Y/N]:y
Please wait...

Ipsetup

Syntax

ipsetup { dhep | ip address ip-address { mask | mask-length } [ default-gateway ip-address | }
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Parameters

dhcp: Specifies the interface to obtain an IP address through DHCP.

ip-address ip-address: Specifies an IP address for VLAN-interface 1 in dotted decimal notation.

mask: Subnet mask in dotted decimal notation.

mask-length: Subnet mask length, the number of consecutive ones in the mask, in the range of 0 to 32.

default-gateway ip-address: Specifies the IP address of the default gateway or the IP address of the
outbound interface. With this argument and keyword combination configured, the command not only
assigns an IP address to the interface, but also specifies a default route for the device.

Description

Use the ipsetup dhcp command to specify VLAN-interface 1 to obtain an IP address through DHCP.

Use the ipsetup ip address ip-address { mask | mask-length } command to assign an IP address to
VLAN-interface 1.

By default, the device automatically obtains its IP address through DHCP; if fails, it uses the assigned default
IP address. For more information, see b.

If there is no VLAN-interface 1, either command creates VLAN-interface 1 first, and then specifies its IP
address.

Examples

# Create VLAN-interface 1 and specify the interface to obtain an IP address through DHCP.

<Sysname> ipsetup dhcp

# Create VLAN-interface 1 and assign 192.168.1.2 to the interface, and specify 192.168.1.1 as the
default gateway.
<Sysname> ipsetup ip-address 192.168.1.2 24 default-gateway 192.168.1.1

password

Syntax

password

Parameters

None

Description

Use the password command to modity the login password of a user.

Examples

# Modify the login password of user admin.
<Sysname> password

Change password for user: admin

Old password: ***

Enter new password: **

Retype password: **

The password has been successfully changed.
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ping
Syntax
ping host
Parameters
host: Destination IP address (in dotted decimal notation), URL, or host name (a string of 1 to 20 characters).
Description
Use the ping command to ping a specified destination.
You can enter Ctrl+C to terminate a ping operation.
Examples

# Ping IP address 1.1.2.2.

<Sysname> ping 1.1.2.2
PING 1.1.2.2: 56 data bytes, press CTRL_C to break
Reply from 1.1.2.2: bytes=56 Sequence=1 ttl=254 time=205 ms
Reply from 1.1.2.2: bytes=56 Sequence=2 ttl=254 time=1 ms
Reply from 1.1.2.2: bytes=56 Sequence=3 ttl=254 time=1 ms
Reply from 1.1.2.2: bytes=56 Sequence=4 ttl=254 time=1 ms
Reply from 1.1.2.2: bytes=56 Sequence=5 ttl=254 time=1 ms

--- 1.1.2.2 ping statistics ---
5 packet(s) transmitted
5 packet(s) received
0.00% packet loss
round-trip min/avg/max = 1/41/205 ms

The output shows that IP address 1.1.2.2 is reachable and the echo replies are all returned from the
destination. The minimum, average, and maximum roundtrip intervals are 1 millisecond, 41 milliseconds,
and 205 milliseconds respectively.

quit
Syntax
quit
Parameters
None
Description
Use the quit command to log out of the system.
Examples

# Log out of the system.

<Sysname> quit

* Copyright (c) 2004-2011 Hewlett-Packard Development Company, L.P. *
* Without the owner®s prior written consent, *
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* no decompiling or reverse-engineering shall be allowed.

User interface auxO is available.

Please press ENTER.

reboot
Syntax

reboot
Parameters
None
Description
Use the reboot command to reboot the device and run the main configuration file.
Use this command with caution because reboot results in service interruption.

If the main configuration file is corrupted or does not exist, the device cannot be rebooted with the reboot
command. In this case, you can specify a new main configuration file to reboot the device, or you can
power off the device, and then power it on, and the system will automatically use the backup configuration
file at the next startup.

If you reboot the device when file operations are being performed, the system does not execute the
command to ensure security.

Examples

# If the configuration does not change, reboot the device.

<Syshame> reboot
Start to check configuration with next startup configuration file, pleasewait......... DONE!
This command will reboot the device. Continue? [Y/N]:y

Now rebooting, please wait...

# If the configuration changes, reboot the device.
<Sysname> reboot

Start to check configuration with next startup configuration file, pleasewait......... DONE!
This command will reboot the device. Current configuration will be lost in next startup if
you continue. Continue? [Y/N]:y

Now rebooting, please wait...

summary
Syntax

summary
Parameters

None
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Description

Use the summary command to view the summary information of the device, including the IP address of
VLAN-interface 1, and software version information.

Examples

# Display summary information of the device.
<Sysname> summary

Select menu option: Summary

IP Method: DHCP

IP address: 10.153.96.86
Subnet mask: 255.255.255.0
Default gateway: 0.0.0.0

Current boot app is: flash:/v1910-cmw520-al1108.bin
Next main boot app is: flash:/v1910-cmw520-a1108.bin
Next backup boot app is: NULL

HP Comware Platform Software

Comware Software, Version 5.20 Alpha 1108,

Copyright (c) 2004-2011 Hewlett-Packard Development Company, L.P.

HP V1910-24G-PoE (365W) Switch uptime is 0 week, O day, 6 hours, 28 minutes

HP V1910-24G-PoE (365W) Switch

128M bytes DRAM

128M bytes Nand Flash Memory
Config Register points to Nand Flash

Hardware Version is REV.B

CPLD Version is 002

Bootrom Version is 138

[SubSlot 0] 24GE+4SFP+POE Hardware Version is REV.B

upgrade
Syntax
upgrade server-address source-filename { bootrom | runtime }
Parameters
server-address: IP address or host name (a string of 1 to 20 characters) of a TFTP server.
source-filename: Software package name on the TFTP server.
bootrom: Specifies the Boot ROM image in the software package file as the startup configuration file.

runtime: Specifies the system software image file in the software package file as the startup configuration
file.
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Description

Use the upgrade server-address source-filename bootrom command to upgrade the Boot ROM image. If the
Boot ROM image in the downloaded software package file is not applicable, the original Boot ROM image
is still used as the startup configuration file.

Use the upgrade server-address source-filename runtime command to upgrade the system software image
file. If the system software image file in the downloaded software package file is not applicable, the original
system software image file is still used as the startup configuration file.

To make the downloaded software package file take effect, reboot the device.

NOTE:

The HP V1910 Switch Series does not provide an independent Boot ROM image; instead, it integrates the
Boot ROM image with the system software image file together in a software package file with the
extension name of .bin.

Examples

# Download software package file main.bin from the TFTP server and use the Boot ROM image in the
package as the startup configuration file.

<Sysname> upgrade 192.168.20.41 main.bin bootrom

# Download software package file main.bin from the TFTP server and use the system software image file in
the package as the startup configuration file.

<Sysname> upgrade 192.168.20.41 main.bin runtime

Contfiguration example for upgrading the system
software image at the CLI

Network requirements

As shown in o, a V1910 switch is connected to the PC through the console cable, and connected to the
gateway through GigabitEthernet 1/0/1. The IP address of the gateway is 192.168.1.1/24, and the TFTP
server where the system software image (SwitchV1910.bin) is located is 192.168.10.1/24. The gateway
and the switch can reach each other.

The administrator upgrades the Boot ROM image and the system software image file of the V1910 switch
through the PC and sets the IP address of the switch to 192.168.1.2/24.

a. Network diagram for upgrading the system software image of the V1910 switch at the CLI

&w“§" IP network

Console port WP GE1/0/ R

Console cable

PC Switch Gateway TFTP server

Configuration procedure

Table 13 Run the TFTP server program on the TFTP server, and specify the path of the file to be loaded.
(Omitted)

Table 14 Perform the following configurations on the switch.

26



# Configure the IP address of VLAN-interface 1 of the switch as 192.168.1.2/24, and specify the default
gateway as 192.168.1.1.
<Switch> ipsetup ip-address 192.168.1.2 24 default-gateway 192.168.1.1

# Download the software package file SwitchV1910.bin from the TFTP server to the switch, and upgrade the
system software image in the package.
<Switch> upgrade 192.168.10.1 SwitchVv1910.bin runtime

File will be transferred in binary mode

Downloading file from remote TFTP server, please wait.../

TFTP: 10262144 bytes received in 71 second(s)

File downloaded successfully.

# Download the software package file SwitchV1910.bin from the TFTP server to the switch, and upgrade the
Boot ROM image.
<Switch> upgrade 192.168.10.1 SwitchVv1910.bin bootrom
The file flash:/SwitchV1910.bin exists. Overwrite it? [Y/N]:y
Verifying server file...
Deleting the old file, please wait...
File will be transferred in binary mode
Downloading file from remote TFTP server, please wait.../
TFTP: 10262144 bytes received in 61 second(s)
File downloaded successfully.
BootRom file updating finished!

# Reboot the switch.
<Switch> reboot

After getting the new image file, reboot the switch to have the upgraded image take effect.
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Configuration wizard

Overview

The configuration wizard guides you through the basic service setup, including the system name, system
location, contact information, and management IP address (IP address of the VLAN interface).

Basic service setup

Entering the configuration wizard homepage

From the navigation tree, select Wizard to enter the configuration wizard homepage, as shown in a.

a. Configuration wizard homepage

Welcome to the Management IP Interface Setup Wizard: Step 1 of 4

This wizard helps you set, modify, or quickly view the IP configuration parameters.

To continue, click Nesxt.

ext= Cancel

Configuring system parameters

In the wizard homepage, click Next to enter the system parameter configuration page, as shown in a.
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a. System parameter configuration page

System Parameters: Step 2 of 4

Sysname; HP %1910 Swatch (1- 30Char)

Svslocation:  HP {1- 200Char)

Syscontact  hitp:/fwww hp com {1- 200Char)
=Hack Mext= Cancel

2. System parameter configuration items

ltem Description

Specify the system name.

The system name appears at the top of the navigation tree.

Sysname You can also set the system name in the System Name page you enter by selecting

Device > Basic. For more information, see the chapter “Device basic information
configuration”.

Specify the physical location of the system.

Syslocation You can also set the physical location in the setup page you enter by selecting Device
- SNMP. For more information, see the chapter “SNMP configuration”.

Set the contact information for users to get in touch with the device vendor for help.

Syscontact You can also set the contact information in the setup page you enter by selecting Device
- SNMP. For more information, see the chapter “SNMP configuration”.

Configuring management IP address

NOTE:

Modifying the management IP address used for the current login will tear down the connection to the
device. Use the new management IP address fo re-log in to the system.
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A management IP address is the IP address of a VLAN interface, which can be used to access the device.
You can also set configure a VLAN interface and its IP address in the page you enter by selecting Network
- VLAN Interface. For more information, see the chapter “VLAN interface configuration”.

Atter finishing the configuration, click Next to enter the management IP address configuration page, as
shown in a.

a. Management IP address configuration page

Management IP lnterface confimr ation: Step 3 of 4

The IP address of a VLAN interface can be used as the management IF address o access the device

Select VLAM Interface: 1~ Admin stalus: | Up b

Configure IPvé address
) DHCP ) BOOTP (% Manual

IPvd address: | 192.168.0.27 MaskLen: | 24 (255.255.25510) bt

<Back MNext= Cancel

2.  Management IP address configuration items

ltem Description

Select a VLAN interface.

Select VLAN Interface  Available VLAN interfaces are those configured in the page you enter by selecting
Network > VLAN Interface and selecting the Create tab.

Enable or disable the VLAN interface.

When errors occurred on the VLAN interface, disable the interface and then enable
the port to bring the port to work properly.

By default, the VLAN interface is in the down state if all Ethernet ports in the VLAN are
down. The VLAN is in the up state if one or more ports in the VLAN are up.

Admin Status

@ IMPORTANT:

Disabling or enabling the VLAN inferface does not affect the status of the Ethernet ports
in the VLAN. That is, the port status does not change with the VLAN interface status.

Configure IPv4 DHCP Configure how the VLAN interface obtains an IPv4 address.
address e DHCP: Specifies the VLAN interface to obtain an IPv4 address by
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ltem Description

DHCP.

BOOTP e BOOTP: Specifies the VLAN interface to obtain an IPv4 address
EE— through BOOTP.

e Manual: Allows you to specify an IPv4 address and a mask length.

Manual (D) imporTaNT:
Support for IPv4 obtaining methods depends on the device model.
[Pv4
c(:l/dress Specify an IPv4 address and the mask length for the VLAN interface.
These two text boxes are configurable if Manual is selected.
MaskLen

Finishing configuration wizard

After finishing the management IP address configuration, click Next, as shown in a.

a. Configuration finishes

Completing the Management IP Interface Setup Wizard: Step 4 of 4

You have successfully completed the Management IP Interface Setup wizard.

You have specified the following settings:

Sysname: HP V1910 Switch
Syslocation: HP
Syscontact: hitpifasa bipLcom

WLAN Interface: 1 Admin Status: UP
Config IPv4 address:
mMethod: Manual

IPv4 address: 192.168.0.27
Subnet mask: 255.255.255.0

=Back Finish Cancel

The page displays your configurations. Review the configurations and if you want to modify the settings
click Back to go back to the page. Click Finish to confirm your settings and the system then performs the
configurations.
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IRF stack management

The HP V1910 IRF stack management feature enables you to configure and monitor a stack of connected HP
V1910 switches by logging in to one switch in the stack, as shown in a.

(D IMPORTANT:

The HP V1910 IRF stack management feature does not provide the functions of HP Intelligent Resilient

Framework (IRF) technology. To avoid confusion, IRF stack management is simply called stack
management in this document.

a. Network diagram for stack management

Master switch

To set up a stack, you must log in to one switch to create the stack, and this switch becomes the master for
the stack. You then configure and monitor all other member switches on the master switch. The ports that
connect the stack member switches are called stack ports.

Contiguring stack management

Stack management configuration task list

Perform the tasks in 1 to configure stack management.

1. Stack management configuration task list

Task Remarks
Required
t(}i:nr:glsjtr;:g Configuring global ~ Configure a private IP address pool for a stack and establish the stack,
switch of a parameters of a with the switch becoming the master switch of the stack.
stack stack By default, no IP address pool is configured for a stack and no stack is

established.
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Task Remarks

Required
Configuring stack Configure the ports of the master switch that connect to member
ports switches as stack ports.

By default, a port is not a stack port.

Configuring Required

member Configuring stack Configure a port of a member switch that connects to the master switch
switches of @ ports or another member switch as a stack port.

stack

By default, a port is not a stack port.

Displaying topology summary of a Optional
stack Display the information of stack members.

Optional

Display the control panels of stack members.

@ IMPORTANT:

Before viewing the control panel of a member switch, you must ensure

that the username, password, and access right you used to log on to the
master switch are the same with those configured on the member switch;
otherwise, the control panel of the member switch cannot be displayed.

Displaying device summary of a stack

Optional
Log in to the web interface of a member switch from the master switch.
@ IMPORTANT:

Logging info a member swifch from  Before logging into a member switch, you must ensure that the

the master switch username, password, and access right you used to log on to the master

switch are the same with those configured on the member switch;
otherwise, you cannot log into the member switch. You can configure
them by selecting Device and then clicking Users from the navigation
tree.

Contiguring global parameters of a stack

Select IRF from the navigation tree to enter the page shown in a. You can configure global parameters of a
stack in the Global Settings area.
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a.

2.

Setup

Topology Summary Device Summary

Global Settings

Private Met IP

Build Stack

Paort Settings

Mask

Disable |

Apply

b Search ltem: | Port Name = | Keywords: Search

Port Mame Fort Status

OoooooooooOoooood

GigahitEthernet1/0/1
GigahitEthernet1/0/2
GigahitEthernet1/0/3
GigahitEthernet1/0/4
GigahitEthernet1/0/5
GigahbitEthernet1/0/6
GigabitEthernet1/0/7
GigabitEthernet1/0/8
GigahitEthernet1/0/9
GigahitEthernet1/0M10
GigahitEthernet1/0/11
GigahitEthernet1/0/12
GigahitEthernet1/0M13
GigahitEthernet1/0/M14
GigahbitEthernet1/0/15

not stack port
not stack port
not stack port
not stack port
not stack port
not stack port
not stack part
not stack port
not stack port
not stack port
not stack port
not stack port
not stack port
not stack port

not stack port

20records,| 15 ™| per page | page 1/2, record 1-15 | Mext Last |1 GO

Enable Disable

Configuration items of global parameters

ltem

Description

Private Net [P

Configure a private IP address pool for the stack.

The master switch of a stack must be configured with a private IP address pool to
ensure that it can automatically allocate an available IP address to a member switch
when the device joints the stack.

Mask

(D IMPORTANT:

When you configure a private IP address pool for a stack, the number of IP addresses
in the address pool needs to be equal to or greater than the number of switches to be
added to the stack. Otherwise, some switches may not be able to join the stack
automatically for lack of private IP addresses.
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ltem Description

Enable the switch to establish a stack.

After you enable the switch to establish a stack, the switch becomes the master switch
of the stack and automatically adds the switches connected to its stack ports to the

Build Stack stack.
@ IMPORTANT:

You can delete a stack only on the master switch of the stack. The Global Settings area
on a member switch is grayed out.

Return to Stack management configuration task list.

Configuring stack ports

Select IRF from the navigation tree to enter the page shown in a. You can configure stack ports in the Port
Setftings area.

o Select the check box before a port name, and click Enable to configure the port as a stack port.

o Select the check box before a port name, and click Disable to configure the port as a non-stack port.

Return to Stack management configuration task list.

Displaying topology summary of a stack

Select IRF from the navigation tree and click the Topology Summary tab to enter the page shown in a.

a. Topology summary

Setup Device Summary
Member 1D Rale
1 Slave
0 Master

2. Fields of topology summary

Fields Description

Member ID of the device in the stack:

e Value O indicates that the switch is the master switch of the stack.

Member ID
e A value other than O indicates that the switch is a member switch and the value
is the member ID of the switch in the stack.
Role Role of the switch in the stack: master or member.

Return to Stack management configuration task list.
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Displaying device summary of a stack

Select IRF from the navigation tree and click the Device Summary tab to enter the page shown in a. On this
page, you can view interfaces and power socket layout on the panel of each stack member by clicking the
tab of the corresponding member switch.

a. Device summary (the master switch)

Setup Topology Summary

HF V1910-16G Sw...

Return to Stack management configuration task list.

Llogging into a member switch from the master switch

Select IRF from the navigation tree, click the Device Summary tab, and click the tab of a member switch to
enter the page shown in a.

Click the Configuring the Device hyperlink, you can log on to the web interface of the member switch to
manage and maintain the member switch directly.

a. Device summary (@ member switch)

Setup Topology Summary

HF V1910-16G Sw...

Configuring the Device
Return fo Stack management configuration task list.

Stack contiguration example

Network requirements

e Asshown in a, Switch A, Switch B, Switch C, and Switch D are connected with one another.
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e  Create a stack, where Switch A is the master switch, Switch B, Switch C, and Switch D are stack
members. An administrator can log in to Switch B, Switch C and Switch D through Switch A to perform
remote configurations.

a. Network diagram for stack management

w.,%

Switch A
(Master switch)

Stack

Eth1/0/3

Eth1/0/1

Switch C Switch D

Configuration procedure
Table 15 Configure the master switch

# Configure global parameters for the stack on Switch A.

o Select IRF from the navigation tree of Switch A to enter the page of the Setup tab.
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b. Configure global parameters for the stack on Switch A

Topology Summary Device Summary

Global Settings

Frivate Met [P |'1EIE.'1EE!.'1.'1 | [Mask 2652652550
Build Stack |Enah|e j
Apply
FPaort Settings
P Search itern: | Port Mame ¥ | Keywards: Search

Part Mame Paort Status

N I A 0 I R W R

GigabitEthernet1/0/1
GigabitEthernet1/0/2
GigabitEthernet1/0/3
GigabitEthernet1/0/4
GigabitEthernet1/0/3
GigabitEthernet1/0/8
GigabitEthernet1/0/7
GigabitEthernet1/0/8
GigabitEthernet1/0/9
GigabitEthernet1/0/10
GigabitEthernet1/0/11
GigahitEthernet1/012
GigahitEthernet1/0/13
GigahitEthernet1/0/14
GigahbitEthernet1/0M15

nat stack port
nat stack port
nat stack port
nat stack port
nat stack port
nat stack port
nat stack port
nit stack port
nat stack port
nat stack port
nat stack port
not stack port
not stack port
not stack port

not stack port

Next Last

20 records, |19 | per page | page 142, record 1-15 |

Enahle Disahble

o Type 192.168.1.1 in the text box of Private Net IP.
e Type 255.255.255.0 in the text box of Mask.

o Select Enable from the Build Stack drop-down list.
o Click Apply.

Now, switch A becomes the master switch.
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# Configure a stack port on Switch A.

C.

On the page of the Setup tab, perform the following configurations, as shown in c.

Configure a stack port on Switch A

Topolagy Summary

Global Settings

Device Summary

Frivate Met IF

Build Stack

FPaort Settings

| Mask

|Enah|e

[-

b Search itern: | Port Mame  » Keywnrl:ls:|

Fort Mame

GigahbitEthernet1/0i1

OO0O0O00OD0O0OOD0OO0O0O0OOEO

GigahitEthernet1/0/2
GigahitEthernet1/0/3
GigabitEthernet1/0/4
GigabitEthernet1/0/5
GigabitEthernet1/0/a
GigabitEthernet1/0/7
GigabitEthernet1/0/3
GigabitEthernet1/0/9
GigabitEthernet1/0/10
GigahitEthernet1/0/11
GigabitEthernet1/0/12
GigabitEthernet1/0/13
GigabitEthernet1/0/14
GigabitEthernet1/0/15

20 records,| 19 7| per page | page 142, record 1-15 |

Search

not stack port
not stack port
not stack port
nat stack port
nat stack port
nat stack port
nat stack port
nat stack port
nat stack port
nat stack port
nat stack port
nat stack port
nat stack port
nat stack port

nat stack port

Enable Disahble

Port Status

Next Last

In the Port Settings areq, select the check box before GigabitEthernet1/0/1.
Click Enable.

Table 16 Configure the member switches
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# On Switch B, configure local ports GigabitEthernet 1/0/2 connecting with switch A, GigabitEthernet
1/0/1 connecting with Switch C, and GigabitEthernet 1/0/3 connecting with Switch D as stack ports.

o Select IRF from the navigation tree of Switch B to enter the page of the Setup tab.
d. Configure stack ports on Switch B

Topology Summary Device Summary

Global Settings

Private Net P | | Mask

Build Stack |Disah|e ﬂ

Apply

FPaort Settings

P Search itern: | Port Mame ¥ | Keywards: Search

[F Port Mame

Paort Status

GigabitEthernet1/0/1
GigabitEthernet1/0/2
| GigabitEthernet1/0/3

(N A I R

GigabitEthernet1/0/4
GigabitEthernet1/0/3
GigabitEthernet1/0/8
GigabitEthernet1/0/7
GigabitEthernet1/0/8
GigabitEthernet1/0/9
GigabitEthernet1/0/10
GigabitEthernet1/0/11
GigahitEthernet1/012
GigahitEthernet1/0/13
GigahitEthernet1/0/14
GigahbitEthernet1/0M15

20 records, |19 | per page | page 142, record 1-15 |

In the Port Settings areq, select the check boxes before GigabitEthernet1/0/1, GigabitEthernet1/0/2,
and GigabitEthernet1/0/3.

Click Enable.

nat stack port
nat stack port
nat stack port
nat stack port
nat stack port
nat stack port
nat stack port
nit stack port
nat stack port
nat stack port
nat stack port
not stack port
not stack port
not stack port

not stack port

Enahle Disahble
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Now, switch B becomes a member switch.

# On Switch C, configure local port GigabitEthernet 1/0/1 connecting with Switch B as a stack port.
o Select IRF from the navigation tree of Switch C to enter the page of the Setup tabe.

e. Configure a stack port on Switch C

Topology Summary Device Summary

Global Settings

Private Net P | | Mask

| Disahle -]

Build Stack

FPaort Settings

P Search item: | Fort Mame > KE'y'w'nrds:| Search
[F Port Mame Port Status

GigabitEthernet1/0/1

nat stack port

OOo0O0oOoooOoooOoood

GigabitEthernet1/0/2
GigabitEthernet1/0/3
GigabitEthernet1/0/4
GigabitEthernet1/0/3
GigabitEthernet1/0/8
GigabitEthernet1/0/7
GigabitEthernet1/0/8
GigabitEthernet1/0/9
GigabitEthernet1/0/10
GigabitEthernet1/0/11
GigahitEthernet1/012
GigahitEthernet1/0/13
GigahitEthernet1/0/14
GigahbitEthernet1/0M15

nat stack port
nat stack port
nat stack port
nat stack port
nat stack port
nat stack port
nit stack port
nat stack port
nat stack port
nat stack port
not stack port
not stack port
not stack port

not stack port

Next Last

20 records, |19 | per page | page 142, record 1-15 |
Enable

Disahble

e In the Port Settings areq, select the check box before GigabitEthernet1/0/1.
e  Click Enable.
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Now, Switch C becomes a member switch.

# On Switch D, configure local port GigabitEthernet 1/0/1 connecting with Switch B as a stack port.
o Select IRF from the navigation tree of Switch D to enter the page of the Setup tab.

e In the Port Settings areq, select the check box before GigabitEthernet1/0/1.

e Click Enable.

Now, Switch D becomes a member switch.

Table 17 Verity the configuration

# Display the stack topology on Switch A.

e Select IRF from the navigation tree of Switch A and click the Topology Summary tab.

e  You can view the information as shown in f.

f.  Verify the configuration

Setup Device Summary
Member 1D Role
] [Master
1 Slave
2 Slave
3 Slave

Configuration guidelines

When configuring a stack, note the following issues:

Table 18 If a switch is already configured as the stack master, you are not allowed to modify the private IP
address pool on the switch.

Table 19 If a switch is already configured as a stack member, the Global Settings area on the member
switch is grayed out.
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Summary

The device summary module helps you understand the system information, port information, power
information, and fan information on the device. The system information includes the basic system

information, system resources state, and recent system operation logs.

Displaying device summary

Displaying system information

After you log in to the web interface, the System Information tab appears by default, as shown in a.

a. System information

Drevice Information

Systern Resource State

CPU Usage

Mermory Usage -

Recent System Operation Logs

Time Level
More Logs On DeviceMore...

Refresh Period

1%
iM%

Description

Refresh

@ Device Mame

A

HP %1 910-16G Switch JEOOSA
Froduct Infarmation

HP %1 910-16G Switch
Software Wersion Alpha 1108

Device Lacation

Contact Information

SerialMum
21023544150000000002
Software Version

5.20 Alpha 1108
Hardware Yersion

REVY.B

G Bootrom Wersion

135

Running Time

0 days 9 hours 8 minutes 3
seconds

e Ifyou select a certain time period, the system refreshes the system information at the specified interval.

e If you select Manual from the Refresh Period drop-down list, the system refreshes the information only

when you click the Refresh button.

The system information tab is divided into three sections, which display the following information:

° Basic system information
o System resource state

. Recent system operation logs
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Basic system information

The INFO area on the right of the page displays the basic system information such as device name, product
information, device location, contact information, serial number, software version, hardware version, Boot
ROM version, and running time. The running time displays how long the device is up since the last boot.

You can configure the device location and contact information on the Setup page you enter by selecting
Device > SNMP.

System resource state
The System Resource State displays the latest CPU usage and memory usage.
Recent system operation logs

1. Description about the recent system operation logs

Field Description
Time Displays the time when the system operation logs are generated.
Level Displays the severity of the system operation logs.
Description Displays the description of the system operation logs.
NOTE:

o The Summary page displays up to five latest system operation logs about the login and logout events.

o For more system operation logs, click More to enter the Log List page. You can also enter this page by
selecting Device > Syslog. For more information, see the chapter “Log management configuration”.

Displaying device information

After logging in to the web interface, you can click the Device Information tab to enter the page displaying
the device ports. Hover the cursor over a port and the port details appears, including the port name, type,
speed, utilization, and status, as shown in a. For the description about the port number and its color, see a.
Similarly, you can view the power type and working status and the fan working status.
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a.

Device information

Systarn Infarmation

Port: GigahitEthernet1/0/16

s Twne: 1000BASE-T
8 Speed: 1000, Full Duplex
Utilization: =1%
Status: Enabled

Refresh Period Refresh

Description of port humber color:

Unconnected Port.

D Connected port.

. Fartthat has heen set to inactive by user or protocol.

. FPortthat has heen selected by user.

Description on port numbers:
o Common number: Number of the port

e Underlined number: Number of the aggregation group of the port

If you select a certain time period from the Refresh Period drop-down list, the system refreshes the
information at the specified interval.

If you select Manual from the Refresh Period drop-down list, the system refreshes the information only
when you click the Refresh button.
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Device basic information configuration

The device basic information feature provides the following functions:

o Set the system name of the device. The configured system name is displayed on the top of the
navigation bar.

o Set the idle timeout period for logged-in users. The system logs an idle user off the web for security
purpose after the configured period.

Contiguring device basic information

Configuring system name

Select Device - Basic from the navigation tree fo enter the system name configuration page, as shown in a.

a. Configure system name

Web Idle Timeout

Set sysname

Sysname |sysname * Chars.(1-30)

Items marked with an asterisk(*) are required

2. System name configuration item

ltem Description

Sysname Set the system name.

Configuring idle timeout period

Select Device > Basic from the navigation tree, and then click the Web Idle Timeout tab to enter the page
for configuring idle timeout period, as shown in a.
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a. Configure idle timeout period

System Name

Set idle timeout

|dle timeout 10 :'1.1inutes<1-999.Del‘aultz 10]

Iterms marked with an asterisk(*) are required

Apply
2. Idle timeout period configuration item
ltem Description
Idle timeout Set the idle timeout period for logged-in users.
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System time configuration

The system time module allows you to display and set the device system time on the web interface. The
device supports setting system time through manual configuration and automatic synchronization of NTP
server time.

An administrator can keep time synchronized among all the devices within a network by changing the
system clock on each device, however, this is a huge amount of workload and cannot guarantee the clock
precision.

Defined in RFC 1305, the Network Time Protocol (NTP) synchronizes timekeeping among distributed time
servers and clients. NTP allows quick clock synchronization within the entire network and ensures a high
clock precision so that the devices can provide diverse applications based on the consistent time.

Contiguring system time

Select Device > System Time from the navigation tree. The system time configuration page appears by
default, as shown in a. The current system time and clock status are displayed.

a. System time configuration page

Systern Time Configuration

System Time: 2000-04-26 13:19:29 Refrash

Clock status: unsynchronized

Configure the system time
O manual

Hour | J Minute| J Secaond
morth [+ | Date |25 | vear

@ NTP

Source Interface Ylan-interfacel -

External Reference Source

NTPgenert [ ] o L]
opaza? | oo L]

Set Bystermn TimeZone
TimeZone: |(GMTJ Greerwich Mean Time: Dublin Edinburgh Lisbon, Londan j

oy
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2. System time configuration items

ltem

Description

Manual

Select to manually configure the system time, including the setting
of Year, Month, Day, Hour, Minute, and Second.

Source Interface

Set the source interface for an NTP message.

If you do not want the IP address of a certain interface on the local
device to become the destination address of response messages,
you can specify the source interface for NTP messages, so that the
source IP address in the NTP messages is the primary IP address of
this interface.

Key 1

Key 2
NTP

Set an NTP authentication key.

The NTP authentication feature should be enabled for a system
running NTP in a network where there is a high security demand.
This feature enhances the network security by means of
client-server key authentication, which prohibits a client from
synchronizing with a device that has failed authentication.

You can set two authentication keys, each of which is composed of
a key ID and key string.

o IDis the ID of a key.

o Key string is a character string for MD5 authentication key.

NTP Server
1/Reference
Key ID

External

Reference
Source NTP Server

2/Reference
Key ID

Specify the IP address of an NTP server, and configure the
authentication key ID used for the association with the NTP server.
Only if the key provided by the server is the same with the
specified key will the device synchronize its time to the NTP server.

You can configure two NTP servers. The clients will choose the
optimal reference source.

@ IMPORTANT:

The IP address of an NTP server is a unicast address, and cannot be
a broadcast or a multicast address, or the IP address of the local
clock source.

TimeZone

Set the time zone for the system.

System time contiguration example

Network requirements

e Asshown in q, the local clock of Device A is set as the reference clock.

e  Switch B works in the client mode, and uses Device A as the NTP server.

e Configure NTP authentication on Device A and Switch B.

a. Network diagram for configuring system time

w T 1.0.1.11/24 1.0.1.12/24@
-

Device A Switch B
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Configuration procedure
Table 20 Configure Device A

# Configure the local clock as the reference clock, with the stratum of 2. Enable NTP authentication, set the
key ID to 24, and specify the created authentication key aNiceKey as a trusted key. (Configuration omitted.)

Table 21 Configure Switch B
# Configure Device A as the NTP server of Switch B.

o Select Device > System Time from the navigation tree, and then select the Net Time tab to perform the
configurations as shown in b.

b. Configure Device A as the NTP server of Switch B

System Time Canfiguration

System Time: | 2000-04-26 13:46:11 Refresh

Clock status: unsynchronized

Configure the system time
) Manual

Hour Minute Second
Mnnth| J Cate | J Vear

@ NTP
Source Interface Ylan-interfacel -
Ky 1 o |24 (1-4284967295) Key String | eessssss {1-32 Chars.)
Key 2 I {1-42048672095)  Key String {1-32 Chars )

External Reference Source
MNTP Server 1 1.01.11

Reference key

D 24
Reference Key

D

MTF Server 2

Set System TimeZone
TimeZane: |(GMT) Greenwich Mean Time: Dublin Edinburgh Lisbon Londaon j

Apply

o Select NTP.

e Type 24 in the ID box, and type aNiceKey in the Key String text box for key 1.

e Type 1.0.1.11 in the NTP Server 1 text box and type 24 in the Reference Key ID text box.
e  Click Apply.

Table 22 Verity the configuration

After the above configuration, you can see that the current system time on Device A is the same as Switch
B.
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Configuration guidelines

When configuring system time, note the following guidelines:

e A device can act as a server to synchronize the clock of other devices only after its clock has been

synchronized. If the clock of a server has a stratum level higher than or equal to that of a client’s clock,
the client does not synchronize its clock to the server’s.

e The synchronization process takes a period of time. Therefore, the clock status may be unsynchronized

after your configuration. In this case, you can refresh the page to view the clock status and system time
later on.
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Log management configuration

System logs contain a large amount of network and device information, including running status and
configuration changes. System logs are an important way for administrators to know network and device
status. With system log information, administrators can take corresponding actions against network
problems and security problems.

System logs can be stored in the log buffer, or sent to the loghost.

Contiguring log management

Configuration task list

Perform the tasks in 1 to configure log management.

1. Log management configuration task list

Task Description

Optional

. o Set the number of logs that can be stored in the log buffer.
Setting syslog related parameters

o Set the refresh period of the log information displayed on the
web interface.

Displaying syslog Display detailed information of system logs.

Optional
Setting loghost
Set the loghost that can receive system logs.

Setting syslog related parameters

Select Device > Syslog from the navigation tree, and click the Log Setup tab to enter the syslog
configuration page, as shown in a.
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a. Set system logs related parameters

Loglist Loghost

Euffer Sat

Euffer _ 512 ltermis) (1 - 1024,
Capacity default=512)

Fefresh Set

Fefresh

M anual w
Interval

Apply

2. Syslog configuration items

ltem Description

Buffer Capacity Set the number of logs that can be stored in the log buffer.

Set the refresh period on the log information displayed on the web interface.
You can select manual refresh or automatic refresh:

e Manual—Click Refresh to refresh the Web interface when displaying log
information.

Refresh Interval

e Automatic—Select a time period to refresh the Web interface every 1 minute, 5
minutes, or 10 minutes.

Return to Log management configuration task list.

Displaying syslog

Select Device - Syslog from the navigation tree to enter the syslog display page, as shown in a.
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a. Display syslog

Loghost Log Setup
Search lterm Time/Date j Keywwords Search
TimelDate Source Lewvel Digest Description
Apr2612:00:15:768 2000 MSTP Critical STPSTART STP is now anahbled on the device.
Apr2612:00:14:612 2000 HTTFD Warning Lag Stat HTTP server.

Total: 2 termni(s)

Clear Sequential Display Refresh
2. Syslog display items
ltem Description
Time/Date Displays the time/date when system logs are generated.
Source Displays the module that generates system logs.
Level Displays the severity level of system logs. For more information about severity levels,
see 3.
Digest Displays the brief description of system logs.
Description Displays the contents of system logs.

3. System logs severity level

Severity level Description Value
Emergency The system is unavailable. 0
Alert Information that demands prompt reaction 1
Critical Critical information 2
Error Error information 3
Warning Warnings 4
Notification Normal information that needs to be noticed 5
Informational Informational information to be recorded 6
Debugging Information generated during debugging 7

Note: A smaller value represents a higher severity level.

Return to Log management configuration task list.
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Setting loghost

Select Device > Syslog from the navigation tree, and click the Loghost tab to enter the loghost configuration
page, as shown in a.

a. Set loghost

Laoglist Lag Setup

Loghost IF

Flease selectthe loghaost IP

Loghost P

Hote: The maximum number of loghosts that can be configured is 4.

2. loghost configuration item

ltem Description

IP address of the loghost.
Loghost IP e You can specify up to four loghosts.

e You must input a valid IP address.

Return to Log management configuration task list.
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Configuration management

Back up configuration

Configuration backup provides the following functions:
e Open and view the configuration file (.cfg file or .xml file) for the next startup

e Back up the configuration file (.cfg file or .xml file) for the next startup to the host of the current user

Select Device > Configuration from the navigation tree to enter the backup configuration page, as shown
ina.

a. Backup configuration page

Restore Save Initialize

Configuration File
Backup:

Backup the configuration file with the extension ~.cfg” Backup

Backup the configuration file with the extension “xml” Backup

e When you click the upper Backup button in this figure, a file download dialog box appears. You can
select to view the .cfg file or to save the file locally.

e When you click the lower Backup button in this figure, a file download dialog box appears. You can
select to view the .xml file or to save the file locally.

Restore configuration

Configuration restore provides the following functions:
e Upload the .cfg file on the host of the current user to the device for the next startup

e Upload the .xml file on the host of the current user to the device for the next startup, and delete the
previous .xml configuration file that was used for the next startup

Select Device > Configuration from the navigation tree, and then click the Restore tab to enter the
configuration restore page, as shown in a.
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a. Configuration restore page

Backup Save Initialize

Restore the Configuration File:

| [ Browse. . |ithe file with the extension ".cfg"}

| |[ Browse. . . ]ithe file with the extension “xml”)

Hote: The restored configuration will take effect after reboot,

[tems marked with an asterisk(*} are required
Apply

When you click the upper Browse button in this figure, the file upload dialog box appears. Select the
.cfg file to be uploaded, and then click OK.
When you click the lower Browse button in this figure, the file upload dialog box appears. Select the
xml file to be uploaded, and then click OK.

Save configuration

The save configuration module provides the function to save the current configuration to the configuration
file (.cfg file or .xml file) for the next startup.

/\ CAUTION:
 Saving the configuration takes some time.
o The system does not support the operation of saving configuration of two or more consecutive users. If
such a case occurs, the system prompts the latter users to try later.

You can save the configuration in one of the following ways:
e Fast—Click the Save button at the upper right of the auxiliary area.

Common—Select Device or Configuration from the navigation tree, and then click the Save tab to enter

[ ]
the save configuration confirmation page, as shown in a. Click Save Current Settings.

a. Save configuration confirmation

Save | Help | Logont

Backup Festare Initialize

Save Current Settings

Note: Click Save Current Settings to save the current configuration.
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Initialize

This operation restores the system to factory defaults, deletes the current configuration file, and reboots the
device.

Select Device > Configuration from the navigation tree, and then click the Initialize tab to enter the initialize
confirmation page as shown in a.

a. Initialize confirmation dialog box

Backup Restore Save

Restore Factory-Default Settings

Mote: Click Restore Factory-Default Settings to restore and initialize the factory-default settings and
reboot,

Click the Restore Factory-Default Settings button to restore the system to factory defaults.
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Device maintenance

Software upgrade

A system software image file is used to boot the device. Software upgrade allows you to obtain a target
system software image file from the local host and set the file as the startup configuration file. In addition,
you can select whether to reboot the device to bring the upgraded system software image file into effect.

/\ CAUTION:

Software upgrade takes some time. Avoid performing any operation on the web interface during the
upgrading procedure. Otherwise, the upgrade operation may be interrupted.

Select Device > Device Maintenance from the navigation tree to enter the software upgrade configuration
page, as shown in a.

a. Software upgrade configuration page

Fehoot Electronic Lahel Diagnostic Information

Device
Filename: *
File Type: Mlain b
[11f 2 file with the same name already exists, overwrite it without any prompt

[ 1 Reboot after the upgrade is finished

« Mote: Do not perform any operation when upgrade is in process.,
[tems marked with an asterisk(™ are required

Apply
2. Software upgrade configuration items
ltem Description
File Specifies the filename of the local system software image file, which must be with an

extension .bin.

Specifies a filename for the file to be saved on the device. The filename must have

Fil . . :
riename an extension, which must be the same as that of the source file.

59



ltem Description

Specifies the type of the startup configuration file:
File Type e  Main
e Backup

o Specifies whether to overwrite the file with the same name.
If a file with same name

already exists, overwrite
it without prompt.

If you do not select the option, when a file with the same name exists, a dialog box
appears, telling you that the file already exists and you cannot continue the

upgrade.
Reboot after the Specifies whether to reboot the device to make the upgraded system software
upgrading finished. image file take effect after the system software image file is uploaded.

Device reboot

/\ CAUTION:

o Before rebooting the device, save the configuration; otherwise, all unsaved configuration will be lost
after device reboot.

*  When the device reboots, you need to re-log in to the web interface.

Select Device > Device Maintenance from the navigation tree, click the Reboot tab to enter the device
reboot configuration page, as shown in a.

a. Device reboot page

Software Upgrade Electronic Lahel Diagnostic Information

Device Rehoot

Any canfiguration changes that have not heen saved will be lostwhen the systemn rehoots.

Checkwhether the current configuration is saved inthe next starup configuration file.

Apply

Click Apply to reboot the device. You can check whether the current configuration has been saved to the
startup configuration file.

o If you select Check configuration with next startup configuration file, the system checks the
configuration before rebooting the device. If the check succeeds, the system reboots the device; if the
check fails, a dialog box appears, telling you that the current configuration and the saved
configuration are inconsistent, and the device will not be rebooted. In this case, you need to save the
current configuration manually before you can reboot the device.

e If you do not select the check box, the system reboots the device directly.
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Electronic label

Electronic label allows you to view information about the device electronic label, which is also known as the
permanent configuration data or archive information. The information is written into the storage medium of
a device or a card during the debugging and testing processes, and includes the card name, product bar
code, MAC address, debugging and testing date(s), manufacture name, and so on.

Select Device > Device Maintenance from the navigation tree, and click the Electronic Label tab to enter the
page as shown in a.

a. Electronic label

Software Upgrade Rehoot Diagnostic Infarmation

b Search ltem: | Device ¥ |Keywords: Search

Device et B ] Mame Serial Mumhber A RERVEGITE Wendor Mame
|n) Date

0 - - HF %1810-16G Switch JEODSA  210235A4150000000002 000f-e000-0002 2010-1-7 HF

Diagnostic information

Each functional module has its own running information, and generally, you view the output information for
each module one by one. To receive as much information as possible in one operation during daily
maintenance or when system failure occurs, the diagnostic information module allows you to save the
running statistics of multiple functional modules to a file named default.diag. This allows you to locate
problems faster by checking this file.

Select Device > Device Maintenance from the navigation tree, and click the Diagnostic Information tab to
enter the page as shown in a.

a. Diagnostic information

Software Upograde Feboot Electronic Label

Create Diagnostic Information File

» Note: The aperation may take a long time. Do nat perform any operation when creating diagnostic
information file is in process,

When you click Create Diagnostic Information File, the system begins to generate a diagnostic information
file, and after the file is generated, the page is as shown in b.
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b. The diagnostic information file is created

Software Upograde Feboot Electronic Label
Create Diagnaostic Infarmatian File

Click to Download

« Mote: The operation may take a long time. Do not perdorm any operation when creating diagnostic
information file is in process,

Creating diagnostic information file succeeded.

Click Click to Download, and the File Download dialog box appears. You can select to open this file or save
this file to the local host.

NOTE:

o The generation of the diagnostic file takes some time. During this process, do not perform any
operation on the web page.

o After the diagnostic file is generated successfully, you can view this file by selecting Device > File
Management, or downloading this file to the local host. For more information, see the chapter “File
management configuration”.
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File management

The device saves files such as host software and configuration file into the storage device, and provides the
file management function for users to manage those files conveniently and effectively. File management
function provides the following operations:

e  Displaying file list
e  Downloading a file
e  Uploading a file

e Removing a file

File management configuration

Displaying file list

Select Device -> File Management from the navigation tree to enter the file management page, as shown in
a. Select a disk from the Please select disk drop-down list on the top of the page, and the page then displays
used space, free space and capacity of the disk at the right of the drop-down list, and all files saved in this
disk (in the format of path + filename) and file sizes.

a. File management

Plaase selact disk Used space: 11,56 MB Free space: 84,44 MB Capacity 86.00 MB
Fl File Size(kB) Operation
[J fashidefaultdiag 243858 m
[ fashisystem.xml 0.147 m
[ fashistartop.cly 1,869 il
[ flashi910-criws20-a1108.hin 10,021,625 m
[ flashiaa.ciy 1587 i
[0 fashilogflelogfile. og 7.395 i
Erecurds,perpage|page1f1,rec0rd1—5|
Download File Remove File
Upload File
Flease selectdisk
File | “ Browse . . . I

» PMote: Do not perform any operation when upload is in process.

Anply
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Downloading a file

Select Device - File Management from the navigation tree to enter the file management page, as shown in
a. Select a file from the list, click the Download File button, and then a File Download dialog box appears.
You can select to open the file or to save the file locally, and you can download only one file at a time.

Uploading a file

Select Device - File Management from the navigation tree to enter the file management page, as shown in
a. In the Upload File areq, select a disk from the Please select disk drop-down list to save the file, and then

select the file path and filename by clicking Browse. Click Apply to upload the file to the specified storage
device.

/\ CAUTION:

Uploading a file takes some time. HP recommends you not to perform any operation on the web interface
during the upgrading procedure.

Removing a file

Select Device - File Management from the navigation tree to enter the file management page, as shown in
a. You can remove a file by using one of the following ways:

e Clickthe T icon to remove a file.

e Select one or multiple files from the file list, and then click Remove File.
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Port management configuration

You can use the port management feature to set and view the operation parameters of a Layer 2 Ethernet
port, including but not limited to its state, rate, duplex mode, link type, PVID, MDI mode, flow control settings
MAC learning limit, and storm suppression ratios.

’

Contiguring a port

Setting operation parameters for a port

Select Device > Port Management from the navigation tree, and then select the Setup tab on the page that
appears to enter the page as shown in a.

a. The Setup tab

Summary Detail

Basic Configuration

Port State Mo Change Speed Mo Change v Duplex Mo Change v
Link Type | Mo Change [ pun |:|(1-4094)

Advanced Configuration

(X141 Mo Change £ Flow Contrel | Mo Change w

b ax MAC
Count

Power Save | Mo Change |N0 Change V|| |(0-s192)

Storm Suppression

Broadeast NoChange 8 Multicast No Change 8 Unicast Mo Change (8§
Suppression l:l Suppressian I:I Suppression

ppsrange (1-142210 for a 100 Mbps port, 1-1422100 for 8 GE port, and 1-14281000 for a 10GE port)
kbps range (1-102400 for a 100 Mbps port, 1-1024000 for a GE port, and 1-10240000 for a 10GE port)

HP 41910-1

SelectAll Select Mone

Tnit Selected Ports

+ |t maytake some time if you apply the above settings to multiple ports. Cancel
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2. Port configuration items

ltem Description

Enable or disable the port. Sometimes, after you modify the operation
Port State parameters of a port, you need to disable and then enable the port to have the
modifications take effect.

Set the transmission rate of the port.
Available options include:
e 10: 10 Mbps
e 100: 100 Mbps
e 1000: 1000 Mbps
e Auto: auto-negotiation
e Auto 10: auto-negotiated to 10 Mbps
Speed e Auto 100: auto-negotiated to 100 Mbps
e Auto 1000: auto-negotiated to 1000 Mbps
e Auto 10 100: auto-negotiated to 10 or 100 Mbps
e Auto 10 1000: auto-negotiated to 10 or 1000 Mbps
e Auto 100 1000: auto-negotiated to 100 or 1000 Mbps
e Auto 10 100 1000: auto-negotiated to 10, 100, or 1000 Mbps

@ IMPORTANT:
SFP optical ports do not support the 10 or 100 option.

Set the duplex mode of the port.
e Auto: auto-negotiation
o Full: full duplex

Duplex e Half: half duplex

@ IMPORTANT:

Ethernet electrical ports whose transmission rate is configured as 1000 Mbps
and SFP optical ports do not support the half option.

Set the link type of the current port, which can be access, hybrid, or trunk. For
more information, see the chapter “VLAN configuration.”

Link Type @ \MPORTANT:

To change the link type of a port from trunk to hybrid or vice versa, you must first
set its link type to access.

Set the default VLAN ID of the interface. For more information about setting the
PVID, see the chapter “VLAN configuration.”

PVID @ \MPORTANT:

To enable a link to properly transmit packets, be sure the trunk or hybrid ports at
the two ends of the link have the same PVID.
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ltem

Description

MDI

Set the Medium Dependent Interface (MDI) mode of the port. Two types of
Ethernet cables can be used to connect Ethernet devices: crossover cable and
straightthrough cable. To accommodate these two types of cables, an Ethernet
port can operate in one of the following three MDI modes: across, normal, and
auto.

An Ethernet port is composed of eight pins. By default, each pin has its
particular role. For example, pin 1 and pin 2 are used for transmitting signals;
pin 3 and pin 6 are used for receiving signals. You can change the pin roles
by setting the MDI mode.

e For an Ethernet port in across mode, pin 1 and pin 2 are used for
transmitting signals; pin 3 and pin 6 are used for receiving signals. The pin
roles are cannot be changed.

e For an Ethernet port in auto mode, the pin roles are decided through auto
negotiation.

e For an Ethernet port in normal mode, the pin roles are changed. Pin 1 and
pin 2 are used for receiving signals; pin 3 and pin 6 are used for
transmitting signals.

To enable normal communication, you must connect the local transmit pins to

the remote receive pins. Therefore, you should configure the MDI mode

depending on the cable types.

e HP does not recommend you to use the auto mode. The other two modes
are used only when the device cannot determine the cable type.

e When straightthrough cables are used, the local MDI mode must be
different from the remote MDI mode.

e  When crossover cables are used, the local MDI mode must be the same as
the remote MDI mode, or the MDI mode of at least one end must be set to
auto.

@ IMPORTANT:
SFP optical ports do not support this feature.

Flow Control

Enable or disable flow control on the port.

With flow control enabled at both sides, when traffic congestion occurs on the
ingress port, the ingress port will send a Pause frame notifying the egress port
to temporarily suspend the sending of packets. The egress port is expected to
stop sending any new packet when it receives the Pause frame. In this way,
flow control helps to avoid dropping of packets.

@ IMPORTANT:

Flow control works only after it is enabled on both the ingress and egress ports.

Power Save

Enable or disable auto power down on the port.

With auto power down enabled, when an Ethernet port does not receive any
packet for a certain period of time, it automatically enters the power save
mode and resumes its normal state upon the arrival of a packet.

By default, auto power down is disabled.

Max MAC Count

Set the MAC learning limit on the port. Available options include:
e User Defined: Select this option fo set the limit manually.

e No Limited: Select this option to set no limit.
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ltem

Description

Broadcast Suppression

Set broadcast suppression on the port. You can suppress broadcast traffic by
percentage or by PPS as follows:

e ratio: Sets the maximum percentage of broadcast traffic to the total
bandwidth of an Ethernet port. When this option is selected, you need to
input a percentage in the box below.

e pps: Sets the maximum number of broadcast packets that can be
forwarded on an Ethernet port per second. When this option is selected,
you need fo input a number in the box below.

e kbps: Sets the maximum number of broadcast kilobits that can be
forwarded on an Ethernet port per second. When this option is selected,
you need fo input a number in the box below.

@ IMPORTANT:

Do not configure this item if the storm constrain function for broadcast traffic is
enabled on the port. Otherwise, the suppression result will be unpredictable. To
set storm constrain for broadcast traffic on a port, select Device > Storm
Constrain.

Multicast Suppression

Set multicast suppression on the port. You can suppress multicast traffic by
percentage or by PPS as follows:

o ratio: Sets the maximum percentage of multicast traffic to the total
bandwidth of an Ethernet port. When this option is selected, you need to
input a percentage in the box below.

e pps: Sets the maximum number of multicast packets that can be forwarded
on an Ethernet port per second. When this option is selected, you need to
input a number in the box below.

e kbps: Sets the maximum number of multicast kilobits that can be forwarded
on an Ethernet port per second. When this option is selected, you need to
input a number in the box below.

@ IMPORTANT:

Do not configure this item if the storm constrain function for multicast traffic is
enabled on the port. Otherwise, the suppression result will be unpredictable. To
set storm constrain for multicast traffic on a port, select Device > Storm
Constrain.

Unicast Suppression

Set unicast suppression on the port. You can suppress unicast traffic by
percentage or by PPS as follows:

e ratio: Sets the maximum percentage of unicast traffic to the total bandwidth
of an Ethernet port. When this option is selected, you need to input a
percentage in the box below.

e pps: Sets the maximum number of unicast packets that can be forwarded
on an Ethernet port per second. When this option is selected, you need to
input a number in the box below.

o kbps: Sets the maximum number of unicast kilobits that can be forwarded
on an Ethernet port per second. When this option is selected, you need to
input a number in the box below.

@ IMPORTANT:

Do not configure this item if the storm constrain function for unicast traffic is
enabled on the port. Otherwise, the suppression result will be unpredictable. To
set sform constrain for unicast traffic on a port, select Device > Storm Constrain.
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ltem Description

Port or ports that you have selected from the chassis front panel and the
aggregate interface list below, for which you have set operation parameters.
@ IMPORTANT:

e Only in the presence of link aggregations groups, Aggregation ports will
be displayed under the chassis front panel.

Selected Ports

e You can set only the state and MAC learning limit for an aggregate
interface.

Viewing the operation parameters of a port

Select Device > Port Management from the navigation tree. The Summary tab is displayed by default.
Select the parameter you want to view by clicking the radio button before it to display the setting of this
parameter for all the ports in the lower part of the page, as shown in a.

a. The Summary tab

Detail Setup

Select Feature:

& PoriState O Max MAC Count

O Flow Contral O Default YLAM ID(PYIDY
O Link Type Cmol

) Duplex O 5peed

) Broadeast Suppression

) Multicast Suppression £ Unicast Suppression

O Power Save

Feature Summarny;

Forts= SJetting

GEL1/0/1 Enabled -
GE1/0/2 Enabled

GE1/0/3 Enabled

GE1/0/4 Enabled

GE1/0/5 Enabled

GEL/0/6 Enabled

GE1/0/7 Enabled

GE1/0/8 Enabled -

Select Device > Port Management from the navigation tree, select the Details tab on the page that appears,
and then click the port whose operation parameters you want to view in the chassis front panel, as shown
in b. The operation parameter settings of the selected port are displayed on the lower part of the page (in
the square brackets).
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b. The Details tab

Summary Setup

Select a Port

HF ¥1910-

Port State PWID

Flow Contral Link Type

D1 Speed

Duplex Max MAC Count

Broadeast Suppression

Multicast Suppression Unicast Suppression

Fawer Save

The table shows the configured walues for the selected port, while those inzside the square bradeets are the actual walues of the selected port.

Port management configuration example

Network requirements

As shown in a:

e Server A, Server B, and Server C are connected to GigabitEthernet 1/0/1, GigabitEthernet 1/0/2,
and GigabitEthernet 1/0/3 or the switch respectively. The rates of the network adapters of these
servers are all 1000 Mbps.

o The switch connects to the external network through GigabitEthernet 1/0/4 whose rate is 1000
Mbps.

e To avoid congestion at the egress port, GigabitEthernet 1/0/4, configure the auto-negotiation rate
range on GigabitEthernet 1/0/1, GigabitEthernet 1/0/2, and GigabitEthernet 1/0/3 as 100 Mbps.

a. Network diagram for port rate configuration

GE1/0/4

Switch

(Speed 1000Mbps)

(Speed 1000Mbps)

(Speed 1000Mbps)

Server A Server B Server C
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Configuration procedure

# Set the rate of GigabitEthernet 1/0/4 to 1000 Mbps.

e Select Device > Port Management from the navigation tree, click the Setup tab to enter the page
shown in a, and make the following configurations:

a. Configure the rate of GigabitEthernet 1/0/4

Summary Dietail

Basic Configuration

Port State Mo Change v Speed 1000 v Duplex Mo Change +
Link Type Mo Change % O pvip k1-4094)

Advanced Configuration

[T1] Mo Change v Flaw Control | Mo Change |

b ax bMAC
Count

Power Save | Mo Change v | Mo Change V| | |(0.9192)

Storm Suppression

Broadeast No Change |8 Multicast No Change 8 Unicast Ma Change (8
Suppression Suppression I:l Suppression

ppsrange (1-142210 far 2 100 Mbpz port, 1-1428100 for a GE port, and 1-14281000 for 2 10GE por)
kbps range (1- 102400 for a 100 Mbps port, 1-1024000 for 3 GE port, and 1-10240000 for 3 10GE porf)

¥

HF %1810-16G Sw...

Select All Select Mone
Tnit Jelected Ports
1 GE1/0/4
+ [t maytake some time ifyou apply the above settings to multiple ports, Apply Cancel

e  Select 1000 in the Speed dropdown list.

o Select GigabitEthernet 1/0/4 on the chassis front panel.

e  Click Apply.

# Batch configure the auto-negotiation rate range on GigabitEthernet 1/0/1, GigabitEthernet 1/0/2, and
GigabitEthernet 1/0/3 as 100 Mbps.

e Select Auto 100 in the Speed dropdown list on the page shown in b.

e Select GigabitEthernet 1/0/1, GigabitEthernet 1/0/2, and GigabitEthernet 1/0/3 on the chassis
front panel.

e Click Apply.
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b. Batch configure port rate

Surmary Detail

Basic Configuration

Fort State Mo Change | Speed Augto 100 A Duplex Mo Change |
Link Type Mo Change [ pvip L:1-4og4)

Advanced Canfiguration

[F]s) Mo Change Flaw Contral | Mo Change %
bl ax bAC
Fower Save | Mo Change v F—— |ND Change V|| |(0.3192)

Storm Suppression

Broadeast |10 Change v Mulicast 0 Change Unicast Mo Change v
Suppression I:I Suppressian I:I Suppression

ppsrange (1-145810 for a 100 hibps port, 1-1458400 for a3 *E port, and 1-14551000 for a3 10GE pord)
kbpz range (1-102400 far a 100 Mbps port, 1-1024000 for a GE port, and 1-10240000 for 3 10GE porf)

Select All Select Mone
Unit Selected Ports
1 GE1/0/1-GEL/0/3

+ |t maytake some time if wou apply the above settings to multiple parts. Apply Cancel

# Display the rate settings of ports.
o Click the Summary tab.

o Select the Speed option to display the rate information of all ports on the lower part of the page, as
shown in c.
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c. Display the rate settings of ports

Select Feature:

Detail

Setup

C PortState
O Flaw Contral
O Link Type
O Duplex

) Max MAC Count
O Default VLAN IDPYID)
COmol

() Broadeast Suppression

() Multicast Suppression

() Unicast Suppression

O Power Save
Feature Summary:
FPorts Setting
GE1/0/1 Auto [100M)
GE1/0/2 Auto (100M)
GE1/0/3 Auto [100M)
GE1/0/4 1000M
GEL/0/5 huto
GE1/0/6 Auto
GE1/0/7 Auto
GE1/0/8 Auto
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Port mirroring configuration

Introduction to port mirroring

Port mirroring is the process of copying the packets passing through a port (called a mirroring port) to
another port (called the monitor port) connected with a monitoring device for packet analysis.

You can mirror inbound, outbound, or bidirectional traffic on a port as needed.

Implementing port mirroring

Port mirroring is implemented through local port mirroring groups. The following subsections describe how
local port mirroring is implemented.

Local port mirroring

In local port mirroring, all packets (including protocol and data packets) passing through a port can be
mirrored. Local port mirroring is implemented through a local mirroring group.

As shown in o, packets on the mirroring port are mirrored to the monitor port for the data monitoring device
to analyze.

a. Local port mirroring implementation

How the device processes packets

_______
-
'l

CA) mirrored to O--}-»
1
1

Mirroring port Monitor port

=1

53 ) Monitor port ‘

Mirroring port )
gp Data monitoring device
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Contiguring local port mirroring

Configuration task list

Configuring local port mirroring

To configure local port mirroring, you must create a local mirroring group and then specify the mirroring
ports and monitor port for the group.

1. Local port mirroring configuration task list

Task Remarks

o Required
Create a local mirroring group ) ) ., ) o ,
For more information, see “Creating a mirroring group”.

Required

Configure the mirroring ports For more information, see “Configuring ports for a mirroring group”.

During configuration, you need to select the port type Mirror Port. You
can configure multiple mirroring ports for a mirroring group.

Required

Configure the monitor port For more information, see “Configuring ports for a mirroring group”.

During configuration, you need fo select the port type Monitor Port. You
can configure one only monitor port for a mirroring group.

Creating a mirroring group

Select Device > Port Mirroring from the navigation tree and click Create to enter the page for creating a
mirroring group, as shown in a.
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a. Create a mirroring group

summary Remove Modify Port

Mirraring Group 1D | (1-1)

Type Local -

Group 1D Type

2. Configuration items of creating a mirroring group

ltem Description

Mirroring Group ID ID of the mirroring group to be created

Specify the type of the mirroring group to be created:

Type
yP e Local: Creates a local mirroring group.

Return fo Local port mirroring configuration task list.

Contiguring ports for a mirroring group

Select Device > Port Mirroring from the navigation tree and click Modify Port to enter the page for
configuring ports for a mirroring group, as shown in a.
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a. The Modify Port tab

Summary

Wirraring Group 1D

Port Type

Select port(s)

Remaove

Select Group 1D+
Stream Orientation

HPF V1910-16G Sw...

Selected Portis)

.Seleded Port(s)

-H-Jt Available for Selection

MNote:

1. Selected Port(s):Configured member port(s).
2. Mot Available for Selection:All the member ports of mirroring group on the device except Selected Portis).

2. Configuration items of configuring ports for a mirroring group

ltem Description
Mirroring ID of the mirroring group to be configured
Group ID The available groups were created previously.
Configure ports for a local mirroring group:
Set the type of . ' . oo
e Monitor Port: Configures the monitor ports for the local mirroring
Port Type the port to be
. group.
configured )
e Mirror Port: Configures mirroring ports for the local mirroring group.
Set the direction of the traffic monitored by the monitor port of the mirroring group
This configuration item is available when Mirror Port is selected is the Port Type drop-down
Stream list.
Orientation e both: Mirrors both received and sent packets on mirroring ports.

e inbound: Mirrors only packets received by mirroring port.

e outbound: Mirrors only packets sent by mirroring ports.

Select port(s)

Click the poris to be configured on the chassis front panel. If aggregate interfaces are
configured on the device, the page displays a list of aggregate interfaces below the chassis
front panel. You can select aggregate interfaces from this list and configure them as
mirroring ports of a port mirroring group.

Return fo Local port mirroring configuration task list.
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Configuration examples

Local port mirroring configuration example

Network requirements
e Department 1 accesses Switch C through GigabitEthernet 1/0/1.
e Department 2 accesses Switch C through GigabitEthernet 1/0/2.
e Server is connected to GigabitEthernet 1/0/3 of Switch C.

Configure port mirroring fo monitor the bidirectional traffic of Department 1 and Department 2 on the
server.

To satisfy the requirement through local port mirroring, perform the following configuration on Switch C:
o Configure GigabitEthernet 1/0/1 and GigabitEthernet 1/0/2 as mirroring ports.
e  Configure GigabitEthernet 1/0/3 as the monitor port.

a. Network diagram for local port mirroring configuration

Department 1

Switch C

&S
Department 2 Device B
Configuration procedure

# Create a local mirroring group.

Select Device > Port Mirroring from the navigation tree and click Create to enter the page to create a local
mirroring group, as shown in a.
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a. Create a local mirroring group

sSummary Remove Modify Port

Mirrering Group 1D |1 (1-1

Type Local -

Apply

Group D Type

e  Type in mirroring group ID 1.

e Select Local in the Type drop-down list.
e Click Apply.

# Configure the mirroring ports.

Click Modify Port to enter the page for configuring the mirroring group ports, as shown in b.
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b. Configure the mirroring ports

Summary Create Remove
Mirrering Group 1D 1- Local -
Port Type Mirror Port > Stream Orientation  |both =]
Select port(s)

B T TETe] HP V110-166 Sw..
Jedeflelel«dellrlolc]=]

Select All Select Mone

.Seleded Part(s)

-Nnt Available for Selection
Apply

Selected Port(s)
GE1/0M-GE1/0I2

Mote:

1. Selected Port(ts):Configured member port(s).
2. Mot Available for Selection:All the member ports of mirrering group on the device except Selected Pori(s).

e Select 1 - Local in the Mirroring Group ID drop-down list.

o Select Mirror Port in the Port Type drop-down list.

e Select both in the Stream Orientation drop-down list.

e Select GigabitEthernet 1/0/1 and GigabitEthernet 1/0/2 on the chassis front panel.

e Click Apply. A configuration progress dialog box appears, as shown in c.

c. Configuration progress dialog box

Current Configuration
Add port GigahitEthernet1/0i1 - Okl
Add port GigahitEthernet1/0/2 - Okl

100%

Close

o After the configuration process is complete, click Close.

# Configure the monitor port.
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Click Modify Port to enter the page for configuring the mirroring group ports, as shown in d.

d. Configure the monitor port

Summary Create Remave
Wirrering Group 1D 1-Local -
Fort Type Monitar Port > Stream Orientation
Select portis)

HF V1910-16G Sw...

.Seleded Paorti(s) -Nnt Available for Selection

Selected Port(s)
GE1/0/3

Mote:

1. Selected Port(ts):Configured member port(s).
2. Mot Available for Selection:All the member ports of mirrering group on the device except Selected Pori(s).

e Select 1 - Local in the Mirroring Group ID drop-down list.

o Select Monitor Port in the Port Type drop-down list.

o Select GigabitEthernet 1/0/3 on the chassis front panel.

e Click Apply. A configuration progress dialog box appears.

o After the configuration process is complete, click Close in the dialog box.

Configuration guidelines

Consider the following points during local port mirroring configuration:
e To ensure operation of your device, do not enable STP, MSTP, or RSTP on the monitor port.

e You can configure multiple mirroring ports but only one monitor port for a local mirroring group.
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User management

Overview

The switch provides the following user management functions:

o Add local user accounts for FTP and Telnet users, and specify the password, access level, and service
types for each user.

o Set the super password for non-management level users to switch to the management level.

e Switch to the management level from a lower level.

Managing users

Adding a local user
Select Device > Users from the navigation tree, and click the Create tab to add a local user, as shown in a.
a. Add a user
Summary | SuperPassward Madify | Remove | Switch Ta Management

Create User

Username (1-55 Chars.) Access Level Wisitar v

Fassword (1-B3 Chars.) Confirm Password | |
Password Display :

Hode

Service Type OFTP service [ Telnet Service

Apply

Summary

Username Locess Level Service Type

adinin Hanagement Telnet
Hote: Username cannot include characters "/, ™", ™", "[", "@", """, "3", "™, "<" or "=",

2. Local user configuration items

ltem Description

Username Set a username for the user
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ltem Description

Select an access level for the user.
Users of different levels can perform different operations. User levels, in order from low
to high, are visitor, monitor, configure, and management.

e Visitor: Users of this level can only perform ping and traceroute operations. They can
neither access data on the switch nor configure the switch.
Access Level * Monitor: Users of this level can perform ping and traceroute operations and access
data on the switch but cannot configure the switch.
o Configure: Users of this level can perform ping and traceroute operations, access
data on the switch, and configure the switch, but they cannot upgrade the host
software, add/delete/modify users, or back up/restore the configuration file.

e Management: Users of this level can perform any operations on the switch.

Password Set the password for the user.

Input the same password again. Otherwise, the system will prompt that the two

Confirm Password . . .
passwords are not consistent when you apply the configuration.

Set the password displaying mode.
Options include:

e Simple: Saves the password in the configuration file in plain text so that the

Password Display password is displayed in plain text.

Mode
o Cipher: Saves the password in the configuration file in cipher text so that the
password is displayed in cipher text.
A plaintext password is not safe. It is good practice to use the cipher mode.
Service Type Set the service type, including FTP and Telnet services. You must select either of them.

Setting the super password

A management level user can set the password for non-management level users to switch to the
management level. If the super password is not configured, no switchover can occur.

Select Device > Users from the navigation tree, and click the Super Password tab to set the super password.
a. Super password

Sumrmary Create M adify Rermaove Switch Ta Management

Please specify the super password

@ Create O Remove

Fasswiord (1-16 Chars )
Confirm Password

Fassword Display Mode Simple v

Apply

Note: Use the super password to switch from the current user level to the management level.
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2. Super password configuration items

ltem Description

Select the operation type.

Options include:

Create/Remove ] )
o Create: Configure or modify the super password.
e Remove: Remove the current super password.
Password Set the password for non-management level users to switch to the management level.

Confirm Password

Input the same password again. Otherwise, the system will warn that the two passwords

input are not consistent when you apply the configuration.

Set the password displaying mode.
Options include:

Password Display

Mode password is displayed in plain text.

o Simple: Saves the password in the configuration file in plain text so that the

o Cipher: Saves the password in the configuration file in cipher text so that the

password is displayed in cipher text.

A plaintext password is not safe. It is good practice to use the cipher mode.

Switching to the management level

This function allows a user to switch from the current user level to the management level. To switch to the

management level, a user must provide the correct super password.

The access level switchover of a user is valid for the current login only; it does not change the access level
configured for the user. When the user re-logs in to the Web interface, the access level of the user is still the

original level.

To switch to the management level, select Device > Users from the navigation tree, click the Switch To

Management tab, input the correct super password, and click Login.

a. Switch to the management level.

Summary Super Password Create Modify Remove

Please enter the super password to switch from the current user level
to the management level,

Password (1-16 Chars.}

Login
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Loopback test configuration

Overview

You can check whether an Ethernet port works normally by performing the Ethernet port loopback test,
during which the port cannot forward data packets normally.

Ethernet port loopback test can be an internal loopback test or an external loopback test.

e In an infernal loopback test, self loop is established in the switching chip to check whether there is a
chip failure related to the functions of the port.

e In an external loopback test, a loopback plug is used on the port. Packets forwarded by the port will
be received by itself through the loopback plug. The external loopback test can be used to check
whether there is a hardware failure on the port.

Loopback operation

Select Device > Loopback from the navigation tree to enter the loopback test configuration page, as shown
in a.

a. Loopback test configuration page

Testing type: @External Olnternal

HF ¥1910-1

Result:

2. Lloopback test configuration items

ltem Description
Testi External
t;;emg Set the loopback test type, which can be External or Internal.

Internal
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After selecting a testing type, you need to select a port on which you want to perform the loopback test from
the chassis front panel.

Atter that, click Test to start the loopback test, and you can see the test result in the Result box, as shown in
a.

a. Loopback test result

Testing fype: OEx‘ternaI @Internal

HF %1810-16¢

Result :

GigahitEthernet1/0i1; Loop internal succeaded!

Configuration guidelines

Note the following when performing a loopback test:

e You can perform an internal loopback test but not an external loopback test on a port that is physically
down, but you can perform neither test on a port that is manually shut down.

e The system does not allow Rate, Duplex, Cable Type and Port Status configuration on a port under a
loopback test.

e An Ethernet port works in full duplex mode when the loopback test is performed, and restores its
original duplex mode after the loopback test.
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VCT

Overview

NOTE:
The fiber interface of a SFP port does not support this feature.

A link in the up state goes down and then up automatically if you perform this operation on one of the
Ethernet interfaces forming the link.

You can use the Virtual Cable Test (VCT) function to check the status of the cable connected to an Ethernet
port on the device. The check result is returned in less than 5 seconds. The test covers whether short circuit
or open circuit occurs on the cable and the length of the faulty cable.

Testing cable status

Select Device > VCT from the navigation tree to enter the page for testing cable status. Select the port you
want to test in the chassis front panel and then click Test. The test result is returned in less than 5 seconds and
displayed in the Result text box, as shown in a.

a. Test the status of the cable connected to an Ethernet port

HF W1810-

Test

Result :

GigahitEthernet1f0/3:

Cahble status: ahnormaliopen), 0 metres
Fair Impedance mismatch: no

Fair skew: - ns

Fair swap: -

Fair palarity: -

Insetion loss: - db

Return loss: - dh

Mear-end crosstalk: - db

Mote: The emor of the length detected is 25 meters.
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2.

Description on the cable test result

ltem

Description

Cable status

Status and length of the cable.

The status of a cable can be normal, abnormal, abnormal(open), abnormal(short), or
failure.

e When a cable is normal, the cable length displayed is the total length of the cable.
e When a cable is not normal, the cable length displayed is the length of the cable
between the current port and the location where fault occurs.

@ IMPORTANT:

The error of the length defected is within 5 meters.
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Flow interval configuration

Overview

With the flow interval module, you can view the number of packets and bytes sent/received by a port over
the specified interval.

Monitoring port traffic statistics

Setting the traffic statistics generating interval

Select Device > Flow interval from the navigation bar, and click the Interval Configuration tab to enter the
page shown in a.

a. The page for setting the traffic statistics generating interval

Port Traffic Statistics
Interval for generating traffic statistics: Seconds(s-aoo, it must be a multiple of 5, Default= 200)

Select ports

HF V1910-16G Sw...

Select Al Select Mone

Selected Pors

2. Traffic statistics generating interval configuration items

ltem Remarks

Interval for generating traffic statistics Set the interval for generating port traffic statistics.

Select ports from the chassis front panel to apply the interval

lect port
Select ports o them.

Viewing port traffic statistics

Select Device > Flow interval from the navigation tree to enter the Port Traffic Statistics tab shown in a. On
the tab, you can view the number of packets and bytes sent/received by each port over the last interval.
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a.

Port traffic statistics

P search ltem: Interface Mame Kenmords:

Interface Mame
GigabitEthernet! /01 6
GigahitEthernet! /oM 7
GigabitEthernet! /01 8
GigabitEthernet1 /019
GigahitEthernet!/0i20
GigabitEthernet! /0521
GigahitEthernet! /022
GigabitEthernet! /0623
GigahitEthernet! /024
GigabitEthernet! /0925
GigabitEthernet! /026
GigahitEthernet! /027
GigabitEthernet! /0628

Intereal iSec) Received Packet (packetiSec)

200
300
200
300
300
300
300
200
300
200
300
300
300

Interval Configuration

e T e N e R e Y T N e Y e Y e Y e Y e Y e e

Search

e Y e N e R e ) N N e Y e Y e Y e Y e Y e Y e

28 records, 15+

Refresh
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Storm constrain configuration

Overview

The storm constrain function limits traffic of a port within a predefined upper threshold to suppress packet
storms in an Ethernet. With this function enabled on a port, the system detects the amount of broadcast
traffic, multicast traffic, and unicast traffic reaching the port periodically. When a type of traffic exceeds the
threshold for it, the function, as configured, blocks or shuts down the port, and optionally, sends trap
messages and logs.

/\ CAUTION:

Alternatively, you can configure the storm suppression function to control a specific type of traffic. Because
the storm suppression function and the storm constrain function are mutually exclusive, do not enable them
at the same time on an Ethernet port. For example, with broadcast storm suppression enabled on a port,
do not enable storm constrain for broadcast traffic on the port. The storm suppression function is
configured in Device > Port Management. For more information, see the chapter “Port management
configuration”.

With storm constrain enabled on a port, you can specify the system to act as follows when a certain type of
traffic (broadcast, multicast, or unicast) exceeds the corresponding upper threshold:

e Block—Blocks the port. The port is blocked and stops forwarding the traffic of this type until the type of
traffic drops down below the lower threshold. A port blocked by the storm constrain function can still
forward other types of traffic and collect statistics for the blocked traffic.

e Shutdown—Shuts down the port. The port is shut down and stops forwarding all types of traffic. To
bring up the port, select Device > Port Management to configure the port, or cancel the storm
constrain setting on the port.

Contiguring storm constrain

Setting the traffic statistics generating interval

Select Device > Storm Constrain from the navigation tree to enter the page shown in a. In the Interval for
generating traffic statistics text box, input the traffic statistics generating interval for storm constrain.
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a. The Storm Constrain tab

Interval Confiauration

Interval for generating traffic |10 Seconds{1-300, el

statistics: Default= 10)

Fort Storm Canstrain

¥search tem: | INterface Mame % |kepwords: Search
I:‘ M atch case and whole waord
I:‘ Search in previous results

Broadcast hulticast LInicast
[ Interface Mame Storm Control Storm Storm Control Mode  Trap Log  Operation
Info Contral Info Control Info
Add Delete

NOTE:

The traffic statistics generating interval set here is the interval used by the storm constrain function for
measuring traffic against the traffic thresholds. It is different from the interval set in the flow interval
module, which is used for measuring the average traffic sending and receiving rates over a specific
inferval.

For network stability sake, set the traffic statistics generating interval for the storm constrain function to
the default or a greater value.

Contfiguring storm constrain

Select Device > Storm Constrain from the navigation tree to enter the page shown in a. In the Port Storm
Constrain area, the configured port storm constrain settings are displayed. Click Add to enter the page for
adding port storm constrain configuration, as shown in a.
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a. Add storm constrain settings for ports

Add Fort Storm Constrain

Control Mode : Mone V|
Broadeast Threshald : | Mone Vi

L—— &8
Multicast Threshald : [ Mone v!

Unicast Threshold : Mone v!

pps range(100M:1-148810; GE:1-1488100; 10GE:1-14881000)

Trap Log

Select ports

B i g HP VA 910-186 S
EERE BRI faeli el

Select All Select Mone

Selacted Ports

Cancel

2. Port storm constrain configuration items

ltem Remarks

Specify the action to be performed when a type of traffic exceeds the corresponding
upper threshold. Available options include:

e None—Performs no action.
e Block—Blocks the traffic of this type on a port when the type of traffic exceeds the

upper threshold.
e Shutdown—Shuts down the port when a type of traffic exceeds the traffic
Control Mode threshold. The port stops forwarding traffic as a result.
(D IMPORTANT:

The storm constrain function, after being enabled, requires a full traffic statistics
generating interval (in seconds) fo collect traffic data, and analyzes the data in the next
inferval. It is normal that a period longer than one traffic statistics generating inferval is
waited for a control action to happen if you enable the function while the packet storm
is present. Nevertheless, the action will be taken within two intervals.

Broadcast Threshold Set the broadcast, multicast, and unicast thresholds.

Multicast Threshold e None—Performs no storm constrain for the selected port or ports.

e pps—Specifies the storm constrain upper threshold and lower threshold in
packets per second (pps).

@ IMPORTANT:

e On a port, you can set the thresholds for broadcast, multicast, and unicast traffic
at the same time. To set storm constrain on a port successfully, you must specify
the thresholds for at least a type of traffic.

Unicast Threshold

e When the pps option is selected, the upper threshold and lower threshold ranges
depend on the interface type, as shown in the pps range description on the page.
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ltem

Remarks

Trap

Select or clear the option to enable or disable the system to send trap messages both
when an upper threshold is crossed and when the corresponding lower threshold is
crossed after that.

Log

Select or clear the option to enable or disable the system to output logs both when an
upper threshold is crossed and when the corresponding lower threshold is crossed
after that.

Select ports

Select ports from the chassis front panel to apply the storm constrain settings to them.
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RMON configuration

Remote Monitoring (RMON) is used for management devices to monitor and manage the managed devices
on the network by implementing such functions as statistics collection and alarm generation. The statistics
collection function enables a managed device to periodically or continuously track various traffic
information on the network segments connecting to its ports, such as total number of received packets or
total number of oversize packets received. The alarm function enables a managed device to monitor the
value of a specified MIB variable, log the event and send a trap to the management device when the value
reaches the threshold, such as the port rate reaches a certain value or the potion of broadcast packets
received in the total packets reaches a certain value.

Both the RMON protocol and the Simple Network Management Protocol (SNMP) are used for remote
network management:

e RMON is implemented on the basis of the SNMP, and is an enhancement to SNMP. RMON sends
traps to the management device to notify the abnormality of the alarm variables by using the SNMP
trap packet sending mechanism. Although trap is also defined in SNMP, it is usually used to notify the
management device whether some functions on managed devices operate normally and the change of
physical status of interfaces. Traps in RMON and those in SNMP have different monitored targets,
triggering conditions, and report contents.

e RMON provides an efficient means of monitoring subnets and allows SNMP to monitor remote
network devices in a more proactive, effective way. The RMON protocol defines an alarm threshold
on the managed device and when that threshold is reached, the managed device sends a trap to the
management device automatically. This method reduces the communication traffic between the
management device and the managed device because the management device does not need to
retrieve and compare the values of MIB variables multiple times. In this way, you can manage a large
scale of network easily and effectively.

Working mechanism

RMON allows multiple monitors (management devices). A monitor provides the following methods for data
gathering:
e Using RMON probes. Management devices can obtain management information from RMON probes

directly and control network resources. In this approach, management devices can obtain all RMON
MIB information.

e Embedding RMON agents in network devices such as routers, switches, and hubs to provide the
RMON probe function. Management devices exchange data with RMON agents by using basic
SNMP operations to gather network management information, which, due to system resources
limitation, only covers four groups of MIB information alarm, event, history, and statistics, in most
cases.

The HP device adopts the second way and includes the RMON agent function. With the RMON agent
function, the management device can obtain the traffic flow among the managed devices on each
connected network segments and obtain information about error statistics and performance statistics for
network management.
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RMON groups

Among the RMON groups defined by RMON specifications (RFC 2819), the device uses the statistics group,
history group, event group, and alarm group supported by the public MIB. In addition, HP defines and
implements a private alarm group, which enhances the functions of the alarm group. This section describes
the five kinds of groups.

Ethernet statistics group

The statistics group defines the statistics that the system collects on various traffic information on a particular
inferface (at present, only Ethernet interfaces are supported) and saves the statistics in the Ethernet statistics
table (ethernetStatsTable) for query convenience of the management device. It provides statistics about
network collisions, CRC alignment errors, undersize/oversize packets, broadcasts, multicasts, bytes
received, packets received, and so on.

After the creation of a statistics entry on an interface, the statistics group starts to collect traffic statistics on
the interface. The result of the statistics is a cumulative sum.

History group

The history group defines the statistics that the system periodically collects on traffic information at a
particular interface and saves the statistics in the history record table (ethernetHistoryTable) for query
convenience of the management device. The statistics includes bandwidth utilization, number of error
packets, and total number of packets.

A history group collects statistics on packets received on the interface during each period, which can be
configured through the command line interface (CLI).

Alarm group

The RMON alarm group monitors specified alarm variables, such as total number of received packets
(etherStatsPkis) on an interface. After you define an alarm entry, the system gets the value of the monitored
alarm variable at the specified interval. When the value of the monitored variable is greater than or equal
to the rising threshold, a rising event is triggered; when the value of the monitored variable is smaller than
or equal to the falling threshold, a falling event is triggered. The event is then handled as defined in the event

group.

If the value of a sampled alarm variable surpasses the same threshold multiple times, only the first one can
cause an alarm event. In other words, the rising alarm and falling alarm are alternate. As shown in o, the
value of an alarm variable (the black curve in the figure) surpasses the threshold value (the blue line in the
figure) for multiple times, and multiple crossing points are generated, but only crossing points marked with
the red crosses can trigger alarm events.
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a.

Event group

Rising threshold

N\ JaN

Rising and falling alarm events

Alarm
variable value

Time

The event group defines event indexes and controls the generation and notifications of the events triggered
by the alarms defined in the alarm group and the private alarm group. The events can be handled in one
of the following ways:

Log—Logging event related information (the occurred events, contents of the event, and so on) in the
event log table of the RMON MIB of the device, so the management device can check the logs through
the SNMP Get operation.

Trap—Sending a trap fo notify the occurrence of this event o the network management station (NMS).
Log-Trap—Logging event information in the event log table and sending a trap to the NMS.

None—No action.

Contiguring RMON

Configuration task list

Configuring the RMON statistics function

RMON statistics function can be implemented by either the Ethernet statistics group or the history group, but
the objects of the statistics are different, and you can configure a statistics group or a history group
accordingly.

A statistics object of the Ethernet statistics group is a variable defined in the Ethernet statistics table,
and the recorded content is a cumulative sum of the variable from the time the statistics entry is created
to the current time. Perform the tasks in 1 to configure RMON Ethernet statistics function.

A statistics object of the history group is the variable defined in the history record table, and the
recorded content is a cumulative sum of the variable in each period. Perform the tasks in 2 to configure
RMON history statistics function.
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1. RMON statistics group configuration task list

Task Remarks

Required
You can create up to 100 statistics entries for a statistics table.

After a statistics entry is created on an interface, the system collects statistics on
various traffic information on the interface. It provides statistics about network
collisions, CRC alignment errors, undersize/oversize packets, broadcasts,
multicasts, bytes received, packets received, and so on. The statistics are cleared
after the device reboots.

Configuring a statistics
entry

@ IMPORTANT:

Only one statistics entry can be created on one inferface.

2. RMON history group configuration task list

Task Remarks

Required
You can create up to 100 history entries for a history table.

After an entry is created, the system periodically samples the number of packets
received/sent on the current interface, and saves the statistics as an instance under

Configuring a history the leaf node of the etherHistoryEntry table.

entry

@ IMPORTANT:

When you create an entry, if the value of the specified sampling interval is identical
to that of the existing history entry, the system considers the configurations identical
and the creation fails.

Configuring the RMON alarm function

e To enable the managed devices to send traps to the NMS when the NMS triggers an alarm event,
configure the SNMP agent as described in the chapter “SNMP configuration” before configuring the
RMON alarm function.

e If the alarm variables that can be configured through the web interface are MIB variables defined in
the history group or the statistics group, make sure that the RMON Ethernet statistics function or the
RMON history statistics function is configured on the monitored Ethernet interface.

Perform the tasks in 1 to configure RMON alarm function.
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1.

RMON alarm configuration task list

Task Remarks

Optional

You can create up to 60 event entries for an event table.

An event entry defines event indexes and the actions the system will take, including

Configuring an event
entry

log the event, send a trap fo the NMS, take no action, and log the event and send
a trap to the NMS.

@ IMPORTANT:

An entry cannot be created if the values of the specified alarm variable, sampling
interval, sampling type, rising threshold and falling threshold are identical to those of
an existing entry in the system.

Required

You can create up to 60 alarm entries for an alarm table.

Configuring an alarm
entry

With an alarm entry created, the specified alarm event will be triggered when an
abnormity occurs, and the alarm event defines how to deal with the abnormity.

@ IMPORTANT:

An entry cannot be created if the values of the specified event description, owners,
and actions are identical to those of an existing entry in the system.

Displaying RMON running status

After you configure the RMON statistics function or the alarm function, you can view RMON running status

and verify the configuration by performing tasks in 1.

1.

Display RMON running status

Task

Remarks

Displaying RMON statistics
information

View the inferface statistics during the period from the time the statistics
entry is created to the time the page is displayed. The statistics are
cleared after the device reboots.

Displaying RMON history sampling
information

After you have created a history control entry on an interface, the system
calculates the information of the interface periodically and saves the
information to the etherHistoryEntry table. You can perform this task to
view the entries in this table. And the number of history sampling records
that can be displayed and the history sampling interval are specified
when you configure the history group.

Displaying RMON event logs

If you have configured the system to log an event after the event is
triggered when you configure the event group, the event is recorded into
the RMON log. You can perform this task to display the details of the log
table

Contiguring a statistics entry

Select Device > RMON from the navigation tree fo enter the page of the Statistics tab, as shown in a. Click

Add to enter the page for adding a statistics entry, as shown in b.
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a. Statistics entry

History Alarm Event Log
P Search ltem:| Index e |Keywnn:|s:| Search
[] Index Interface Mame Owner Status Operation
] GigahbitEthernet1/0M1 ser Active LR
Add Del Selected

b. Add a statistics entry

Histary Alarm Event Log

Add a Statistic Group

Interface

Name: |GigahitEthernet1.-"[]_-"1 w |

Owner: | |Chars.[1—12?j:

&« Only one statistics group can be created on one interface.
lterms marked with an asterisk{*) are required

Apply Cancel

2. Statistics entry configuration items

ltem Description

Select the name of the interface on which the statistics entry is created.

Interface Name . i
Only one statistics entry can be created on one interface.

Owner Set the owner of the statistics entry.

Return o RMON statistics group configuration task list.

Configuring a history entry

Select Device > RMON from the navigation tree and click the History tab to enter the page, as shown in a.
Click Add to enter the page for adding a history entry, as shown in b.
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a. History entry

Statistics Alarm Event Log
b Search ltem:| Index ¥ |Keywords: Search
_ Buckets  Buckets Interval . o ;
] Index Interface Mame Requested Granted (Sec) Dwner Status  Operation
] GigabitEthernet1/0/1 10000 10 360 user!t  Active X
Add Del Selected
b. Add a history entry
Statistics Alarm Event Log
Add a History Group
Interface Mame: GigabitEthernet1/0/1 | »
Buckets Granted: *(1-55535)
Interval: *Seconds(3-3600)
Owner. Chars.{1-127)

lterms marked with an asterisk{*) are required

Apply Cancel

2. History entry configuration items

ltem Description

Interface Name Select the name of the interface on which the history entry is created.

Set the capacity of the history record list corresponding to this history entry, namely,
the maximum number of records that can be saved in the history record list.

Buckets Granted If the current number of the entries in the table has reached the maximum number, the
system will delete the earliest entry to save the latest one. The statistics include total
number of received packets on the current interface, total number of broadcast
packets, total number of multicast packets in a sampling period, and so on.

Interval Set the sampling period.

Owner Set the owner of the entry.

Return to RMON history group configuration task list.

Configuring an event entry

Select Device > RMON from the navigation tree and click the Event tab to enter the page, as shown in a.
Click Add to enter the page for adding an event entry, as shown in b.
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a. Evententry

Statistics History Alarm Log
P Search ltem:| Index v |Ke-,-‘-m‘-:uru:|5:| Search
_— Event Evnet Last - =
] Index Description Type Trigger Time Chwner Status
] test Log,Trap - Luserl Active
Add Del Zelected

b. Add an event entry

Statistics History Alarm Log

Add an Event Group

Description: | |Char5_[1-12?;
Owner: | |Chars.[1—12?j:
Event Type: CLog ClTrap

[tems marked with an asterisk(*) are required

Apply Cancel

2.  Event entry configuration items

ltem Description
Description Set the description for the event.
Owner Set the owner of the entry.

Set the actions that the system will take when the event is triggered:
e log—The system will log the event.
Event Type o Trap—The system will send a trap in the community name of null.

If both Log and Trap are selected, the system will log the event and send a trap. If
none of them is selected, the system will take no action

Return to RMON alarm configuration task list.

Contfiguring an alarm entry

Select Device > RMON from the navigation tree and click the Alarm tab to enter the page, as shown in a.
Click Add to enter the page for adding an alarm entry, as shown in b.

102



a. Alarm entry

Statistics History Event Log
P Search Item:| Index v |Ke'y'w'ords:| Search
. . Current . ; Rising Falling
Interval Statics ' Sampling = . Rising Falling . y = :
[ Index (Sec) e Interface Name Type .dlc-!mpllng Threshold Threshald Event Event Owner Status Operation
Value Index Index
Mumber
O 10000 gecei”ed GigabitEthernet1/0/1 Absclute |0 100000000 100 1 1 user! | Active
Bytes
Add Del Selected
b. Add an alarm entry
Statistics History Event Log
Add an Alarm Group
Alarm Variable
Statics Iterm: |NL|mher of Packet Discarding Events il
Interface | - . -
GigabitEthernet 1/01 V|
Mame: g
Sample ltem
Interval: | “Seconds(5-65535)
Sample Type: Absolute »
Owner. | |Chars.[1-12?j:
Alarm

[ ] Create Default Event
Rising Threshnld:|

0- o -
Rising Event: -1 v
2147483647) g

Falling Threshnld:| |*m- Falling Event

2147483647)

« Before creating Alarm, please create Statistic and Event at fisrt.
lterns marked with an asterisk{™) are required
Apply Cancel

2. Alarm entry configuration items

ltem Description
. Set the traffic statistics that will be collected and monitored. For more information,
Statics ltem 9
Alarm see Z.
variable Set the name of the interface whose traffic statistics will be collected and
Interface Name .
monitored.
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ltem

Description

Sample

Item

Interval Set the sampling interval.

Set the sampling type, including:

o Absolute—Absolute sampling, namely, to obtain the value of the variable
Sample Type when the sampling time is reached.

o Delta—Delta sampling, namely, to obtain the variation value of the variable
during the sampling interval when the sampling time is reached.

Owner

Set the owner of the alarm entry.

Alarm

Create Default
Event

Select whether to create a default event.

The description of the default event is default event, the action is log-and-trap,
and the owner is default owner.

If there is no event, you can select to create the default event. And when the value
of the alarm variable is higher than the alarm rising threshold or lower than the
alarm falling threshold, the system will adopt the default action, that is,
log-and-trap.

Rising -
Threshold Set the alarm rising threshold.

Set the action that the system will take when the value of the alarm variable is
Rising Event higher than the alarm rising threshold.

If the Create Default Event check box is selected, this option is not configurable.
Falling .
Threshold Set the alarm falling threshold.

Set the action that the system will take when the value of the alarm variable is
Falling Event lower than the alarm falling threshold.

If the Create Default Event check box is selected, this option is not configurable.

Return to RMON alarm configuration task list.

Displaying RMON statistics information

Select Device > RMON from the navigation tree fo enter the page of the Statistics tab, as shown in a. Click
the " icon of a statistics entry fo enter the page as shown in a, which displays all statistics items on the

current interface.
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RMON statistics information

a.
History Alarm Event Log
Statistic Group Detail
“ﬁ;'g:g;: GigabitEthernet1/0/1
Statistic ltem Statistic Value
Mumber of Received Bytes 21657
Mumber of Received Packets 307
Mumber of Received Broadcasting Packets a6
Mumber of Received Multicast Packets 34
Mumber of Received Packets With CRC Check 0
Failed
Mumber of Received Packets Smaller Than 64 0
Bytes
Mumber of Received Fackets Larger Than 15138 0
Byies
Mumber of Received Packets Smaller Than 64 0
Bytes And FC3 Check Failed
Mumber of Received Fackets Larger Than 15138 0
Bytes And FC3 Check Failed
Mumber of Metwark Conflicts ]
Fumber of Packet Discarding Events ]
Mumber of Received 64 Bytes Packets 235
Mumber of Received 65 to 127 Bytes Packets 67
Mumber of Received 128 to 255 Bytes Packets 4
Mumber of Received 256 to 511 Bytes Packets 1
Mumber of Received 512 to 1023 Bytes Packets ]
Mumber of Received 1024 to 1518 Bytes Packets 0
Back Refresh

2. Fields of RMON statistics

ltem Description

Number of Received Bytes

Total number of octets received by the interface,
corresponding to the MIB node etherStatsOctets.

Number of Received Packets

Total number of packets received by the interface,
corresponding to the MIB node etherStatsPks.

Number of Received Broadcasting Packets

Total number of broadcast packets received by the
interface, corresponding to the MIB node
etherStatsBroadcastPkis.

Number of Received Multicast Packets

Total number of multicast packets received by the
interface, corresponding to the MIB node
etherStatsMulticastPkts.
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ltem

Description

Number of Received Packets With CRC Check
Failed

Total number of packets with CRC errors received on the
interface, corresponding to the MIB node
etherStatsCRCAlignErrors.

Number of Received Packets Smaller Than 64
Bytes

Total number of undersize packets (shorter than 64 octets)
received by the interface, corresponding to the MIB node
etherStatsUndersizePkis.

Number of Received Packets Larger Than 1518
Bytes

Total number of oversize packets (longer than 1518 octets)
received by the interface, corresponding to the MIB node
etherStatsOversizePkts.

Number of Received Packets Smaller Than 64
Bytes And FCS Check Failed

Total number of undersize packets (shorter than 64 octets)
with CRC errors received by the interface, corresponding
to the MIB node etherStatsFragments.

Number of Received Packets Larger Than 1518
Bytes And FCS Check Failed

Number of oversize packets (longer than 1518 octets) with
CRC errors received by the interface, corresponding to the
MIB node etherStats]abbers.

Number of Network Conflicts

Total number of collisions received on the interface,
corresponding to the MIB node etherStatsCollisions.

Number of Packet Discarding Events

Total number of drop events received on the interface,
corresponding to the MIB node etherStatsDropEvents.

Number of Received 64 Bytes Packets

Total number of received packets with 64 octets on the
interface, corresponding to the MIB node
etherStatsPkts64Octets.

Number of Received 65 to 127 Bytes Packets

Total number of received packets with 65 to 127 octets on
the interface, corresponding to the MIB node
etherStatsPkis65t0127Octets.

Number of Received 128 to 255 Bytes Packets

Total number of received packets with 128 to 255 octets
on the interface, corresponding to the MIB node

etherStatsPkts 128t02550ctets.

Number of Received 256 to 511 Bytes Packets

Total number of received packets with 256 to 511 octets
on the interface, corresponding to the MIB node

etherStatsPkts256t0511Octets.

Number of Received 512 to 1023 Bytes Packets

Total number of received packets with 512 to 1023 octets
on the interface, corresponding to the MIB node

etherStatsPkts512t01023Octets.

Number of Received 1024 to 1518 Bytes Packets

Total number of received packets with 1024 to 1518
octets on the interface, corresponding to the MIB node

etherStatsPkts 1024t01518Octets.

Return to Display RMON running status.

Displaying RMON history sampling information

Select Device > RMON from the navigation tree and click the History tab to enter the page, as shown in a.
Click the "™« icon of a history entry to enter the page as shown in o, which displays all history sampling
information on the current inferface.
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a. RMON history sampling information

Statistics

History Group Detail

Event Log

Current Interface: GigabitEthernet1/01

P search item: | Time

Search

NO  Time DropEvents Octets Pkis BroadcastPkis MulticastPkts CRCAlignErrors  UndersizePkts  OversizePkts Fragments Jabbers Collisions Utilization

2000-4-
1 28 0
16:43:22

] 0 0 0 ] 0 ] ] 0%

Back Refresh

2. Fields of RMON history sampling information

ltem Description
NO Number of the entry in the system buffer

Statistics are numbered chronologically when they are saved to the system buffer.
Time Time at which the information is saved
DropEvents Droppgd packets during the sampling period, corresponding to the MIB node

etherHistoryDropEvents.

Number of octets received during the sampling period, corresponding to the MIB
Octets .

node etherHistoryOctets.

Number of packets received during the sampling period, corresponding to the MIB
Pkts :

node etherHistoryPkis.

Number of broadcasts received during the sampling period, corresponding fo the
BroadcastPkts MIB node etherHistoryBroadcastPkis.
MulticastPkis Number of multicasts received during the sampling period, corresponding to the

MIB node etherHistoryMulticastPkis.

CRCAlignErrors

Number of packets received with CRC alignment errors during the sampling period,
corresponding to the MIB node etherHistoryCRCAlignErrors.

UndersizePkts

Number of undersize packets received during the sampling period, corresponding
to the MIB node etherHistoryUndersizePkts.

Number of oversize packets received during the sampling period, corresponding to

OversizePlis the MIB node etherHistoryOversizePkts.
Fraaments Number of fragments received during the sampling period, corresponding to the
J MIB node etherHistoryFragments.

Jabbers Number of jabbers received during the sampling period (Support for the field
depends on the device model.), corresponding to the MIB node etherHistoryJabbers.

Collisions Number of collision packets received during the sampling period, corresponding to
the MIB node etherHistoryCollisions.

Utilization Bandwidth utilization during the sampling period, corresponding to the MIB node

etherHistoryUtilization.

Return to Display RMON running status.
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Displaying RMON event logs

Select Device > RMON from the navigation tree and click the Log tab to enter the page, as shown in g,
which displays log information for all event entries.

a. log
Statistics History Alarm Event
P Search ltem:| Event Index Keywu:uru:ls:| Search
Event Log : .
Index Index Log Time Description
1 1 2000-4-26 The 1.3.6.1.2.1.16.1.1.1.4.1 defined in alarmEntry 1, less than{or =)
16:50:53 100 with alarm value 0. Alarm sample type is absolute
Fefresh

Return to Display RMON running status.

RMON contiguration example

Network requirements

As shown in a, Agent is connected to a remote NMS across the Internet. Create an entry in the RMON
Ethernet statistics table to gather statistics on Ethernet 1/0/1, and perform corresponding configurations so
that the system will log the event when the number of bytes received on the interface exceed the specified

threshold.
a. Network diagram for RMON

Agent
GE1/0/1

Server NMS

Configuration procedure

# Configure RMON to gather statistics for interface Ethernet 1/0/1.
o Select Device > RMON from the navigation tree to enter the page of the Statistics tab. Click Add.
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a. Add a statistics entry

History Alarm Event Log

Add a Statistic Group

Interface — —
Mame: | GigabitEthernet1/0/1 v|
Qwner. |L|ser1-rm|:|n |Char5_31-12?;

« Only one statistics group can be created on one interface.

lterns marked with an asterisk(*}) are required

Apply Cancel

Select GigabitEthernet1/0/1 from the Interface Name drop-down box.

e  Type user1-rmon in the text box of Owner.

Click Apply.

# Display RMON statistics for interface Ethernet 1/0/1.

e Click the icon "« corresponding to GigabitEthernet 1/0/1.

e  You can view the information as shown in b.
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b.

Display RMON statistics

History Alarm Event

Statistic Group Detail

Current

Interface: GigabitEthernet!/0M

Statistic ltem
Mumber of Received Bytes
Mumber of Received Packets
Mumber of Received Broadcasting Packets
Mumber of Received Multicast Packets

Mumber of Received Packets With CRC Check
Failed

Mumber of Received Packets Smaller Than 64
Bytes

Mumber of Received Fackets Larger Than 15138
Byies

Mumber of Received Packets Smaller Than 64
Bytes And FC3 Check Failed

Mumber of Received Fackets Larger Than 15138
Bytes And FC3 Check Failed

Mumber of Metwark Conflicts

Fumber of Packet Discarding Events

Mumber of Received 64 Bytes Packets

Mumber of Received 65 to 127 Bytes Packets
Mumber of Received 128 to 255 Bytes Packets
Mumber of Received 256 to 511 Bytes Packets
Mumber of Received 512 to 1023 Bytes Packets
Mumber of Received 1024 to 1518 Bytes Packets

Back

Log

21657
307
56

24

235

Lo I o R

Refresh

# Create an event fo start logging after the event is triggered.

Click the Event tab, click Add.
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c. Configure an event group

Statistics History Alarm Log

Add an Event Group

Cescription: | |Chars.[1—‘12?j:
Owner: |1-rm|:|n |Chars.[1-12?j:
Event Type: Log |:|Tra|:|

lterms marked with an asterisk(*) are required

Apply Cancel

e Type 1-rmon in the text box of Owner.
o Select the check box before Log.
o Click Apply.

o The page goes to the page displaying the event entry, and you can see that the entry index of the new
event is 1, as shown in d.

d. Display the index of a event entry

Statistics History Alarm Log
P Search Item:||l1dEX V|KE'y'w'nrds:| | Search
_— Event EwnetLastTrigger . a
[] Index Description = Time Owner Status
Fi |1 null Log - 1-rman | Active
Add Del Selected

# Configure an alarm group to sample received bytes on Ethernet 1/0/1. When the received bytes exceed
the rising or falling threshold, logging is enabled.

e  Click the Alarm tab, click Add.
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e. Configure an alarm group

Statistics History

Add an Alarm Group

Event

Log

Alarm Variable

Sample ltem

Statics Item: | Mumber of Received Bytes
Interface — —
Name: |G|gah|tEthernet1fU_f1 v|

*Seconds{5-65535)

|Chars.[1—‘12?j:

Interval: |1[]
Crwner: | 1-rmon
Alarm

] Create Default Event

Rising Threshnld:|1UUU

2147483647)

"0 Rising Event:

Falling Threshn|u:|1ﬂﬂ

|‘[D_ Falling Event:

2147483647)

« Before creating Alarm, please create Statistic and Event at fisrt.

lterns marked with an asterisk(*) are required

Apply

Cancel

o Select Number of Received Bytes from the Statics ltem drop-down box.
e Select GigabitEthernet1/0/1 from the Interface Name drop-down box.

e Type 10 in the fext box of Interval.

o Select Delta from the Simple Type drop-down box.

e Type 1-rmon in the text box of Owner.

e Type 1000 in the text box of Rising Threshold.
o Select 1 from the Rising Event drop-down box.
e Type 100 in the text box of Falling Threshold.

o Select 1 from the Falling Event drop-down box.

o Click Apply.
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Energy saving configuration

Overview

Energy saving allows you to configure a port to work at the lowest transmission speed, disable PoE, or go
down during a specified time range on certain days of a week. The port resumes working normally when
the effective time period ends.

Contiguring energy saving on a port

Select Device > Energy Saving from the navigation tree to enter the energy saving configuration page, as
shown in a. You can select a port and configure an energy saving policy for the port.

a. Energy saving configuration page

Flease select a port:

i 0 0 O D e
2 0 1 0 A 3 i

Index Time Range Sun Man Tue Wed Thu Fri Sat Lowest Speed Shutdown
1 0002400 | O O O
2 00000000 | O O O
3 oooooooo | B FE E B EBE B H O O
1 00000000 | e FE CF E E ELE O O
5 ooooon00 | B OE E OB B B H O O

Applhy zancel

2. Configuration items for configuring energy saving on a port

ltem Description

Set the time period when the port is in the state of energy saving.

Time Range @ IMPORTANT:
e Up to five energy saving policies with different time ranges can be configured on
a port.

e Specity the start time and end time in units of 5 minutes, such as 08:05 to 10:15.
Otherwise, the start time will be postponed and the end time will be brought
forward so that they meet the requirements. For example, if you set the time range
to 08:08 to 10:12, however, the effective time range is actually 08:10 to 10:10.

Sun through Sat

PoE Disabled Disable PoE on the port.
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ltem Description

Set the port to transmit data at the lowest speed.

@ IMPORTANT:

If you configure the lowest speed limit on a port that does not support 10 Mbps, the
configuration cannot take effect.

Lowest Speed

Shut down the port.
Shutdown @ IMPORTANT:

An energy saving policy can have all the three energy saving schemes configured, of
which the shutdown scheme takes the highest priority.
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SNMP configuration

The Simple Network Management Protocol (SNMP) is an Internet standard protocol widely used for a
management station to access and operate the devices on a network, regardless of their vendors, physical
characteristics and interconnect technologies.

SNMP enables network administrators to read and set the variables on managed devices to monitor their
operating and health state, diagnose network problems, and collect statistics for management purposes.

SNMP mechanism

The SNMP framework comprises the following elements:

e SNMP manager—works on a network management workstation (NMS) to monitor and manage the
SNMP-capable devices in the network.

e SNMP agent—works on a managed device to receive and handle requests from the NMS, and send
traps to the NMS when some events, such as interface state change, occur.

e Management Information Base (MIB)—Specifies the variables (such as interface status and CPU
usage) maintained by the SNMP agent for the SNMP manager to read and set.

a. Relationship between an NMS, agent and MIB

’ Get/Set requests é/ MIB

Get/Set responses
NMS and Traps Agent

A MIB stores variables called “nodes” or “objects” in a tree hierarchy and identifies each node with a
unique OID. An OID is a string of numbers that describes the path from the root node to a leaf node. For
example, the object B in b is uniquely identified by the OID {1.2.1.1}.

b. MIB tree
1
1‘ 2
1 2
1, ‘2
5 6
A

SNMP provides the following four basic operations:
o Get—The NMS retrieves SNMP object nodes in an agent MIB.
Set—The NMS modifies the value of an object node in the agent MIB.

Trap—The SNMP agent sends traps to report events to the NMS.
Inform—The NMS sends alarms to other NMSs.
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SNMP protocol version

SNMP agents support three SNMP protocol versions: SNMPv1, SNMPv2¢, and SNMPv3.

SNMPv1 uses community names for authentication. A community name performs a similar role as a
password fo regulate access from the NMS to the agent. If the community name provided by the NMS
is different from the community name set on the agent, the SNMP connection cannot be established
and the NMS fails to access the agent.

SNMPv2c uses community names for authentication. SNMPv2c¢ is compatible with SNMPv1, but it
provides more operation modes, supports more data types, and provides various error codes for
troubleshooting.

SNMPv3 offers authentication based on the User-based Security Model (USM), which allows network
administrators to set authentication and privacy functions. The authentication function is used to
authenticate the validity of the sending end of the authentication packets, preventing access of
unauthorized users. The privacy function is used to encrypt packets between the NMS and agents,
preventing the packets from being intercepted. USM ensures more secure communication between
NMSs and agents by providing authentication and privacy functions.

Successful interaction between an NMS and the agents requires consistency of SNMP versions configured
on them.

SNMP configuration

Configuration task list

As configurations for SNMPv3 differ substantially from those for SNMPv1 and SNMPv2c, their
configuration tasks are introduced separately as follows.

Configuring SNMPv1 or SNMPv2c
Perform the tasks in 1 to configure SNMPv1 or SNMPv2c:

1.

SNMPv1 or SNMPv2c configuration task list

Task Remarks

Enabling SNMP

Required
The SNMP agent function is disabled by default.

@ IMPORTANT:
If SNMP is disabled, all SNMP-related configurations are removed.
Optional

Configuring an SNMP After creating SNMP views, you can specify an SNMP view for an

SNMP community to limit the MIB objects that can be accessed by the
SNMP community.

Contiguring an SNMP Required
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Task Remarks

Optional

Allows you to configure that the agent can send SNMP traps to the
Configuring SNMP trap NMS, and configure information about the target host of the SNMP
traps.

By default, an agent is allowed to send SNMP traps to the NMS.

Configuring SNMPv3

Perform the tasks in 1 to configure SNMPv3:
1. SNMPv3 configuration task list

Task Remarks

Required

Enabling SNMP
The SNMP agent function is disabled by default.

Optional
Configuring an SNMP After creating SNMP views, you can specify an SNMP view for an
SNMP group to limit the MIB objects that can be accessed by the SNMP
group.
Required
After creating an SNMP group, you can add SNMP users to the group
Configuring an SNMP when creating the users. Therefore, you can realize centralized
management of users in the group through the management of the
group.
Required
Configuring an SNMP Before creating an SNMP user, you need to create the SNMP group to
which the user belongs.
Optional
Allows you to configure that the agent can send SNMP traps to the
Configuring SNMP trap NMS, and configure information about the target host of the SNMP
traps

By default, an agent is allowed to send SNMP traps to the NMS.

Enabling SNMP

Select Device > SNMP from the navigation tree to enter the SNMP configuration page, as shown in a. On
the upper part of the page, you can select to enable or disable SNMP and configure parameters such as
SNMP version; on the lower part of the page, you can view the SNMP statistics, which helps you
understand the running status of the SNMP after your configuration.
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a. Setup

Carmrmunity Group Usar Trap Wiew
SHMP (Enable () pisable
Local Engine ID BO0000ZB03000F E2012970 Fr10-64 Hex Chars.)
Waximum Facket Size 1500 FEytes994-17940, Default= 1500)
Contact dCarn Corporation. F(1-200 Chars.)
Location harlborough, hA 01752 LISA F(1-200 Chars.)
SHMP Version 0wt Owze [z

ltems madied with an asterisa™) are raquired

Apply Cancel

SHMP Statistics Count
hMessages delivered to the SHMP entity
Messages which were for an unsupported version
Messages which used a SHMP community name not known
Messages which represented anillegal operation far the community supplied
ASM.1 or BER errars inthe process of decoding
hIB ohjects retrieved successfully
hIB ohjects altered successfully
GetRequest-PDU accepted and processed
GethexRequest-FDU accepted and processed
SetRequest-PDU accepted and processed
Messages passed from the SMMP entity
SHMP PDUs which had tooBig error-status (Maximum packet size 1500}
SMMP POUs which had noSuchiame error-status
SHMP PDUs which had hadvalue error-status
SHMP PDUs which had genErr error-status
GetResponze-PDU accepted and processed
Trap PDUs accepted and processed

o o o o o o o o o o o oo oo o O

Refresh

2. Configuration items for enabling SNMP

ltem Description

SNMP Specify to enable or disable SNMP.

Configure the local engine ID.

The validity of a user after it is created depends on the engine ID of the SNMP
agent. If the engine ID when the user is created is not identical to the current
engine ID, the user is invalid.

Local Engine ID

Configure the maximum size of an SNMP packet that the agent can

Maximum Packet Size .
receive/send.
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ltem Description

Set a character string to describe the contact information for system
maintenance.

Contact o o
If the device is faulty, the maintainer can contact the manufacture factory
according to the contact information of the device.
Location Set a character string to describe the physical location of the device.
SNMP Version Set the SNMP version run by the system

Return to SNMPv1 or SNMPv2c configuration task list or SNMPv3 configuration task list.

Contiguring an SNMP view

Select Device > SNMP from the navigation tree, and then click the View tab to enter the page as shown in
a.

a. View page

Setup Community GEroup ser Trap
b Search Item:| View Name v |Keywu:uru:|s:| Search
Yiew Mame Rule MIB Subtree QID Subtree Mask Qperation

ViewDefault il 3=
Included 1

Excluded 1.3.61.6315
Excluded 1.3.6.1.6.3.16

Excluded 1.3.6.1.6.3.18

PR2ER B
& & & &

Add

Creating an SNMP view
Table 23 Click Add, the Add View window appears as shown in b.
Table 24 Type the view name and click Apply, and then you enter the page as shown in c.
b. Create an SNMP view (1)

Please input the name of the view you want to create.

Wiewy Name| i1-32 Chars.)

Appaly Cancel
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c¢. Create an SNMP view (2)

Add View

View Mame viewT |

Rule @ Included O Excluded

MIB Subtree QID “{1-255 Chars.)
Subtree Mask (2-32Hex Chars.)

Items marked with an asterisk{*} are required

Rule MIB Subtree QID Subtree Mask Operation

Apply Cancel

Table 25 Configure the parameters of a rule and click Add to add the rule into the list box at the lower part
of the page.

Table 26 Configure all rules and click Apply to create an SNMP view. Note that the view will not be created
if you click Cancel.

2. Configuration items for creating an SNMP view

ltem Description

View Name Set the SNMP view name.

Select to exclude or include the objects in the view range determined by the MIB

Rule subtree OID and subtree mask.

Set the MIB subtree OID (such as 1.4.5.3.1) or name (such as system).

MIB Subtree OID MIB subtree OID identifies the position of a node in the MIB tree, and it can uniquely
identify a MIB subtree.

Set the subtree mask.

Subtree Mask If no subtree mask is specified, the default subtree mask (all Fs) will be used for
mask-OID matching.

Adding rules to an SNMP view

Table 27 Click the 5 icon corresponding to the specified view on the page as shown in o, the Add rule for
the view ViewDefault window appears as shown in b.

Table 28 Configure the parameters, and click Apply to add the rule for the view. 2 describes the
configuration items for creating an SNMP view.
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b. Add rules to an SNMP view

Add rule for the view ViewDefault

Rule ® Included O Excluded

*(1-255 Chars.}

MIB Subtree OID |

Subtree Mask | |[2—32Hex Chars.)

terms marked with an asterisk(®) are required

Apply Cancel

NOTE:

You can also click the B icon corresponding to the specified view on the page as shown in o, and then

you can enter the page to modify the view.

Return to SNMPv1 or SNMPv2c configuration task list or SNMPv3 configuration task list.

Configuring an SNMP community
Table 29 Select Device > SNMP from the navigation tree.

Table 30 Click the Community tab to enter the page as shown in b.
Table 31 Click Add to enter the Add SNMP Community page as shown in c.

b. Configure an SNMP community

Setup Group ser Trap Wiew
b Search Item:| Community Name |+ |Kewmrd5:| Search

FI Community Mame EZ‘;?S MIB View ACL Qperation
[1 sommunity Read only ViewDefault @ ﬁl

Add Delete Selected

c. Create an SNMP Community

Add SMNMP Community

Community Mame | *(1-32 Chars.)

Access Right | Fead only w |
View | ViewDefault hd |
ACL | |(2000-2999)

lterms marked with an asterisk(*) are required

Apply Cancel
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2. Configuration items for configuring an SNMP community

ltem Description

Community Name Set the SNMP community name.

Configure SNMP NMS access right
e Read only—The NMS can perform read-only operations to the MIB objects when
Access Right it uses this community name to access the agent,
e Read and write—The NMS can perform both read and write operations to the MIB
objects when it uses this community name to access the agent.

Specify the view associated with the community to limit the MIB objects that can be

View accessed by the NMS.

Associate the community with a basic ACL to allow or prohibit the access to the agent

ACL from the NMS with the specified source IP address.

Return to SNMPv1 or SNMPv2c configuration task list.

Configuring an SNMP group

Table 32 Select Device > SNMP from the navigation tree.
Table 33 Click the Group tab to enter the page as shown in b.
Table 34 Click Add to enter the Add SNMP Group page as shown in c.

b. SNMP group

Setup Community ser Trap Wiew
b Search ltem:| Group Name % |Keywords: Search

[J Group Name Sl'_icg?t ReadView  WriteView  NofifyView ACL Operation
[] groupt mosuthiMoPriv ViewDefault ViewDefault ViewDefault m

Add Delete Selected
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c. Create an SNMP group

Add SMMP Group

Group Mame

Security Level

Read View
Write View
Matify View
ACL

*(1-32 Chars.)

MoAuth/MaPrv i
ViewDefault w
W
W

(2000-2999]

Items marked with an asterisk{*} are required

Apply Cancel

2. Configuration items for creating an SNMP group

ltem

Description

Group Name

Set the SNMP group name.

Security Level

Select the security level for the SNMP group. The available security levels are:
e NoAuth/NoPriv—No authentication no privacy.

e Auth/NoPriv—Authentication without privacy.

o Auth/Priv—Authentication and privacy.

@ IMPORTANT:

For an existing SNMP group, its security level cannot be modified.

Read View Select the read view of the SNMP group.
Select the write view of the SNMP group.
Write View If no write view is configured, the NMS cannot perform the write operations to all MIB
obijects on the device.
Select the notify view of the SNMP group, that is, the view that can send trap
Notify View messages.
If no notify view is configured, the agent does not send traps to the NMS.
Associate a basic ACL with the group to restrict the source IP address of SNMP
ACL packets, that is, you can configure to allow or prohibit SNMP packets with a specific

source IP address, so as to restrict the intercommunication between the NMS and the
agent.

Return to SNMPv3 configuration task list.

Configuring an SNMP user

Table 35 Select Device > SNMP from the navigation tree.
Table 36 Click the User tab to enter the page as shown in b.
Table 37 Click Add to enter the Add SNMP User page, as shown in c.
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b. SNMP user

Setup Community Group Trap Wiew
P Search Item:| User Name v |Keywnn:|s:| Search
Authentication . i
FI ser Mame Group Mame Mode Privacy Mode ACL Operation
[ usert group1 DS DESS6 ]

[ MoAuth/MaPriv ]

Add Delete Selected

c. Create an SNMP user

Add SNMP User

lser Mame | *(1-32 Chars.)
Security Level | Moduth/MoPriv b |
Group Mame | group? { NoAuth/NoPriv ) » |

Authentication Mode

Authentication Password | |[1-54 Chars.}

Confirm Authentication Password | |[1—E4 Chars )

Frivacy Mode

Privacy Passwaord | |[1—E4 Chars.)
Canfirm Frivacy Passwaord | |[1-54 Chars.)
ACL | |(2000-2999)

ltems marked with an asterisk(*) are required

Apply Cancel

2. Configuration items for creating an SNMP user

ltem Description

User Name Set the SNMP user name.

Select the security level for the SNMP group. The following are the
available security levels:

Security Level e NoAuth/NoPriv—No authentication no privacy.
e Auth/NoPriv—Authentication without privacy.
o Auth/Priv—Authentication and privacy.
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ltem Description

Select an SNMP group to which the user belongs.

e When the security level is NoAuth/NoPriv, you can select an
SNMP group with no authentication no privacy.

e When the security level is Auth/NoPriv, you can select an
SNMP group with no authentication no privacy or
authentication without privacy.

Group Name

e When the security level is Auth/Priv, you can select an SNMP
group of any security level.

Select an authentication mode (including MD5 and SHA) when the

Authentication Mode security level is Auth/NoPriv or Auth/Priv.

Authentication Password Set the authentication password when the security level is
Auth/NoPriv or Auth/Priv.
Confirm Authentication Password The confirm authentication password must be the same with the

authentication password.

Select a privacy mode (including DES56, AES128, and 3DES)
when the security level is Auth/Priv.

Privacy Mode

Privacy Password Set the privacy password when the security level is Auth/Priv.

The confirm privacy password must be the same with the privacy

Confirm Privacy Password d
password.

Associate a basic ACL with the user to restrict the source IP address
of SNMP packets, that is, you can configure to allow or prohibit

ACL SNMP packets with a specific source IP address, so as to allow or
prohibit the specified NMS to access the agent by using this user
name.

Return to SNMPv3 configuration task list.

Configuring SNMP trap function
Table 38 Select Device > SNMP from the navigation tree.
Table 39 Click the Trap tab to enter the page as shown in b.

Table 40 On the upper part of the page, you can select to enable the SNMP trap function; on the lower part
of the page, you can configure target hosts of the SNMP traps.

Table 41 Click Add to enter the Add Trap Target Host page, as shown in c.
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b. Traps configuration

Setup Community Group ser Wiew

[¥]Enable SMMP Trap Apply

Trap Target Host
B Search ltern: | Destination IP Address » |KE.J.-.I.-.,.-.:|r|j5;| | Search
Destination IP EeT T UDP  Security Security :
VaATTEY E k !
[F Address IPvd/IPvE ecurity Mame Port Model Level Operation
[1 10112 IPvd abc 162 V3 AuthitaPriv ﬂ

Add Celete Selected

c. Add atarget host of SNMP traps

Setup Cammunity GEraup User ey
Add Trap Target Host
Destination IP Address IO IPvE
Security Name | %(1-32 Chars.)
UDP Part 162 *(0-65535, Default = 162)
Security Model |v1 j
Security Level | J

[terms marked with an asteriski™ are required

Bpply Cancel

2. Configuration items for adding a target host

ltem Description

Set the destination IP address.

Destination IP Address Select the IP address type: IPv4 or IPv6, and then type the corresponding IP
address in the text box according to the IP address type.

Set the security name, which can be an SNMPv1 community name, an

Security Name SNMPv2¢c community name, or an SNMPv3 user name.
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ltem Description

Set UDP port number.

@ IMPORTANT:

The default port number is 162, which is the SNMP-specified port used for

receiving traps on the NMS. Generally (such as using iMC or MIB Browser as the
NMS), you can use the default port number. To change this parameter to another
value, you need to make sure that the configuration is the same with that on the

NMS.

UDP Port

Select the security model, that is, the SNMP version. Ensure that the SNMP
Security Model version is the same with that on the NMS; otherwise, the NMS cannot receive
any trap.

Set the authentication and privacy mode for SNMP traps when the security
model is selected as v3. The available security levels are: no authentication no
Security Level privacy, authentication but no privacy, and authentication and privacy.

When the security model is selected as v1 or v2¢, the security level is no
authentication no privacy, and cannot be modified.

Return to SNMPv1 or SNMPv2c configuration task list or SNMPv3 configuration task list.

SNMP configuration example

Network requirements

e Asshown in a, the NMS connects to the agent, Switch, through an Ethernet.

e  The IP address of the NMS is 1.1.1.2/24.

e  The IP address of the VLAN interface on Switch is 1.1.1.1/24.

e The NMS monitors the agent using SNMPv3. The agent reports errors or faults to the NMS.

a. Network diagram for SNMP configuration

Vlan-int2
@ 1.1.1.1/24 ‘

Switch NMS
Agent 1.1.1.2/24

Configuration procedure
Table 42 Configure Agent
# Configuration IP addresses for the interfaces. (Procedure omitted)

# Enable SNMP.
e Select Device > SNMP from the navigation tree to enter the Setup page.
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b. Enable SNMP

Trap Wiew

Cammunity Group zer
SHMP @ Enable O Disable |
Lacal Engine D |BDDDEBAZDSSCE5%1238DD

}*{1 0-64 Hex Chars.)

Maximurm Packet Size |15EIEI

)*m-zuu Chars.)

h']-znn Chars.)

Contact |HF'
Location |HF'
SNMP Version 0w Ovze vz ]

}"'EI\_.-TES(484-1 7940, Default=1500)

[termns marked with an asterisk{™) are required

Apply

SHMP Statistics
Messages delivered to the SMMP entity
Messages which were far an unsupported version

Cancel

Messages which used a SMMP community name nat known

e  Select the Enable radio box.
e Select the v3 radio box.

e Click Apply.

# Configure an SNMP view.

e Click the View tab and then click Add to enter the page as shown in c.

c. Create an SNMP view (1)

Please input the name of the view you want to create.

View Mame |view1

(1-32 Chars)

Ay Cancel

e Type view1 in the text box.

o Click Apply to enter the SNMP rule configuration page, as shown in d.
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d. Create an SNMP view (2)

Add View

View Mame view

Rule @ Included O Excluded
MIB Subtree OID linterfaces

*(1-255 Chars.)

Subtree Mask |

|(2-32Hex Chars.)

ltems marked with an asterisk{*) are required

Rule MIB Subtree OID

Included interfaces

Add

Apply

e  Select the Included radio box.

e Type the MIB subtree OID interfaces.

e  Click Add.

Cancel

Subtree Mask Qperation

@

e Click Apply. A configuration progress dialog box appears, as shown in e.

e. Configuration progress dialog box

Current Configuration

Creating view rule 1- 0K

100%

Close

o After the configuration process is complete, click Close.

# Configure an SNMP group.

o Click the Group tab and then click Add to enter the page as shown in f.
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f.

Add SNMP Group

Create an SNMP group

Group Mame |gr|:n_||:|1 *(1-32 Chars.)
Security Level | MoAuth/MaPrv ¥ |

Read View |uiew1 b |

Write View [view v

Natify View | v|

ACL | |(2000-2999)

ltems marked with an asterisk{*) are required

# Configure an SNMP user

g.

Apply

Cancel

Type group1 in the text box of Group Name.

Select view1 from the Read View drop-down box.

Select view1 from the Write View drop-down box.

Click Apply.

Click the User tab and then click Add to enter the page as shown in g.

Add SMMP User

Create an SNMP user

ser Mame
Security Level

Group Mame

|user1 “(1-32 Chars.}

| NoAuth/NoPriv v|

|gr|:|up1 { MoAuth/MoPriv ) [+ |

Authentication Mode

Authentication Password

Caonfirm Authentication Passward

Frivacy Mode

Privacy Passwaord

Caonfirm Privacy Password

ACL

| |(1-64 Chars.)

| |(1-64 Chars.)

| |(1-64 Chars )

| |(1-64 Chars.)

| |(2000-2009)

ltems marked with an asteriski{*) are required

Apply

Cancel

Type user] in the text box of User Name.

Select group1 from the Group Name drop-down box.
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e Click Apply.

# Enable the agent to send SNMP traps.

e Click the Trap tab and enter the page as shown in h.
h. Enable the agent to send SNMP traps

Setup Community Group ser Wiew
[¥] Enable SNIMP Trap Apply
Trap Target Host
P Search Item: | Destination IP Address |KE'y‘-NI:|rI:Is:| Search
Destination IP oAlEuE _— LUDF  Security Security y
[F Address IPvdiIPvE  Security Mame Fort Model Level Qperation
Add Delete Selected
o Select the Enable SNMP Trap check-box.
o Click Apply.
# Add the target hosts of SNMP traps.
e Click Add to enter the page as shown in i.
i.  Add target hosts of SNMP traps
Add Trap Target Host
Destination P Address @ pyd O IPVE
11.1.1.2 |+
Security Bame |user1 |*.:1-32 Chars.)
UDP Part 162 |*(0-65535, Default = 162)
Secutity Mode| |v3 V|
Security Level | Mosuthi/MaPriv V|

[terms marked with an asterisk(™ are required

Al Cancel

o Select the destination IP address type as IPv4.

e Type the destination address 1.1.1.2.

e Type the user name user1.

o Select v3 from the Security Model drop-down box.
o Click Apply.

Table 43 Configure NMS.
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/\ CAUTION:

The configuration on NMS must be consistent with that on the agent. Otherwise, you cannot perform
corresponding operations.

SNMPv3 adopts a security mechanism of authentication and privacy. You must configure the username and
security level. According to the configured security level, you must also configure the related authentication
mode, authentication password, privacy mode, privacy password, and so on.

You must also configure the aging time and retry times. After these configurations, you can configure the
device as needed through the NMS. For more information about NMS configuration, see the manual
provided for NMS.

Configuration verification

o After the above configuration, the NMS can establish an SNMP connection with the agent and query
and reconfigure values of objects in the agent MIB.

o Ifanidle interface on the agent is shut down or brought up, the NMS receives trap information sent by
the agent.
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Interface statistics

Overview

The interface statistics module displays statistics information about the packets received and sent through
interfaces.

Displaying interface statistics

Select Device - Interface Statistics from the navigation tree to enter the interface statistics display page, as
shown in a.

a. Interface statistics display page

»Search ftem; | Interface Name ¥ |Keywords: Search
Last
[ Interface Mame  InOctets InlcastPkis InNUcastPkts InDiscards InEmars InUnknownProtos Outdctets OutUcastPks  OuthUcastPks OutDiscards  OutErrors Sc“a;;it;fgs
tirne

[ GigabitEthemetion 0 1} 1} ] i] 1} ] i] 1} 0 1}

[ GigabitEthernet1/0iz 0 1} 1} 0 i] 1} 0 i] 1} 0 1}

[ GigabitEthernet1i0iz 0 1} 1} ] i] 1} ] i] 1} 0 1}

[ GigabitEthernet1i0id 0 1} 1} 0 i] 1} 0 i] 1} 0 1}

[ sigabitEthernet1firs 0 1} 1} ] i] 1} ] i] 1} 0 1}

[ sigabitEthernet1f0ré 0 a a 1} 1} a 1} 1} a 0 a

[ sigabitEthernettioi7 0 a a 1} 1} a 1} 1} a 0 a

[ GigabitEthernetiois 0 a a 1} 1} a 1} 1} a 0 a

[ GigabitEthernetiom 0 a a 1} 1} a 1} 1} a 0 a

[ GigabitEthernetioino o a a 1} 1} a 1} 1} a 0 a

[ GigabitEthernetioi1 o a a 1} 1} a 1} 1} a 0 a

[ GigabitEthernet /o2 o o o 0 1} o 0 1} o 0 o

[ GigabitEthernet1i0i3 0 1) 1) 0 1} 1) 0 1} 1) 0 1)

[ GigabitEthernet1i0i4 0 1) 1) 0 1} 1) 0 1} 1) 0 1)

2000-4-
[] GigabitEthermetl/0M 5 8167 a0 18 0 1} o 34632 37 o 0 o 26
19:06:41
22 records,| 15 ¥ per page | page 1/2, record 1-15 | Mext Last|1
Reset Selected ResetAll

2. Details about the interface statistics

Field Description

InOctets Total octets of all packets received on the interface.

InUcastPkts Number of received unicast packets.

InNUcastPkts Number of received non-unicast packets.

InDiscards Number of valid packets discarded in the inbound direction.

InErrors Number of received invalid packets.

InUnknownProtos Number of received unknown protocol packets.

OutOctets Total octets of all packets sent through the interface.
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Field

Description

OutUcastPkis Number of unicast packets sent through the interface.
OutNUcastPkts Number of non-unicast packets sent through the interface.
OutDiscards Number of valid packets discarded in the outbound direction.
OutErrors Number of invalid packets sent through the interface.
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VLAN configuration

Introduction to VLAN

Ethernet is a network technology based on the Carrier Sense Multiple Access/Collision Detect (CSMA/CD)
mechanism. As the medium is shared, collisions and excessive broadcasts are common on Ethernet
networks. To address the issue, virtual LAN (VLAN) was introduced to break a LAN down into separate
VLANSs. VLANSs are isolated from each other at Layer 2. A VLAN is a bridging domain, and all broadcast
traffic is contained within it, as shown in a.

a. A VLAN diagram

VLAN 2
& <P <
Switch A Switch B
Router

VLAN 5

A VLAN is logically divided on an organizational basis rather than on a physical basis. For example, all
workstations and servers used by a particular workgroup can be connected to the same LAN, regardless of
their physical locations.

VLAN technology delivers the following benefits:

e  Confining broadcast traffic within individual VLANSs. This reduces bandwidth waste and improves
network performance.

e Improving LAN security. By assigning user groups to different VLANS, you can isolate them at Layer 2.
To enable communication between VLANS, routers or Layer 3 switches are required.

e Flexible virtual workgroup creation. As users from the same workgroup can be assigned to the same
VLAN regardless of their physical locations, network construction and maintenance is much easier and
more flexible.

VLAN fundamentals

To enable a network device to identify frames of different VLANs, a VLAN tag field is inserted into the data
link layer encapsulation.

The format of VLAN-+tagged frames is defined in IEEE 802.1Q issued by the Institute of Electrical and
Electronics Engineers (IEEE) in 1999.
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In the header of a traditional Ethernet data frame, the field after the destination MAC address and the
source MAC address is the Type field indicating the upper layer protocol type, as shown in a.

a. Traditional Ethernet frame format

DA&SA Type Data

IEEE 802.1Q inserts a four-byte VLAN tag after the DA&SA field, as shown in b.
b. Position and format of VLAN tag

VLAN Tag
< >

DA&SA TPID Priority | CFI | VLANID | Type

A VLAN tag comprises the following fields: tag protocol identifier (TPID), priority, canonical format indicator
(CFI), and VLAN ID.

e The 16-:bit TPID field with a value of 0x8100 indicates that the frame is VLAN tagged.
o The 3-bit priority field indicates the 802.1p priority of the frame.

e The 1-bit CFl field specifies whether the MAC addresses are encapsulated in the standard format when
packets are transmitted across different media. A value of O indicates that the MAC addresses are
encapsulated in canonical format. A value of 1 indicates that the MAC addresses are encapsulated in
a non-standard format. The value of the field is O by default.

e The 12-bit VLAN ID field identifies the VLAN the frame belongs to. The VLAN ID range is O to 4095.
As 0 and 4095 are reserved, a VLAN ID actually ranges from 1 to 4094.

A network device handles an incoming frame depending on whether the frame is VLAN tagged and the
value of the VLAN tag, if any. For more information, see “Introduction to port-based VLAN".

NOTE:

The Ethernet Il encapsulation format is used here. Besides the Ethernet Il encapsulation format, Ethernet
also supports other encapsulation formats, including 802.2 LLC, 802.2 SNAP, and 802.3 raw. The VLAN
tag fields are added to frames encapsulated in these formats for VLAN identification.

VLAN types

You can implement VLANs based on the following criteria:
e Port

e MAC address

e Protocol

e P subnet

e Policy

o  Other criteria

The web interface is available only for port-based VLANSs, and this chapter introduces only port-based
VLANSs.
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Introduction to port-based VLAN

Port-based VLANs group VLAN members by port. A port forwards traffic for a VLAN only after it is assigned
to the VLAN.

Port link type

PVID

You can configure the link type of a port as access, trunk, or hybrid. The link types use the following VLAN
tag handling methods:

An access port belongs to only one VLAN and sends traffic untagged. It is usually connects to a user
device unable to recognize VLAN tagged-packets or when there is no need to separate different VLAN
members.

A trunk port can carry multiple VLANS to receive and send traffic for them. Except traffic from the port
VLAN ID (PVID), traffic sent through a trunk port will be VLAN tagged. Usually, ports connecting

network devices are configured as trunk ports.

Like a trunk port, a hybrid port can carry multiple VLANS to receive and send traffic for them. Unlike
a trunk port, a hybrid port allows traffic of all VLANSs to pass through VLAN untagged. Usually, hybrid
ports are configured to connect devices whose support for VLAN tagged-packets you are uncertain
about.

By default, VLAN 1 is the PVID for all ports. You can change the PVID for a port as required.

Use the following guidelines when configuring the PVID on a port:

An access port can join only one VLAN. The VLAN to which the access port belongs is the PVID of the
port. The PVID of the access port changes along with the VLAN to which the port belongs.

A trunk or hybrid port can join multiple VLANS, and you can configure a PVID for the port.

The following table shows how ports of different link types handle frames:

Port type Actions (in the inbound direction) Actions (in the outbound direction)
Untagged frame Tagged frame
Access Tags the frame with ® Receivesthe frameifits Removes the VLAN tag and sends the
the PVID tag. VLAN ID is the same as  frame.
the PVID.

e Drops the frame if its
VLAN ID is different
from the PVID.

Trunk Checks whether the © Receivesthe frameifits © Removes the tag and sends the
PVID is carried on the VLAN is carried on the frame if the frame carries the PVID
port: port. tag and the port belongs fo the PVID.
o If yes, tags the e Drops the frame if its e Sends the frame without removing

frame with the VLAN is not carried on the tag if its VLAN is carried on the
PVID tag. the port. port but is different from the PVID.

Hybrid e If not, drops the Sends the frame if its VLAN is carried on

frame. the port. The frame is sent with the VLAN

tag removed or intact depending on
your configuration.
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Contiguring a VLAN

Configuration task list

Use either of the following approaches or the combination of them to configure a VLAN, as shown in 1 and
2:

1. VLAN configuration task list (approach I)

Task Remarks

Required
Creating VLANs
Create one or multiple VLANS.

Required

Selecting VLANs Configure a subset of all existing VLAN. This step is required before
displaying, modifying, or removing a VLAN.
Required

Modifying a VLAN Configure the untagged member ports and tagged member ports of the VLAN,

or remove the specified ports from the VLAN.

2. VLAN configuration task list (approach i)

Task Remarks

Required
Creating VLANs
Create one or multiple VLANS.

Required

Medifying ports Configure ports as the untagged members or tagged members of VLANS, or
remove ports from VLANS; configure the link type and PVID of the ports.

Creating VLANs

Select Network > VLAN from the navigation tree and click the Create tab to enter the page shown in a.
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a. The Create tab

Select WLAN Fort Detail Dretail iy WLAM modify Port Rermove
Craate:
WLAMN Ds: Example:3, 5-10
Create
[n] Description
1 WA 0001

Modify WLAMN description (Mote: you can do this later on the Modify VLAN page)
hodify the description of the zelected WLARM:
|0 Description

(1-32 Chars)

2. Configuration items of creating VLANs

ltem Description
VLAN IDs IDs of the VLANS to be created.
Modify the D Select the ID of the VLAN whose description string is to be modified.
dfes}::ription Click the ID of the VLAN to be modified in the list in the middle of the page.
ot the
selected o Set the description string of the selected VLAN.
Description o ) o
VLAN By default, the description string of a VLAN is its VLAN ID, such as VLAN 0001.

Return to VLAN configuration task list (approach ).
Return to VLAN configuration task list (approach II).

Selecting VLANs

Select Network > VLAN from the navigation tree. The Select VLAN tab is displayed by default for you to
select VLANs, as shown in a.

139



a. The Select VLAN tab

Create Fart Detail Detail M odify WLAR modify Paort Rermaove

WLAM range display: select an option to view all available VLARNS or a subset of configured WLANS.

@Displa\; allwLaMs. Mote: This option may reduce browser response time.

O Display 3 subset of all configured YLAME, example: 3,5-10.
Select
WLAMN Summary
D Description Untagged Membership Tagged Membership

2. Configuration items of selecting VLANs

ltem Description

Select one of the two options:
o Display all VLANs—Display all configured VLANS.

o Display a subnet of all configured VLANs—Type the VLAN
IDs you want to display.

Display all VLANs

Display a subnet of all configured VLANs

Return to VLAN configuration task list (approach ).

Modifying a VLAN

Select Network - VLAN from the navigation tree and click the Modify VLAN tab to enter the page shown

in a.
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a. The Modify VLAN tab

Select WLAN Create Fort Detail Dietail modify Port Remove
Please select 3 WLAN to modify: todify Descrption (optional)
Fleaze zelect a VLAN T 1:1_32 Chars ) Anply

Select membership type:

@ . Untagged O D Tagged O D Mot A hember . Hot awaliable for selaction

Select ports to be modified and assigned to this WLAN:

HF ¥1810-

Mote: You can assign multiple ports in different membership types to this WLAN.

Summary

Untagged Membership Tagged Membership

2. Configuration items of modifying a VLAN

ltem Description

Select the VLAN to be modified.

Select a VLAN in the drop-down list. The VLANs available for selection are
created first and then selected on the page for selecting VLANS.

Please select a VLAN to
modify

Modify the description string of the selected VLAN.

Modify Description
By default, the description string of a VLAN is its VLAN ID, such as VLAN 0001.

Set the member type of the port to be modified in the VLAN.

Unfagged The options include:
Select ¢ Untagged—Indicates that the port sends the traffic of the VLAN after
membership  Tagged removing the VLAN tag.
fype —— ¢ Tagged—Indicates that the port sends the traffic of the VLAN without
Not A removing the VLAN tag.

Member e Not A Member—Remove the port from the VLAN.

Select the ports to be modified in the selected VLAN.

Select ports to be modified Click one or more ports you want to modify on the chassis front panel.

and assigned to this VIAN If aggregate interfaces are configured on the device, the page displays a list of
aggregate interfaces below the chassis front panel, and you can select
aggregate interfaces from this list.

Return to VLAN configuration task list (approach ).
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Modifying ports

Select Network > VLAN from the navigation tree and click the Modify Port tab to enter the page shown in
a.

a. The Modify Port tab

Select WLAN Create Fort Detail Dietail hdodify WLAR Femove

Select Ports

HP 1910-16

Select Al Select Mone . ] .
Mot zvaliable for selection

Select membership type:

@ Urtagged O Tagged O Mot A hlember O Link Type O D

Erter WLAN D= to which the port is to be assigned:

WLAM 10s: Example: 1,3.5-10

Selected ports:

Urtagged hembership

Apply Cancel

2. Configuration items of modifying ports

ltem Description

Select the ports to be modified.

Click one or more ports you want to modify on the chassis front panel.

Select Ports If aggregate interfaces are configured on the device, the page displays a list of

aggregate interfaces below the chassis front panel, and you can select
aggregate interfaces from this list.

Set the member types of the selected ports to be modified in the specified VLANS.

Untagged The options include:
e Untagged—Assign the selected ports to the specified VLANs as untagged
Select members. Affer that, the ports send the traffic of those VLAN affer removing
membership  Tagged the VLAN tags.
fype o Tagged—Assign the selected ports to the specified VLANSs as tagged
members. After that, the ports send the traffic of those VLANs without
Not A removing the VLAN tags.
Member

e Not A Member—Remove the selected ports from the specified VLANS.
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ltem Description

Set the IDs of the VLANSs that the selected ports are to be assigned to or removed
VLAN IDs from. This item is available when the Untagged, Tagged, or Not A Member option
is selected in the Select membership type area.

Set the link type of the selected ports, which can be access, hybrid, or trunk.

Link Type This item is available when the Link Type option is selected in the Select
membership type area.

PVID Set the PVID of the selected ports.
If you select Delete, you restore the PVID to VLAN 1.

Delete This item is available when the PVID option is selected in the Select membership
type area.

Return to VLAN configuration task list (approach I).

VLAN configuration example

Network requirements

As shown in a:

e Trunk port GigabitEthernet 1/0/1 of Switch A is connected to trunk port GigabitEthernet 1/0/1 of
Switch B.

e The PVID of GigabitEthernet 1/0/1 is VLAN 100.

e  GigabitEthernet 1/0/1 permits packets of VLAN 2, VLAN 6 through VLAN 50, and VLAN 100 to pass
through.

a. Network diagram for VLAN configuration

@ GE1/0/1 GE1/0/1 @

Switch A Switch B

Configuration procedure
Table 44 Configure Switch A
# Configure GigabitEthernet 1/0/1 as a trunk port and configure VLAN 100 as its PVID.

Select Device > Port Management from the navigation tree and click the Setup tab to enter the page shown

in b.
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b. Configure GigabitEthernet 1/0/1 as a trunk port and its PVID as 100

Summary Dietail

Basic Configuration

Port State | Mo Change v Speed MNo Change v Duplex Mo Change

‘Link Type Trunk A FVID 100 (1-4094) |

Advanced Configuration
' Flow
in Mo Change + Cantrol Mo Change v
e Sy Max MAC _
Power Save | No Change ot~ [No Change ]| | 0-8192)

Storm Suppression

Broadcast Mo Change v Multicast Mo Change v Unicast Mo Change v

pps range (1-148810 for a 100 Mbps port, 1-1488100 for a GE port, and 1-14881000 for a 10GE port)
kbps range (1-102400 for a 100 Mbps port, 1-1024000 for 3 GE port, and 1-10240000 for a 10GE port)

HPF V1910-16G Sw...

Select All Select Mone
Unit Selected Ports
1 GE1/0/1

& |t maytake some time if you apply the above settings to multiple ports. Apply Cancel

o Select Trunk in the Link Type drop-down list.

o Select the PVID option, and type 100 in the text box.

e Select GigabitEthernet 1/0/1 on the chassis front device panel.
o Click Apply.

# Create VLAN 2, VLAN 6 through VLAN 50, and VLAN 100.

Select Network > VLAN from the navigation tree and click the Create tab to enter the page shown in c.
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c. Create VLAN 2, VLAN 6 through VLAN 50, and VLAN 100

Select WLAMN Fort Detail Detail T oo iy WA Modify Port Remaove
Create;
YLAM IDs: 2, 6-50, 100 Example:3, 5-10
Create
[n] Description
1 WLAR 0001

modify VLAMN description (Mote: you can do this 1ater an the Modify WLAN page)
maodify the description ofthe selected WLAN:
[n] Description

(1-32 Chars.)

«  Type VLAN IDs 2, 6-50, 100.
e  Click Create.

# Assign GigabitEthernet 1/0/1 to VLAN 100 as an untagged member.
Click Select VLAN to enter the page for selecting VLANS, as shown in d.
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d. Set a VLAN range

Create Paort Detail Cietail M odify WLARN Madify Paort Remove

WLAN range display: select an option to view all availakle WLARNS ar a subset of configured WLANS.

&) Display all YLAMS. Mote: This option may reduce hrowser response time.

@ 1-100 Display a subset of all configured YLAMS, example: 3,5-10.
WLAR Summary
| ] Description Untagged Memhbership Tagoed Membership

o Select the Display a subnet of all configured VLANs option and type 1-100 in the text box.
o Click Select.

Click Modify VLAN to enter the page for modifying the ports in a VLAN, as shown in e.
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e. Assign GigabitEthernet 1/0/1 to VLAN 100 as an untagged member

Select WLAN Create Fort Detail Dretail hodify Port Remove
Flease select a VLAR to maodify; hodify Description {optional)
100 — WLANW 0100 v VLAN 0100 |(1_32 Chars.) Apply

Select membership type:

© -Untagged o DTagged © DNDtAMember .Not avaliable for selection

Select ports to he modified and assigned to this WLAN:

HP %1910-1

Select All Select Mone Mote: You can assign multiple parts in different membership types to this VLAN.
Summanry
Untagged Membership Tagged Membership
GE1/0M

Apply Cancel

e Select 100 - VLAN 0100 in the Please select a VLAN to modify drop-down list.
e Select the Untagged option in the Select membership type area.

e Select GigabitEthernet 1/0/1 on the chassis front device panel.

o Click Apply. A configuration progress dialog box appears, as shown in f.

f.  Configuration progress dialog box

Current Configuration
Setting GigahitEthernet1/001...... - Kl

100%

o After the configuration process is complete, click Close.

# Assign GigabitEthernet 1/0/1 to VLAN 2 and VLANSs 6 through 50 as a tagged member.
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Click Modify Port to enter the page for modifying the VLANS to which a port belongs, as shown in g.
g. Assign GigabitEthernet 1/0/1 to VLAN 2 and VLANSs 6 through 50 as a tagged member

SelectWLARN Create Fort Detail Cetail Modify WYLAN Remove

Select Ports

SRR ST T2 .Not avaliable for selection

Select membership trpe:

O Untagoed & Tagoed O Mot A member O Link Type O PVID

Enter VLAN IDs to which the portis to be assigned:

WLAN IDg: |2, 6-50 Exarnple: 1,3,5-10

Selected ports:

Tagged Membership
GE10M

Apply Cancel

o Select GigabitEthernet 1/0/1 on the chassis front device panel.

o Select the Tagged option in the Select membership type area.

e  Type VLAN IDs 2, 6-50.

e Click Apply. A configuration progress dialog box appears.

o After the configuration process is complete, click Close in the dialog box.
Table 45 Configure Switch B

Configure Switch B as you configured Switch A.

Contiguration guidelines

When configuring the VLAN function, follow these guidelines:

e As the default VLAN, VLAN 1 cannot be created or removed.

e You cannot create or remove VLANS reserved for special purposes.

e Dynamic VLANs cannot be removed on the page for removing VLANS.
e You cannot remove a VLAN that has referenced a QoS policy.

e To remove a remote probe VLAN for remote port mirroring, you must remove the remote probe VLAN
configuration first.
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VLAN interface configuration

NOTE:

For more information about VLANS, see the chapter “VLAN configuration.”

For hosts of different VLANs to communicate, you must use a router or Layer 3 switch to perform layer 3
forwarding. To achieve this, VLAN interfaces are used.

VLAN interfaces are virtual interfaces used for Layer 3 communication between different VLANSs. They do
not exist as physical entities on devices. For each VLAN, you can create one VLAN interface. You can
assign the VLAN interface an IP address and specify it as the gateway of the VLAN to forward the traffic
destined for an IP subnet different from that of the VLAN.

Configuring VLAN interfaces

Configuration task list

Perform the tasks in 1 to configure a VLAN interface:

1. VLAN interface configuration task list

Task Remarks

Required
Create a VLAN inferface. You can select to assign an IPv4 address to the
VLAN interface in this step or in a separate step.

Before creating a VLAN interface for a VLAN, create the VLAN first (select
Network = VLAN). For more information about the configuration
procedure, see the chapter “VLAN configuration”.

Creating a VLAN interface

Optional
Modifying a VLAN interface Assign an IPv4 address to the VLAN interface, and shut down or bring up
the VLAN interface.

Creating a VLAN interface

Select Network - VLAN Interface from the navigation tree and click the Create tab to enter the page shown
ina.
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a. The Create tab
Summary Madify Remove

Input a VLAM 1D
[ 1-4094)
Configure Primary IPv4 Address

) DHCP OBooTP ® Manual
IPv4 Address: Mask Length: | 24 (255 255255 .0) v

Canfigure IPvE Link Local Address
Auto Manual

IPvE Address:

Apply Cancel

2. Configuration items of creating a VLAN interface

ltem Description
) Input the ID of the VLAN interface to be created. Before creating a VLAN
Input @ VLAN ID: interface, make sure that the corresponding VLAN exists.
DHCP Configure the way in which the VLAN interface obtains an IPv4 address.
BOOTP Allow the VLAN interface to automatically obtain an IP address by selecting
— the DHCP or BOOTP option, or manually assign the VLAN interface an IP
Configure Manual address by selecting the Manual option.
Primary [Pv4 Configure an IPv4 address for the VLAN interface.
Address IPv4 Address

This option is available after you select the Manual option.

Select the subnet mask length.
Mask Length
This option is available after you select the Manual option.

Return to VLAN interface configuration task list.

Moditying a VLAN interface

NOTE:

After you modify the IPv4 address for a selected VLAN interface on the page for modifying VLAN
interfaces, click the Apply button to submit the modification.

After you change the IP address of the VLAN interface you are using to log in to the device, you will be
disconnected from the device. You can use the changed IP address to re-log in.
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Select Network - VLAN Interface from the navigation tree and click the Modify tab to enter the page shown
ina.

a. The Modify tab

Summary Create Remaove

Select VLAN Interface| 999+

Muodify IPvd Address Muodify IPvE Address
Modify Primary IP And Status Modify IPvE Link Local Address And Status
O DHecP O BooTP @ Manual Auto Manual
192.168.1.60 24 (255255 2550) w
Admin Status| Up b Admin Status
Apply

Add IPvE Unicast Address

EUI-G4

IPviE Address

2. Configuration items of modifying a VLAN interface

ltem Description

Select the VLAN interface to be configured.

Select VLAN Interface The VLAN interfaces available for selection in the drop-down list are those
created on the page for creating VLAN interfaces.

Modif DHCP Configure the way in which the VLAN interface obtains an IPv4 address.

odi —_—

1Py Y BOOTP Allow the VLAN interface to obtain an IP address automatically by selecting the

Address — DHCP or BOOTP option, or manually assign the VLAN inferface an IP address by
Manual selecting the Manual option.
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ltem Description

Select Up or Down in the Admin Status drop-down list fo bring up or shut down
the selected VLAN interface.

To restore a failed VLAN interface, you can shut down and then bring up the
VLAN interface.

By default, a VLAN interface is down if all Ethernet ports in the VLAN are down,

Admin Status 5 s up if one or more Ethernet ports in the VLAN are up.

@ IMPORTANT:

e The current VLAN interface state in the Modify IPv4 Address area changes if
the VLAN interface state is modified in the Admin Status drop-down list.

o The state of each port in the VLAN is independent of the VLAN interface state.

Return to VLAN interface configuration task list.
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Voice VLAN configuration

A voice VLAN is configured especially for voice traffic. After assigning the ports connecting to voice devices
to a voice VLAN, the system automatically configures quality of service (QoS) parameters for voice traffic,
improving the transmission priority of voice traffic and ensuring voice quality.

OUI addresses

A device determines whether a received packet is a voice packet by checking its source MAC address. A
packet whose source MAC address complies with the voice device’s Organizationally Unique Identifier
(OUI) address is regarded as voice traffic.

You can configure the OUI addresses of a device in advance or use the default OUl addresses. 1 lists the
default OUl address for each vendor’s devices.

1. The default OUI addresses of different vendors

Number OUI Address Vendor

1 0001-E300-0000 Siemens phone

2 0003-6B00-0000 Cisco phone

3 0004-0D00-0000 Avaya phone

4 00DO-1E00-0000 Pingtel phone

5 0060-8900-0000 Philips/NEC phone

6 OOE0-7500-0000 Polycom phone

7 OOEO-BB0O0-0000 3Com phone
NOTE:

In general, as the first 24 bits of a MAC address (in binary format), an OUl address is a globally
unique identifier assigned to a vendor by the IEEE. OUI addresses mentioned in this document,
however, are different from those commonly used. In this document, OUI addresses are used by the
system to determine whether a received packet is a voice packet. They are the results of the AND
operation of a MAC address and a mask. For more information, see “Adding OUI addresses to the
OUI list"”.

You can manually remove the default OUI address of a device and then add new ones.

Voice VLAN assignment modes

A port can be assigned to a voice VLAN in one of the following modes:

e In automatic mode, the system matches the source MAC addresses carried in the untagged packets
sent when an IP phone is powered on against the device’s OUl addresses. If a match is found, the
system automatically assigns the receiving port to a voice VLAN, issues ACL rules and configures the
packet precedence. You can configure voice VLAN aging time on the device. The system will remove
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a port from the voice VLAN if no packet is received from the port during the aging time. Assigning
ports to and removing ports from a voice VLAN are automatically performed.

e In manual mode, you need to manually assign an IP phone accessing port to a voice VLAN. Then, the
system matches the source MAC addresses carried in the packets against the device’s OUl addresses.
If a match is found, the system issues ACL rules and configures the packet precedence. In this mode,
assigning ports to and removing ports from a voice VLAN are performed manually.

Both modes forward tagged packets according to their tags.

1 lists the relationships between the voice assignment VLAN mode, the voice traffic type of an IP phone, and
the port link type.

1. Co-relation

Voice VLAN Voice traffic Port link type
assignment .
mode type Access Trunk Hybrid
Supported, but you must
ensupre that the >FI’V|D of Supported, but you must
Tagged voice the port has been egirinhE;;:ethL?eZ{:;Z is
99 ! Not supported created and is not the P . l
Automatic traffic voice VIAN and the not the voice VLAN and the
mode iraffic of the PVID can traffic of the PVID can pass
oass through the port. through the port tagged.
Untagged q q q
voice fraffic Not supporte Not supporte Not supporte
Supported, but you must  Supported, but you must
ensure that the PVID of  ensure that the PVID of the
Taaged voice the port has been port has been created and is
v ?ﬁg Not supported created and is not the  not the voice VLAN and the
ame voice VLAN and the traffic of the voice VLAN can
traffic of the PVID can pass through the port
Manual pass through the port.  tagged.
mode Su d b
pported, but you must
Supported, but configure the PVID of SUprOffedt,hbl'J:V);BU T;E]St X
Untaaaed you must the port as the voice cor:hlgL\J/rei eVLANO nde por
. gtgr s configure the PVID  VLAN and configure the ctsm(.e rociﬁ " to I
VoI TAC  of the port as the  port to allow the traffic ::; tlg;}.e fethpo ° OV(I)_VAVN
voice VLAN. of the voice VLAN to toepc::s ltErZUg: J:tl;::ged
pass through. ’
NOTE:

If an IP phone sends tagged voice traffic and its accessing port is configured with 802.1X
authentication and guest VLAN, you must assign different VLAN IDs for the voice VLAN, the port
VLAN ID (PVID) of the accessing port, and the 802.1X guest VLAN.

If an IP phone sends untagged voice traffic, to implement the voice VLAN feature, you must configure
the PVID of the IP phone’s accessing port as the voice VLAN. As a result, 802.1X authentication cannot
be implemented.
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Security mode and normal mode of voice VLANs

Depending on their inbound packet filtering mechanisms, voice VLAN-enabled port can operate in the
following modes:

e Normal mode: In this mode, voice VLAN-enabled ports receive packets carrying the voice VLAN tag
and forward packets in the voice VLAN without checking their source MAC addresses against the OUI
addresses configured for the device. If the PVID of the port is the voice VLAN and the port works in
manual VLAN assignment mode, the port forwards all received untagged packets in the voice VLAN.
In normal mode, the voice VLANs are vulnerable to traffic attacks. Vicious users may forge a large
amount of voice packets and send them to the device to consume the voice VLAN bandwidth, affecting
normal voice communication.

e Security mode: In this mode, only voice packets whose source MAC addresses match the recognizable
OUl addresses can pass through the voice VLAN-enabled inbound port, but all other packets are
dropped.

In a safe network, you can configure the voice VLANSs to operate in normal mode, reducing the consumption
of system resources due to source MAC addresses checking.

HP does not recommend you transmit both voice traffic and non-voice traffic in a voice VLAN. If you have
to, ensure that the voice VLAN security mode is disabled.

1. How a voice VLAN-enable port processes packets in security/normal mode

Voice VLAN mode Packet type Packet processing mode

Untagged packets If the source MAC address of a packet matches an
OUI address configured for the device, it is

Packets carrying the voice  forwarded in the voice VIAN; otherwise, it is
Security mode VLAN tag dropped.

Forwarded or dropped depending on whether the

Packets carrying other tags port allows packets of these VLANS to pass through

Untagged packets The port does not check the source MAC addresses
of inbound packets. In this way, both voice traffic

Packets carrying the voice and non-voice traffic can be transmitted in the voice
Normal mode VLAN tag VIAN.

Forwarded or dropped depending on whether the

Packets carrying other fags port allows packets of these VLAN to pass through

Contiguring the voice VLAN

Contfiguration task list

Before configuring the voice VLAN feature, you must create the corresponding VLAN and configure the link
type of each port to be assigned to the VLAN. VLAN 1 is the default VLAN, and you cannot create it or
configure it as a voice VLAN. For more information about port link types, see the chapter “Port management
configuration”.
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Configuring voice VLAN on a port in automatic voice VLAN assignment mode

Perform the tasks described in 1 to configure the voice VLAN function on a port working in automatic voice
VLAN assignment mode.

1. Voice VLAN configuration task list for a port in automatic voice VLAN assignment mode

Task Remarks
Optional
Configuring voice VLAN globally Configure the voice VLAN to operate in security mode and

configure the aging timer.

Required

Configure the voice VLAN assignment mode of a port as
Configuring voice VLAN on a port automatic and enable the voice VLAN function on the port.

By default, the voice VLAN assignment mode of a port is
automatic, and the voice VLAN function is disabled on a port.

Optional

Adding OUI addresses fo the OUI list You can configure up to 16 OUI addresses.

By default, the system is configured with seven OUI addresses,
as shown in 1.

Configuring voice VLAN on a port working in manual voice VLAN assignment mode

Perform the tasks described in 1 to configure the voice VLAN function on a port working in manual voice
VLAN assignment mode.

1. Configuration task list for a port in manual voice VLAN assignment mode

Task Remarks
Optional
Configuring voice VLAN globally Configure the voice VLAN to operate in security mode and

configure the aging timer.

Required

After an access port is assigned fo the voice VLAN, the voice

Assigning the port fo the voice VIAN VLAN automatically becomes the PVID of the access port.

For more information, see the chapter “VLAN configuration”.

Optional

This task is required if the incoming voice traffic is untagged and
Configuring the voice VLAN as the PVID of  the link type of the receiving port is trunk or hybrid. If the
a hybrid or trunk port incoming voice traffic is tagged, do not perform this task.

For more information, see the chapter “Port management
configuration”.

Required

Configure the voice VLAN assignment mode of a port as manual
Configuring voice VLAN on a port and enable the voice VLAN function on the port.

By default, the voice VLAN assignment mode of a port is
automatic, and the voice VLAN function is disabled on a port.
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Task Remarks

Optional

Adding OUI addresses fo the OUI list You can configure up to 16 OUl addresses.

By default, the system is configured with seven OUI addresses,
as shown in 1.

Configuring voice VLAN globally

Select Network > Voice VLAN from the navigation tree, and click the Setup tab to enter the page shown in
a.

a. Configure voice VLAN

2ummary Fort Setup Ul Summary QU Add OUl Remave
Woice VLAM security: Enable w
Voice VLAN aging time: 1440 minutes (5-43200, Default = 1440}
Apply Cancel

2. Global voice VLAN configuration items

ltem Description

Select Enable or Disable in the drop-down list to enable or disable the voice
Voice VLAN security VLAN security mode.
By default, the voice VLANs operate in security mode.

Set the voice VLAN aging timer.

The voice VLAN aging timer applies only to a port in automatic voice VLAN

Voice VIAN aging time assignment mode. The voice VLAN aging timer starts as soon as the port is
assigned to the voice VLAN. If no voice packet has been received before
the timer expires, the port is removed from the voice VLAN.

Return to Configuring voice VLAN on a port in automatic voice VLAN assignment mode.

Return to Configuring voice VLAN on a port working in manual voice VLAN assignment mode.

Contiguring voice VLAN on a port

Select Network > Voice VLAN from the navigation tree, and click the Port Setup tab to enter the page
shown in a.
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a. Configure voice VLAN on a port

Summary Setup QU Summary QU Add QU Remove

Woice WLAMN port mode:
Voice VLAN port state:
Voice WLAN 1D : I:Ig_;mg;n

Select ports:

HF %1810-1

Select Al Select Mone

Farts selected for voice WLAM:

Apply Cancel

2. Configuration items of configuring voice VLAN for a port

ltem Description

Set the voice VLAN assignment mode of a port:
Voice VLAN port mode e Auto—Indicates the automatic voice VLAN assignment mode.

* Manual—Indicates the manual voice VLAN assignment mode.

Select Enable or Disable in the drop-down list to enable or disable the

Voice VIAN port state voice VLAN function on the port.

Set the voice VLAN ID.
This option is available when the voice VLAN port state is set to Enable.

Voice VLAN ID @ IMPORTANT:

The device supports only one voice VLAN. Only an existing static VLAN can
be configured as the voice VLAN.

Select the port on the chassis front panel.

You can select multiple ports to configure them in bulk. The interface
numbers of the selected ports will be displayed in the Ports selected for

voice VLAN text box.
Select ports
@ IMPORTANT:

To set the voice VLAN assignment mode of a port fo automatic, ensure that
the link type of the port is trunk or hybrid, and that the port does not belong
to the voice VLAN.

Return to Configuring voice VLAN on a port in automatic voice VLAN assignment mode.

Return to Configuring voice VLAN on a port working in manual voice VLAN assignment mode.
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Adding OUI addresses to the OUI list

Select Network - Voice VLAN from the navigation tree and click the OUI Add tab to enter the page shown
ina.

a. Add OUI addresses to the OUI list

Summary Setup Fort Setup QLU Summany QU Remaove

Specify an OUl and click Apply to add it to the list. There can be 16 entries at most.

QU Address:
hask FFFF-FFO0-0000
Description:

Appaly Cancel
DUl Address hlask Description
0001-e300-0000 fff-ffO0-0000 Siemens phone
0003-6L00-0000 fif-ff00-0000 Cisco phone
0004-0d00-0000 fif-ff00-0000 Avaya phone
Q005-2100-0000 fif-ff00-0000 FPhone A
0005-2200-0000 fif-ff00-0000 FPhone B
0060-Ra00-0000 fif-ff00-0000 FhilipsMEC phone
00d0-1e00-0000 fif-ff00-0000 Fingtel phone
00e0-7500-0000 ffif-ff00-0000 Folycom phone
00e0-bhO0-0000 fif-ff00-0000 2com phone

2. OUI list configuration items

ltem Description

OUI Address Set the source MAC address of voice traffic.
Mask Set the mask length of the source MAC address.
Description Set the description of the OUI address entry.

Return to Configuring voice VLAN on a port in automatic voice VLAN assignment mode.

Return to Configuring voice VLAN on a port working in manual voice VLAN assignment mode.
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Voice VLAN configuration examples

Contfiguring voice VLAN on a port in automatic voice VLAN
assignment mode

Network requirements

As shown in a,
e Configure VLAN 2 as the voice VLAN allowing only voice traffic to pass through.
o The IP phone connected to hybrid port GigabitEthernet 1/0/1 sends untagged voice traffic.

e  GigabitEthernet 1/0/1 operates in automatic VLAN assignment mode. Set the voice VLAN aging
timer to 30 minutes.

e  Configure GigabitEthernet 1/0/1 to allow voice packets whose source MAC addresses match the
OUl addresses specified by OUl address 0011-2200-0000 and mask FFFF-FFO0-0000. The
description of the OUI address entry is test.

a. Network diagram for automatic voice VLAN assignment mode configuration

Switch A Switch B

Internet

VLAN 2

010-1001 0755-2002
OUI: 0011-2200-0000
Mask: ffff-ff00-0000

Configuration procedure
# Create VLAN 2.

o Select Network > VLAN from the navigation tree, and click the Create tab to enter the page shown in
a.
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a. Create VLAN 2

Select WVLAN FPort Detail Detail Madify VAN Madify Port Remaove
Create:
WLAN IDs: 2 Example:3, 5-10
Create
In] Description
1 WLAM 0001

Maodify VLAN description (Mote: you can do this later on the Madify VLAMN page)
IModify the description of the selected VLAMN:
D Descripticn

(1-32 Chars.}

o Type VIAN ID 2.
e  Click Create.

# Configure GigabitEthernet 1/0/1 as a hybrid port.

o Select Device > Port Management from the navigation tree, and click the Setup tab to enter the page
shown in b.

161



b. Configure GigabitEthernet 1/0/1 as a hybrid port

Summary Detail

Basic Configuration
PortState | No Change Speed Mo Change v Duplex Mo Change |+

‘LinkT‘fpe Hybrid w ‘ [ PyvID |:|[1-40943

Advanced Configuration

Flow
D Mo Change » Control

Power Save | Mo Change ggzm'm |No Change v|| |0-8192)

Storm Suppression

Broadcast No Change i Multicast No Change | Unicast No Change [
Suppression |:| Suppression |:| Suppression I:I

pps range (1-148810 for a 100 Mbps port, 1-1488100 for a GE port, and 1-14881000 for a 10GE port)
khps range (1-102400 for a 100 Mbps port, 1-1024000 for a GE port, and 1-10240000 for a 10GE port)

Mo Change +

HP V1910-16G Sw...

Select Al Select Mone
Unic Selected Ports
1 GE1/0/1
« [t maytake some time if you apply the ahove settings to multiple ports. Apply Cancel

o Select Hybrid from the Link Type drop-down list.

e Select GigabitEthernet 1/0/1 from the chassis front panel.
o Click Apply.

# Configure the voice VLAN function globally.

o Select Network > Voice VLAN from the navigation tree and click the Setup tab to enter the page
shown in c.
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c. Configure the voice VLAN function globally

Summary FPort Setup QU Summary QU Add Ul Remaove
Woice VLAM security:
Voice VLAN agingime: 130 |yinutes|(5-43200, Default = 1440)
Apply Cancel

e  Select Enable in the Voice VLAN security drop-down list. You can skip this step, because the voice
VLAN security mode is enabled by default.

e Set the voice VLAN aging timer to 30 minutes.

o Click Apply.

# Configure voice VLAN on GigabitEthernet 1/0/1.

e Click the Port Setup tab to enter the page shown in d.
d. Configure voice VLAN on GigabitEthernet 1/0/1

Summary Setup QU Summary Qi Add QU Remove

“Woice WLAN port mode:
Woice WLAM port state:
Yoice WLAM 1D : (2_4094)

Select ports:

160 10 O 0 —
1 KN I I K 0 A K A

Select All Select Mone

Forts selected for voice WLAM:
GE1/0M

Cancel

e Select Auto in the Voice VLAN port mode drop-down list.
o Select Enable in the Voice VLAN port state drop-down list.
e  Type voice VIAN ID 2.

o Select GigabitEthernet 1/0/1 on the chassis front panel.
e Click Apply.

# Add OUI addresses to the OUI list.

e Click the OUI Add tab to enter the page shown in e.
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e. Add OUI addresses to the OUI list
summary Setup Port Setup QU Summary OUl Remuove

Specify an OUI and click Apply to add itto the list. There can be 16 entries at most,
OUI Address: |0011-2200-0000 |

Mask: | FFFF-FFO0-0000 + |

Description: |test

Apply Cancel

QU Address Mask Description
0001-e300-0000 fiff-fo0-0000 Siemens phone
0003-5R00-0000 fif-ff00-0000 Cisco phone
0004-0d00-0000 fif-ff00-0000 Avaya phone
00G0-b200-0000 fif-ff00-0000 Fhilips/MEC phone
00do0-1e00-0000 f-fi00-0000 Fingtel phone
00e0-7500-0000 fiff-fo0-0000 Polycom phone
00e0-bb00-0000 fiff-fo0-0000 3com phone

e  Type OUl address 0011-2200-0000.
e  Select FFFF-FF00-0000 in the Mask drop-down list.
o Type description string test.
e  Click Apply.
Verify the configuration

e When the configurations are completed, the OUl Summary tab is displayed by default, as shown in a.
You can view information about the newly-added OUI address.

a. Current OUI list of the device

Summary Setup FPort Setup QU Add QLU Remaove
QU Address Mask Description
0001-e300-0000 fiff-ff00-0000 Siemens phane
0003-6000-0000 fif-f00-0000 Cisco phone
0004-0d00-0000 fif-f00-0000 Avaya phone
0011-2200-0000 fif-fF00-0000 test
0060-b900-0000 fif-f00-0000 Philips/MEC phone
00d0-1e00-0000 ff-00-0000 Pingtel phone
00e0-7500-0000 fiff-ff00-0000 Folycom phone
00e0-bb0O0-0000 fiff-ff00-0000 3com phone

e Click the Summary tab to enter the page shown in b, where you can view the current voice VLAN
information.
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b. Current voice VLAN information

Setup Port Setup QU Summary oul Add OUl Remove
Yoice WLAN security: Enahbled
Woice WVLANM aging time: 30 minutes
Maximum of voice VLAMS : 1
Current number af voice VLAMNS & 1

Paorts enahkled for voice VLAN:

Fart Mame Yaice WLAM 1D Mode
GigahitEthernet1/0/1 2 Auto

Configuring a voice VLAN on a port in manual voice VLAN
assignment mode

Network requirements

As shown in g,
e Configure VLAN 2 as a voice VLAN that carries only voice traffic.
e The IP phone connected to hybrid port GigabitEthernet 1/0/1 sends untagged voice traffic.

e GigabitEthernet 1/0/1 operates in manual voice VLAN assignment mode and allows voice packets
whose source MAC addresses match the OUI addresses specified by OUI address 0011-2200-0000
and mask FFFF-FFO0-0000 to pass through. The description of the OUI address entry is test.

a. Network diagram for manual voice VLAN assignment mode configuration

Switch A Switch B

Internet

VLAN 2

010-1001 0755-2002
OUI: 0011-2200-0000
Mask: ffff-ff00-0000
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Configuration procedure

# Create VLAN 2.

e Select Network > VLAN from the navigation tree, and click the Create tab to enter the page shown in
a.

a. Create VLAN 2

Select VLAN Fort Detail Detail Idodify VLAN IModify Port Remove
Create:
YLAM IDs: 2 Example 3, 5-10
Create
In} Description
1 WVLAM 0001

Modify YLAMN description (Mote: you can do this later on the Modify VLARMN page)
Modify the description of the selected VLAN:
1n] Description

(1-32 Chars.}

e Type VIANID 2.
e  Click Create.

# Configure GigabitEthernet 1/0/1 as a hybrid port and configure its PVID as VLAN 2.

e Select Device > Port Management from the navigation tree, and click the Setup tab to enter the page
shown in b.
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b. Configure GigabitEthernet 1/0/1 as a hybrid port

Summary Cetail

Basic Configuration

Port State | Mo Change Speed Mo Change hd Duplex Mo Change +
Link Type | Hyhbrid v PVID (1-4094) ‘

Advanced Configuration

Flow
DI Mo Change % Cantrol MNo Change (v

Power Save | No Change % QEEHAC |No Change v/ | |i0-8102)

Storm Suppression

Broadsast Mo Change v Multicast Mo Change » Unicast Mo Change +
Suppression I:I Suppressian Suppressian I:I

pps range (1-148810 for a 100 Mbps port, 1-1488100 for a GE port, and 1-14881000 for a 10GE port)
kkps range (1-102400 for a 100 Mbps part, 1-1024000 for 3 GE port, and 1-10240000 far a 10GE port)

I

i

HP V1910-16G Sw...

Select All Select None
Unit Selected Ports
1 GE1/0/1
« [t maytake some time if you apply the above settings to multiple pors. Apply Cancel

o Select Hybrid from the Link Type drop-down list.

o Select the PVID option and type 2 in the text box.

e Select GigabitEthernet 1/0/1 from the chassis front panel.

e Click Apply.

# Assign GigabitEthernet 1/0/1 to VLAN 2 as an untagged member.

o Select Network > VLAN from the navigation tree, and click the Modify Port tab to enter the page
shown in c.
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c.  Assign GigabitEthernet 1/0/1 to VLAN 2 as an untagged member

Select WLAN Create Fort Detail Dietail Mo dify WLAR Rermuove

Select Ports

HF 191 0-1

Seleetel SEECThonE .Nut avaliable for selection

Select membership type:

@ Untagged O Tagged O Mota Mermber O Link Type O PYID

Enter YLAM |Ds to which the portis to be assigned:

VLAN IDs: |2 Example: 1,3,5-10

Selected ports:

Untagged Memhbership
GE10N

Cancel

o Select GigabitEthernet 1/0/1 from the chassis front panel.

o Select the Untagged option.

e Type VIANID 2.

o Click Apply. A configuration progress dialog box appears, as shown in d.

d. Configuration progress dialog box

Current Configuration
Setting GigahitEthernet1/001...... - Kl

100%

o After the configuration process is complete, click Close.

# Configure voice VLAN on GigabitEthernet 1/0/1.
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e.

Select Network - Voice VLAN from the navigation tree, and click the Port Setup tab to enter the page
shown in e.

Configure voice VLAN on GigabitEthernet 1/0/1
Summary Setup QU Summany QU Add QU Remove
Woice WLAR port mode:
Woice WLAR port state:
Yoice WLAN ID 2 (2_4094)
Select ports:

Select All Select Maone

Paorts selected for vaice WLAN:

GE1/01

Cancel

Select Manual in the Voice VLAN port mode drop-down list.
Select Enable in the Voice VLAN port state drop-down list.
Type voice VLIAN ID 2.

Select GigabitEthernet 1/0/1 on the chassis front panel.
Click Apply.

# Add OUI addresses to the OUI list.

Click the OUI Add tab to enter the page shown in f.
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f.  Add OUI addresses to the OUI list
Summary Setup Port Setup Ul Summary ol Remove

Specify an QU and click Apply to add itto the list There can be 16 entries at most.
OUI Address: |0011-2200-0000 |

Mask: | FFFF-FF00-0000 + |

Description: [test

Apply Cancel
QU Address Mask Description
0001-e300-0000 fif-f00-0000 Siemens phone
0003-6R00-0000 fiff-fi00-0000 Cisco phone
0004-0d00-0000 fiff-fi00-0000 Avaya phone
0060-ba00-0000 fff-f00-0000 Fhilips/MEC phone
00d0-1e00-0000 fff-f00-0000 Fingtel phone
00e0-¥500-0000 fiff-ff00-0000 Falycom phone
00e0-bb0O0-0000 fiff-ff00-0000 3com phane

e Type OUl address 0011-2200-0000.
e Select FFFF-FF00-0000 from the Mask drop-down list.
e Type description string test.
o Click Apply.
Verify the configuration

e When the configurations are completed, the OUl Summary tab is displayed by default, as shown in a.
You can view information about the newly-added OUI address.

a. Current OUI list of the device

summary Setup FPaort Setup QLU Add Ul Remoaove
QU Address Mask Description
0001-e300-0000 fiff-ffO0-0000 Siemens phone
0003-6R00-0000 fiff-ffo0-0000 Cisco phone
0004-0d00-0000 fiff-ff00-0000 Avaya phone
0011-2200-0000 fiff-ffo0-0000 test
0060-p200-0000 fiff-ffo0-0000 Fhilips/METC phone
00d0-1e00-0000 fiff-ffo0-0000 Fingtel phone
00e0-7500-0000 fiff-ff00-0000 Folycom phone
00e0-bb0O0-0000 fiff-ff00-0000 3com phone

e  Click the Summary tab to enter the page shown in b, where you can view the current voice VLAN
information.
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b. Current voice VLAN information

Setup FPort Setup QU Summary QU Add QU Remaove
Wioice VLAM security: Enakled
“oice VLAM aging time: 1440 minutes
Maximum of voice VLAMNS & 1
Current number of voice WV0LARNS : 1

Paorts enahkled for voice VLAN:

Part Mame “oice VLAM ID Mode
GigahbitEthernet1/0M1 2 Manual

Contiguration guidelines

When configuring the voice VLAN function, follow these guidelines:
e To remove a VLAN functioning as a voice VLAN, disable its voice VLAN function first.

e In automatic voice VLAN assignment mode, a hybrid port can process only tagged voice traffic.
However, the protocol-based VLAN function requires hybrid ports to process untagged traffic.
Therefore, if a VLAN is configured as the voice VLAN and a protocol-based VLAN at the same time,
the protocol-based VLAN cannot be associated with the port.

e Only one VLAN is supported and only one existing static VLAN can be configured as the voice VLAN.

o I Link Aggregation Control Protocol (LACP) is enabled on a port, the voice VLAN function cannot be
enabled on it.

o After you assign a port working in manual voice VLAN assignment mode to the voice VLAN, the voice

VLAN takes effect.
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MAC address configuration

NOTE:
The MAC address table can contain only Layer 2 Ethernet ports.

This manual covers only the management of static and dynamic MAC address entries, not multicast
MAC address entries.

An Ethernet device uses a MAC address table for forwarding frames through unicast instead of broadcast.
This table describes from which port a MAC address (or host) can be reached. The entries in the MAC
address table come from two sources: automatically learned by the device and manually added by the
administrator. Static entries never age out, but dynamic entries, which are whether manually configured or
dynamically learned, will age out.

The device can automatically populate its MAC address table by learning the source MAC addresses of
incoming frames on each port.

When a frame arrives at a port, Port A for example, the device performs the following tasks:
Table 46 Checks the source MAC address (MAC-SOURCE for example) of the frame.

Table 47 Looks up the source MAC address in the MAC address table.

If an entry is found, the device updates the entry.

If no entry is found, the device adds an entry for MAC-SOURCE and Port A.

After learning the source MAC address, when the device receives a frame destined for MAC-SOURCE, the
device finds the MAC-SOURCE entry in the MAC address table and forwards the frame out port A.

NOTE:

Dynamically learned MAC addresses cannot overwrite static MAC address entries, but the latter can
overwrite the former.

When forwarding a frame, the device adopts the following two forwarding modes based on the MAC
address table:

e Unicast mode: If an entry is available for the destination MAC address, the device forwards the frame
out the outgoing interface indicated by the MAC address table entry.

e Broadcast mode: If the device receives a frame with an all-ones destination address, or no entry is
available for the destination MAC address, the device broadcasts the frame to all the interfaces except
the receiving interface.
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b. MAC address table of the device

MAC address | Port
MAC A 1
MAC B 1
MAC C 2
MAC D 2
MAC A MAC C
MAC B I MAC D

| Port 1 > @I Port 2 >
Contiguring MAC addresses

You can configure and display MAC address entries and set the MAC address entry aging time.

Contiguring a MAC address entry

Select Network > MAC from the navigation tree. The system automatically displays the MAC tab, which
shows all the MAC address entries on the device, as shown in a.
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a.

The MAC tab

Setup

» Search ltem: | MAC

AT

O

000d-56Mh-3820

000d-2813-4e71

000f-ch00-2601

0o00fe200-0144

000f-e207-f2e0

000f-e218-d0d1

0015-e943-712f

0015-e943-7326

0022-3377-893c

00e0-4c3d-35d7

00e0-fc00-000h

00e0-fc00-0041

00e0-fc00-3963

00e0-fc00-5503

I B O

00e0-fc00-2544

¥ | Weywords:

WLAM 1D

Learned

Learned

Learned

Learned

Learned

Learned

Learned

Learned

Learned

Learned

Learned

Learned

Learned

Learned

Learned

Refrash

Type

Search

Fort
GigahitEthernet1/0M1 5
GigahitEthernet1/0M1 5
GigahitEthernet1/01 5
GigahitEthernet1f0/1 5
GigahitEthernet1 /01 5
GigahitEthernet1 /01 5
GigahitEthernet1/0M1 5
GigahitEthernet1/0M1 5
GigahitEthernet1/0M1 5
GigahitEthernet1/0M1 5
GigahitEthernet1f01 5
GigahitEthernet1f0/1 5
GigahitEthernet1 /01 5
GigahitEthernet1/0M1 5

GigahitEthernet1/0M1 5

24 records,| 15 ¥ |perpage | page 1/2, record 1-15 |

Delete Selected

Click Add in the bottom to enter the page as shown in b.

b.

“{Example; 0010-dc28-aded)

Create a MAC address entry
Setup
Add MAC
MAC:
Type: static v
WLAR: 1 L
Fort: GigahitEthernet1/0/1 |+

Cperation

== s s E s s S

Mext Last|{

ltermns marked with an asterisk(*) are required

Apply Cancel
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2. Configuration items of creating a MAC address entry

ltem Description
MAC Set the MAC address to be added.

Set the type of the MAC address entry:
e Static—Static MAC address entries that never age out.
e Dynamic—Dynamic MAC address entries that will age out.

o Blackhole—Blackhole MAC address entries that never age out.

@ IMPORTANT:
Type The tab displays the following types of the MAC address entries:

e Conlfig static—Static MAC address entries manually configured.

e Config dynamic—Dynamic MAC address entries manually configured.
e Blackhole—Blackhole MAC address entries.

o learned—Dynamic MAC address entries learned by the device.

o Other—Other types of MAC address entries.

VIAN Set the ID of the VLAN to which the MAC address belongs.

Port Set the port to which the MAC address belongs.

Setting the aging time of MAC address entries

Select Network > MAC from the navigation tree, and click the Setup tab to enter the page shown in a.
a. Set the aging time for MAC address entries

MAC

Set mac-address aging time

(O Mo-aging
@Aging Time ano seconds(10-630, Default= 3000

Apply

2. Configuration items of setting the aging time for a MAC address entry

ltem Description
No-aging Specify that the MAC address entry never ages out.
Aging time Set the aging time for the MAC address entry.
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MAC address configuration example

Network requirements

Use the web-based NMS to configure the MAC address table of the device. It is required to add a static
MAC address 00e0-4c35-dc7 1 under GigabitEthernet 1/0/1 in VLAN 1.

Configuration procedure
# Create a static MAC address entry.

Select Network > MAC from the navigation tree o enter the MAC tab, and then click Add. The page shown
in o appears.

a. Create a static MAC address entry

Setup
Add MAC
MAC: |UUeU-ﬁ:35-dc?1 |‘[Exa|‘n|:|le: 0010-dc28-a4eq)
Type: | static A |
VLAN; 1 v|
Fort: | GigahitEthernst1/0/1 |+ |

ltems marked with an asterisk(*) are required

Apply Cancel

e Type MAC address 00e0-fc35-dc71.
o Select static in the Type drop-down list.
e Select 1 in the VLAN drop-down list.

o Select GigabitEthernet1/0/1 in the Port drop-down list.
o Click Apply.
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MSTP configuration

STP

As a Layer 2 management protocol, the Spanning Tree Protocol (STP) eliminates Layer 2 loops by selectively
blocking redundant links in a network, and also allows for link redundancy.

Recent versions of STP include Rapid Spanning Tree Protocol (RSTP) and Multiple Spanning Tree Protocol
(MSTP). This chapter describes the characteristics of STP, RSTP, MSTP, and the relationship among them.

STP was developed based on the 802.1d standard of IEEE to eliminate loops at the data link layer in a local
area network (LAN). Networks often have redundant links as backups in case of failures, but loops are a
very serious problem. Devices running STP detect loops in the network by exchanging information with one
another, and eliminate loops by selectively blocking certain ports to prune the loop structure into a loop-free
tree structure. This avoids proliferation and infinite cycling of packets that would occur in a loop network
and prevents decreased device performance caused by receiving duplicate packets.

In the narrow sense, STP refers to the IEEE 802.1d STP. In the broad sense, STP refers to the IEEE 802.1d

STP and various enhanced spanning tree protocols derived from that protocol.

STP protocol packets

STP uses bridge protocol data units (BPDUs), also known as configuration messages, as its protocol packets.

STP-enabled network devices exchange BPDUs to establish a spanning tree. BPDUs contain sufficient

information for the network devices to complete spanning tree calculation.

STP uses the following types of BPDUs:

e  Configuration BPDUs, used for calculating a spanning tree and maintaining the spanning tree
topology.

o Topology change notification (TCN) BPDUs, which notify network devices of network topology
changes.

Basic concepts in STP
Root bridge

A tree network must have a root bridge.

There is only one root bridge in the entire network. The root bridge is not permanent, but can change with
changes of the network topology.

Upon initialization of a network, each device generates and periodically sends out configuration BPDUs
with itself as the root bridge. After network convergence, only the root bridge generates and periodically
sends out configuration BPDUs. The other devices only forward the BPDUs.

Root port

On a non-root bridge, the port nearest to the root bridge is the root port. The root port communicates with
the root bridge. Each non-root bridge has only one root port. The root bridge has no root port.
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Designated bridge and designated port

1. Description of designated bridges and designated ports

Classification Designated bridge Designated port

A device directly connected with the local
For a device device and responsible for forwarding
BPDUs to the local device

The port through which the designated
bridge forwards BPDUs to this device

The port through which the designated
bridge forwards BPDUs to this LAN
segment

The device responsible for forwarding

For a LAN BPDUs to this LAN segment

As shown in a, AP1 and AP2, BP1 and BP2, and CP1 and CP2 are ports on Device A, Device B, and Device
C respectively.

e  If Device A forwards BPDUs to Device B through AP1, the designated bridge for Device B is Device A,
and the designated port of Device B is port AP1 on Device A.

e Two devices are connected to the LAN: Device B and Device C. If Device B forwards BPDUs to the
LAN, the designated bridge for the LAN is Device B, and the designated port for the LAN is the port
BP2 on Device B.

a. A schematic diagram of designated bridges and designated ports

Device A

Path cost

Path cost is a reference value used for link selection in STP. STP calculates path costs to select the most robust
links and block redundant links that are less robust, to prune the network into a loop-ree tree.

NOTE:
Al the ports on the root bridge are designated ports.

How STP works

The devices on a network exchange BPDUs to identify the network topology. Configuration BPDUs contain
sufficient information for the network devices to complete spanning tree calculation. Important fields in a
configuration BPDU include:

e Root bridge ID: Comprises the priority and MAC address of the root bridge.
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e Root path cost: The cost of the path to the root bridge.

o Designated bridge ID: Comprises the priority and MAC address of the designated bridge.
e Designated port ID: Comprises the port priority and global port number.

e Message age: age of the configuration BPDU while it propagates in the network.

e Max age: The maximum age of the configuration BPDU.

e Hello time: The transmission interval of the configuration BPDU.

e  Forward delay: The delay before a port transitions to the forwarding state.

NOTE:

For simplicity, the descriptions and examples in this document involve only the following fields in the
configuration BPDUs:

Root bridge ID (represented by device priority)

Root path cost

Designated bridge ID (represented by device priority)
Designated port ID (represented by port name)

Calculation process of the STP algorithm
e Initial state

Upon initialization of a device, each port generates a BPDU with itself as the root bridge, in which the root
path cost is O, designated bridge ID is the device ID, and the designated port is the local port.

e Selection of the optimum configuration BPDU
Each device sends out its configuration BPDU and receives configuration BPDUs from other devices.
The process of selecting the optimum configuration BPDU is as follows:

1. Selection of the optimum configuration BPDU

Step Actions

Upon receiving a configuration BPDU on a port, the device performs the following:

o If the received configuration BPDU has a lower priority than that of the configuration
BPDU generated by the port, the device discards the received configuration BPDU and
1 does not process the configuration BPDU of this port.

o |If the received configuration BPDU has a higher priority than that of the configuration

BPDU generated by the port, the device replaces the content of the configuration BPDU
generated by the port with the content of the received configuration BPDU.

The device compares the configuration BPDUs of all the ports and chooses the optimum
configuration BPDU.
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NOTE:
The following are the principles of configuration BPDU comparison:
The configuration BPDU with the lowest root bridge ID has the highest priority.

If the configuration BPDUs have the same root bridge ID, their root path costs are compared. Assume
that the root path cost in a configuration BPDU plus the path cost of a receiving port is S. The
configuration BPDU with the smallest S value has the highest priority.

If all configuration BPDUs have the same ports value, their designated bridge IDs, designated port IDs,
and the IDs of the receiving ports are compared in sequence. The configuration BPDU containing a
smaller ID wins out.

e Selection of the root bridge

Initially, each STP-enabled device on the network assumes itself to be the root bridge, with the root bridge
ID being its own device ID. By exchanging configuration BPDUs, the devices compare their root bridge IDs
to elect the device with the smallest root bridge ID as the root bridge.

e Selection of the root port and designated ports on a non-root device

2. Selection of the root port and designated ports

Step Description

A non-root device regards the port on which it received the optimum configuration BPDU as the

! root port.

Based on the configuration BPDU and the path cost of the root port, the device calculates a
designated port configuration BPDU for each of its other ports.

o The root bridge ID is replaced with that of the configuration BPDU of the root port.

2 o The root path cost is replaced with that of the configuration BPDU of the root port plus the path
cost of the root port.

o The designated bridge ID is replaced with the ID of this device.
o The designated port ID is replaced with the ID of this port.

The device compares the calculated configuration BPDU with the configuration BPDU on the port

whose port role is to be defermined:

e |If the calculated configuration BPDU is superior, the device considers this port as the
designated port, replaces the configuration BPDU on the port with the calculated configuration

3 BPDU, and periodically sends out the calculated configuration BPDU.

o If the configuration BPDU on the port is superior, the device blocks this port without updating
its configuration BPDU. The blocked port can receive BPDUs, but cannot send BPDUs or
forward data.

NOTE:

When the network topology is stable, only the root port and designated ports forward traffic, while other
ports are all in the blocked state to receive BPDUs but not to forward BPDUs or user traffic.

A tree-shape topology forms when the root bridge, root ports, and designated ports are selected.

The following describes how the STP algorithm works.
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a. Network diagram for the STP algorithm

Device A
With priority 0

Device B
With priority 1

Device C
With priority 2

As shown in q, the priority values of Device A, Device B, and Device C are O, 1, and 2, and the path costs
of links among the three devices are 5, 10 and 4 respectively.

e Initial state of each device

3. Initial state of each device

Device Port name BPDU of port
AP1 {0, 0, O, AP1}
Device A
AP2 {0, 0, O, AP2}
BP1 {1,0, 1, BP1}
Device B
BP2 {1,0, 1, BP2}
CP1 {2, 0, 2, CP1}
Device C
CP2 {2,0,2, CP2}

e Comparison process and result on each device

4. Comparison process and result on each device

Configuration BPDU on

Device Comparison process .
ports after comparison

e Port AP1 receives the configuration BPDU of Device B {1, O, 1,
BP1}. Device A finds that the configuration BPDU of the local
port {0, 0, O, AP1} is superior to the received configuration
BPDU, and therefore discards the received configuration
BPDU.

e Port AP2 receives the configuration BPDU of Device C {2, 0, 2,
CP1}. Device A finds that the BPDU of the local port {0, 0, 0, AP1: {0, O, O, AP1}
AP2} is superior to the received configuration BPDU, and AP2: {0, 0, 0, AP2}
therefore discards the received configuration BPDU.

o Device A finds that both the root bridge and designated bridge
in the configuration BPDUs of all its ports are itself, so it
assumes itself to be the root bridge. In this case, it does not
make any change to the configuration BPDU of each port, and
starts sending out configuration BPDUs periodically.

Device A
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Device

Comparison process

Configuration BPDU on
ports after comparison

Device B

Port BP1 receives the configuration BPDU of Device A {0, 0, O,
AP1}. Device B finds that the received configuration BPDU is

superior to the configuration BPDU of the local port {1, O, T,
BP1}, and updates the configuration BPDU of BP1.

Port BP2 receives the configuration BPDU of Device C {2, 0, 2,
CP2}. Device B finds that the configuration BPDU of the local
port {1, O, 1, BP2} is superior to the received configuration
BPDU, and therefore discards the received configuration
BPDU.

BP1: {0, 0, 0, AP1}
BP2: {1, 0, 1, BP2}

Device B compares the configuration BPDUs of all its ports, and
determines that the configuration BPDU of BP1 is the optimum
configuration BPDU. Then, it uses BP1 as the root port, the
configuration BPDUs of which will not be changed.

Based on the configuration BPDU of BP1 and the path cost of
the root port (5), Device B calculates a designated port
configuration BPDU for BP2 {0, 5, 1, BP2}.

Device B compares the calculated configuration BPDU {0, 5, 1,
BP2} with the configuration BPDU of BP2. If the calculated
BPDU is superior, BP2 will act as the designated port, and the
configuration BPDU on this port will be replaced with the
calculated configuration BPDU, which will be sent out
periodically.

Root port BP1:
{0, 0, O, APT}
Designated port BP2:
{0, 5, 1, BP2}

Device C

Port CP1 receives the configuration BPDU of Device A {0, 0, 0,
AP2}. Device C finds that the received configuration BPDU is

superior to the configuration BPDU of the local port {2, O, 2,
CP1}, and updates the configuration BPDU of CP1.

Port CP2 receives the configuration BPDU of port BP2 of Device
B {1, 0, 1, BP2} before the configuration BPDU is updated.
Device C finds that the received configuration BPDU is superior
to the configuration BPDU of the local port {2, 0, 2, CP2}, and
therefore updates the configuration BPDU of CP2.

CP1: {0, 0, O, AP2}
CP2:{1, 0, 1, BP2}

After comparison:

The configuration BPDU of CP1 is elected as the optimum
configuration BPDU, so CP1 is identified as the root port, the
configuration BPDUs of which will not be changed.

Device C compares the calculated designated port
configuration BPDU {0, 10, 2, CP2} with the configuration
BPDU of CP2, and CP2 becomes the designated port, and the
configuration BPDU of this port will be replaced with the
calculated configuration BPDU.

Root port CP1:

{0, 0, 0, AP2}
Designated port CP2:
{0, 10, 2, CP2}

Then, port CP2 receives the updated configuration BPDU of
Device B {0, 5, 1, BP2}. Because the received configuration
BPDU is superior to its own configuration BPDU, Device C
launches a BPDU update process.

At the same time, port CP1 receives periodic configuration

BPDUs from Device A. Device C does not launch an update
process after comparison.

CP1:{0, 0, 0, AP2}
CP2: {0, 5, 1, BP2}
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Configuration BPDU on

Device Comparison process .
ports after comparison

After comparison:

e Because the root path cost of CP2 (9) (root path cost of the
BPDU (5) plus path cost corresponding to CP2 (4)) is smaller
than the root path cost of CP1 (10) (root path cost of the BPDU
(0) + path cost corresponding to CP2 (10)), the BPDU of CP2 is  Blocked port CP2:
elected as the optimum BPDU, and CP2 is elected as the root {0, 0, 0, AP2}
port, the messages of which will not be changed.

Root port CP2:

o After comparison between the configuration BPDU of CP1 and
the calculated designated port configuration BPDU, port CP1is {0, 5, 1, BP2}
blocked, with the configuration BPDU of the port unchanged,
and the port will not receive data from Device A until a
spanning tree calculation process is triggered by a new event,
for example, the link from Device B to Device C going down.

After the comparison processes described in 4, a spanning tree with Device A as the root bridge is
established, and the topology is shown in a.

a. The final calculated spanning tree

Device A
With priority O

Device B
With priority 1

Device C
With priority 2

NOTE:

This example shows a simplified spanning tree calculation process.

The configuration BPDU forwarding mechanism in STP

The configuration BPDUs of STP are forwarded following these guidelines:

e Upon network initiation, every device regards itself as the root bridge, generates configuration BPDUs
with itself as the root, and sends the configuration BPDUs at a regular hello interval.

o Ifitis the root port that received a configuration BPDU and the received configuration BPDU is superior
to the configuration BPDU of the port, the device increases the message age carried in the
configuration BPDU following a certain rule and starts a timer to time the configuration BPDU while
sending out this configuration BPDU through the designated port.

o If the configuration BPDU received on a designated port has a lower priority than the configuration
BPDU of the local port, the port immediately sends out its own configuration BPDU in response.
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e Ifa path becomes faulty, the root port on this will no longer receives new configuration BPDUs and the
old configuration BPDUs will be discarded due to timeout. The device generates a configuration BPDU
with itself as the root and sends out the BPDUs and TCN BPDUs. This triggers a new spanning tree
calculation process to establish a new path to restore the network connectivity.

However, the newly calculated configuration BPDU cannot be propagated throughout the network
immediately, so the old root ports and designated ports that have not detected the topology change
continue forwarding data along the old path. If the new root ports and designated ports begin to forward
data as soon as they are elected, a temporary loop may occur.

STP timers

STP calculation involves the following timers: forward delay, hello time, and max age.

e  Forward delay
Forward delay is the delay time for state transition.

A path failure can cause spanning tree re-calculation to adapt the spanning tree structure to the change.
However, the resulting new configuration BPDU cannot propagate throughout the network immediately. If
the newly elected root ports and designated ports start to forward data right away, a temporary loop is
likely to occur.

For this reason, as a mechanism for state transition in STP, the newly elected root ports or designated ports
require twice the forward delay time before transiting to the forwarding state to ensure that the new
configuration BPDU has propagated throughout the network.

e  Hello time

The device sends hello packets at the hello time interval to the neighboring devices to ensure that the paths
are faultfree.

e Maxage

The device uses the max age to determine whether a stored configuration BPDU has expired and discards
it if the max age is exceeded.

RSTP

RSTP achieves rapid network convergence by allowing a newly elected root port or designated port to enter
the forwarding state much faster under certain conditions than STP.

A newly elected RSTP root port rapidly enters the forwarding state if the old root port on the device has
stopped forwarding data and the upstream designated port has started forwarding data.

A newly elected RSTP designated port rapidly enters the forwarding state if it is an edge port (which directly
connecls to a user terminal rather than to another network device or a shared LAN segment) or it connects
to a pointto-point link (to another device). Edge ports directly enter the forwarding state. Connecting to a
pointto-point link, a designated port enters the forwarding state immediately after the device receives a
handshake response from the directly connected device.
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MSTP
STP and RSTP limitations

STP does not support rapid state transition of ports. A newly elected port must wait twice the forward delay
time before transiting fo the forwarding state, even if it connects to a pointto-point link or is an edge port.

Although RSTP supports rapid network convergence, it has the same drawback as STP—AIl bridges within
a LAN share the same spanning tree, so redundant links cannot be blocked based on VLAN, and the
packets of all VLANs are forwarded along the same spanning tree.

MSTP features

Developed based on IEEE 802.1s, MSTP overcomes the shortcomings of STP and RSTP. In addition to
supporting for rapid network convergence, it also provides a better load sharing mechanism for redundant
links by allowing data flows of different VLANs to be forwarded along separate paths.

MSTP includes the following features:
e MSTP supports mapping VLANs to MST instances (MSTls) by means of a VLAN+4o-MSTI mapping table.

MSTP can reduce communication overheads and resource usage by mapping multiple VLANs to one

MSTI.

e MSTP divides a switched network into multiple regions, each containing multiple spanning trees that
are independent of one another.

e MSTP prunes a loop network into a loop-ree tree, avoiding proliferation and endless cycling of
packets in a loop network. In addition, it provides multiple redundant paths for data forwarding,
supporting load balancing of VLAN data.

e MSTP is compatible with STP and RSTP.

MSTP basic concepts

Assume that all the four devices in a are running MSTP. This section explains some basic concepts of MSTP
based on the figure.
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a. Basic concepts in MSTP

Region AO

VLAN 1 mapped to instance 1
VLAN 2 mapped to instance 2
Other VLANs mapped to CIST

Region DO

VLAN 1 mapped to instance 1,
B as regional root bridge.
VLAN 2 mapped to instance 2,
C as regional root bridge.
Other VLANs mapped to CIST

Region BO

VLAN 1 mapped to instance 1
VLAN 2 mapped to instance 2
Other VLANs mapped to CIST

Region CO

VLAN 1 mapped to instance 1
VLAN 2,3 mapped to instance 2
Other VLANs mapped to CIST

MST region

A multiple spanning tree region (MST region) consists of multiple devices in a switched network and the
network segments among them. All these devices have the following characteristics:

e MSTP-enabled

e  Same region name

e Same VLAN-+4o-MSTl mapping configuration

e Same MSTP revision level

e Physically linked together

All the devices in region AO in a have the same MST region configuration:

e The same region name

e The same VLAN-+o-MSTI mapping configuration (VLAN 1 is mapped to MSTI 1, VLAN 2 to MSTI 2,
and the rest to the common and internal spanning tree (CIST, that is, MSTI 0)

e The same MSTP revision level (not shown in the figure)

Multiple MST regions can exist in a switched network. You can assign multiple devices to the same MST
region.

VLAN-to-MSTI mapping table

As an attribute of an MST region, the VLAN-o-MSTI mapping table describes the mapping relationships
between VLANs and MSTIs. In o, the VLAN-+o-MSTI mapping table of region AO is: VLAN 1 is mapped to
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IST

CST

CIST

MSTI

MSTI 1, VLAN 2 to MSTI 2, and the rest to CIST. MSTP achieves load balancing by means of the
VLAN-o-MSTI mapping table.

An internal spanning tree (IST) is a spanning tree that runs in an MST region. It is also called MSTI O, a
special MSTI to which all VLANs are mapped by default.

In a, the CIST has a section in each MST region, and this section is the IST in the respective MST region.

The common spanning tree (CST) is a single spanning tree that connects all MST regions in a switched
network. If you regard each MST region as a device, the CST is a spanning tree calculated by these devices
through STP or RSTP.

The red lines in a represent the CST.

The common and internal spanning tree (CIST) is a single spanning tree that connects all devices in a
switched network. It consists of the ISTs in all MST regions and the CST.

In o, the ISTs (MSTI ) in all MST regions plus the inter-region CST constitute the CIST of the entire network.

Multiple spanning trees can be generated in an MST region through MSTP, one spanning tree being
independent of another. Each spanning tree is referred to as a multiple spanning tree instance (MSTI).

In a, for example, multiple MSTls can exist in each MST region, each MSTI corresponding to the specified
VLANE.

Regional root

The root bridge of the IST or an MSTI within an MST region is the regional root of the IST or MSTI. Based on
the topology, different spanning trees in an MST region may have different regional roots.

In region DO in o, the regional root of MSTI 1 is device B, while that of MSTI 2 is device C.

Common root bridge

The common root bridge is the root bridge of the CIST.

In a, the common root bridge is a device in region AO.

Boundary port

A boundary port is a port that connects an MST region to another MST region, or to a single spanning-tree
region running STP, or to a single spanning-ree region running RSTP. It is at the boundary of an MST region.

During MSTP calculation, the role of a boundary port in an MSTI must be consistent with its role in the CIST.
But this is not true with master ports. A master port on MSTls is a root port on the CIST. For example, in a,
if a device in region AO is interconnected with the first port of a device in region DO and the common root
bridge of the entire switched network is located in region AOQ, the first port of that device in region DO is the
boundary port of region DO.

Port roles

MSTP calculation involves the following port roles:

e Root port: Forwards data for a non-root bridge to the root bridge.
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e Designated port: Forwards data to the downstream network segment or device.

e Master port: A port on the shortest path from the local MST region to the common root bridge,
connecting the MST region to the common root bridge. If the region is seen as a node, the master port
is the root port of the region on the CST. The master port is a root port on IST or CIST and still a master
port on the other MSTIs.

e Alternate port: The backup port for a root port and master port. When the root port or master port is
blocked, the alternate port takes over.

e Backup port: The backup port of a designated port. When the designated port is invalid, the backup
port becomes a new designated port and starts forwarding data without delay. A loop occurs when
two ports of the same MSTP device are interconnected, so the device blocks one of the ports. The
blocked port acts as the backup.

A port can play different roles in different MSTIs.

a. Portroles

Connecting to the
common root bridge

MST region

S

Wiy
Designated port4>

Port 3 Port 4

In a, devices A, B, C, and D constitute an MST region. Port 1 and port 2 of device A are connected to the
common root bridge, port 5 and port 6 of device C form a loop, port 3 and port 4 of Device D are
connected downstream to the other MST regions.

Port states

In MSTP, a port may be in one of the following states:
e  Forwarding: The port learns MAC addresses and forwards user traffic.
e Learning: The port learns MAC addresses but does not forward user traffic.

e Discarding: The port does not learn MAC addresses or forwards user traffic.

NOTE:
When in different MSTls, a port can be in different states.
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A port state is not exclusively associated with a port role. 1 lists the port states supported by each port role,
where “vV" indicates that the port supports the state and “—" indicates that the port does not support the
state.

1. Poris states supported by different port roles

Port role (right) Root Designated ~ Boundary Alternate

port/master Backup port
Port state (below) port port port port
Forwarding v v v — —
Learning v v v — —
Discarding v v v v v

How MSTP works

MSTP divides an entire Layer 2 network into multiple MST regions, which are interconnected by a
calculated CST. Inside an MST region, multiple spanning trees, called MSITs, are calculated. Among these

MSTIs, MSTI O is the CIST.

Similar to STP, MSTP uses configuration BPDUs to calculate spanning trees. However, an important
difference is that an MSTP BPDU carries the MSTP configuration on the device from which this BPDU is sent.

CIST calculation

The calculation of a CIST tree is also the process of configuration BPDU comparison. During this process, the
device with the highest priority is elected as the root bridge of the CIST. MSTP generates an IST within each
MST region through calculation, and, at the same time, MSTP regards each MST region as a single device
and generates a CST among these MST regions through calculation. The CST and ISTs constitute the CIST
of the entire network.

MSTI calculation

Within an MST region, MSTP generates different MSTls for different VLANs based on the VLAN-+4o-MSTI
mappings. For each spanning tree, MSTP performs a separate calculation process similar fo spanning tree
calculation in STP. For more information, see “How STP works”.

In MSTP, a VLAN packet is forwarded along the following paths:
e Within an MST region, the packet is forwarded along the corresponding MSTI.
e Between two MST regions, the packet is forwarded along the CST.

Implementation of MSTP on devices
MSTP is compatible with STP and RSTP. STP and RSTP protocol packets can be recognized by devices

running MSTP and used for spanning tree calculation.

In addition to basic MSTP functions, the following functions are provided for ease of management:
e Root bridge hold

e Root bridge backup

e  Root guard

e  BPDU guard
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e Lloop guard
e  TCBPDU (a message that notifies the device of topology changes) guard

Protocols and standards

e |EEE 802.1d, Media Access Control (MAC) Bridges
e |EEE 802.1w, Part 3: Media Access Control (MAC) Bridges—Amendment 2: Rapid Reconfiguration
e |EEE 802.1s, Virtual Bridged Local Area Networks—Amendment 3: Multiple Spanning Trees

Contiguring MSTP

Configuration task list

Perform the tasks described in 1 to configure MSTP.
1. MSTP configuration task list

Task Remarks

Optional
Configuring an MST region Configure the MST region-related parameters and VLAN-o-MSTI mappings.
By default, the MST region-related parameters adopt the default values, and

all VLANs in an MST region are mapped to MSTI 0.

Required
Enable MSTP globally and configure MSTP parameters.

By default, MSTP is enabled globally; and all MSTP parameters have
default values.

Configuring MSTP globally

Optional

Configuring MSTP on a port Enable MSTP on a port and configure MSTP parameters.

By default, MSTP is enabled on a port, and all MSTP parameters adopt the
default values.

Optional

Displaying MSTP information of
a port Display MSTP information of a port in MSTI O, the MSTI to which the port
belongs, and the path cost and priority of the port.

Contiguring an MST region

Select Network > MSTP from the navigation tree to enter the page as shown in a.
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a. MST region

Global Fort Summary FPort Setup

Farmat Selector Region Mame Revision Level
0 00e0fcO03620 0
IMadify
Instance WVLAM Mapped

0 1to0 4094
Click Modify to enter the page shown in b.
b. Configure an MST region

Global Port Summary Paort Setup
Region Mame 00e0fc003620 (1-32 Chars.}
Revision Level 0 (0-65535, Default= 0}

& Manual O Modula

Instance 1ID| 1 %

Instance 1D

WLAM ID (Example:1,3,5-10)

Apply  Remaove

WLAMN Mapped

Activate Cancel

2. Configuration items of configuring an MST region

ltem

Description

Region Name

MST region name.

The MST region name is the bridge MAC address of the device by
default.

Revision Level

Revision level of the MST region.

Manual Instance 1D Manually add VLAN+o-MSTI mappings. Click Apply to add the
anua VIAN ID VLAN+4o-MSTI mapping entries fo the list below.
Modulo Modulo Value The device automatically maps 4094 VLANS to the corresponding

MSTls based on the modulo value.

Return to MSTP configuration task list.
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Contiguring MSTP globally

Select Network > MSTP from the navigation tree, and click the Global tab to enter the page shown in a.
a. Configure MSTP globally

Region Fart Surmmary Fort Setup

Global METP Configuration

Enahle 5TP Glabally: Enable il
BPDU Protection: Disable :
Mode: MSTP e
Max Hops: 20 il
Path Cost Standard: Legacy >

[ Bridye Diarneter:

[ Timertin centiseconds)

Foraard Delay: (400-3000, Must he a multiple of 100}

Hello Time: {100-1000, Must he a multiple of 100)

My Age: (600-4000, Must be a multiple of 100)
[instance:

Instance IO

Root Type:

Bridge Priority:
TC Protection: Enable e

TC Protection Threshaold: B {1-255, default=6)

2. Configuration items of MSTP global configuration

ltem Description

Globally enable or disable STP.

Enable STP Globally
Other MSTP configurations take effect only after you globally enable STP.

Enable or disable BPDU guard.

BPDU Protection BPDU guard can protect the device from malicious BPDU attacks, making the
network topology stable.
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ltem Description
Set the STP working mode:
e STP—Each port on a device sends out STP BPDUs.
e RSTP—Each port on a device sends out RSTP BPDUs, and automatically migrates
to STP-compatible mode when detecting that it is connected with a device
Mode running STP.
e MSTP—Each port on a device sends out MSTP BPDUs, and automatically
migrates to STP-compatible mode when detecting that it is connected with a
device running STP.
The working mode is RSTP by default.
Set the maximum number of hops in an MST region fo restrict the region size.
Max Hops

The setting can take effect only when it is configured on the regional root bridge.

Path Cost Standard

Specify the standard for path cost calculation. Options include Legacy, IEEE
802.1D-1998, and IEEE 802.1T.

Bridge Diameter

Any two stations in a switched network are interconnected through a specific path
composed of a series of devices. The bridge diameter (or the network diameter) is
the number of devices on the path composed of the most devices.

After you set the network diameter, you cannot set the timers. Instead, the device
automatically calculates the forward delay, hello time, and max age.

@ IMPORTANT:
o The configured network diameter is effective only for the CIST, not for MSTIs.

o The bridge diameter cannot be configured together with the timers.

Forward Set the delay for the root and designated @ IMPORTANT:
Delay ports to transit to the forwarding state. o The seftings of hello fime,
Set the interval at which the device sends forward delay, and max age
Hello Time  hello packets to the surrounding devices to must meet a cerfain formula.
ensure that the paths are faultfree. Otherwise, the network
topology will not be stable. HP
Timer recommends you set the
network diameter and then have
Set the maximum length of time a the device automatically
Max Age  configuration BPDU can be held by the calculate the timers.
device. o The bridge diameter cannot be
configured together with the
timers.
Instance ID  Set the role of the device in the MSTI or the bridge priority of the device, which is one
of the factors determining whether the device can be elected as the root bridge.
Roles of the device in the MSTl include:
e Not Set—The device role is not set. You can set the bridge priority of the device
Root Type . .
Instance when selecting this role.
e Primary—Configure the device as the root bridge. You cannot set the bridge
priority of the device when selecting this role.
Bridge e Secondary—Configure the device as a secondary root bridge. You cannot set
Priority the bridge priority of the device when selecting this role.
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ltem Description
Enable or disable TC-BPDU guard.

When receiving topology change (TC) BPDUs, the device flushes its forwarding
address entries. If someone forges TC-BPDUs to attack the device, the device will
receive a large number of TC-BPDUs within a short time and frequently flushes its
forwarding address entries. This affects network stability.

TC Protection
With the TC-BPDU guard function, you can prevent frequent flushing of forwarding

address entries.

@ IMPORTANT:

HP does not recommend you to disable this function.

Set the maximum number of immediate forwarding address entry flushes the device

TC Protection Threshold can perform within a certain period of time after receiving the first TC-BPDU.

Return to MSTP configuration task list.

Contiguring MSTP on a port

Select Network - MSTP from the navigation tree, and click the Port Setup tab to enter the page shown in
a.

a. MSTP configuration on a port

Region Global Part Surnmary

5TP: Protection: Note : The new protection will replace the old one
+instance

+Advanced

Select port{s):

HP %1910-16G Sw...

Select All Select Mone

Selected port{s):

Cancel

2. Configuration items of configuring MSTP on a port

ltem Description
STP Enable or disable STP on the port.
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ltem

Description

Protection

Set the type of protection to be enabled on the port:
e Not Set—No protection is enabled on the port.

e Edged Port, Root Protection, Loop Protection—For more information, see 3.

Instance ID

Port
Priority

Auto Path
Cost

Instance

Manual
Path Cost

Set the priority and path cost of the port in the current MSTI.

o The priority of a port is an important factor in determining whether or not the
port can be elected as the root port of a device. If all other conditions are the
same, the port with the highest priority will be elected as the root port. On an
MSTP-enabled device, a port can have different priorities in different MSTIs,
and the same port can play different roles in different MSTIs, so that data of
different VLANs can be propagated along different physical paths, thus
implementing per-VLAN load balancing. You can set port priority values based
on the actual networking requirements.

e Path cost is a parameter related to the rate of a port. On an MSTP-enabled
device, a port can have different path costs in different MSTls. Setting
appropriate path costs allows VLAN traffic flows to be forwarded along
different physical links, thus achieving VLAN-based load balancing. The device
can automatically calculate the default path cost; alternatively, you can also
manually configure path cost for ports.

Point to
Point

Specify whether or not the port is connected to a pointto-point link:
e Auto—The link type of the port is automatically detected.
e Force False—The link type for the port is not point-to-point link.

o Force True—The link type for the port is point-to-point link.
@ IMPORTANT:

If a port is configured as connecting to a point-to-point link, the setting takes effect for
the port in all MSTIs. If the physical link to which the port connects is not a
point-to-point link but you force it to be a point-to-point link by configuration, the
configuration may cause a temporary loop.

Advanced
Transmit
Limit

Configure the maximum number of MSTP packets that can be sent during each
hello interval.

The larger the transmit limit is, the more network resources will be occupied. HP
recommends you fo use the default value.

MSTP
Mode

Set whether or not the port migrates to the MSTP mode.

In a switched network, if a port on an MSTP (or RSTP) device connects to a device
running STP, this port will automatically migrate to the STP-compatible mode. After
the device running STP is removed, the port on the MSTP (or RSTP) device may not
be able to migrate automatically to the MSTP (or RSTP) mode, but will remain
working in the STP-compatible mode. You can set this option to enable the port to
automatically migrate to the MSTP (or RSTP) mode.

Select port(s)

Select one or multiple ports on which you want to configure MSTP on the chassis
front panel. If aggregate interfaces are configured on the device, the page displays
a list of aggregate interfaces below the chassis front panel. You can select
aggregate interfaces from this list.
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3. Protection types

Protection type Description

Set the port as an edge port.

Some ports of access layer devices are directly connected to PCs or file servers,
which cannot generate BPDUs. You can set these ports as edge ports fo achieve
Edged Port fast transition for these ports.

HP recommends you to enable the BPDU guard function in conjunction with the
edged port function to avoid network topology changes when the edge ports
receive configuration BPDUs.

Enable the root guard function.

Configuration errors or attacks may result in configuration BPDUs with their

Root Protection priorities higher than that of a root bridge, which causes a new root bridge to be
elected and network topology change to occur. The root guard function is used to
address such a problem.

Enable the loop guard function.

By keeping receiving BPDUs from the upstream device, a device can maintain the
state of the root port and other blocked ports. These BPDUs may get lost because of
network congestion or unidirectional link failures. In this case, the device will

re-elect a root port, and blocked ports may transit fo the forwarding state, causing
loops in the network. The loop guard function is used to address such a problem.

Loop Protection

Return to MSTP configuration task list.

Displaying MSTP information of a port

Select Network - MSTP from the navigation tree, and click the Port Summary tab to enter the page shown
ina.
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a. The Port Summary tab

Redion Glohal Puart Setup

Selecta port

HP %¥1910-

Instance 0

————[Port15 (GigabitEthernetl/0/16) ] [FORWARD ING]-———

Port Protocol tenabled
Fort Role tCIST Designated Port
Fort Priority t128

Port CostiLegacy) :Config=auto / Actiwe=20
Desg. Bridge/Port  :32768. 000f-e000-0002 / 128.16
Port Edgzed :Config=enabled / Active=disabled -

Instance Cost Priority

Select a port (GigabitEthernet 1/0/16 for example) on the chassis front panel. If aggregate interfaces are
configured on the device, the page displays a list of aggregate interfaces below the chassis front panel, and
you can select aggregate inferfaces from this list. The lower part of the page displays the MSTP information
of the port in MSTI O (when STP is enabled globally) or the STP status and statistics (when STP is disabled
globally), the MSTI to which the port belongs, and the path cost and priority of the port in the MSTI.

2. Fields in the displayed MSTP information of GigabitEthernet 1/0/16 in MSTI O

Field Description

[FORWARDING] The port is in forw<':1rd|ng state. The port learns MAC addresses and
forwards user traffic.

(LEARNING] The port is in |eqrr1|ng state. The port learns MAC addresses but does not
forward user traffic.

[DISCARDING] The port is in o||sc.c:rd|ng state. The port does not learn MAC addresses or
forward user traffic.

[DOWN] The port is down.

Port Protocol Whether or not STP is enabled on the port.
The role of the port, which can be Alternate, Backup, Root, Designated,

Port Role .
Master, or Disabled.

Port Priority The priority of the port.
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Field

Description

Port Cost(Legacy)

Path cost of the port. The field in the bracket indicates the standard used for
port path cost calculation, which can be Legacy, dot1d-1998, or dot1t.

e Config indicates the configured value.

e Adhive indicates the actual value.

Desg. Bridge/Port

Designated bridge ID and port ID of the port.

The port ID displayed is insignificant for a port that does not support port
priority.

Port Edged

Whether or not the port is an edge port:
e Config indicates the configured value.

e Active indicates the actual value.

Pointto-point

Whether or not the port is connected to a pointto-point link:
e Config indicates the configured value.

e Active indicates the actual value.

Transmit Limit

The maximum number of packets sent within each hello time.

Protection Type

Protection type on the port:
¢ Root—Root guard

¢ Loop—Loop guard

e BPDU—BPDU guard

e None—No protection

MST BPDU Format

Format of the MST BPDUs that the port can send, which can be legacy or
802.1s.

e Config indicates the configured value.

e Adive indicates the actual value.

Port Config-
Digest-Snooping

Whether or not digest snooping is enabled on the port.

Rapid transition

Whether or not the current port rapidly transitions to the forwarding state.

Num of Vlans Mapped

Number of VLANs mapped to the current MSTI.

Maijor parameters for the port:
o Hello—Hello timer

*  MaxAge—Max Age timer

PortTimes
e FWDIly—Forward delay timer
* MsgAge—Message Age timer
e Remain Hop—Remaining hops
BPDU Sent Statistics on sent BPDUs.

BPDU Received

Statistics on received BPDUs.

Protocol Status

Whether or not MSTP is enabled.

Protocol Std. MSTP standard.

Version MSTP version.

CIST Bridge-Prio. Priority of the current device in the CIST.
MAC address MAC address of the current device.
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Field Description

Max agel(s) Maximum age of a configuration BPDU.

Forward delay(s) Port state transition delay, in seconds.

Hello time(s) Configuration BPDU transmission interval, in seconds.
Max hops Maximum hops of the current MST region.

Return to MSTP configuration task list.

MSTP configuration example

Network requirements

Configure MSTP in the network shown in a to enable packets of different VLANs to be forwarded along
different MSTIs.

All devices on the network are in the same MST region.

Packets of VLAN 10, VLAN 20, VLAN 30, and VLAN 40 are forwarded along MSTI 1, MSTI 2, MSTI
3, and MSTI O respectively.

Switch A and Switch B operate at the distribution layer; Switch C and Switch D operate at the access
layer. VLAN 10 and VLAN 20 are terminated on the distribution layer devices, and VLAN 30 is
terminated on the access layer devices, so the root bridges of MSTI 1 and MSTI 2 are Switch A and
Switch B respectively, while the root bridge of MSTI 3 is Switch C.

a. Network diagram for MSTP configuration
Switch A Switch B
Permit: all VLAN
Permit: Permit:
VLAN 10, 40 VLAN 20, 40
Permit: Permit:
VLAN 10, 40 VLAN 20, 40
Permit: VLAN 30, 40
Switch C Switch D

NOTE:

“Permit” next to a link in the figure is followed by the VLANS the packets of which are permitted to pass this
link.

Configuration procedure

Table 48 Configure Switch A.

# Configure an MST region.
e Select Network > MSTP from the navigation tree to enter the page shown in b.
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b. The Region tab

Global Port Summary Port Setup
Farmat Selector Region Mame Revision Level
0 00e0fc003620 0
Maodify
Instance WLAM Mapped
0 1to 4084

e Click Modify to enter the page shown in c.

c. Configure an MST region

Global Port Summary Port Setup
Region Mame |examp|e ||;1-32 Chars.)
Revision Levsl |0 (0-65535, Default = 0)

@ Wanual | O Madula

‘ Instance ID WLAN ID | |[Examp|e:1.3.5-'1tlj:
Apply Remaove

Instance 1D WLAM Mapped
10

(TR G
ra
L=}

20

Canc

e Type the region name example.

e Set the revision level to O.

e Select the Manual option.

o Select 1 in the Instance ID drop-down list.
e  Type the VIAN ID 10.

o Click Apply to map VLAN 10 to MSTI 1 and add the VLAN+o-MSTI mapping entry to the VLAN-o-MSTI
mapping list.

e Repeat the previous steps to map VLAN 20 to MSTI 2 and VLAN 30 to MSTI 3, and add the
VLAN-+o-MSTI mapping entries to the VLAN-o-MSTI mapping list.

e Click Activate.
# Configure MSTP globally.
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o Select Network > MSTP from the navigation tree, and click the Global tab to enter the page shown in
d.

d. Configure MSTP globally (on Switch A)

Reaqion Part Summary Part Setup

Glokal M3TP Configuration

Enable STP Globally | Enable v |
BPOU Protection: |Disahle hd |
Made: [MSTP v|
Max Hops: |2EI hd |
Path Cost Standard: | Legacy v |

|:|Elriu:lge Diameter:

[ Timer(in centiseconds)

Forward Delay: | |[4IZIIZI—3EIEIEI. Must be a multiple of 100)
Hello Time: | |[1IZIIZI—1EIEIEI. Must be a multiple of 100)
Max Age: | |[EIZIIZI—4EIEIEI. Must be a multiple of 100}

[¥] Instance:

Instance ID: | 1 w |

Root Type: |F'rims|r§rr b |

Bridge Priority:

TC Protection: |Enah|e L |

TC Protection Threshald: |I3 |[1_255_ default=6)

Apply

e Select Enable in the Enable STP Globally drop-down list.
e Select MSTP in the Mode drop-down list.

o Select the Instance option.

e Type the Instance ID 1.

o Select Primary in the Root Type drop-down list.

o Click Apply.

Table 49 Configure Switch B.

# Contigure an MST region. The procedure is the same as that of configuring an MST region on Switch A.

# Configure MSTP globally.
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Select Network > MSTP from the navigation tree, and click the Global tab to enter the page for
configuring MSTP globally. See d.

Select Enable in the Enable STP Globally drop-down list.
Select MSTP in the Mode drop-down list.

Select the Instance option.

Select 2 in the Instance ID drop-down list.

Select Primary in the Root Type drop-down list.

Click Apply.

Table 50 Configure Switch C.

# Configure an MST region. The procedure is the same as that of configuring an MST region on Switch A.
# Configure MSTP globally.

Select Network > MSTP from the navigation tree, and click the Global tab to enter the page shown in
d.

Select Enable in the Enable STP Globally drop-down list.
Select MSTP in the Mode drop-down list.

Select the Instance option.

Select 3 in the Instance ID drop-down list.

Select Primary in the Root Type drop-down list.

Click Apply.

Table 51 Configure Switch D.

# Configure an MST region. The procedure is the same as that of configuring an MST region on Switch A.
# Configure MSTP globally.

Select Network > MSTP from the navigation tree, and click the Global tab to enter the page shown in
e.
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e. Configure MSTP globally (on Switch D)

Region Port Summary FPort Setup

Glokal M3TP Configuration

Enable STP Globally |Enabls v |
BPOU Protection: |Disahle hd |
Mode: [MSTP v|
Max Hops: |2EI b |
Path Cost Standard: | Legacy v|

|:|Elriu:lge Diameter:

LI Timerin centiseconds)

Forward Delay: | |[4IZIIZI—3EIEIEI. Must be a multiple of 100)

Hello Time: | |[1IZIIZI—1EIEIEI. Must be a multiple of 100}

Max Age: | |[EIZIIZI—4EIEIEI. Must be a multiple of 100)
[Jinstance:

Instance |0

Root Type:

Bridge Priority:

TC Protection: |Enah|e W |

TC Protection Threshold: |E |[1_255_ default=5)

Apply

e  Select Enable in the Enable STP Globally drop-down list.
o Select MSTP in the Mode drop-down list.
e  Click Apply.

Contiguration guidelines
When configuring MSTP, follow these guidelines:

e Two devices belong to the same MST region only if they are interconnected through physical links, and
share the same region name, the same MSTP revision level, and the same VLAN-o-MSTI mappings.

e If two or more devices have been designated to be root bridges of the same spanning tree instance,
MSTP will select the device with the lowest MAC address as the root bridge.
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If the device is not enabled with BPDU guard, when a boundary port receives a BPDU from another
port, it converts into a non-boundary port. To restore its port role as a boundary port, you need to

restart the port.

Configure ports that are directly connected to terminals as boundary ports and enable BPDU guard for
them. These ports can rapidly transit fo the forwarding state, and the network security can be ensured.
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Link aggregation and LACP configuration

Ethernet link aggregation, or simply link aggregation, combines multiple physical Ethernet ports into one
logical link, called an aggregate link. Link aggregation delivers the following benefits:

e Increases bandwidth beyond the limits of any single link. In an aggregate link, traffic is distributed
across the member ports.

e Improves link reliability. The member ports dynamically back up one another. When a member port
fails, its traffic is automatically switched to other member ports.

Basic concepts

Aggregate interface

An aggregate interface is a logical Layer 2 or Layer 3 aggregate interface.

NOTE:

The device supports Layer 2 aggregation interfaces only.

Aggregation group

An aggregation group is a group of Ethernet interfaces combined together. When you create an aggregate
interface, the device automatically creates an aggregation group of the same type and number as the
aggregate interface. For example, when you create interface Bridge-Aggregation 1, Layer 2 aggregation
group 1 is created.

You can assign Layer 2 Ethernet interfaces only to a Layer 2 aggregation group, and Layer 3 Ethernet
interfaces only to a Layer 3 aggregation group.

NOTE:
The device supports Layer 2 aggregation groups only.

Aggregation states of member ports in an aggregation group

A member port in an aggregation group can be in either of the following aggregation states:
o Selected: A Selected port can forward user traffic.

e  Unselected: An Unselected port cannot forward user traffic.

The rate of an aggregate interface is the sum of the selected member ports’ rates. The duplex mode of an
aggregate interface is consistent with that of the selected member ports. All selected member ports use the
same duplex mode.

For how the state of a member port is determined, see “Static aggregation mode” and “Dynamic
aggregation mode”.

LACP

The IEEE 802.3ad Link Aggregation Control Protocol (LACP) enables dynamic aggregation of physical links.
It uses link aggregation control protocol data units (LACPDUs) for exchanging aggregation information
between LACP-enabled devices.
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LACP is automatically enabled on interfaces in a dynamic aggregation group. For information about
dynamic aggregation groups, see “Dynamic aggregation mode”. An LACP-enabled interface sends
LACPDU:s to notify the remote system (the partner) of its system LACP priority, system MAC address, LACP
port priority, port number, and operational key. Upon receiving an LACPDU, the partner compares the
received information with the information received on other interfaces to determine the interfaces that can
operate as selected interfaces. This allows the two systems to reach an agreement on which link
aggregation member ports should be placed in Selected state.

Operational key

When aggregating ports, link aggregation control automatically assigns each port an operational key
based on port attributes, including the port rate, duplex mode and link state configuration.

In an aggregation group, all selected ports are assigned the same operational key.
Class-two configurations

The contents of classtwo configurations are listed in 1. A member port can be placed in the Selected state
only if it has the same classtwo configurations as the aggregate interface.

1. Class-two configurations

Type Considerations
Port isolation Whether a port has joined an isolation group.
VIAN Permitted VLAN IDs, PVID, link type (trunk, hybrid, or access), and tag mode.
MAC address learning MAC address learning limit.
NOTE:

Some configurations are called class-one configurations. Such configurations, for example, MSTP, can
be configured on aggregate interfaces and member ports but are not considered during operational
key calculation. For more information about MSTP configuration on member ports of link aggregation
groups or aggregate inferfaces, see the chapter “MSTP configuration”.

Any class-two configuration change may affect the aggregation state of link aggregation member
ports and ongoing traffic. To make sure that you are aware of the risk, the system displays a warning
message every time you attempt to change a class-two configuration setting on a member port. For
more information about the port isolation configuration, VLAN configuration, and MAC address
learning limit configuration on member ports of link aggregation groups or aggregate interfaces, see
the chapters “Port isolation configuration”, “VLAN configuration”, and “Port management
configuration”.

Link aggregation modes

Link aggregation has the following modes: dynamic and static.
Static aggregation mode

LACP is disabled on the member ports in a static aggregation group. In a static aggregation group, the
system sets a port to Selected or Unselected state by the following rules:

o Select a port as the reference port from the ports that are in up state and have the same classtwo
configurations as the corresponding aggregate interface. The candidate ports are sorted by
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aggregation priority, duplex, and speed in the following order (with the one at the top selected as the
reference port):

©)

©)

o

o

o

Lowest aggregation priority value
Full duplex/high speed
Full duplex/low speed

Half duplex/high speed
Half duplex/low speed

o Consider the ports in up state with the same port aftributes and classtwo configurations as the
reference port as candidate Selected ports, and set all others in the Unselected state.

e  Static aggregation limits the number of Selected ports in an aggregation group. When the number of
the candidate Selected ports is under the limit, all the candidate Selected ports become Selected ports.
When the limit is exceeded, set the candidate Selected ports with smaller port numbers in the Selected
state and those with greater port numbers in the Unselected state.

e If all the member ports are down, set their states to Unselected.

e Set the ports that cannot aggregate with the reference port to the Unselected state.

NOTE:

If a static aggregation group has reached the limit on Selected ports, any port that joins the group is
placed in the Unselected state to avoid traffic interruption on the current Selected ports. Avoid this
situation, however, because it may cause the aggregation state of a port to change after a reboot.

Dynamic aggregation mode

LACP is automatically enabled on all member ports in a dynamic aggregation group.

In a dynamic aggregation group, the following rules apply:

e A Selected port can receive and transmit LACPDUs.

e An Unselected port can receive and send LACPDUs only if it is up and with the same configurations as
those on the aggregate interface.

In a dynamic aggregation group, the system sets the ports to Selected or Unselected state using the
following workflow:

Table 52 The local system (the actor) negotiates with the remote system (the partner) to determine port state
based on the port IDs on the end with the preferred system ID. The following is the detailed negotiation
procedure:

o

Compare the system ID (comprising the system LACP priority and the system MAC address) of the
actor with that of the partner. The system with the lower LACP priority wins out. If they are the same,
compare the system MAC addresses. The system with the smaller MAC address wins out.

Compare the port IDs of the ports on the system with the smaller system ID. A port ID comprises a
port LACP priority and a port number. First compare the port LACP priorities. The port with the
lower LACP priority wins out. If two ports are with the same LACP priority, compare their port
numbers. The port with the smaller port ID, that is, the port with smaller port number, is selected as
the reference port.

If a port (in an up state) is with the same port attributes and class-two configuration as the reference
port, and the peer port of the port is with the same port aftributes and classtwo configurations as
the peer port of the reference port, consider the port as a candidate selected port; otherwise set the
port to the Unselected state.
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o The number of selected ports that an aggregation group can contain is limited. When the number
of candidate selected ports is under the limit, all the candidate selected ports are set to Selected
state. When the limit is exceeded, the system selects the candidate selected ports with smaller port
IDs as the selected ports, and set other candidate selected ports to Unselected state. At the same
time, the peer device, being aware of the changes, changes the state of its ports accordingly.

Table 53 Set the ports that cannot aggregate with the reference port to the Unselected state.

NOTE:
For static and dynamic aggregation modes:

In an aggregation group, the port to be a selected port must be the same as the reference port in port
attributes, and class-two configurations. To keep these configurations consistent, you should manually
configure the port.

Change a port attribute or class-two configuration setting for a port with caution, because the change
may affect the aggregation state of member ports and interrupt services.

Load sharing mode of an aggregation group

Every link aggregation group created on HP V1910 Switch Series operates in load sharing mode all the
time, even when it contains only one member port.

Contiguring link aggregation and LACP

Configuration task list

Configuring a static aggregation group
Perform the tasks in 1 to configure a static aggregation group.

1. Static aggregation group configuration task list

Task Remarks

Required

Create a static aggregate interface and configure member
Creating a link aggregation group ports for the static aggregation group automatically created
by the system when you create the aggregate interface.

By default, no link aggregation group exists.

Optional
Displaying information of an aggregate

inferface Perform this task to view detailed information of an existing

aggregation group.

Configuring a dynamic aggregation group

Perform the tasks in 1 to configure a dynamic aggregation group.
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1. Dynamic aggregation group configuration task list

Task Remarks

Required

Create a dynamic aggregate interface and configure
member ports for the dynamic aggregation group

Creating a link aggregation group automatically created by the system when you create the
aggregate inferface. LACP is enabled automatically on all the
member ports.

By default, no link aggregation group exists.

Optional
Displaying information of an aggregate

interface Perform this task to view detailed information of an existing

aggregation group.

Optional
Perform the task to set LACP priority for the local system and
link aggregation member poris.

Sefting LACP priority Changes of LACP priorities affect the Selected/Unselected
state of link aggregation member ports.

The default port LACP priority and system LACP priority are
both 32768.

Optional

Perform the task to view detailed information of
LACP-enabled poris and the corresponding remote (pariner)
ports.

Displaying information of LACP-enabled ports

Creating a link aggregation group

Select Network > Link Aggregation from the navigation tree, and click the Create tab to enter the page as
shown in a.
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Create a link aggregation group

a.
Summary hadify Rermaove
Enter Link Aggregation Interface 1D: (.1_.10)
Specify Interface Type: " . Mote: The type of the link aggregation interface set here
@ Stati (LACF Disabled) ovenurites the existing LACP seftings of the portsin the link

ODynamic(LACP Enabled) aggregation interface.

Select pord(s) for the link aggregation interface:

Select All Select Mone

Selected Ports: Unselected Ports:

Memebers of the link aggregation intedface to be created. _Not.a mamber Of. any link aggregation intetace , and LACF
is dizabled on thiz port.

D LACF has been enabled on thiz port.

. hlembears of existing link aggragation interfaces.

Summary:

Aggregation Interface (D Member Forts Aggregation Interface Type

1 Static

Aoply Cancel

2. Configuration items of creating a link aggregation group

ltem Description

Assign an ID to the link aggregation group to be created.
Enter Link Aggregation Interface ID Yoy can view the result in the Summary list box at the bottom of the
page.

Set the type of the link aggregation interface to be created:

Specify Interface Type e Static (LACP Disabled)
e Dynamic (LACP Enabled)

Select one or multiple ports to be assigned to the link aggregation

Select port(s) for the link aggregation ~ group from the chassis front panel.

inferface You can view the result in the Summary list box at the bottom of the
page.

Return fo Static aggregation group configuration task list.

Return to Dynamic aggregation group configuration task list.

210



Displaying information of an aggregate interface

Select Network > Link Aggregation from the navigation tree. The Summary tab is displayed by default, as
shown in a.

a. Display information of an aggregate interface

Create todify Femaove
Selected
Adaregation Interface Link Type Partrer 1D Parts Standhy Ports
Bridge-Agaregationi Static 0x8000,0000-0000-0000 0 3

2. Fields on the Summary tab

Field Description

o Type and ID of the aggregate interface.
Aggregation interface . L )
Bridge-Aggregation indicates a Layer 2 aggregate interface.

Link Type Type of the aggregate interface, which can be static or dynamic.

Partner ID ID of the remote device, including its LACP priority and MAC address.

Number of Selected ports in each link aggregation group. Only Selected ports

Selected Ports . .
can transmit and receive user data.

Number of Unselected ports in each link aggregation group. Unselected ports

t Port: . .
S ondby ors cannot transmit or receive user data.

Return to Static aggregation group configuration task list.

Return to Dynamic aggregation group configuration task list.

Setting LACP priority

Select Network - LACP from the navigation tree, and click the Setup tab to enter the page shown in a.

211



a. The Setup tab

Surnmary

Select LACP enabled port(s] parameters

PortFriorty| |(0-6563, Default= 32768)

Select port(=)to apply Port Priority:

HP %1910-16¢

CLT)

Select All Select Mone

Note:Click a portto toggle its state

Selected  LACF Enabled LACF Disableg ®tWEeN enabled and disabled.

Cancel

Sat global LACF parameters

System Friority: I:I (0-G5535, Default = 32768)

Apply Cancel

After finishing each configuration item, click the right Apply button to submit the configuration.
2 describes the configuration items.

2. LACP priority configuration items

ltem Description

Select LACP enabled port(s) parameters Set a port LACP priority.

Select the ports where the port LACP priority you set will

o apply on the chassis front panel.
Select port(s) to apply Port Priority o
You can set LACP priority not only on LACP-enabled ports but

also on LACP-disabled ports.

System Priority Set the LACP priority of the local system.

Return to Dynamic aggregation group configuration task list.

Displaying information of LACP-enabled ports

Select Network > LACP from the navigation tree. The Summary tab is displayed by default, as shown in a.
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a. Display information about LACP-enabled ports

Setup

Select port{s) from the table to view partner port details:

LACE Port #*Inactive Partner Partner Cperxr

Unit Port State Priority State Reason Port Port State Key

1 0/1 Enable 32768 Not in group 3 [} EF 1

1 /2 Enable 32768 Not in group 3 0 EF 2

View Details

Partner Port Details:

Unit Porc Partner ID Partner Port Priority Partner Cper Eey

1 0/1 0x8000,0000-0000-0000 32768 0

*Note: The following numbers are used to indicate the reasons for being inactive.
1- All active ports are already in-use for this aggregator.

2— All aggregation resources are already in-use.

3— The portis not canfigured properly.

d4— The port's partneris not canfigured properly.

The upper part of the page displays a list of all LACP-enabled ports on the device and information about
them. To view information about the partner port of a LACP-enabled port, select it in the port list, and then
click View Details. Detailed information about the peer port will be displayed on the lower part of the page.

2. Fields in the LACP-enabled port summary table

Field/button Description

Unit The ID of a device in a stack.
Port Port where LACP is enabled.
LACP State State of LACP on the port.
Port Priority LACP priority of the port.
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Field/button Description

Active state of the port. If a port is selected, its state is active and the ID of the

State aggregation group it belongs to will be displayed.

Reason code indicating why a port is inactive (that is, unselected) for
Inactive Reason receiving/transmitting user data. For the meanings of the reason codes, see the
bottom of the page shown in a.

Partner Port Name of the peer port.

State information of the peer port, represented by letters A through H.
o Aindicates that LACP is enabled.

e B indicates that LACP short timeout has occurred. If B does not appear, it
indicates that LACP long timeout has occurred.

e Cindicates that the link is considered as aggregatable by the sending
system.

o Dindicates that the link is considered as synchronized by the sending system.
Partner Port State e E indicates that the sending system considers that collection of incoming

frames is enabled on the link.

e Findicates that the sending system considers that distribution of outgoing
frames is enabled on the link.

e G indicates that the receive state machine of the sending system is using the
default operational partner information.

e H indicates that the receive state machine of the sending system is in the
expired state.

Oper Key Operational key of the local port

3 describes the fields in the Partner Port Details table
3. Fields in the Partner Port Details table

Field Description

Unit Number of the remote system

Port Name of the remote port

Partner ID LACP priority and MAC address of the remote system
Partner Port Priority LACP priority of the remote port

Partner Oper Key Operational key of the remote port.

Return to Dynamic aggregation group configuration task list.

Link aggregation and LACP configuration example

Network requirements

As shown in g, Switch A and Switch B are connected to each other through their Layer 2 Ethernet ports
GigabitEthernet 1/0/1 through GigabitEthernet 1/0/3.

Aggregate the ports on each device to form a link aggregation group, thus balancing incoming/outgoing
traffic across the member ports.
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a. Network diagram for static link aggregation configuration
——

D2 B
Device A

Link aggregation

e
@ Device B

Configuration procedure
You can create a static or dynamic link aggregation group to achieve load balancing.
Table 54 Approach 1: Create a static link aggregation group
# Create static link aggregation group 1.
Select Network > Link Aggregation from the navigation tree, and click the Create tab to enter the page as
shown in b.

b. Create static link aggregation group 1

Summany hodify Femaove

Enter Link Aggregation Interface 1D: 1 (1-10)

Specify Interface Type: " . Mote: The type of the link aggregation interface set here
@ Statis (LACF Disabled) ovenurites the existing LACP seftings of the portsin the link
(,} Dynamic (LACF Enabled) aggregation interface.

Select poris) for the link aggregation interface:

HP %1310-16

Select All Select Nane

Selected Ports: Unselected Forts:

Memeabers of the link aggragation inteface to be created. _Not.a member Of. any link aggregatien interface . and LACF
iz dizabled on thiz port.

D LACF has been enabled on thiz port.

. hlembears of existing link aggragation interfaces.

Summary:
Aggregation Interface D ember Ports

1 GE10M-GENDS

Aggregation Inteface Type
Static

S

o Set the link aggregation interface ID o 1.
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Select the Static (LACP Disabled) option as the aggregate interface type.
Select GigabitEthernet 1/0/1, GigabitEthernet 1/0/2, and GigabitEthernet 1/0/3 on the chassis
front panel.

Click Apply.

Table 55 Approach 2: Create a dynamic link aggregation group

# Create dynamic link aggregation group 1.

Select Network > Link Aggregation from the navigation tree, and click the Create tab to enter the page as

shown in c.
c. Create dynamic link aggregation group 1
Summary hdodify Remave
Enter Link Aggregation Intedace 1D: 1 (1-10)
Spactyretace Tpe O st uace bt e T e kg e e
@ Dynamic(LACF Enabled) aggregation interface.

Select pori(s) for the link aggregation interface:

HP 1910-16G

Select All Select Mone

Selected Ports: Unselected Ports:

Memebers of the link aggregation interface to be created. .Not.a membar Of. any link aggregation interface , and LACR
iz dizabled on thiz port.

D LACP has been enabled on this port.

. Members of existing link aggregation intefaces.

Summary:
Aggregation Interface 1D fdember Ports
1 GE1OM-GENDIS Dynamic

Aggregation Interface Type

Apply Cancel

e Set the link aggregation interface ID to 1.

o Select the Dynamic (LACP Enabled) option as the aggregate interface type.

o Select GigabitEthernet 1/0/1, GigabitEthernet 1/0/2, and GigabitEthernet 1/0/3 on the chassis
front panel.

o Click Apply.
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Configuration guidelines

Follow these guidelines when configuring a link aggregation group:

In an aggregation group, the port to be a selected port must be the same as the reference port in port
attributes, and class-two configurations. To keep these configurations consistent, you should configure
the port manually.

Reference port: Select a port as the reference port from the ports that are in up state and with the same
classtwo configurations as the corresponding aggregate interface. The selection order is as follows:
full duplex/high speed, full duplex/low speed, half duplex/high speed, and half duplex/low speed,
with full duplex/high speed being the most preferred. If two ports with the same duplex mode/speed
pair are present, the one with the lower port number wins out.

Port attribute configuration includes the configuration of the port rate, duplex mode, and link state.
For more information about class4wo configurations, see “Classtwo configurations”.

To guarantee a successful static aggregation, ensure that the ports at the two ends of each link to be
aggregated are consistent in the Selected/Unselected state. To guarantee a successful dynamic
aggregation, ensure that the peer ports of the ports aggregated at one end are also aggregated. The
two ends can automatically negotiate the selected state of the ports.

Removing a Layer 2 aggregate interface also removes the corresponding aggregation group. At the
same time, all member ports leave the aggregation group.
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LLDP configuration

Background

In a heterogeneous network, it is important that different types of network devices from different vendors can
discover one other and exchange configuration for interoperability and management sake. To ensure
compatibility, a standard configuration exchange platform was created.

The IETF drafted the Link Layer Discovery Protocol (LLDP) in IEEE 802.1AB. The protocol operates on the
data link layer to exchange device information between directly connected devices. With LLDP, a device
sends local device information as TLV (type, length, and value) triplets in LLDP Data Units (LLDPDUs) to the
directly connected devices, and at the same time, stores the device information received in LLDPDUs sent
from the LLDP neighbors in a standard management information base (MIB). It allows a network
management system to quickly detect and identify Layer 2 network topology changes.

Basic concepts

LLDPDUs

LLDP sends device information in LLDPDUs. LLDPDUs are encapsulated in Ethernet Il or Subnetwork Access
Protocol (SNAP) frames.

Table 56 Ethernet Il-encapsulated LLDPDU format
b. Ethernet ll-encapsulated LLDPDU format

0 15 31
Destination MAC address

Source MAC address

Type

Data = LLDPU
(1500 bytes)

FCS

2. Fields in an Ethernet Il encapsulated LLDPDU

Field Description

The MAC address to which the LLDPDU is advertised. It is fixed to
0x0180-C200-000E, a multicast MAC address.

The MAC address of the sending port. If the port does not have a MAC
address, the MAC address of the sending bridge is used.

Destination MAC address

Source MAC address

Type The Ethernet type for the upper layer protocol. It is 0x88CC for LLDP.
Data LLDPDU.
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Field Description

Frame check sequence, a 32-bit CRC value used to determine the validity of

FCS the received Ethernet frame.

Table 57 SNAP-encapsulated LLDPDU format
b. SNAP-encapsulated LLDPDU format

0 15 31
Destination MAC address

Source MAC address

Type

Data = LLDPU
(n bytes)

FCS

3. Fields in a SNAP encapsulated LLDPDU

Field Description

The MAC address to which the LLDPDU is advertised. It is fixed to
0x0180-C200-000E, a multicast MAC address.

The MAC address of the sending port. If the port does not have a MAC
address, the MAC address of the sending bridge is used.

Destination MAC address

Source MAC address

T The SNAP-encoded LLDP Ethernet type for the upper layer protocol. It is
ype OxAAAA-0300-0000-88CC for LLDP.

Data LLDPDU.

Frame check sequence, a 32-bit CRC value used to determine the validity of

FCS the received Ethernet frame.

LLDPDUs

LLDP uses LLDPDUs to exchange information. An LLDPDU comprises multiple TLV sequences. Each carries a
specific type of device information, as shown in a.

a. LLDPDU encapsulation format

Chassis ID TLV | Port ID TLV | Time To Live TLV | Optional TLV Optional TLV | End of LLDPDU TLV

An LLDPDU can carry up 28 types of TLVs. Mandatory TLVs include Chassis ID TLV, Port ID TLV, Time To Live
TLV, and End of LLDPDU TLV. Other TLVs are optional.

TLVs

TLVs are type, length, and value sequences that carry information elements. The type field identifies the type
of information, the length field indicates the length of the information field in octets, and the value field
contains the information itself.
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LLDPDU TLVs fall into the following categories:

e  Basic management TLVs

e Organizationally (IEEE 802.1 and IEEE 802.3) specific TLVs
e  LLDP-MED (media endpoint discovery) TLVs

Basic management TLVs are essential to device management. Organizationally specific TLVs and LLDP-MED
TLVs are used for enhanced device management; they are defined by standardization or other
organizations and thus are optional to LLDPDUs.

Table 58 Basic management TLVs
2 lists the basic management TLV types. Some of them must be included in every LLDPDU.
2. Basic LLDP TLVs

Type Description Remarks
Chassis ID Bridge MAC address of the sending device.

ID of the sending port.

If the LLDPDU carries LLDP-MED TLVs, the port ID TLV carries

Port ID the MAC address of the sending port or the bridge MAC in
case the port does not have a MAC address. If the LLDPDU  Mandatory
carries no LLDP-MED TLVs, the port ID TLV carries the port

name.

Time To Live Life of the transmitted information on the receiving device.
End of LLDPDU Marks the end of the TLV sequence in the LLDPDU.

Port Description Port description of the sending port.

System Name Assigned name of the sending device.

System Description Description of the sending device.

Identifies the primary functions of the sending device and the

Optional
enabled primary functions. priona

System Capabilities

Management address used to reach higher level entities to
assist discovery by network management, and the interface
number and object identifier (OID) associated with the
address.

Management Address

Table 59 IEEE 802.1 organizationally specific TLVs
3. |EEE 802.1 organizationally specific TLVs

Type Description

Port VLAN ID PVID of the sending port.

Port And Protocol VLAN ID Port and protocol VLAN IDs.

VLAN Name A specific VLAN name on the port.

Protocol Identity Protocols supported on the port.
NOTE:

HP V1910 Switch Series can receive but cannot send protocol identity TLVs.
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Table 60 IEEE 802.3 organizationally specific TLVs
4. |EEE 802.3 organizationally specific TLVs

Type Description

Contains the rate and duplex capabilities of the sending port, support
for auto negotiation, enabling status of auto negotiation, and the
current rate and duplex mode.

MAC/PHY Configuration/Status

Power Via MDI Contains Power supply capability of the port.
Indicates the support of the port for link aggregation, the aggregation
Link Aggregation capability of the port, and the aggregation status (whether the link is in

an aggregation).

Maximum Frame Size Indicates the supported maximum frame size. It is the MTU of the port.

LLDP-MED TLVs

LLDP-MED TLVs provide multiple advanced applications for voice over IP (VolIP), such as basic configuration,
network policy configuration, and address and directory management. LLDP-MED TLVs provide a
cost-effective and easy-to-use solution for deploying voice devices in Ethernet. LLDP-MED TLVs are shown in

1.
1. LLDP-MED TLVs

Type

Description

LLDP-MED Capabilities

Allows a MED endpoint to advertise the supported LLDP-MED TLVs and its
device type.

Network Policy

Allows a network device or MED endpoint to advertise LAN type and VLAN ID
of the specific port, and the Layer 2 and Layer 3 priorities for a specific set of
applications.

Extended Power-via-MDI

Allows a network device or MED endpoint to advertise power-related
information (according to IEEE 802.3AF).

Hardware Revision

Allows a MED endpoint device to advertise its hardware version.

Firmware Revision

Allows a MED endpoint to advertise its firmware version.

Software Revision

Allows a MED endpoint to advertise its software version.

Serial Number

Allows an LLDP-MED endpoint device to advertise its serial number.

Manufacturer Name

Allows a MED endpoint to advertise its vendor name.

Model Name

Allows a MED endpoint to advertise its model name.

Asset ID

Allows a MED endpoint to advertise its asset ID. The typical case is that the
user specifies the asset ID for the endpoint to facilitate directory management
and asset tracking.

Location Identification

Allows a network device to advertise the appropriate location identifier
information for an endpoint to use in the context of location-based
applications.

NOTE:

For more information about LLDPDU TLVs, see the IEEE standard (LLDP) 802.1AB-2005 and the LLDP-MED
standard (ANSI/TIA-1057).
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Management address

The management address of a device is used by the network management system to identify and manage
the device for topology maintenance and network management. The management address is encapsulated
in the management address TLV.

How LLDP works

Operating modes of LLDP

LLDP can operate in one of the following modes:

e TxRx mode. A port in this mode sends and receives LLDPDUs.
e  Txmode. A port in this mode only sends LLDPDUs.

e Rx mode. A port in this mode only receives LLDPDUs.

e Disable mode. A port in this mode does not send or receive LLDPDUs.

When the LLDP operating mode of a port changes, its LLDP protocol state machine re-initializes. A
re-initialization delay, which is user configurable, prevents LLDP from being initialized too frequently during
times of frequent operating mode change. With this delay configured, before a port can initialize LLDP, it
must wait for the specified interval after the LLDP operating mode changes.

Transmitting LLDPDUs

An LLDP-enabled port operating in TxRx mode or Tx mode sends LLDPDUs to its directly connected devices
both periodically and when the local configuration changes. A frame transmit interval between two
successive LLDP frames prevents the network from being overwhelmed by LLDPDUs during times of frequent
local device information change.

This interval is shortened to 1 second in either of the following cases:

e Anew neighbor is discovered. A new LLDPDU is received carrying device information new to the local
device.

e The LLDP operating mode of the port changes from Disable/Rx to TxRx or Tx.

This is the fast sending mechanism of LLDP. This feature sends a specific number of LLDPDUs at 1-second
intervals to help LLDP neighbors discover the local device as soon as possible. Then, the normal LLDPDU
transit interval resumes.

Receiving LLDPDUs

An LLDP-enabled port operating in TxRx mode or Rx mode checks the validity of TLVs carried in every
received LLDPDU. If valid, the information is saved and an aging timer is set for it based on the time to live
(TTL) value in the TTL TLV carried in the LLDPDU. If the TTL value is zero, the information is aged out
immediately.

Compatibility of LLDP with CDP

To make your device work with Cisco IP phones, you must enable CDP compatibility.

If your LLDP-enabled device cannot recognize Cisco Discovery Protocol (CDP) packets, it does not respond
to the requests of Cisco IP phones for the voice VLAN ID configured on the device. As a result, a requesting
Cisco IP phone sends voice traffic without any tag to your device, which disables your device from
differentiating the voice traffic from other types of traffic.
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With CDP compatibility enabled, your device can receive and recognize CDP packets from a Cisco IP
phone and respond with CDP packets, which carry the voice VLAN configuration TLVs. The voice traffic is
confined in the configured voice VLAN, and differentiated from other types of traffic.

CDP-compatible LLDP operates in one of the following modes:

e TxRx: CDP packets can be transmitted and received.

e Disable: CDP packets cannot be transmitted or received.

Protocols and standards

e |EEE 802.1AB-2005, Station and Media Access Control Connectivity Discovery
e ANSI/TIA-1057, Link Layer Discovery Protocol for Media Endpoint Devices

Contiguring LLDP

LLDP configuration task list

Perform the tasks in 1 to configure LLDP:

1. LLDP configuration task list

Task

Remarks

Enabling LLDP on ports

Optional
By default, LLDP is enabled on ports.

Make sure that LLDP is also enabled globally, because LLDP can work on a port
only when it is enabled both globally and on the port.

Configuring LLDP settings
on ports

Optional

LLDP settings include LLDP operating mode, packet encapsulation, CDP
compatibility, device information polling, trapping, and advertised TLVs.
By defaul,

o The LLDP operating mode is TxRx.

o The encapsulation format is Ethernet II.

o CDP compatibility is disabled.

e Device information polling and trapping are disabled.

o All TLVs except the Location Identification TLV are advertised.

Configuring global LLDP
setup

Required
By default, global LLDP is disabled.
To enable LLDP to work on a port, enable LLDP both globally and on the port.

Displaying LLDP
information for a port

Optional
You can display the local LLDP information, neighbor information, statistics, and
status information of a port, where

e The local LLDP information refers to the TLVs to be advertised by the local
device to neighbors.

o The neighbor information refers to the TLVs received from neighbors.
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Task Remarks

Displaying global LLDP Ogptional

information You can display the local global LLDP information and statistics.
Displaying LLDP Optional

information received from

LLDP neighbors You can display the LLDP information received from LLDP neighbors.

NOTE:

LLDP-related configurations made in Ethernet interface view takes effect only on the current port, and those
made in port group view takes effect on all poris in the current port group.

Enabling LLDP on ports

Select Network = LLDP from the navigation tree to enter the Port Setup tab, as shown in a.

This tab displays the LLDP status and operating mode on a port. Select one or more ports and click Enable
beneath the port list to enable LLDP on them.

To disable LLDP on a port, select the port and click Disable.
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a. The Port Setup tab

Global Setup Global Summary Meighbaor Summary

b Search ltem:| Port Name "|Keywnrds:| Search

F] FPart Mame LLDP Status LLDP Wark Made Qperation
[] GigakitEthernet1/00M Enahled TxRx @

[] | GigakitEthernet1/0i2 Enakled TxRx @

[] | GigakitEthernet1/0:3 Enahled TxRx @

[] GigabitEthernet1/0/4 Enahled TxRx @

[] GigabitEthernet1i0/5 Enahled TrRx @

[] GigabitEthernet1/0/G Enahled TxRx @

[] | GigakitEthernet1/07 Enahbled TxRx @

[] | GigakitEthernet1/0/8 Enahled TxRx @

[ GigabitEthernet1/0/2 Enahled TxRx @

[] GigabitEthernet1/0/10 Enahled TxRx @

[] GigakitEthernet1/0/11 Enahled TxRx @

[] |GigakitEthernet1/0M12 Enakled TxRx @

[ |GigakitEthernet1/0M13 Enahled TxRx @

[ GigabitEthernet1/0/14 Enahled TxRx @

[ GigabitEthernet1/0/15 Enahled TrRx @

20 recnrds.per page | page 1/2, record 1-15 | Mext Last
Enahble Disable Modify Selected

Meighbor Information | Statistic Information | Status Information

Return to LLDP configuration task list.

Configuring LLDP settings on ports

Select Network = LLDP from the navigation tree to enter the Port Setup tab, as shown in a.

You can configure LLDP settings on ports individually or in batch.
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e To configure LLDP settings on individual ports, click the (& icon for the port you are configuring. On
the page displayed as shown in a, you can modify or view the LLDP settings of the port.

a. The page for modifying LLDP settings on a port

Global Setup Global Summary Meighbar Summary
Interface Mame LLDP State
Basic Settings
LLDP Operating Mode |TxRx v | Encapsulation Format | ETHII v |
CDP Operating Mode | Disable v| LLDF Polling Interval | | [f_e;uf:”ds
LLOF Trapping |Disah|e V|

Base TLV Settings

[¥] Pert Description [¥] gystem Capabhilities
[¥] System Description [¥] System Mame

[¥]Management Address | |

|Numher V|

~+sddtional TLV Seftings
Apply Cancel

e To bulk configure LLDP settings on ports, select multiple ports and click Modify Selected. The page
shown in b appears.
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b. The page for modifying LLDP settings on ports in batch
zlobal Setup Global Summary Meighbar Summary

Interface Mame GigahitEthernet1/0/1 GigahitEthernet1/0/2 GigabitEthernet1/0/3

Basic Settings

Encapsulation

LLDP Operating Mode TxRx v Format ETHII v
CDP Operating Mode | Disable v LLDP Folling Interval Seconds(i-
LLDP Trapping Disahle A
Base TLV Settings
[l Port Description [ systermn Capabilities
(] 5ystem Description (] system Mame
O Management Address
String b
~+2ddtional Settings
Apply Cancel
2. Port LLDP configuration items
ltem Description
Interface Name Displays the name of the port or ports you are configuring.

Displays the LLDP enabling status on the port you are
LLDP State configuring.
This field is not available when you batch-configure ports.

Set the LLDP operating mode on the port or ports you are
configuring:

e TxRx—Sends and receives LLDPDUs.

e Tx—Sends but not receives LLDPDUs.

e Rx—Receives but not sends LLDPDUs.

¢ Disable—Neither sends nor receives LLDPDUs.

LLDP Operating Mode

Set the encapsulation for LLDPDUs:

o ETHII—Encapsulates outgoing LLDPDUs in Ethernet Il frames
and processes an incoming LLDPDU only if its encapsulation
is Ethernet II.

Encapsulation Format e SNAP—Encapsulates outgoing LLDPDUs in Ethernet I
frames and processes an incoming LLDPDU only if its
encapsulation is Ethernet II.

Basic Settings

@ IMPORTANT:
LLDP-CDP PDUs use only SNAP encapsulation.
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ltem

Description

CDP Operating Mode

Set the CDP compuaitibility of LLDP:
e Disable—Neither sends nor receives CDPDUs.
e TxRx—Sends and receives CDPDUs.

@ IMPORTANT:

To enable LLDP to be compatible with CDP on the port, you must
enable CDP compatibility on the Global Setup tab and set the
CDP operating mode on the port to TxRx.

LLDP Polling Interval

Enable LLDP polling and set the polling interval.
If no polling interval is set, LLDP polling is disabled.

With the polling mechanism, LLDP periodically detects local
configuration changes. If a configuration change is defected,
an LLDPDU is sent fo inform the LLDP neighbors of the change.

LLDP Trapping

Set the enable status of the LLDP trapping function on the port or
ports.

LLDP trapping is used to report to the network management
station critical events such as new neighbor devices detected
and link failures.

@ IMPORTANT:

To avoid excessive traps from being sent when topology is
instable, you can tune the minimum trap transit interval on the

Global Setup tab.

Base TLV
Settings

Port Description

Select to include the port description TLV in transmitted

LLDPDUs.

System Capabilities

Select to include the system capabilities TLV in transmitted
LLDPDUs.

System Description

Select to include the system description TLV in transmitted
LLDPDUs.

System Name

Select to include the system name TLV in transmitted LLDPDUs.

Management Address

Select to include the management address TLV in transmitted
LLDPDUs and in addition, set the management address and its
format (a numeric or character string in the TLV).

If no management address is specified, the main IP address of
the lowest VLAN carried on the port is used. If no main IP
address is assigned to the VLAN, 127.0.0.1 is used.

DOT1 TLV
Setting

Port VLAN ID

Select to include the PVID TLV in transmitted LLDPDUs.

Protocol VLAN ID

Select to include port and protocol VLAN ID TLVs in transmitted
LLDPDUs and specify the VLAN IDs to be advertised.

If no VLAN is specified, the lowest protocol VLAN ID is
transmitted.

VLAN Name

Select to include VLAN name TLVs in transmitted LLDPDUs and
specify the VLAN IDs to be advertised.

If no VLAN is specified, the lowest VLAN carried on the port is
advertised.
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ltem Description

. . Select to include the link aggregation TLV in transmitted

Link Aggregation LLDPDUs.

MAC/PHY Select to include the MAC/PHY configuration/status TLV in
DOT3 TLV Configuration/Status transmitted LLDPDUs.
Setting

. . Select to include the maximum frame size TLV in transmitted

Maximum Frame Size

LLDPDUs.

Power via MDI Select to include the power via MDI TLV in transmitted LLDPDUs.
. Select to include the LLDP-MED capabilities TLV in transmitted
LLDP-MED Capabilities LLDPDUs.

Select to include the hardware revision TLV, firmware revision
| ; TLV, software revision TLV, serial number TLV, manufacturer
nventory name TLV, model name TLV and asset ID TLV in transmitted

LLDPDUs.

Network Policy Select to include the network policy TLV in transmitted LLDPDUs.
Extended Power-via-MDI  Select to include the extended power-via-MDI TLV in transmitted
Capability LLDPDUs.

Select to encode the emergency call number in the location
Emergency Number identification TLV in transmitted LLDPDUs and set the emergency

call number.

MED TLV
Setting Select Address to encode the civic address information of the

Address

Network Device Address

network connectivity device in the location identification TLV in
transmitted LLDPDUs. In addition, set the device type, which can
be a DHCP server, switch or LLDP-MED endpoint, country code,
and network device address.

When configuring the network device address, select the
address information type from the drop-down list, type the
address information in the text box below and click Add next to
the text box to add the information to the address information
list below. To remove an address information entry, select the
entry from the list, and click Delete. The civic address
information can include language, province/state, country,
city, street, house number, name, postal/zip code, room
number, post office box, and if necessary, additional
information.

Return to LLDP configuration task list.

Contiguring global LLDP setup

Select Network - LLDP from the navigation tree and click the Global Setup tab to enter the page shown in

a.
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a.

The Global Setup tab

FPort Setup

Global Setup

LLDP Enable

CDP Compatibility

Fast LLOPDL
Count

TTL Multiplier
Trap Interval
Reinit Delay
Tr Delay

Tx Interval

Global Summary Meighbor Summary
Disable b
Disable b
3 (1-10, Default = 3}
4 (2-10, Default = 4}
5 Second(5-3600, Default = 3)
2 Second(1-10, Default = 2}
2 Second(1-8192, Default = 2}
20 Second(5-32768, Default = 30)

Apply
2. Global LLDP setup configuration items
ltem Description
LLDP Enable Select from the drop-down list to enable or disable global LLDP.

CDP Compatibility

Select from the drop-down list to enable or disable CDP compatibility of LLDP.

@ IMPORTANT:

e Toenable LLDP to be compatible with CDP on a port, you must set the CDP work
mode (or the CDP operating mode) on the port to TxRx in addition to enabling
CDP compatibility on the Global Setup tab.

e As the maximum TTL allowed by CDP is 255 seconds, you must ensure that the
product of the TTL multiplier and the LLDPDU transmit interval is less than 255
seconds for CDP-compatible LLDP to work properly with Cisco IP phones.

Fast LLDPDU Count

Set the number of LLDPDUs sent each time fast LLDPDU transmission is triggered.

TTL Multiplier

Set the TTL multiplier.

The TTL TLV carried in an LLDPDU determines how long the device information
carried in the LLDPDU can be saved on a recipient device. You can configure the
TTL of locally sent LLDPDUs to determine how long information about the local
device can be saved on a neighbor device by setting the TTL multiplier. The TTL is
expressed as TTL multiplier x LLDPDU transit interval.

@ IMPORTANT:
e If the product of the TTL multiplier and the LLDPDU transmit interval is greater
than 65535, the TTL carried in transmitted LLDPDUs takes 65535 seconds.

e Asthe maximum TTL allowed by CDP is 255 seconds, you must ensure that the
product of the TTL multiplier and the LLDPDU transmit interval is less than 255
seconds for CDP-compatible LLDP to work properly with Cisco IP phones.
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ltem Description

Set the minimum interval for sending traps.

With the LLDP trapping function enabled on a port, traps are sent out the port to

Trap Interval advertise the topology changes detected over the trap interval to neighbors. By
tuning this interval, you can prevent excessive traps from being sent when topology
is instable.

Set initialization delay for LLDP-enabled ports.

Each time the LLDP operating mode of a port changes, its LLDP protocol state
machine re-initializes. To prevent LLDP from being initialized too frequently at times

Reinit Delay
of frequent operating mode change, initialization delay is infroduced. With this
delay mechanism, a port must wait for the specified interval before it can initialize
LLDP after the LLDP operating mode changes.
Set LLDPDU transmit delay.
With LLDP enabled, a port advertises LLDPDUs to its neighbors both periodically
and when the local configuration changes. To avoid excessive number of LLDPDUs
caused by frequent local configuration changes, an LLDPDU transmit delay is
intfroduced. Thus, after sending an LLDPDU, the port must wait for the specified
Tx Delay interval before it can send another one.
@ IMPORTANT:
LLDPDU transmit delay must be less than the TTL to ensure that the LLDP neighbors can
receive LLDPDUs to update information about the device you are configuring before it
is aged out.
Set the LLDPDU transmit interval.
@ IMPORTANT:
If the product of the TTL multiplier and the LLDPDU transmit interval is greater than
Tx Interval

65535, the TTL carried in transmitted LLDPDUs takes 65535 seconds. In this case, the
likelihood exists that the LLDPDU transmit interval is greater than TTL. You should
avoid the situation, because the LLDP neighbors will fail to receive LLDPDUs to update
information about the device you are configuring before it is aged out.

Return to LLDP configuration task list.

Displaying LLDP information for a port

Select Network > LLDP from the navigation tree to enter the Port Setup tab, as shown in a. In the port list,
click a port name to display its LLDP information at the lower half of the page. The LLDP information is
organized by type and displayed in tabs as shown in a. You can click these tabs to display data you are
inferested in.
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a. The Local Information tab
Meighbor Information | Statistic Information | Status Information

LLDP local-information of port l6[GigabitEthernetlys0/16]:
Port ID subtype : Interface name
Port ID : GigabitEthernetl/0/16
Port description : GigabitEthernetl/0/16 Interface

Managemnent address type  ipwd
Managenent address p 192.168.0.91
Managenent address interface type : IfIndex
Management address interface ID 22
Managenent address 0ID H]

Fort WLAN ID(PVID): 1

2. Local information of an LLDP-enabled port

Field Description

Port ID type:

e Interface alias

e Port component
Port ID subtype * MAC oddress
e Network address
¢ Interface name
e Agent circuit ID

o Llocally assigned, namely, the local configuration

The power over Ethernet port class:
Power port class e PSE—A power supply device.

e PD—A powered device.

Port power classification of the PD:

e Unknown

e Class 0
Port power classification e Class 1
e Class 2
e Class 3
e Class 4

Available options include:

e Unknown

e Voice

e Voice signaling
Media policy type ° Gvest vo!ce o
e Guest voice signaling
e Soft phone voice
e Videoconferencing
e Streaming video

e Video signaling
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Field Description

The type of PSE power source advertised by the local device:
PoE PSE power source e Primary

e Backup

Available options include:

e Unknown—The PSE priority of the port is unknown.
Port PSE priority e Critical—The priority level 1.

e High—The priority level 2.

o low—The priority level 3.

a. The Neighbor Information tab

Local Information Statistic Information | Status Information

LLDP neighbor-information of port l6[GigabitEthernetl/0/16]:

Neighbor index t 1

Tpdate time : 0 days,0 hours, 39 ninutes, 0 seconds

Chassis type : MAC address

Chassis ID : 00e0-£cO0-5502

Port ID type : Interface name

Port ID i GigabitEthernetl/ 0723

Port description : GigabitEthernetl/0/23 Interface

Systen name ! gysnane

Jysten descriprtion : 3witch 42106 Z4-Port Joftware Version 5.:20 REelease ZZ202P17
Systewm capabilities supported : Bridge,Router -

3. LLDP neighbor information of an LLDP-enabled port

Field Description

Chassis ID type:

e Chassis component
e Interface alias

e Port component

e MAC address

e Network address

Chassis type

e Interface name

o locally assigned—Local configuration.

Chassis ID Chossis. ID depending on the chassis type, which can be a MAC address of
the device.
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Field

Description

Port ID type:

e Interface alias
e Port component
e  MAC address

Port ID t
e ype e Network address
e Interface name
e Agent circuit ID
e Llocally assigned—Local configuration.
Port ID The port ID value.

System capabilities supported

The primary network function of the system:
e Repeater
e Bridge

o Router

System capabilities enabled

The network function enabled on the system:
e Repeater
e Bridge

e Router

Auto-negotiation supported

The support of the neighbor for auto negotiation.

Auto-negotiation enabled

The enable status of auto negotiation on the neighbor.

OperMau

Current speed and duplex mode of the neighbor.

Link aggregation supported

The neighbor supports link aggregation.

Link aggregation enabled

Link aggregation is enabled on the neighbor.

Aggregation port ID

Link aggregation group ID. It is O if the neighbor port is not assigned to any
link aggregation group.

Maximum frame Size

The maximum frame size supported on the neighbor port.

Device class

MED device type:

e Connectivity device—An intermediate device that provide network
connectivity.

o Class |—a generic endpoint device. All endpoints that require the
discovery service of LLDP belong to this category.

e Class ll—A media endpoint device. The class Il endpoint devices support
the media stream capabilities in addition to the capabilities of generic
endpoint devices.

e Class lll—A communication endpoint device. The class Il endpoint
devices directly support end users of the IP communication system.
Providing all capabilities of generic and media endpoint devices, Class
Il endpoint devices are used directly by end users.
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Field

Description

Media policy type

Available options include:
e Unknown

e Voice

e Voice signaling

e Guest voice

e Guest voice signaling
o Soft phone voice

e Videoconferencing

e Streaming video

e Video signaling

Unknown Policy

Indicates whether or not the media policy type is unknown.

VLAN tagged

Indicates whether or not packets of the media VLAN are tagged.

Media policy VlanID

ID of the media VLAN.

Media policy L2 priority

Layer 2 priority.

Media policy Dscp

DSCP precedence.

HardwareRev

Hardware version of the neighbor.

FirmwareRev

Firmware version of the neighbor.

SoftwareRev

Software version of the neighbor.

SerialNum

The serial number advertised by the neighbor.

Mcmufc:cturer name

The manufacturer name advertised by the neighbor.

Model name

The model name advertised by the neighbor.

Asset tracking identifier

Asset ID advertised by the neighbor. This ID is used for the purpose of
inventory management and asset tracking.

PoE PSE power source

The type of PSE power source advertised by the neighbor:
e Primary

e Backup

Port PSE priority

Available options include:

e Unknown—The PSE priority of the port is unknown.
o Critical—The priority level 1.

e High—The priority level 2.

e Low—The priority level 3.
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a. The Statistic Information tab

Laocal Information | Meighbor Infarmation Status Information

LLDP statistics information of port 10 [GigebitEthernetl/0,/10]:
The number of LLDE ames transmitted 27

The number of LLDE ames receiwved

The number of LLDE ames discarded

The number of LLDP error frames

The mumbker of LLDP TLV:z discarded

The mumbker of LLDE TLVs unrecognized

The mumbker of LLDP neighbor informaticon aged ocut
The number of CDPF frames transmitted

The number of CDP frames received

The mumber of CDP frames discarded

The number of CDP error frames

(=T

[ T I e T
o oin

[ I T

4

Fefresh

b. The Status Information tab

Laocal Information | Meighbor Information | Statistic Information

Port 10 [GigebitEthernetl/0/10]:

Port status of LLLF : Enakle
Admin status + Tx_Bx
ITrap flag : No
Polling interval : 0=

Number
Number
HNumber
Number
Number

neighkors: 2
MED neighbors : 0
CDP neighbors : 0
3ent cpticnal TLV : 22
received unknown TLV : 0O

[ S R R

Fefresh

Return to LLDP configuration task list.

Displaying global LLDP information

Select Network - LLDP from the navigation tree, and click the Global Summary tab to display global local
LLDP information and statistics, as shown in a.
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a. The Global Summary tab

Part Setup Global Setup FHeighbar Surmmary

Laocal Informatian

Global LLDP local-information:

Chassis ID S000fte000-0002

System name CHP w1910 Switch

System description : HP %1910-168G Switch Software Version 5.20 Alpha 1108
Copyright (o) 2004-2011 Hewlett-Packard Developrment Company, L.P.

Systemn capahilities supported : Bridge, Router

System capabilities enahled  Bridge, Router

MED infarmation
Device class: Connectivity device

HardwareRey -REV.H
FirmuwareR ey ©138

Statistic Information

LLDP statistics global information:

LLDF neighbor information last change time:0 days,l0 hours,47 minutes,39 seconds
The number of LLDP neighbor information inserted : 5

The rmmbher of LLDP neighbhor information deleted : 0O

The rnumber of LLDP neighbor information dropped @ 66

The rumber of LLDP neighbor information aged out : 0

Refresh
2. Global LLDP information
Field Description
Chassis ID The local chassis ID depending on the chassis type defined.

The primary network function advertised by the local device:
System capabilities

supported * Bridge

e Router

The enabled network function advertised by the local device:
System capabilities

enabled * Bridge

e Router
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Field Description

The device class advertised by the local device:

e Connectivity device—An intermediate device that provide network
connectivity.

o Class I—A generic endpoint device. All endpoints that require the discovery
service of LLDP belong to this category.

e Class lI—A media endpoint device. The class Il endpoint devices support the

media stream capabilities in addition to the capabilities of generic endpoint
devices.

Device class

e Class lll—A communication endpoint device. The class Ill endpoint devices
directly support end users of the IP communication system. Providing all
capabilities of generic and media endpoint devices, Class lll endpoint devices
are used directly by end users.

Return to LLDP configuration task list.

Displaying LLDP information received from LLDP neighbors

Select Network - LLDP from the navigation tree and click the Neighbor Summary tab to display the LLDP
neighbor information, as shown in a.

a. The Neighbor Summary tab

Fart Setup Glohal Setup Glohal Summary
b Search Itern:| Update Time ¥ |Keywords: Search

Undate Time Lacal Port Chassis D Ch?yspsés L PortID Part ID Type Systern Name
0 days Dhours 34 o itEthemet /06 DDe0-fc00-5502 MAC Address  GigabitEthemet!/0i23  Port Narme sysname
minutes 21 seconds
D days Dhours 39 o0y itEthemet! /06 DDe0-fc00-5602 MAC Address  GigahitEthemet!j0i22  Port Narme sysname
minutes 0 seconds
Ddays Dhours 35 o, itEthemet /06 00e0-fo00-5502 MAC Address  GigabitEthemetl/0i23  Port Name hp
minutes 13 seconds
Ddays Dhours 35 0 iEthemett /016 0020-fc00-5502 MAC Address  GigabitEthemnet!/0/23  Fart Name HP
minutes 24 seconds
0days 1 hours 17 oo bitEthemett /06 00e0-fc00-5502 MAC Address  GigabitEthernet!/0/23  Port Name HP

minutes 55 seconds

9records, |5 ¥ perpage | page 142, record 1-5 Mext Last|1

Refresh

Return to LLDP configuration task list.

LLDP configuration examples

Basic LLDP configuration example

Network requirements

As shown in a, the NMS and Switch A are located in the same Ethernet network. Switch A is connected to
a MED device and Switch B through ports GigabitEthernet 1/0/1 and GigabitEthernet 1/0/2,
respectively.
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Enable LLDP on the ports of Switch A and Switch B to monitor the link between Switch A and Switch B and
the link between Switch A and the MED device on the NMS.

a. Network diagram for basic LLDP configuration

GE1/0/1

GE1/0/2 GE1/0/1 @

Switch A Switch B

Configuration procedure
Table 61 Configure Switch A

# Enable LLDP on GigabitEthernet 1/0/1 and GigabitEthernet 1/0/2. This step is optional, because LLDP
is enabled on Ethernet ports by default.

# Set the LLDP operating mode to Rx on GigabitEthernet 1/0/1 and GigabitEthernet 1/0/2.

o Select Network - LLDP from the navigation tree to enter the Port Setup tab, as shown in b. Select port
GigabitEthernet 1/0/1 and GigabitEthernet 1/0/2 and click Modify Selected. The page shown in ¢

appears.
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b.

b Search ttern: | Port Name

O

The Port Setup tab

Glohal Setup

Fart Mame

GigabitEthernet1/0/1
GigahitEthernet!/0i2

I A o I A 0 Y R

GigabitEthernet1/0/3
GigabitEthernet1/0/4
GigahitEthernet1 /015
GigahitEthernet! /G
GigabitEthernet1/0i7
GigahitEthernet1/0/8
GigabitEthernet1 /09
GigabitEthernet1/0/10
GigahitEthernet1 0511
GigabitEthernet1 i1 2
GigabitEthernet1/0i13
GigabitEthernet! /0514
GigahitEthernet1/i14

Global Summary

¥ |Keywords:

Enabled
Enahled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled

LLDF Status

20records,| 18 |per page | page 1/2, record

Enable Dizahle

Meighhor Summary

Search

TxRx
THRx
TeRx
THR¥
TiRx
TeRx
THRY
TRx
TeRx
THR¥
TiRx
TeRx
THRY
THRx
TR

Modify Selected

keighboar Information | Statistic Information | Status Information
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c. The page for setting LLDP on multiple ports

Global Setup

Interface Mame

Basic Settings

Global Summary

Meighbor Summary

GigahitEthernet1/01 GigahitEthernet1/0/2

LLDP Operating Mode | Rx v
CDP Operating Mode |Disah|e V|
LLOP Trapping |Disah|e V|

Base TLV Seftings

Encapsulation | ETHI

|

Format

LLDP Palling Interval |

ClPort Description

[ system Description

CIManagement Address

~+2ddtional Settings

[ systern Capabilities

[ system Name

|String V|

seconds(i-
30

Apply Cancel

o Select Rx from the LLDP Operating Mode drop-down list.

o Click Apply.
# Enable global LLDP.

e  Click the Global Setup tab, as shown in d.
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d. The Global Setup tab

Paort Setup Global Summary Meighbor Summary

Global Setup

LLDF Enahle | Enable v|

CDP Compatibiliy | Disable v

FastLLOFBU g |(1-10, Default = 3}

TTL Multiplier |4 |[2—1I:|_ Default = 4)

Trap Interval |5 |Sen:n:unn:|[5—35[|l:|. Default = 5
Reinit Delay |2 |Secnnd[1—1ﬂ. Default = 2)

Tx Delay |2 |second(1-8192, Default = 2)
Tx Interval |3IZI |Secnnd[5—32?58. Default = 20]

Apply

o Select Enable from the LLDP Enable drop-down list.

o Click Apply.

Table 62 Configure Switch B

# Enable LLDP on port GigabitEthernet 1/0/1. (Optional. By default, LLDP is enabled on Ethernet ports.)

# Set the LLDP operating mode to Tx on GigabitEthernet 1/0/1.

o Select Network - LLDP from the navigation tree to enter the Port Setup tab, as shown in e. Click the
B4 icon for port GigabitEthernet 1/0/1. The page shown in f is displayed.

e. The Port Setup tab

Global Setup Global Summary Meighbor Summary
P Search ltem:| Port Mame - |Keywu:|rds:| | Search
F] Part Mame LLDOP Status LLDP Wark Mode Cperation
||:| GigabitEthernet1/01 Enabled TxRx B |
] GigabitEthernet1/0/2 Enabled TxRx B
] GigabitEthernet1/0/3 Enabled TxRx B
] GigabitEthernet1/0/4 Enabled TxRx B
M1 ZinakhitEtharnot1 NS Friahlad TwRw r‘@l
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f.  The page for configuring LLDP on the selected port

Global Setup Global Summary Meighbor Summary
Interface Mame LLDP State
Basic Settings
LLDP Operating Mode ‘Tx w ‘ Encapsulation Format ‘ ETHII A |
CDP Operating Mode | Disable v LLDP Poling Interval | | HS_E;D”:”E'S
LLDP Trapping ‘Disahle V‘

Base TLY Settings

[“lPart Description [¥] Systern Capabiliies
System Description System Name

[ Management Address | |

|Numher V|

+iddtional TLV Seftings

Apply Cancel

o Select Tx from the LLDP Operating Mode drop-down list.
e  Click Apply.
# Enable global LLDP and configure the global LLDP setup as needed (see d).
o Click the Global Setup tab.
o Select Enable from the LLDP Enable drop-down list.
e  Click Apply.
Configuration verification
# Display the status information of port GigabitEthernet 1/0/2 on Switch A.
o Select Network - LLDP from the navigation tree to enter the Port Setup tab.
o  Click GigabitEthernet1/0/2 in the port list.

o Click the Status Information tab at the lower half of the page. The output shows that port
GigabitEthernet 1/0/2 is connected to a non-MED neighbor device (Switch B), as shown in a.
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a. The Status Information tab

Lacal Infomation | Meighbar Infamation | Statistic Infomation

Fs
ocrt 2 [GigabitEthernetl/0/2]:
Port status of LLLDE : Enakle
Admin status : Bx_Only
Trap f£lag : Ho
Polling interval : 0=
Nunber of neighbors: 1
Nunber of MED neighbors : 0
Number of CDP neighbors : 0
Number of sent opticnal TLV : 0
Humber of received unknown TLV @ 3
-
Refresh

# Tear down the link between Switch A and Switch B.

# Display the status information of port GigabitEthernet 1/0/2 on Switch A.

o Click Refresh. The updated status information of port GigabitEthernet 1/0/2 shows that no neighbor
device is connected to the port, as shown in b.

b. The Status Information tab displaying the updated port status information

Lacal Infomation | Meighbar Infamation | Statistic Infomation

Fs
Port 2 [GigebkitEthernstl/0/2]:
Port status of LLLOE : Enakle
Admin status : Bx Only
Trap £lag : Ho
Polling interval : 0=
Number of neighbors: : 0
Number of MED neighbors : 0
Nunber of CDP neighbors : 0
Nunber of sent opticnal TLV : 0
Number of received unknown TLV : 0
-
Refresh

CDP-compatible LLDP configuration example

Network requirements

As shown in o, port GigabitEthernet 1/0/1 and GigabitEthernet 1/0/2 of Switch A are each connected to
a Cisco IP phone.

On Switch A, configure VLAN 2 as a voice VLAN and enable CDP compatibility of LLDP to allow the Cisco
IP phones to automatically configure the voice VLAN, confining their voice traffic within the voice VLAN to
be isolated from other types of traffic.
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a. Network diagram for CDP-compatible LLDP configuration

@ GE1/0/1 @GEHOQ @

Cisco IP phone 1 Switch A Cisco IP phone 2

Configuration procedure

# Create VLAN 2.

o Select Network - VLAN from the navigation bar and click the Create tab to enter the page shown in
a.

a. The page for creating VLANs

Select VLAM Part Detail Detail Madify YLAN Madify Part Remave
Create:
VLAM IDs: 2 Example:2, 5-10
Create
D Descriptian
1 WLARM 0001

Madify VLAMN description (Maote: you can do this later an the Maodify VLAMN page)
Modify the description of the selected VLAN:
D Description

{1-32 Chars.)

e Type 2 in the VLAN IDs field.
e  Click Create.

# Configure GigabitEthernet 1/0/1 and GigabitEthernet 1/0/2 as trunk ports.

o Select Device > Port Management from the navigation bar and click the Setup tab to enter the page
shown in b.
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b. The page for configuring ports

Summary Detail

Basic Configuration

PortState | Mo Change v Speed Mo Change hd Duplex Mo Change »

|Lmkenpe [Tk ]| Oe [ Jaoe
Advanced Configuration

f1n]] MNo Change % Elnomrol Mo Change %

Power Save | No Change v gsﬁﬁr‘c [No Change  v|| |(0-8122)

Storm Suppression

Broadeast  |1Me Change v WMutticast /0 Change Unicast No Change |

pps range (1-1482810 for a 100 Mbps port, 1-1488100 for a GE port, and 1-14881000 for a 10GE port)
kkbps range (1-102400 for a 100 Mbps port, 1-1024000 for a GE port, and 1-10240000 for a 10GE port)

H HP V1910-16G Sw...
el lelelvlej[T]e]e]a]

Select All Select None

Unit Selected Ports

+ |t may take some time if you apply the above settings to multiple ports. Apply Cancel

o Select Trunk in the Link Type drop-down list.

o Select port GigabitEthernet 1/0/1 and GigabitEthernet 1/0/2 on the chassis front panel.
o Click Apply.

# Configure the voice VLAN function on the two ports.

o Select Network > Voice VLAN from the navigation bar and click the Port Setup tab to enter the page
shown in c.
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C.

The page for configuring the voice VLAN function on ports

Summary Setup QU Summary QU Add QLI Remaove

Woice WLAN port mode:
Woice YLAN port state:
Voice WVLAMN 1D 2 (2_4094)

Select ports:

Select Al Select Mane

Ports selected for voice WLAN:

GE1/0M-GE10r2

Cancel

Select Auto in the Voice VLAN port mode drop-down list.

Select Enable in the Voice VLAN port state drop-down list.

Type 2 in the Voice VLAN ID field.

Select ports GigabitEthernet 1/0/1 and GigabitEthernet 1/0/2 on the chassis front panel.
Click Apply.

# Enable LLDP on ports GigabitEthernet 1/0/1 and GigabitEthernet 1/0/2. If LLDP is enabled (the default
setting), skip this step.

# Set both the LLDP operating mode and the CDP operating mode to TxRx on ports GigabitEthernet 1/0/1
and GigabitEthernet 1/0/2.

Select Network - LIDP from the navigation tree to enter the Port Setup tab. Select ports
GigabitEthernet 1/0/1 and GigabitEthernet 1/0/2 and click Modify Selected, as shown in d. The
page shown in e is displayed.
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d.

b Search ttern: | Port Mame

O

The Port Setup tab

Global Setup

Fart Mame

GigahitEthernet1/0M1
GigahitEthernet1/0/2

I o v o

GinabitEthernet1/0/3
GigahitEthernet1/0/4
GigahitEthernet1/0/5
GinabitEthernet1/0/6
GigahitEthernet /0T
GigahitEthernet1/0/8
GigabitEthernet1/0/9
GigahitEthernet1/0/10
GigahitEthernet1/0/11
GigabitEthernet1/0/12
GinabitEthernet1/0/13
GigahitEthernet1/0/14
GigahitEthernet1/0/14

Global Summary

¥ | Keywords:

Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled

Enahle

LLDF Status

20records,| 19 ™ |per page | page 172, record 1-15 |

Meighbor Surnrmary

Search

TxRx
TxRx
TuRx
TxRx
TxRx
TxRX
TuRx
TxRx
TRy
TxRX
TxRx
TxRx
TuRx
TxRx
TxRx

LLDP Work Mode

Disahle

Modify Selectad

Meighbor Infarmation | Statistic Information | Status Information
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e. The page for modifying LLDP settings on ports

Global Setup Global Summary Meighbor Summary
Interface MName GigabitEthernet1/0/M1 GigahitEthernet1/0/2
Basic Seftings
} Encapsulation
LLDP Qperating Mode |TxRx V| Format |ETHII V|
CDP Operating Mode | TxRx v| LLDP Palling Interval | | [%Szcufflnds

LLDF Trapping | Disahble v |

Base TLV Settings

CJPort Description [ system Capabilities

] System Description ¥ System Mame

|:|r-.-1anagement.i‘xdclress | |

|String V|

~+xddtional Settings

Apply Cancel

o Select TxRx from the LLDP Operating Mode drop-down list.
o Select TxRx from the CDP Operating Mode drop-down list.
e Click Apply.

# Enable global LLDP and CDP compatibility of LLDP.

o  Click the Global Setup tab, as shown in f.
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f.  The Global Setup tab

Part Setup Global Summary Meighbar Summary

Global Setup

LLDP Enable |Enable v|

CDP Compatibility | Enable v|

JESLLBRDE g |(1-10, Default = 3)

TTL Multiplier 4 |(2-10, Default = 4}

Trap Interval 5 | Second(5-3600, Default = 5)
Reinit Delay |2 |Seu:|:|n|:|[1—1lil. Default = 2}

Tx Delay 2 |Second(1-8192, Default = 2)
Tx Interval |3|I| |Secnnd[5—32?58. Default = 30)

Apply

o Select Enable from the LLDP Enable drop-down list.
o Select Enable from the CDP Compaitibility drop-down list.
e Click Apply.
Configuration verification
# Display information about LLDP neighbors on Switch A.

Display information about LLDP neighbors on Switch A after completing the configuration. You can see that
Switch A has discovered the Cisco IP phones attached to ports GigabitEthernet 1/0/1 and GigabitEthernet
1/0/2 and obtained their device information.

Configuration guidelines

When configuring LLDP, follow these guidelines:
Table 63 To make LLDP take effect, you must enable it both globally and on poris.
Table 64 When selecting TLVs to send in LLDPDUs, note the following:
o To advertise LLDP-MED TLVs, you must include the LLDP-MED capabilities set TLV.
o To remove the LLDP-MED capabilities set TLV, you must remove all other LLDP-MED TLVs.
o To remove the MAC/PHY configuration TLV, remove the LLDP-MED capabilities set TLV first.

o Ifthe LLDP-MED capabilities set TLV is included, the MAC/PHY configuration/status TLV is included
automatically.
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IGMP snooping configuration

Overview

Internet Group Management Protocol (IGMP) snooping is a multicast constraining mechanism that runs on
Layer 2 devices to manage and control multicast groups.

Principle of IGMP snooping

By analyzing received IGMP messages, a Layer 2 device running IGMP snooping establishes mappings
between ports and multicast MAC addresses and forwards multicast data based on these mappings.

As shown in a, when IGMP snooping is not running on the switch, multicast packets are flooded to all
devices at Layer 2. However, when IGMP snooping is running on the switch, multicast packets for known
multicast groups are multicast to the receivers, rather than broadcast to all hosts, at Layer 2.

a. Multicast forwarding before and after IGMP snooping runs

Multicast packet transmission
without IGMP Snooping

Multicast packet transmission
when IGMP Snooping runs

Multicast router Multicast router

Source Source

Layer 2 switch Layer 2 switch

N

Host A Host C
Receiver Receiver

Host B

Host A Host C
Receiver Receiver

Host B

|
|
|
|
|
|
|
|
|
|
|
v i
|
|
|
|
|
|
|
|
|
|
|

——» Multicast packets

IGMP snooping related ports

As shown in a, Router A connects to the multicast source, IGMP snooping runs on Switch A and Switch B,
Host A and Host C are receiver hosts (namely, multicast group members).
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a. IGMP snooping related ports

Router A Switch A

GE1/0/1 GE1/0/2

Source

Switch B
@) Router port
O Member port

— > Multicast packets

Host D

IGMP snooping related ports include:

e Router port: A router port is a port on an Ethernet switch that leads the switch towards the Layer 3
multicast device (DR or IGMP querier). In the figure, GigabitEthernet 1/0/1 of Switch A and
GigabitEthernet 1/0/1 of Switch B are router ports. A switch registers all its local router ports in its

router port list.

e Member port: On an Ethernet switch, a member port (also known as multicast group member port)
connects the switch to a multicast group member. In the figure, GigabitEthernet 1/0/2 and
GigabitEthernet 1/0/3 of Switch A and GigabitEthernet 1/0/2 of Switch B are member ports. A
switch registers all its member ports in the IGMP snooping forwarding table.

NOTE:

o Inthis document, a router port is a port on the switch that leads the switch to a Layer 3 multicast device,

rather than a port on a router.

o Unless otherwise specified, router ports and member ports in this document consist of dynamic and

static ports.

o An IGMP snooping enabled switch deems that all its ports on which IGMP general queries with the
source address other than 0.0.0.0 or PIM hello messages are received to be router ports.

Work mechanism of IGMP snooping

A switch running IGMP snooping performs different actions when it receives different IGMP messages, as

follows:

/\ CAUTION:

You can add or delete only dynamic ports rather than static ports.

When receiving a general query

The IGMP querier periodically sends IGMP general queries to all hosts and routers (224.0.0.1) on the local
subnet to find out whether any active multicast group members exist on the subnet.
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After receiving an IGMP general query, the switch forwards it through all ports in the VLAN except the
receiving port and performs the following to the receiving port:

o The switch resets the aging timer for the receiving port if the port is in the router port list.

o The switch adds the receiving port to the router port list if it is not in the list and starts the aging timer
for the port.

When receiving a membership report

A host sends an IGMP membership report to the IGMP querier in the following circumstances:
o After receiving an IGMP query, a multicast group member host responds with an IGMP report.

e When intended to join a multicast group, a host sends an IGMP report to the querier to announce its
interest in the multicast information addressed to that group.

After receiving an IGMP report, the switch forwards it through all the router poris in the VLAN, resolves the
address of the reported multicast group, and performs the following:

e If noforwarding table entry exists for the reported group, the switch creates an entry, adds the port as
a member port to the outgoing port list, and starts @ member port aging timer for that port.

o Ifaforwarding table entry exists for the reported group, but the port is not included in the outgoing port
list, the switch adds the port as a member port to the outgoing port list, and starts a member port aging
timer for that port.

e If a forwarding table entry exists for the reported group and the port is not included in the outgoing
port list, the switch resets the member port aging timer for that port.

NOTE:

A switch does not forward an IGMP report through a non-router port. If the switch forwards a report
message through a member port, all the attached hosts listening to the reported multicast address will
suppress their own reports after hearing this report according to the IGMP report suppression mechanism
on them. This will prevent the switch from knowing whether any hosts attached to that port are still active
members of the reported multicast group.

When receiving a leave group message

When an IGMPv1 host leaves a multicast group, the host does not send an IGMP leave message, so the
switch cannot know immediately that the host has left the multicast group. However, as the host stops
sending IGMP membership reports as soon as it leaves a multicast group, the switch deletes the forwarding
entry for the member port corresponding to the host from the forwarding table when its aging timer expires.

When an IGMPv2 or IGMPv3 host leaves a multicast group, the host sends an IGMP leave message to the
multicast router to announce that it has left the multicast group. When the switch receives a group-specific
IGMP leave group message on a member port, it first checks whether a forwarding table entry for that group
exists, and, if one exists, whether its outgoing port list contains that port.

o If the forwarding table entry does not exist or if the outgoing port list does not contain the port, the
switch discards the IGMP leave group message instead of forwarding it to any port.

o Ifthe forwarding table entry exists and the outgoing port list contains the port, the switch forwards the
IGMP leave group message fo the router ports in the VLAN. Because the switch does not know whether
any other member hosts for that group still exist under the port from which the leave message arrived,
the switch does not immediately remove the port from the outgoing port list. Instead, the switch resets
the member port aging timer for that port.
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After receiving the IGMP leave group message from a host, the IGMP querier resolves from the message the
address of the multicast group that the host just left and sends an IGMP group-specific query to that multicast
group through the port that received the leave group message. After hearing the IGMP group-specific query,
the switch forwards it through all its router ports in the VLAN and all member ports for that multicast group,
and performs the following to the port before the member port aging timer of the port expires (in case it is
a dynamic member port):

e Ifany IGMP report in response fo the group-specific query is heard on a member port before its aging
timer expires, this means that some host attached to the port is receiving or expecting to receive
multicast data for that multicast group. The switch resets the aging timer of the member port.

e I no IGMP report in response to the group-specific query is heard on a member port before its aging
timer expires, this means that no hosts attached to the port are still listening to that group address. The
switch removes the port from the outgoing port list of the forwarding table entry for that multicast group
when the aging timer expires.

IGMP snooping querier

In an IP multicast network running IGMP, a multicast router or Layer 3 multicast switch is responsible for
sending IGMP general queries, so that all Layer 3 multicast devices can establish and maintain multicast
forwarding entries, thus to forward multicast traffic correctly at the network layer. This router or Layer 3
switch is called an IGMP querier.

However, a Layer 2 multicast switch does not support IGMP, and therefore cannot send general queries by
default. By enabling IGMP snooping on a Layer 2 switch in a VLAN where multicast traffic needs to be
Layer-2 switched only and no multicast routers are present, the Layer 2 switch will act as the IGMP snooping
querier to send IGMP queries, thus allowing multicast forwarding entries to be established and maintained
at the data link layer.

Protocols and standards

e RFC 4541, Considerations for Internet Group Management Protocol (IGMP) and Multicast Listener
Discovery (MLD) Snooping Switches

Contiguring IGMP snooping

Configuro’rion task list

Task Remarks
Enabling IGMP snooping Required
globally Disabled by default.
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Task Remarks

Required
Enable IGMP snooping in the VLAN and configure the IGMP snooping version

and querier feature.

o ) By default, IGMP snooping is disabled in a VLAN.
Contiguring IGMP snooping

in a VIAN ( IMPORTANT:
e IGMP snooping must be enabled globally before it can be enabled in a
VLAN.

e When you enable IGMP snooping in a VLAN, this function takes effect for
ports in this VLAN only.

Optional

Configure the maximum number of multicast groups allowed and the fast leave
function for ports in the specified VLAN.

Contiguring IGMP snooping (D IMPORTANT:

port functions o IGMP snooping must be enabled globally before IGMP snooping can be

enabled on a port.

e IGMP snooping configured on a port takes effect only after IGMP snooping
is enabled in the VLAN.

Display IGMP snooping

multicast entry information

Optional

Enabling IGMP snooping globally

Select Network > IGMP Snooping in the navigation tree fo enter the basic configuration page shown in a.

a. Basic IGMP snooping configurations

Advanced

IGMP Snooping: () Enahle () Dizahle Apply

WLAM Configuration

B Search tern: | WLAN 1D ¥ | Keywaords: Search

Cllery .
WLAR  IGMP . . GeneralGuery SpecialCuery .
D Snooping Yersion  Dirop Unknown Gluerier !:r;tsgal o Sl Cperation
1 Disabled 2 Disahled Disahled B0 0.0.0.0 0.0.0.0
9949  Enahled 2 Dizahled Dizahled 60 1.1.1.1 1.1.1.2

+Show Entries

255



2. IGMP snooping configuration items

ltem Description

IGMP snooping Globally enable or disable IGMP snooping.

Return to Configuration task list.

Contfiguring IGMP snooping in a VLAN

Select Network > IGMP Snooping in the navigation tree to enter the basic configuration page shown in a.
Click the B icon corresponding to the VLAN to enter the page you can configure IGMP snooping in the

VLAN, as shown in a.
a. VLAN configuration

Advanced

WLAM Confiquration

WLAN 1D 1

IGMP Snooping: {E}Enahle
Yersion: (O
Drap Unkn o ) Enahble
Querier: ) Enahble
Query Interval: B0

= B0}
General Query Source IP: n.0.0.0
Special Query Source [P 0.0.0.0

() Disahle
C3

() Dizahle
(%) Disahle

*Secaonds (2-300, Default

*IF Address

*IP Address

[terms marked with an asterisk(™ are required

Cancel

2. ltems for configuring IGMP snooping in a VLAN

ltem Description

VLAN ID This field displays the ID of the VLAN to be configured.

Enable or disable IGMP snooping in the VLAN.

IGMP Snooping

You can proceed with the subsequent configurations only if Enable is selected here.

By configuring an IGMP snooping version, you actually configure the versions of
IGMP messages that IGMP snooping can process.

Version

e IGMP snooping version 2 can process IGMPv1 and IGMPv2 messages, but not
IGMPv3 messages, which will be flooded in the VLAN.

o IGMP snooping version 3 can process IGMPv1, IGMPv2, and IGMPv3

messages.
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ltem Description

Enable or disable the function of dropping unknown multicast packets.

Unknown multicast data refer to multicast data for which no entries exist in the IGMP
snooping forwarding table.

o With the function of dropping unknown multicast data enabled, the switch drops

Drop Unknown ’ >
all the unknown multicast data received.

o With the function of dropping unknown multicast data disabled, the switch floods
unknown multicast data in the VLAN to which the unknown multicast data
belong.

Enable or disable the IGMP snooping querier function.

On a network without Layer 3 multicast devices, no IGMP querier-related function
can be implemented because a Layer 2 device does not support IGMP. To address

Querier
this issue, you can enable IGMP snooping querier on a Layer 2 device so that the
device can generate and maintain multicast forwarding entries at data link layer,
thereby implementing IGMP querier-related functions.

Query interval Configure the IGMP query interval.

General Query Source  Specify the source IP address of general queries. HP recommends you to configure a
IP non-all-zero IP address as the source IP address of IGMP queries.

Special Query Source  Specify the source IP address of group-specific queries. HP recommends you fo
IP configure a non-all-zero IP address as the source IP address of IGMP queries

Return to Configuration task list.

Contiguring IGMP snooping port functions

Select Network - IGMP Snooping in the navigation tree fo enter the basic configuration page and then
click the Advanced tab to enter the page shown in a.

a. Advanced configuration

Basic
Fort Configuration
Port: Flease select a pot | #
YLAM IO *1-4094, example: 3,5-10% Up o 10 WLAMN
ranges can be specified.
mMulticast Group Lirmit: {1-288)
Fast Leave: () Enable (*) Disable
[terns marked with an asterisk(™ are required
Apply
b Search ttern:| YLAM D ¥ | eywnrds: Search
WA D Multicast Group Limit Fast Leave Dperation
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2. Configuration items for advanced IGMP snooping features

ltem Description

Select the port on which advanced IGMP snooping features are to be configured. The port
can be an Ethernet port or Layer-2 aggregate port.

After a port is selected, advanced features configured on this port are displayed at the
lower part of this page.

Port @ IMPORTANT:

Advanced IGMP snooping features configured on a Layer 2 aggregate port do not interfere
with features configured on its member ports, nor do they take part in aggregation
calculations; features configured on a member port of the aggregate group will not take
effect until it leaves the aggregate group

Specify a VLAN in which you can configure the fast leave function for the port or the
VIAN ID maximum number of multicast groups allowed on the port.

Configurations made in a VLAN take effect for the ports in this VLAN only.

Configure the maximum number of multicast groups that the port can join.

With this feature, you can regulate multicast traffic on the port.

Group Limit @ IMPORTANT:

When the number of multicast groups a port has joined reaches the configured threshold, the
system deletes all the forwarding entries persistent on that port from the IGMP snooping
forwarding table, and the hosts on this port need to join the multicast groups again.

Enable or disable the fast leave function for the port.

With the fast leave function enabled on a port, the switch, when receiving an IGMP leave
message on the port, immediately deletes that port from the outgoing port list of the
corresponding forwarding table entry. Then, when receiving IGMP group-specific queries
for that multicast group, the switch does not forward them to that port. In VLANs where

Fast Leave only one host is attached to each port, the fast leave function helps improve bandwidth
and resource usage.

@ IMPORTANT:

If fast leave is enabled for a port to which more than one host is attached, when one host
leaves a multicast group, the other hosts listening to the same multicast group fails fo receive
multicast data.

Return to Configuration task list.

Display IGMP snooping multicast entry information

Select Network > IGMP Snooping in the navigation tree to enter the basic configuration page shown in a.
Click the plus sign (+) in front of Show Entries to display information about IGMP snooping multicast entries,
as shown in a. You can view the detailed information of an entry by clicking the “ icon corresponding to
the entry.
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a. Display entry information
—5Show Entries

b Search ttem: | VLAN ID |+ Ke-,-‘-m‘-:url:ls:| Search

YLAM D Source Group Qperation
100 0.00.0 224111 =X

b. Information about an IGMP snooping multicast entry

Entry Details

WLAMN 1D: 100

Source Address: 0.0.0.0

Group Address: 224144

Router Port(s): GigahitEthernet1051
mMember Port(s): GigahitEthernet1/0r3

Back

2. Description of IGMP snooping multicast entries

ltem Description

VLAN ID ID of the VLAN to which the entry belongs

Source Address Multicast source address, where 0.0.0.0 indicates all multicast sources.
Group Address Multicast group address

Router Port(s) All router ports

Member Port(s) All member ports

Return to Configuration task list.

IGMP snooping configuration example

Network requirements

e Asshown in a, Router A connects to a multicast source (Source) through Ethernet 1/2, and to Switch
A through Ethernet 1/1.

e The multicast source sends multicast data to group 224.1.1.1. Host A is a receiver of the multicast
group.

e IGMPv2 runs on Router A and IGMP snooping version 2 runs on Switch A.

e The function of dropping unknown multicast packets is enabled on Switch A to prevent Switch A from
flooding multicast packets in the VLAN if no corresponding Layer 2 forwarding entry exists.

o The fast leave function is enabled for GigabitEthernet 1/0/3 on Switch A to improve bandwidth and
resource usage.
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a. Network diagram for IGMP snooping configuration

1.1.1.1/24

‘ Eth1/2%ah1/1 GE1/0/1

Router A Switch A Host A
IGMP querier Receiver

Source

Configuration procedure
Table 65 Configure IP addresses

Contfigure the IP address for each interface as per a. The detailed configuration steps are omitted.
Table 66 Configure Router A

Enable IP multicast routing, enable PIM-DM on each interface, and enable IGMP on Ethernet 1/1. The
detailed configuration steps are omitted.

Table 67 Configure Switch A

# Create VLAN 100 and add GigabitEthernet 1/0/1 through GigabitEthernet 1/0/3 to VLAN 100.

o Select Network > VLAN in the navigation tree and click the Create tab to enter the configuration page
shown in b.
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b.

Create VLAN 100
Select VLAM Part Detail Detail hl o ify WLARM Modify Port
Create:
WLAN IDs: 1on Example:3, 5-10
Create
0 Description
1 WLAR 0001

Modify YLAMN description (Mote: vou can do this later on the Maodify VLAN page)
Modify the description of the selected YLAM:
IO Description

(1-32 Chars.)

Type the VLAN ID 100.
Click Apply to complete the operation.
Click the Modify Port tab to enter the configuration page shown in c.

261

Remove



C.

Add a port to the VLAN
SelectVLAN Create Port Detail Cietail Modify WLAMN Remove
Select Por

HP 1810-24¢

Select All Select Mone

. Mot avaliable for selection

Select membership type:

@ Untagged O Tagoed O Mot A Member ) Link Type O PYID

Enter VLAM IDs to which the portis to be assigned:

YLAM IDs: [100 Example: 1,3,5-10

Selected ports:

Untagoged Memhbership
GE1I0M-GE1/0r3

Apply Cancel

Select GigabitEthernet 1/0/1, GigabitEthernet 1/0/2, and GigabitEthernet 1/0/3 in the Select Ports
field.

Select the Untagged radio button for Select membership type.
Type the VLAN ID 100.
Click Apply to complete the operation.

# Enable IGMP snooping globally.

Select Network - IGMP snooping in the navigation tree to enter the basic configuration page as
shown in d.
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d. Enable IGMP snooping globally

Advanced

IGMP Snooping: (%) Enable (O Disable Apply

WA Configuration

b Search itern:| YLAN 1D | Keywords: Search
Cllery )

WLAM 1GNP . . GeneralGuery Special@uerny .
D Snooping Yersion  Drop Unknown  Cluerier ::rét:;.:al SourcelP SourcelP Dperation
1 Dizahled 2 Disabled Disahled B0 0.0.0.0 n.0.0.0

100 Disabled 2 Disabled Dizsahled B0 0.0.0.0 n.0.0.0

995 Enabled 2 Disabled Disahled B0 1.1.1.1 1.1.1.2
~+Show Entries

e Select Enable and click Apply to globally enable IGMP snooping.
# In VLAN 100, enable IGMP snooping and the function of dropping unknown multicast data.

e  Click the E¥ icon corresponding to VLAN 100 to enter its configuration page and perform the
following configurations, as shown in e.

e. Configure IGMP snooping in the VLAN

Advance

YA Configuration

YLAM 10 100

IGMP Snooping: (&) Enahle C Disable

Yarsion: ®z O3

Drop Unknown: &) Enahle C Disable

Querier: ) Enable ¥ Disable

Cluery Interval: G0 *Seconds (2-300, Default= 60)
General Query Source P 0.0.0.0 *IP Address (Default= 0.0.0.0)
Special Query Source P 0.0.0.0 *IP Address (Default= 0.0.0.0)

[tems marked with an asterisk(™ are required

Apply Cancel

o Select the Enable radio button for IGMP snooping and 2 for Version.
e Select the Enable radio button for Drop Unknown.

e  Select the Disable radio bution for Querier.
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e  Click Apply to complete the operation.

# Enable the fast leave function for GigabitEthernet 1/0/3.
e  Click the Advanced tab.

f.  Configure IGMP snooping on GigabitEthernet 1/0/3

Basic

Port Configuration

Fort: |GigahitEthernet1fDG 1~~-*|

VLAN ID: 100 *(1-4084| example: 3,5-10) Up to 10 WLAN

ranges can be specified.

mMulticast Group Lirmit: | |.:1-255;.

Fast Leave: () Enahle ) Disable
[tems marked with an asterisk{*) are required

Apply
P Search ftem:| YLAN 1D 1'*’|P<e~,-'-.fw:|r|:|5:| Search
WLAR D Multicast Group Limit Fast Leave Qperation

e Select GigabitEthernet 1/0/3 from the Port drop-down list.
e Type the VLAN ID 100.
e  Select the Enable radio button for Fast Leave.

e Click Apply to complete the operation.
Configuration verification

# Display the IGMP snooping multicast entry information on Switch A.
o Select Network > IGMP Snooping in the navigation tree to enter the basic configuration page.

o Click the plus sign (+) in front of Show Entries in the basic VLAN configuration page to display
information about IGMP snooping multicast entries, as shown in a.

a. IGMP snooping multicast entry information displaying page
= Show Entries
b Search item:| VLAN ID % Keywords: | Search

YLAMN ID Source Group Dperation
100 0.0.0.0 224111 Z

b

o Click the " icon corresponding to the multicast entry (0.0.0.0, 224.1.1.1) to view information about
this entry, as shown in b.

264



b. Details about an IGMP snooping multicast entry

Entry Details

WLAN 1D 100

Source Address: 0.0.0.0

Group Address: 224111

Router Port{s): GigabitEtherneti oM
Member Pori(s): GigahitEthernet1/0r3

Back

As shown above, GigabitEthernet 1/0/3 of Switch A is listening to multicast streams destined for multicast
group 224.1.1.1.
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Routing configuration

NOTE:

The term router in this document refers to a switch supporting routing function.

Upon receiving a packet, a router determines the optimal route based on the destination address and
forwards the packet to the next router in the path. When the packet reaches the last router, it then forwards
the packet to the destination host.

Routing table

Routers forward packets through a routing table. Each entry in the table specifies a physical interface that
packets destined for a certain address should go out to reach the next hop—the next router—or the directly
connected destination.

Routes in a routing table fall into three categories by origin:
e Direct routes—Routes discovered by data link protocols, also known as “interface routes”.
e Static routes—Routes that are manually configured.

e Dynamic routes—Routes that are discovered dynamically by routing protocols.

A route entry has the following key items:

e Destination IP address—Destination IP address or destination network.

e Mask—Specifies, together with the destination address, the address of the destination network.

e Outbound interface—Specifies the interface through which a matching IP packet is to be forwarded.
e Next hop—Specifies the address of the next hop router on the path.

e Preference of the route—Routes to the same destination can be found by various routing protocols or
manually configured; routing protocols and static routes are assigned different preferences. The route
with the highest preference (the smallest value) is selected as the optimal route.

Static route

Static routes are manually configured. If a network’s topology is simple, you only need to configure static
routes for the network to work properly. The proper configuration and usage of static routes can improve
network performance and ensure bandwidth for important network applications.

The disadvantage of using static routes is that they cannot adapt to network topology changes. If a fault or
a topological change occurs in the network, the routes will be unreachable. The network administrator has
to modify the static routes manually.

While configuring a static route, specity either the output interface or the next hop address as needed. The
next hop address cannot be a local interface IP address; otherwise, the route configuration will not take
effect.

It is necessary to identify next hop addresses for all route entries because the router needs to use the next
hop address of a matching entry to resolve the corresponding link layer address.
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Default route

A default route is used to forward packets that match no entry in the routing table. Without a default route,
the packet is discarded.

An IPv4 static default route has both its destination IP address and mask being 0.0.0.0.
Contiguring IPv4 routing

Displaying the IPv4 active route table
Select Network > IPv4 Routing from the navigation tree to enter the page shown in a.
a. Active route table

Create Remaove

Active route table

Destination IP Address Mask FPratacol Freference Mext Hap Interface
127.00.0 000 Direct 0 127.001 InLoopBackn
127.0.01 258 5.2 Direct 0 127.0.01 InLoopBackn
192 168.1.0 258 A0 Direct 0 182 168 1.60 Vlan-interface999
192.168.1.60 255,255 255 Direct 0 127.0.01 InLoopBackn
2. Description of the fields of the active route table

Field Description

Destination IP Address Destination IP address of the route

Mask Mask of the destination IP address

Protocol Protocol that discovered the route

Preference value for the route

Preference

The smaller the number, the higher the preference.
Next Hop Next hop IP address of the route

Output interface of the route. Packets destined for the destination IP
Interface

address will be forwarded out the interface.
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Creating an IPv4 static route

Select Network - IPv4 Routing from the navigation tree and click the Create tab to enter the IPv4 static route
configuration page, as shown in a.

a. Create an IPv4 static route

Summary Remove

Destinatien IP

Address
Mask 24 (255255 .255.0) ¥ [ IPreference (1-255,Default=60)
Next Hop O interface
Apply
Configured static route information
Destination IP Address Mask Protocol Preference Mext Hop Interface
2. IPv4 static route configuration items
ltem Description
Destination IP Address Type the destination IP address of the static route, in dotted decimal notation.

Specify the mask of the destination IP address.

Mask Select a mask length (number of consecutive 1s in the mask) or a mask in
dotted decimal notation from the drop-down list.

Type a preference value for the static route. The smaller the number, the higher
the preference.

Preference For example, specifying the same preference for multiple static routes to the
same destination enables load sharing on the routes; specifying different
preferences enables route backup.

Next Hop Type the next hop IP address, in dotted decimal notation.
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ltem Description

Select the output interface.

Interface You can select any available interface, for example, a virtual interface, of the
device. If you select NULL O, the destination IP address is unreachable.

Static route configuration example

Network requirements

The IP addresses of devices are shown in a. Configure IPv4 static routes on Switch A, Switch B, and Switch
C so that any two hosts can communicate with each other.

a.

1

Network diagram for IPv4 static route configuration

Vlan-int500

Vlan-int500

Vlan-int900
1.2. X 1.1.3.1/24
Host A Switch A Switch C Host C

1.2.2/24 1.1.3.2/124

Configuration outlines

Table 68 On Switch A, configure a default route with Switch B as the next hop.

Table 69 On Switch B, configure one static route with Switch A as the next hop and the other with Switch

C as the next hop.

Table 70 On Switch C, configure a default route with Switch B as the next hop.

Configuration procedure

Table 71 Configure the IP addresses of the interfaces (omitted)

Table 72 Configure IPv4 static routes

# Configure a default route to Switch B on Switch A.

Select Network - IPv4 Routing from the navigation tree of Switch A, and then click the Create tab to
enter the page shown in b.

Type 0.0.0.0 for Destination IP Address.

Select 0 (0.0.0.0) from the Mask drop-down list.
Type 1.1.4.2 for Next Hop.

Click Apply.
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b. Configure a default route

Summary Remaove

Destination [P

Address 0.0.0.0
Mask 0({0.000) v [l Preference {1-255 Default=60)
Mext Hop 1142 (interface

Apply

Configured static route information

Destination IP Address Mask Protocal Freference Mext Hop Interface

# Configure a static route to Switch A and Switch C respectively on Switch B.

o Select Network - IPv4 Routing from the navigation tree of Switch B, and then click the Create tab to
enter the page shown in c.

e Type 1.1.2.0 for Destination IP Address.

o Select 24 (255.255.255.0) from the Mask drop-down list.
e Type 1.1.4.1 for Next Hop.

o Click Apply.

e Type 1.1.3.0 for Destination IP Address.

o Select 24 (255.255.255.0) from the Mask drop-down list.
e Type 1.1.5.6 for Next Hop.

o Click Apply.
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c. Configure a static route

Summary Remaove

Destination [P
Address |1 1.3.0 |
Mask |24 (255 255 255.0) V| [IPreference {1-255 Default=60)
Next Hop 111556 | Cinterface
Apply

Configured static route information

Destination IP Address Mask Protocol Freference Mext Hop Interface
|1.1.2.IZI 255.255.255.0 Static G0 1.1.4.1

# Configure a default route to Switch B on Switch C.

o Select Network - IPv4 Routing from the navigation tree of Switch C, and then click the Create tab to
enter the page as shown in d.

e  Type 0.0.0.0 for Destination IP Address.

e Select 0(0.0.0.0) from the Mask drop-down list.
e  Type 1.1.5.5 for Next Hop.

e Click Apply.
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d. Configure a default route

Summary Remaove

Destination IF
Address 0000
Mask 0({0.000) v [l Preference {1-255 Default=60)
Mext Hap 11564 interface
Apply

Configured static route information

Destination IP Address Mask Protocal Freference Mext Hop Interface

Configuration verification
# Display the active route table.

Enter the IPv4 route page of Switch A, Switch B, and Switch C respectively to verify that the newly
configured static routes are displayed in the active route table.

# Ping Host B from Host A (assuming both hosts run Windows XP).
C:\Documents and Settings\Administrator>ping 1.1.3.2

Pinging 1.1.3.2 with 32 bytes of data:

Reply from 1.1.3.2: bytes=32 time=1lms TTL=128
Reply from 1.1.3.2: bytes=32 time=1ms TTL=128
Reply from 1.1.3.2: bytes=32 time=1ms TTL=128
Reply from 1.1.3.2: bytes=32 time=1lms TTL=128

Ping statistics for 1.1.3.2:

Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milli-seconds:

Minimum = 1ms, Maximum = 1ms, Average = 1ms
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Precautions

When configuring a static route, note the following:

Table 73 If you do not specify the preference when configuring a static route, the default preference will be
used. Reconfiguration of the default preference applies only to newly created static routes. The web
inferface does not support configuration of the default preference.

Table 74 The static route does not take effect if you specify the next hop address first and then configure it
as the IP address of a local interface, such as a VLAN interface.

Table 75 If Null O interface is specified as the output interface, the next hop address is not required. If you
want fo specify a broadcast interface (such as a VLAN interface) as the output interface, which may

have multiple next hops, specify the next hop at the same time.

Table 76 You can delete only static routes on the Remove tab.
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DHCP overview

NOTE:

Atter the DHCP client is enabled on an interface, the interface can dynamically obtain an IP address and
other configuration parameters from the DHCP server. This facilitates configuration and centralized
management. For more information about the DHCP client configuration, see the chapter “VLAN interface
configuration”.

Introduction to DHCP

The fast expansion and growing complexity of networks result in scarce IP addresses assignable to hosts.
Meanwhile, as many people need to take their laptops across networks, the IP addresses need to be
changed accordingly. Therefore, related configurations on hosts become more complex. The Dynamic Host
Configuration Protocol (DHCP) was introduced to solve these problems.

DHCP is built on a client-server model, in which a client sends a configuration request and then the server
returns a reply to send configuration parameters such as an IP address to the client.

A typical DHCP application, as shown in g, includes a DHCP server and multiple clients (PCs and laptops).
a. A typical DHCP application
DHCP client  DHCP client

DHCP server
T

-

DHCP client DHCP client

A DHCP client can get an IP address and other configuration parameters from a DHCP server on another
subnet via a DHCP relay agent. For more information about the DHCP relay agent configuration, see the
chapter “DHCP relay agent configuration”.

DHCP address allocation

Allocation mechanisms

DHCP supports three mechanisms for IP address allocation.
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e Manual allocation: The network administrator assigns an IP address to a client like a WWW server,
and DHCP conveys the assigned address to the client.

e Automatic allocation: DHCP assigns a permanent IP address to a client.

e Dynamic allocation: DHCP assigns an IP address to a client for a limited period of time, which is called
a lease. Most DHCP clients obtain their addresses in this way.

Dynamic IP address allocation process

a. Dynamic IP address allocation process

DHCP client DHCP server

= =
=

(1) DHCP-DISCOVER

(2) DHCP-OFFER

(3) DHCP-REQUEST

(4) DHCP-ACK

As shown in o, a DHCP client obtains an IP address from a DHCP server via four steps:
Table 77 The client broadcasts a DHCP-DISCOVER message to locate a DHCP server.

Table 78 A DHCP server offers configuration parameters such as an IP address to the client in a
DHCP-OFFER message. The sending mode of the DHCP-OFFER is determined by the flag field in the
DHCP-DISCOVER message.

Table 79 If several DHCP servers send offers to the client, the client accepts the first received offer, and
broadcasts it in a DHCP-REQUEST message to request the IP address formally.

Table 80 All DHCP servers receive the DHCP-REQUEST message, but only the server from which the client
accepts the offered IP address returns a DHCP-ACK message to the client, confirming that the IP
address has been allocated to the client, or a DHCP-NAK unicast message, denying the IP address
allocation.

NOTE:

Atter the client receives the DHCP-ACK message, it will probe whether the IP address assigned by the
server is in use by broadcasting a gratuitous ARP packet. If the client receives no response within the
specified time, the client can use this IP address. Otherwise, the client sends a DHCP-DECLINE message
to the server and requests an IP address again.

IP addresses offered by other DHCP servers are still assignable to other clients.

IP address lease extension

The IP address dynamically allocated by a DHCP server to a client has a lease. When the lease expires, the
DHCP server will reclaim the IP address. If the client wants to use the IP address longer, it has to extend the
lease duration.
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When the half lease duration elapses, the DHCP client sends to the DHCP server a DHCP-REQUEST unicast
to extend the lease duration. Upon availability of the IP address, the DHCP server returns a DHCP-ACK
unicast confirming that the client’s lease duration has been extended, or a DHCP-NAK unicast denying the
request.

If the client receives no reply, it will broadcast another DHCP-REQUEST message for lease extension after
7/8 lease duration elapses. The DHCP server will handle the request as above mentioned.

DHCP message format

a gives the DHCP message format, which is based on the BOOTP message format and involves eight types.
These types of messages have the same format except that some fields have different values. The numbers
in parentheses indicate the size of each field in bytes.

a. DHCP message format

0 7 15 23 31
op (1) htype (1) hlen (1) hops (1)

xid (4)

secs (2) flags (2)

ciaddr (4)

yiaddr (4)

siaddr (4)

giaddr (4)

chaddr (16)

shame (64)

file (128)

options (variable)

e op: Message type defined in option field. 1 = REQUEST, 2 = REPLY

e htype, hlen: Hardware address type and length of a DHCP client.

e hops: Number of relay agents a request message traveled.

e  xid: Transaction ID, a random number chosen by the client to identity an IP address allocation.

o secs: Filled in by the client, the number of seconds elapsed since the client began address acquisition
or renewal process. This field is reserved and set to O.

o flags: The leftmost bit is defined as the BROADCAST (B) flag. If this flag is set to O, the DHCP server sent
a reply back by unicast; if this flag is set to 1, the DHCP server sent a reply back by broadcast. The
remaining bits of the flags field are reserved for future use.

e ciaddr: Client IP address.

e yiaddr: 'your' (client) IP address, assigned by the server.

e siaddr: Server IP address, from which the clients obtained configuration parameters.
e giaddr: IP address of the first relay agent a request message traveled.

e chaddr: Client hardware address.

e sname: Server host name, from which the client obtained configuration parameters.
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file: Bootfile name and path information, defined by the server to the client.

options: Optional parameters field that is variable in length, which includes the message type, lease,
domain name server IP address, and WINS IP address.

DHCP options

DHCP options overview

The DHCP message adopts the same format as the Bootstrap Protocol (BOOTP) message for compatibility,
but differs from it in the option field, which identifies new features for DHCP.

DHCP uses the option field in DHCP messages to carry control information and network configuration
parameters, implementing dynamic address allocation and providing more network configuration
information for clients.

a shows the DHCP option format.

a.

0

DHCP option format

7 15

Option type Option length

Value (variable)

Introduction to DHCP options

The common DHCP options are as follows:

Option 6: DNS server option. It specifies the DNS server IP address to be assigned to the client.
Option 51: IP address lease option.
Option 53: DHCP message type option. It identifies the type of the DHCP message.

Option 55: Parameter request list option. It is used by a DHCP client to request specified configuration
parameters. The option contains values that correspond to the parameters requested by the client.

Option 66: TFTP server name option. It specifies a TFTP server to be assigned to the client.
Option 67: Bootfile name option. It specifies the bootfile name to be assigned to the client.

Option 150: TFTP server IP address option. It specifies the TFTP server IP address to be assigned to the
client.

Option 121: Classless route option. It specifies a list of classless static routes (the destination addresses
in these static routes are classless) that the requesting client should add to its routing table.

Option 33: Static route option. It specifies a list of classful static routes (the destination addresses in
these static routes are classful) that a client should add to its routing table. If Option 121 exists, Option

33 is ignored.

For more information about DHCP options, see RFC 2132.

Introduction to Option 82

Some options, such as Option 82, have no unified definitions in RFC 2132.
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Option 82 is the relay agent option in the option field of the DHCP message. It records the location
information of the DHCP client. When a DHCP relay agent or DHCP snooping device receives a client’s
request, it adds Option 82 to the request message before forwarding the message to the server.

The administrator can locate the DHCP client to further implement security control and accounting. The
Option 82 supporting server can also use such information to define individual assignment policies of IP
address and other parameters for the clients.

Option 82 involves at most 255 sub-options. At least one sub-option is defined. The DHCP relay agent
supports two sub-options: sub-option 1 (Circuit ID) and sub-option 2 (Remote ID).

Option 82 has no unified definition. Its padding formats vary with vendors.

By default, the normal padding format is used on the device. You can specify the code type for the
sub-options as ASCIl or HEX. The padding contents for sub-options in the normal padding format are as
follows:

e Sub-option 1: Padded with the VLAN ID and interface number of the interface that received the client’s
request. a gives ifs format. The value of the sub-option type is 1, and that of the circuit ID type is O.

a. Sub-option 1 in normal padding format

0 7 15 23 31
Sub-option type (0x01) Length (0x06) Circuit ID type (0x00) Length (0x04)
VLAN ID Interface number

e Sub-option 2: Padded with the MAC address of the DHCP relay agent interface or the MAC address
of the DHCP snooping device that received the client’s request. b gives its format. The value of the
sub-option type is 2, and that of the remote ID type is O.

b. Sub-option 2 in normal padding format

0 7 15 23 31
Sub-option type (0x02) Length (0x08) Remote ID type (0x00) Length (0x06)

MAC Address

Protocols and standards

e RFC 2131, Dynamic Host Configuration Protocol

e RFC 2132, DHCP Options and BOOTP Vendor Extensions

e RFC 1542, Clarifications and Extensions for the Bootstrap Protocol
e RFC 3046, DHCP Relay Agent Information Option
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DHCP relay agent configuration

Introduction to DHCP relay agent

Application environment

Since DHCP clients request IP addresses via broadcast messages, the DHCP server and clients must be on
the same subnet. Therefore, a DHCP server must be available on each subnet, which is not practical.

DHCP relay agent solves the problem. Via a relay agent, DHCP clients communicate with a DHCP server on
another subnet to obtain configuration parameters. Thus, DHCP clients on different subnets can contact the
same DHCP server, and centralized management and cost reduction are achieved.

Fundamentals

a shows a typical application of the DHCP relay agent.
a. DHCP relay agent application

DHCP client DHCP client

@

DHCP relay agent

=

DHCP client DHCP client DHCP server

No matter whether a relay agent exists or not, the DHCP server and client interact with each other in a
similar way (see the chapter “DHCP overview”). The following describes the forwarding process on the
DHCP relay agent.
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b. DHCP relay agent work process

DHCP client DHCP relay agent DHCP server
——— —
& & &
DHCP-DISCOVER DHCP-DISCOVER
(broadcast) (unicast)
DHCP-OFFER
DHCP-OFFER < (unicast)
DHCP-REQUEST DHCP-REQUEST
(broadcast) (unicast)
DHCP-ACK
DHCP-ACK (unicast)

As shown in b, the DHCP relay agent works as follows:

Table 81 After receiving a DHCP-DISCOVER or DHCP-REQUEST broadcast message from a DHCP client,
the DHCP relay agent fills the giaddr field of the message with its IP address and forwards the message
to the designated DHCP server in unicast mode.

Table 82 Based on the giaddr field, the DHCP server returns an IP address and other configuration
parameters to the relay agent, which conveys them to the client.

DHCP relay agent configuration task list

Complete the following tasks to configure the DHCP relay agent:

Task Remarks

Enabling DHCP and configuring Required

advanced parameters for the DHCP  Enable DHCP globally and configure advanced DHCP parameters.
relay agent By default, global DHCP is disabled.

Required

To improve reliability, you can specify several DHCP servers as a
group on the DHCP relay agent and correlate a relay agent interface
with the server group. When the interface receives requesting
messages from clients, the relay agent will forward them fo all the
DHCP servers of the group.

Creating a DHCP server group

Required
Enable the DHCP relay agent on an interface, and correlate the
inferface with a DHCP server group.
With DHCP enabled, interfaces work in the DHCP server mode by
Enabling the DHCP relay agent on an default.
nferface @ MPORTANT:

* You can enable either the DHCP server or the DHCP relay agent
on an interface. The latest configuration takes effect.

o The DHCP relay agent works on inferfaces with IP addresses
manually configured only.
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Task Remarks

Optional

Create a static IP4o-MAC binding, and view static and dynamic
bindings.

The DHCP relay agent can dynamically record clients’ [P-to-MAC
bindings after clients get IP addresses. It also supports static bindings,
that is, you can manually configure IP-to-MAC bindings on the DHCP
relay agent, so that users can access external network using fixed IP
addresses.

Configuring and displaying clients'
IP-to-MAC bindings

By default, no static binding is created.

Enabling DHCP and configuring advanced
parameters for the DHCP relay agent

Select Network - DHCP from the navigation tree to enter the default DHCP Relay page. Enable or disable
DHCP in the DHCP Service field. Click Display Advanced Configuration to expand the advanced DHCP
relay agent configuration field, as shown in a.

a. DHCP relay agent configuration page
DHCP Shoaping

DHCP Service (O Enable & Disable

Hide Advanced Configuration |

Unauthorized Server Detect O Enable () Disable
Cwnamic Bindings Refresh (&) Enable O Disable
Track Tirmer Interval @ Auto O custom Seconds (1-120)

Apply Cancel

Server Group

b Search ltern: | Server Group 1D Ke\;words:| Search

Server Group 1D IP Address Qperation

Add

Interface Config

b Search Itern: | Interface Name W Kex,words:| Search

Interface Mame DHCF Relay State Operation
Ylan-interface Enabled

User Information

User Information
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2. DHCP service and advanced DHCP relay agent configuration items

ltem Description
DHCP Service Enable or disable global DHCP.

Enable or disable unauthorized DHCP server detection.

There are unauthorized DHCP servers on networks, which reply DHCP clients with
wrong IP addresses.

) With this feature enabled, upon receiving a DHCP request, the DHCP relay agent will
Unauthorized Server record the IP address of any DHCP server that assigned an IP address to the DHCP
Detect client and the receiving interface. The administrator can use this information to check

out DHCP unauthorized servers. The device puts a record once for each DHCP
server. The administrator needs to find unauthorized DHCP servers from the log
information. After the information of recorded DHCP servers is cleared, the relay
agent will re-record server information following this mechanism.

Enable or disable periodic refresh of dynamic client entries, and set the refresh
interval.

Via the DHCP relay agent, a DHCP client sends a DHCP-RELEASE unicast message to
the DHCP server to relinquish its IP address. In this case the DHCP relay agent simply
conveys the message to the DHCP server, thus it does not remove the IP address from

Dynamic Bindings dynamic client entries. To solve this problem, the periodic refresh of dynamic client

Refresh entries feature is introduced.
With this feature, the DHCP relay agent uses the IP address of a client and the MAC
address of the DHCP relay agent interface to periodically send a DHCP-REQUEST
message to the DHCP server.
o Ifthe server returns a DHCP-ACK message or does not return any message within
a specified inferval, which means that the IP address is assignable now, the
DHCP relay agent will age out the client entry.
o |If the server returns a DHCP-NAK message, which means the IP address is still in
Track Timer Interval use, the relay agent will not age it out.

Note that if the Auto radio button is clicked on, the refresh interval is calculated by the
relay agent according fo the number of client entries.

Return to DHCP relay agent configuration task list.

Creating a DHCP server group

Select Network > DHCP from the navigation tree to enter the default DHCP Relay page shown in a. In the
Server Group field, click Add to enter the page shown in a.

a. Create a server group
DHCP Snooping

Server Group 1D “(0-19]

IF Address &

[tems marked with an asterisk{*} are required

Apply Cancel
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2. DHCP server group configuration items

ltem Description

Type the ID of a DHCP server group.
Server Group ID
You can create up to 20 DHCP server groups.

Type the IP address of a server in the DHCP server group.

IP Address The server IP address cannot be on the same subnet as the IP address of the DHCP
relay agent; otherwise, the client cannot obtain an IP address.

Return to DHCP relay agent configuration task list.

Enabling the DHCP relay agent on an interface

Select Network - DHCP from the navigation tree to enter the default DHCP Relay page shown in a. In the

Interface Config field, the DHCP relay agent state of interfaces is displayed. Click the E¥ icon of a specific
interface to enter the page shown in a.

a. Configure a DHCP relay agent interface

DHCP Snooping

Interface Mame Ylan-interface

DHCP Relay ) Enable ) Disahle
Address Match

Check ) Enahle (# Disahle
Server Group D L

[terms marked with an asteriski*} are required

Apply Cancel

2. DHCP relay agent interface configuration items

ltem Description
Interface Name This field displays the name of a specific interface.
DHCP Relay Enable or disable the DHCP relay agent on the interface.

Enable or disable IP address check.

With this function enabled, the DHCP relay agent checks whether a requesting

Address Match Check client’s IP and MAC addresses match a binding (dynamic or static) on the
DHCP relay agent. If not, the client cannot access outside networks via the
DHCP relay agent. This prevents invalid IP address configuration.

Correlate the interface with a DHCP server group.
Server Group ID
A DHCP server group can be correlated with multiple interfaces.

Return to DHCP relay agent configuration task list.
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Configuring and displaying clients' IPto-MAC
bindings

Select Network - DHCP from the navigation tree to enter the default DHCP Relay page shown in a. In the
User Information field, click the User Information button to view static and dynamic bindings, as shown in
a. Click Add to enter the page shown in b.

a. Display clients' IP-to-MAC bindings

DHCF Znooping

P Search Item:| IP Address ; |Keywu:|ru:ls:| Search
P Address WMAC Address Type Interface Mame Ciperation
1.1.1.10 00e0-1234-5678 Static Ylan-interface ﬂ
Add Return Fefrezh Feszet

b. Create a static IP-to-MAC binding

DHCP Snooping

IP Address |

MAC Address | “(H-H-H)

Interface Mame | v|

[terms marked with an asterisk(*) are required

Apply Cancel

2. Static IP-to-MAC binding configuration items

ltem Description
IP Address Type the IP address of a DHCP client.
MAC Address Type the MAC address of the DHCP client.

Select the Layer 3 interface connected with the DHCP client.

@ IMPORTANT:

The interface of a static binding entry must be configured as a DHCP relay agent;
otherwise, address entry conflicts may occur.

Interface Name

Return to DHCP relay agent configuration task list.

284



DHCP relay agent configuration example

Network requirements

As shown in a, VLAN-interface 1 on the DHCP relay agent (Switch A) connects to the network where DHCP
clients reside. The IP address of VLAN-interface 1is 10.10.1.1/24 and the IP address of VLAN-interface 2
is 10.1.1.1/24. VLAN-interface 2 is connected to the DHCP server whose IP address is 10.1.1.1/24.

The switch forwards messages between DHCP clients and the DHCP server.
a. Network diagram for DHCP relay agent configuration

DHCP client DHCP client

Vlan-intl Vlan-int2
10.10.1.1/24 g 10.1.1.2/24 |?I
:
Switch A

DHCP relay agent DHCP server

DHCP client DHCP client

Configuration procedure

Table 83 Specity IP addresses for interfaces (omitted)
Table 84 Configure the DHCP relay agent
# Enable DHCP.

o Select Network > DHCP from the navigation tree to enter the default DHCP Relay page. Perform the
following operations, as shown in b.
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b. Enable DHCP

OHCF Snooping

DHCF Service ® Enable O Disable

Display Advanced Configuration

Apply Cancel

Server Group

P Search ltem:| Server Group ID |+ |Keywnn:|s:| Search

Senver Group (D IP Address Cperation
Add

Interface Config

b Search ltem:| Interface Name % |keywords | Search

Interface Mame DHCF Relay State Operatian
YWlan-interface Disahled @
Vian-interface2 Disabled 2]

ser Infarmation

IJser Information

e Click on the Enable radio button next to DHCP Service.

o Click Apply.

# Configure a DHCP server group.

e In the Server Group field, click Add and then perform the following operations, as shown in c.

c. Add a DHCP server group

DHCP Snooping

Server Group 1D 1 “(0-19)

IF Address 10.1.1.1 &

[terns marked with an asterisk{*) are required

Apply Cancel

e  Type 1 for Server Group ID.
o Type 10.1.1.1 for IP Address.
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e Click Apply.
# Enable the DHCP relay agent on VLAN-interface 1.

o In the Interface Config field, click the E icon of VLAN:interface 1, and then perform the following
operations, as shown in d.

d. Enable the DHCP relay agent on an interface and correlate it with a server group

DHCP Snooping

Interface Mame Ylan-interface1

DHCP Relay ® Enable ) Disable
Address Match

Check ) Enable {(*) Disable
Server Group 1D 1 #

[terms marked with an asterisk(*) are required

Apply Cancel

e  Click on the Enable radio button next to DHCP Relay.
o Select 1 for Server Group ID.

e Click Apply.

NOTE:

Because the DHCP relay agent and server are on different subnets, you need to configure a static route or
dynamic routing protocol to make them reachable to each other.
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DHCP snooping configuration

NOTE:

A DHCP snooping enabled device does not work if it is between the DHCP relay agent and DHCP
server, and it can work when it is between the DHCP client and relay agent or between the DHCP client
and server.

HP recommends you not to to enable the DHCP client, BOOTP client, and DHCP snooping on the same
device. Otherwise, DHCP snooping entries may fail to be generated, or the BOOTP client/DHCP client
may fail to obtain an IP address.

DHCP snooping overview

Functions of DHCP snooping

As a DHCP security feature, DHCP snooping can implement the following:
Table 85 Recording IPto-MAC mappings of DHCP clients
Table 86 Ensuring DHCP clients to obtain IP addresses from authorized DHCP servers

Recording IP-to-MAC mappings of DHCP clients

DHCP snooping reads DHCP-REQUEST messages and DHCP-ACK messages from trusted ports to record
DHCP snooping entries, including MAC addresses of clients, IP addresses obtained by the clients, ports that
connect to DHCP clients, and VLANSs to which the ports belong.

Ensuring DHCP clients to obtain IP addresses from authorized DHCP servers

If there is an unauthorized DHCP server on a network, DHCP clients may obtain invalid IP addresses and
network configuration parameters, and cannot normally communicate with other network devices. With
DHCP snooping, the ports of a device can be configured as trusted or untrusted, ensuring the clients to
obtain IP addresses from authorized DHCP servers.

e Trusted: A trusted port forwards DHCP messages normally.

e Untrusted: An untrusted port discards the DHCP-ACK or DHCP-OFFER messages received from any
DHCP server.
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Application environment of trusted ports

Configuring a trusted port connected to a DHCP server

a. Configure trusted and untrusted ports

DHCP server

DHCP client Unauthorized
DHCP server
—
DHCP reply messages

As shown in a, a DHCP snooping device's port that is connected to an authorized DHCP server should be
configured as a trusted port to forward reply messages from the DHCP server, so that the DHCP client can
obtain an IP address from the authorized DHCP server.

Configuring trusted ports in a cascaded network

In a cascaded network involving multiple DHCP snooping devices, the ports connected to other DHCP
snooping devices should be configured as trusted ports.

To save system resources, you can disable the trusted ports, which are indirectly connected to DHCP clients,
from recording clients’ IPto-MAC bindings upon receiving DHCP requests.

a. Configure trusted poris in a cascaded network

DHCP client

Host A DHCP snooping

Switch A DHCP server

DHCP client GEL/0/3 j DHCP snooping

Host B Switch C
DHCP client DHCP snooping

Host C Switch B

.7 @ Untrusted ports
© Trusted ports disabled from recording binding entries

DHCP client @ Trusted ports enabled to record binding entries

Host D
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2 describes roles of the ports shown in a.

2. Roles of ports

Trusted port disabled from Trusted port enabled to

Device Unirusted port recording binding entries record binding entries
Switch A GigabitEthernet 1/0/1 GigabitEthernet 1/0/3 GigabitEthernet 1/0/2
Switch B GigabitEthernet 1/0/3 and GigabitEthernet 1/0/1 GigabitEthernet 1/0/2

GigabitEthernet 1/0/4

GigabitEthernet 1/0/3 and

Switch C GigabitEthernet 1/0/1 GigabitEthernet 1/0/4

GigabitEthernet 1/0/2

DHCP snooping support for Option 82

Option 82 records the location information of the DHCP client. The administrator can locate the DHCP client
to further implement security control and accounting. For more information, see the chapter “DHCP
overview”.

If DHCP snooping supports Option 82, it will handle a client’s request according to the contents defined in
Option 82, if any. The handling strategies are described in the table below.

If a reply returned by the DHCP server contains Option 82, the DHCP snooping device will remove the
Option 82 before forwarding the reply to the client. If the reply contains no Option 82, the DHCP snooping
device forwards it directly.

It dient’s requesting Handling The DHCP snooping device will...
message has... strategy
Drop Drop the message.
Option 82 Keep Forward the message without changing Option 82.
Reo| Forward the message after replacing the original Option 82
eplace with the Option 82 padded in normal format.
no Option 82 _ Forward the message after adding the Option 82 padded in

normal format.

DHCP snooping configuration task list

Complete the following tasks to configure DHCP snooping:

Task Remarks

Required

Enabling DHCP snoopin
" Pina By default, DHCP snooping is disabled.
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Task Remarks

Required

Specify an interface as trusted and configure DHCP snooping to support

Option 82.

o _ By default, an interface is untrusted and DHCP snooping does not support
Contiguring DHCP snooping Option 82

functions on an interface

@ IMPORTANT:

You need to specify the ports connected to the authorized DHCP servers as
trusted to ensure that DHCP clients can obtain valid IP addresses. The trusted
port and the port connected to the DHCP client must be in the same VLAN.

Displaying clients' IPto-MAC Optional
bindings Display clients' IPto-MAC bindings recorded by DHCP snooping.

Enabling DHCP snooping

Select Network - DHCP from the navigation tree, and then click the DHCP Snooping tab to enter the page
shown in a. You can enable or disable DHCP snooping in the DHCP Snooping field.
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a. DHCP snooping configuration page

DHCF Relay

DHCP Snooping

DHCP Snoeping () Enable (® Disable

Interface Config

P Search Item:l Interface Mame |KE'y'w'|:|rl:Is:| Search
Interface Mame Interface State Cperation

GigakbitEthernet1/0/1 LIntrust @
GigahitEthernet /012 LIntrust @
GigahitEthernet1/0/3 LIntrust @
GigahitEthernet1/0/4 LIntrust @
GigahitEthernet1/0/5 LIntrust @
GigahitEthernet1/0/6 Intrust @
GigahitEthernet1/0/7 LIntrust @
GigabitEthernet1/0/8 LIntrust @
GigahitEthernet1/0/9 Intrust @
GigahitEthernet1/0/10 LIntrust @
GigahitEthernet1/0/11 LIntrust @
GigahitEthernet1/0M 2 LIntrust @
GigahitEthernet1/0/13 Intrust @
GigahitEthernet1/0/14 LIntrust @
GigahitEthernet1/0/15 LIntrust @

25 recurds.per page | page 1/2, record 1-15 | Mext Last

ser Infarmation

User Infarmation

e To enable DHCP snooping, click on the Enable radio button in the DHCP Snooping field.
e To disable DHCP snooping, click on the Disable radio button in the DHCP Snooping field.

Return to DHCP snooping configuration task list.
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Contiguring DHCP snooping functions on an
interface

Select Network - DHCP from the navigation tree, and then click the DHCP Snooping tab fo enter the page

shown in a. You can view trusted and untrusted ports in the Interface Config field. Click the 5¥ icon of a
specific interface to enter the page shown in a.

a. DHCP snooping interface configuration page

OHCP Relay

Interface Mame GigakitEthermet1/0iM1
Interface State ) Trust @& Untrust
Option 82 Support () Enahble (¥ Disable

Opticn 82 Strategy {REPHCE % |(Default = Replace)

Apply Cancel

2. DHCP snooping interface configuration items

ltem Description

Interface Name This field displays the name of a specific inferface.
Interface State Configure the interface as trusted or untrusted.

Option 82 Support Configure DHCP snooping to support Option 82 or not.

Select the handling strategy for DHCP requests containing Option 82. The strategies

include:
Oution 82 Strat o Drop: The message is discarded if it contains Option 82.
phen raesy o Keep: The message is forwarded without its Option 82 being changed.

e Replace: The message is forwarded after its original Option 82 is replaced with
the Option 82 padded in normal format.

Return to DHCP snooping configuration task list.

Displaying clients' IPto-MAC bindings

Select Network - DHCP from the navigation tree, and then click the DHCP Snooping tab fo enter the page
shown in a. Click the User Information button to view clients' IP+o-MAC bindings recorded by DHCP
snooping, as shown in a.
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a.

DHCP Relay

P Search ttem:| IP Address

1

002

IP Address MAC Address
00&0-fc00-5801

DHCP snooping user information

~ |Keywords: Search
Type Interface Mame WLAN Remaining Lease Time (Sec) Operation
Dynamic GigahitEthernet1/0/1 1 86353 ﬂ

Return Refresh Reset

2. DHCP snooping user information configuration items
ltem Description
IP Address This field displays the IP address assigned by the DHCP server to the client.
MAC Address This field displays the MAC address of the client.
This field displays the client type, which can be:
Type e Dynamic: The IP4o-MAC binding is generated dynamically.

e Static: The IPto-MAC binding is configured manually. Static bindings are not
supported.

Interface Name

This field displays the device interface to which the client is connected.

VLIAN

This field displays the VLAN fo which the device belongs.

Remaining Lease Time

This field displays the remaining lease time of the IP address.

Return to DHCP snooping configuration task list.

DHCP snooping configuration example

Network requirements

As shown in a, a DHCP snooping device (Switch) is connected to a DHCP server through GigabitEthernet

1/0/1, and to DHCP clients through GigabitEthernet 1/0/2 and GigabitEthernet 1/0/3.

Enable DHCP snooping on Switch and configure DHCP snooping to support Option 82. Configure the

handling strategy for DHCP requests containing Option 82 as replace.

Enable GigabitEthernet 1/0/1 to forward DHCP server responses; disable GigabitEthernet 1/0/2

and GigabitEthernet 1/0/3 from forwarding DHCP server responses.

Configure Switch to record clients’ IPto-MAC address bindings in DHCP-REQUEST messages and

DHCP-ACK messages received from a trusted port.
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a. Network diagram for DHCP snooping configuration

Device
DHCP server

Switch
DHCP snooping

DHCP client DHCP client

Configuration procedure

# Enable DHCP snooping.

o Select Network > DHCP from the navigation tree, and then click the DHCP Snooping tab. Perform the
following operation, as shown in a.
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a. Enable DHCP snooping

DHCP Relay

DHCP Snooping

DHCP Snooping (& Enable ) Disahle

Interface Canfig

b Search ltem: | Interface Mame ¥ |Keywords| Search
Interface Mame Interface State Cperation

GigahitEthernet1/0/1 Lntrust B
GigabitEthernet1/0/2 Lntrust B
GigahitEthernet1/0/3 ntrust =
GigabitEthernet1/0/4 LIntrust =
GigahitEthernet1/0/5 ntrust B
GigahitEthernet1/0/6 ntrust Bt
GigahitEthernet1/0/7 Lntrust B
GigabitEthernet1/0/8 Intrust =
GigabitEthernet1/0/8 LIntrust B
GigabitEthernet1/0/10 ntrust B
GigahitEthernet1/0/11 ntrust B
GigahitEthernet1/0/12 ntrust B
GigahitEthernet1/0/13 Lntrust B
GigahitEthernet1/0/14 Lntrust B
GigahitEthernet1/0/15 ntrust =

28 recnrds.per page | page 1/2, record 1-15 | Next Last

ser Infarmation

ser Infarmation

e Click on the Enable radio button next to DHCP Snooping.
# Configure DHCP snooping functions on GigabitEthernet 1/0/1.

o  Click the E¥ icon of GigabitEthernet 1/0/1 on the interface list. Perform the following operations on
the DHCP Snooping Interface Configuration page shown in b.
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b. Configure DHCP snooping functions on GigabitEthernet 1/0/1
DHCP Relay

Interface Mlame GigahitEthermet1/0M1
Interface State @ Trust O Untrust

Option 82 Support ) Enable (*) Disable

Opticn 82 Strategy {REFi'E":E ¥ | (Default = Replace)

Apply Cancel

e  Click on the Trust radio button next to Interface State.
e Click Apply.
# Configure DHCP snooping functions on GigabitEthernet 1/0/2.

e  Click the icon of GigabitEthernet 1/0/2 on the interface list. Perform the following operations on
the DHCP Snooping Interface Configuration page shown in c.

c. Configure DHCP snooping functions on GigabitEthernet 1/0/2
DHCF Relay

Interface Mame GigahitEthernet1/0i2
Interface State O Trust & Untrust

Option 82 Support (3 Enable ) Disable

Option B2 Strategy .[FiEplﬂce ¥ |(Default = Replace)

Apply Cancel

e Click on the Untrust radio button for Interface State.

e Click on the Enable radio button next to Option 82 Support.
e Select Replace for Option 82 Strategy.

o Click Apply.

# Configure DHCP snooping functions on GigabitEthernet 1/0/3.

e Click the EF icon of GigabitEthernet 1/0/3 on the interface list. Perform the following operations on
the DHCP Snooping Interface Configuration page shown in d.
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d. Configure DHCP snooping functions on GigabitEthernet 1/0/3

DHCP Relay

Interface Mame GigabitEthermet1/013
Interface State O Trust ® Untrust

Option 82 Support &) Enable O Disable

Apply

Option 82 Strateay | Replace (% | (Default = Replace)

Cancel

e  Click on the Untrust radio button for Interface State.

e Click on the Enable radio button next to Option 82 Support.

e Select Replace for Option 82 Strategy.
o Click Apply.
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Service management configuration

The service management module provides the following types of services: FTP, Telnet, SSH, SFTP, HTTP and
HTTPS. You can enable or disable the services as needed. In this way, the performance and security of the
system can be enhanced, thus secure management of the device can be achieved.

The service management module also provides the function to modity HTTP and HTTPS port numbers, and
the function to associate the FTP, HTTP, or HTTPS service with an ACL, thus reducing attacks of illegal users
on these services.

FTP service

The File Transfer Protocol (FTP) is an application layer protocol for sharing files between server and client
over a TCP/IP network.

Telnet service

The Telnet protocol is an application layer protocol that provides remote login and virtual terminal functions
on the network.

SSH service

Secure Shell (SSH) offers an approach to securely logging in to a remote device. By encryption and strong
authentication, it protects devices against attacks such as IP spoofing and plain text password interception.

SFTP service

The secure file transfer protocol (SFTP) is a new feature in SSH2.0. SFTP uses the SSH connection to provide
secure data transfer. The device can serve as the SFTP server, allowing a remote user to log in to the SFTP
server for secure file management and transfer. The device can also serve as an SFTP client, enabling a user
to login from the device to a remote device for secure file transfer.

HTTP service

The Hypertext Transfer Protocol (HTTP) is used for transferring web page information across the Internet. It
is an application-layer protocol in the TCP/IP protocol suite.

You can log in to the device using the HTTP protocol with HTTP service enabled, accessing and controlling
the device with Web-based network management.

HTTPS service
The Secure HTTP (HTTPS) refers to the HTTP protocol that supports the Security Socket Layer (SSL) protocol.
The SSL protocol of HTTPS enhances the security of the device in the following ways:

o Uses the SSL protocol to ensure the legal clients to access the device securely and prohibit the illegal
clients;

e Encrypts the data exchanged between the HTTPS client and the device to ensure the data security and
integrity, thus realizing the security management of the device;

o Defines certificate attribute-based access control policy for the device to control the access right of the
client, in order to further avoid attacks from illegal clients.
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Contiguring service management

Select Network > Service from the navigation tree to enter the service management configuration page, as
shown in a.

a. Service management

"

[¥F
it
o

+FTP []Enable FTF sernice
Telnet [¥] Enable Telnet senvice
55H ] Enable SSH semice
SFTP []Enable SFTP semvice
+HTTP Enable HTTP service

+HTTRS (] Enahle HTTPS semnvice

PEI Domain: _. v

[tems marked with an asteriski*} are required

Apply Cancel
2. Service management configuration items
ltem Description
Enable FTP Specify whether to enable the FTP service.
service The FTP service is disabled by default.
FTP Associate the FTP service with an ACL. Only the clients that pass the ACL

filtering are permitted to use the FTP service.

Act You can view this configuration item by clicking the expanding button in
front of FTP.
Telnet Enol.ole Telnet Specify whether to enable the Telnet service.
service The Telnet service is disabled by default.
ssH Enql::)le SSH Specify whether to enable the SSH service.
service The SSH service is disabled by default.
Specify whether to enable the SFTP service.
SFTp Enable SFTP The SFTP service is disabled by default.
service @ impoRTANT:
When you enable the SFTP service, the SSH service must be enabled.
HTTP Enable HTTP Specify whether to enable the HTTP service.
service The HTTP service is enabled by default.
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ltem

Description

Port Number

Set the port number for HTTP service.

You can view this configuration item by clicking the expanding button in
front of HTTP.

@ IMPORTANT:

When you modify a port, ensure that the port is not used by other service.

ACL

Associate the HTTP service with an ACL. Only the clients that pass the ACL
filtlering are permitted to use the HTTP service.

You can view this configuration item by clicking the expanding button in
front of HTTP.

HTTPS

Enable HTTPS

service

Specify whether to enable the HTTPS service.
The HTTPS service is disabled by default.

Port Number

Set the port number for HTTPS service.

You can view this configuration item by clicking the expanding button in
front of HTTPS.

@ IMPORTANT:

When you modify a port, ensure that the port is not used by other service.

Associate the HTTPS service with an ACL. Only the clients that pass the ACL
filtering are permitted to use the HTTPS service.

ACL
You can view this configuration item by clicking the expanding button in
front of HTTPS.
Set the PKI domain for the HTTPS service.

PKI Domain You can configure the available PKI domains by selecting Authentication

- PKI from the navigation tree at the left side of the interface. For more
information, see the chapter “PKI configuration”.
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Diagnostic tools

Ping

The ping command allows you to verify whether a device with a specified address is reachable, and to
examine network connectivity.

The ping function is implemented through the Internet Control Message Protocol (ICMP):
Table 87 The source device sends an ICMP echo request to the destination device.

Table 88 The source device determines whether the destination is reachable based on whether it receives
an ICMP echo reply. If the destination is reachable, the source device determines the following:

o The link quality, based on the numbers of ICMP echo requests sent and replies received.

o The distance between the source and destination, based on the round trip time of ping packets.

Trace route

By using the trace route command, you can trace the Layer 3 devices involved in delivering an IP packet
from source to destination to check whether a network is available. This is useful for identification of failed
node(s) in the event of network failure.

a. Trace route diagram

Device A Device B Device C Device D

Sy 1.1.1.1/24 ST 1121124 ) 1.1.3.1/24 S,
1.1.1.2/24 1.1.2.2/24@ 1.1.3.2/24@

Hop Lmit=1 i
TTL exceeded "
Hop leit=2
TTL exceeded

Hop Lmit=n

UDP port unreachable

<
<

The trace route function is implemented through ICMP, as shown in a:

Table 89 The source (Device A) sends a packet with a TTL value of 1 to the destination (Device D). The UDP
port of the packet is a port number that will not be used by any application of the destination.

Table 90 The first hop (Device B) (the Layer 3 device that first receives the packet) responds by sending a
TTL-expired ICMP error message to the source, with its IP address 1.1.1.2 encapsulated. In this way,
the source device can get the address (1.1.1.2) of the first Layer 3 device.

Table 91 The source device sends a packet with a TTL value of 2 to the destination device.

Table 92 The second hop (Device C) responds with a TTL-expired ICMP error message, which gives the
source device the address (1.1.2.2) of the second Layer 3 device.
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Table 93 The process continues until the ultimate destination device is reached. No application of the
destination uses this UDP port. The destination replies a port unreachable ICMP error message with the

destination IP address 1.1.3.2.

Table 94 When the source device receives the port unreachable ICMP error message, it knows that the
packet has reached the destination, and it can get the addresses of all the Layer 3 devices involved to

get to the destination device (1.1.1.2, 1.1.2.2, 1.1.3.2).

Diagnostic tool operations

Ping operation

NOTE:

The web interface supports the IPv4 ping operations only.

Select Network > Diagnostic Tools from the navigation tree to enter the ping configuration page, as shown
ina.

a. Ping configuration page
Trace Route

Command

Fing Start

Summary

Type in the IPv4 address or the host name of the destination device in the text box, and click Start to execute
the ping command. You will see the result in the Summary area, as shown in b.
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b. Ping operation result

Summary

PING 192.1&8.
Beply £

Reply
Reply

e el
WU LD o -

15}

[N S S T ST S ]

o e

O N on o N

.168.1.1 ping
1 transmitted
received

cket laoss

data bytes
.1.1: bytes=5&
.1.1: bytes=5h&
.1.1: bytes=5&
.1.1: bytes=5h&
.1.1: bytes=5&

statistics --—-

uence=1 ttl=2355
uence=2 ttl=255
uence=3 ttl=255
uence=4 ttl=255

quence=5 ttl=255

£l
T
I
T

{9 W ]

e
=
=
e
=

round-trip minfavg/max = 3/5/11 ms

Trace route operation

time=8 ms
time=11 ms3
time=3 ms
time=3 ms
time=3 ms

NOTE:

The web interface supports trace route on IPv4 addresses only.

Before performing the trace route operation on the Web interface, on the intermediate device execute
the ip ttl-expires enable command to enable the sending of ICMP timeout packets and on the
destination device execute the ip unreachables enable command to enable the sending of ICMP

destination unreachable packets.

Select Network - Diagnostic Tools from the navigation tree and then select the Trace Route tab to enter the

trace route configuration page, as shown in a.

a. Trace route configuration page

Ping

Command
Trace Route

Result
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Type in the IP address or host name of the destination device in the Trace Route text box, and click Start to
execute the trace route command. You will see the output in the Summary area, as shown in b.

b. Trace route operation result

Result

traceroute to 192.168.1.1(192.168.1.1) 30 hops max, 40 bytes packet

119216811 1ms2ms 1 ms
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ARP management

ARP overview

ARP function

The Address Resolution Protocol (ARP) is used to resolve an IP address into an Ethernet MAC address (or
physical address).

In an Ethernet LAN, when a device sends data to another device, it uses ARP to translate the IP address of
the destination device to the corresponding MAC address.

ARP message format
ARP messages are classified into ARP requests and ARP replies. a shows the format of the ARP
request/reply.
a. ARP message format

—» Hardware address length

’—> Protocol address length

Hardware|Protocol Sender hardware |Sender protocoll  Target hardware [Target protoco
type type oP address address address address
2 2 11 2 6 4 6 4

A
4

28-byte ARP request/reply

The following describe the fields in a.

II'I n

e Hardware type: This field specifies the hardware address type. The value represents Ethernet.

e Protocol type: This field specifies the type of the protocol address to be mapped. The hexadecimal
value “Ox0800" represents IP.

e Hardware address length and protocol address length: They respectively specify the length of a
hardware address and a protocol address, in bytes. For an Ethernet address, the value of the
hardware address length field is "6”. For an IP(v4) address, the value of the protocol address length
field is “4".

e OP: Operation code. This field specifies the type of the ARP message. The value
request and “2” represents an ARP reply.

II‘I "

represents an ARP

o Sender hardware address: This field specifies the hardware address of the device sending the
message.

e Sender protocol address: This field specifies the protocol address of the device sending the message.

e Target hardware address: This field specifies the hardware address of the device the message is being
sent to.
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e Target protocol address: This field specifies the protocol address of the device the message is being
sent to.

ARP operation

Suppose that Host A and Host B are on the same subnet and Host A sends a packet to Host B, as shown in
a. The resolution process is as follows:

e Host A looks into its ARP table to see whether there is an ARP entry for Host B. If yes, Host A uses the
MAC address in the entry to encapsulate the IP packet into a data link layer frame and sends the frame
to Host B.

e IfHost A finds no entry for Host B, Host A buffers the packet and broadcasts an ARP request, in which
the sender IP address and the sender MAC address are the IP address and the MAC address of Host
A respectively, and the target IP address and the target MAC address are the IP address of Host B and
an all-zero MAC address respectively. Because the ARP request is a broadcast, all hosts on this subnet
can receive the request, but only the requested host (Host B) will respond to the request.

e Host B compares its own IP address with the destination IP address in the ARP request. If they are the
same, Host B saves the source IP address and source MAC address in its ARP table, encapsulates its
MAC address into an ARP reply, and unicasts the reply to Host A.

e After receiving the ARP reply, Host A adds the MAC address of Host B to its ARP table. Meanwhile,
Host A encapsulates the IP packet and sends it out.

a. ARP address resolution process

Host A Host B
192.168.1.1 192.168.1.2
0002-6779-0f4c 00a0-2470-febd
A
Sender MAC Sender IP Target MAC Target IP
address address address

address
0002-6779-0f4c 192.168.1.1 0000-0000-0000 192.168.1.2

Sender MAC Sender IP Target MAC Target IP
address address address address
00a0-2470-febd 192.168.1.2 0002-6779-0f4c 192.168.1.1

If Host A is not on the same subnet with Host B, Host A first sends an ARP request to the gateway. The target
IP address in the ARP request is the IP address of the gateway. After obtaining the MAC address of the
gateway from an ARP reply, Host A sends the packet to the gateway. If the gateway maintains the ARP entry
of Host B, it forwards the packet to Host B directly; if not, it broadcasts an ARP request, in which the target
IP address is the IP address of Host B. After obtaining the MAC address of Host B, the gateway sends the
packet to Host B.

ARP table

After obtaining the MAC address for the destination host, the device puts the IP+to-MAC mapping into its
own ARP table. This mapping is used for forwarding packets with the same destination in future.

An ARP table contains ARP entries, which fall into one of two categories: dynamic or static.
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Dynamic ARP entry

A dynamic entry is automatically created and maintained by ARP. It can get aged, be updated by a new
ARP packet, or be overwritten by a static ARP entry. When the aging timer expires or the interface goes
down, the corresponding dynamic ARP entry will be removed.

Static ARP entry

A static ARP entry is manually configured and maintained. It cannot get aged or be overwritten by a
dynamic ARP entry.

Using static ARP entries enhances communication security. After a static ARP entry is specified, only a
specific MAC address is associated with the specified IP address. Attack packets cannot modify the
IPto-MAC mapping. Thus, communications between devices are protected.

Static ARP entries can be classified into long or short.

e Along static ARP entry can be directly used to forward packets. When configuring a long static ARP
entry, you must configure a VLAN and an outbound interface for the entry besides the IP address and
the MAC address.

e Ashort static ARP entry has only an IP address and a MAC address configured. It cannot be directly
used for forwarding data. If a short static ARP entry matches an IP packet to be forwarded, the device
sends an ARP request first. If the sender IP and MAC addresses in the received ARP reply are the same
as those in the short static ARP entry, the device adds the interface receiving the ARP reply to the short
static ARP entry. Then the entry can be used for forwarding IP packets.

NOTE:

Usually ARP dynamically resolves IP addresses to MAC addresses, without manual intervention.

Managing ARP entries
Displaying ARP entries

Select Network > ARP Management from the navigation tree to enter the default ARP Table page shown in
a. All ARP entries are displayed on the page.

a. ARP Table configuration page

Gratuitous ARP

bSearch ttemn: | IP Address ¥ | Keyworids: Search

F] IP Address MAC Address WLAN (D Paort Type Operation
[]182168.04 00e0-4c3d-35d7 1 GinahitEthernet/0M & Dynamic ﬂ

] 192.168.06 0015-2943-712f 1 GigahitEthernet1/0M & Dynamic ﬂ
11582165018 000f-3dB80-2h38 1 GinahitEthernet/0M & Dynamic ﬂ

] 192.168.0.56 Q00f-chO0-5601 1 GigahitEthernet1/0M & Dynamic ﬂ

Add Delete Selected Drelete All Cielete Static Delete Dynamic Refresh
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Creating a static ARP entry

Select Network > ARP Management from the navigation tree to enter the default ARP Table page shown in
a. Click Add to enter the New Static ARP Entry page. Select the Advanced Options checkbox to expand
advanced configuration items, as shown in a.

a. Add a static ARP entry

Gratuitous ARF

Mew Static ARP Entry

IP Address: 8

MAC Address: “(Example: 0010-dc28-aded)
Advanced Options

VLAN 1D (1-4094)

Faort: b

[tems marked with an asterisk(*) are required

Apply Back

2 describes the static ARP entry configuration items.

2. Static ARP entry configuration items

ltem Description
IP Address Type an IP address for the static ARP entry.
MAC Address Type a MAC address for the static ARP entry.

VIAN ID Type a VLAN ID and specify a port for the static ARP entry.

Advanced @ IMPORTANT:

Opti
pHons The VLAN ID must be the ID of the VLAN that has already been created, and the port

Port must belong to the VLAN. The corresponding VLAN inferface must have been created.

Static ARP configuration example

Network requirements

As shown in a, hosts are connected to Switch A, which is connected to Router B through interface
GigabitEthernet 1/0/1 belonging to VLAN 100. The IP address of Router B is 192.168.1.1/24. The MAC
address of Router B is 00e0-fc01-0000.

To enhance communication security between Switch A and Router B, static ARP entries need to be
configured on Switch A.
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a. Network diagram for configuring static ARP entries

Router B

192.168.1.1/24
00e0-fc01-0000

GE1/0/1
VLAN 100

Switch A

e 2

Configuration procedure

# Create VLAN 100.

o Select Network > VLAN from the navigation tree, click the Add tab, and then perform the following
operations, as shown in a.

a. Create VLAN 100

Select VLAMN Fort Detail Detail Iodify VLARN Modify Port Remaove
Create:
WLAM IDs: 100 Example:2, 5-10
Create
0 Description
1 WLAR 0004
2l=]2] WLAM 0988

Iodify VAN description (Mote: you can do this later on the Modify VLAMN page)
IMadify the description of the selected VLAN:
I Description

{1-32 Chars.)

e Type 100 for VLAN ID.

e Click Create to complete the configuration.

# Add GigabitEthernet 1/0/1 to VLAN 100.

310



o Click the Modify Port tab and then perform the following operations, as shown in b.
b. Add GigabitEthernet 1/0/1 to VLAN 100

Select VLAN Create Part Detail Detail Kodify VLAN Remove

Select Parts

ﬂﬂﬂﬂ e =T HP V1210-16C Sw,
REEQ QERE makakikl

Select All Selact Nona

. Mot avaliable for

Select membership type:

® Untagged |  © Tagged  © NotAMember © Link Type O PVID

Enter VLAN |Ds to which the port is to be assigned:

|VLAN |Ds: |100 Example: 1,3,5-10

Selected ports:

Url'tagééd'mé'rnbe'r'shi;:i
LGE1DM

Cance|

o Select interface GigabitEthernet 1/0/1 in the Select Ports field.
e Click on the Untagged radio button in the Select membership type field.
e Type 100 for VLAN IDs.

e  Click Apply. A configuration progress dialog box appears, as shown in c.

o

Configuration progress dialog box

Current Configuration
Setting GigabitEthernet1/0/1...... - Qkl!

100%

o After the configuration process is complete, click Close.
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# Create VLAN-interface 100.

o Select Network - VLAN Interface from the navigation tree, click the Create tab, and then perform the
following operations, as shown in d.

d. Create VLAN-interface 100
Summary Madify Remove

Input a VLA 1D

100 (1-4094)

Caonfigure Primary IPvd Address
) DHCP O BoOOTP & Manual
IPyv4 Address|192.168.1.2 Mask Length:[ 24 (255 255 255 0) v

Configure IPvE Link Local Address
Auta [Manual

IPvE Address:

Apply Cancel

e Type 100 for VLAN ID.

o Select the Configure Primary IPv4 Address checkbox.
e  Click on the Manual radio botton.

o Type 192.168.1.2 for IPv4 Address.

o Select 24 (255.255.255.0) for Mask Length.

o Click Apply to complete the configuration.

# Create a static ARP entry.

e Select Network > ARP Management from the navigation tree to enter the default ARP Table page.
Click Add Perform the following operations, as shown in e.
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e. Create a static ARP entry

Gratuitous ARF

Mew Static ARP Entry

IP Address: 192.168.1.1 g

MAC Address: 00e0-fc01-0000 “(Example:|0010-dc28-a4ed)
Advanced Cptions

VLAN ID: 100 (1-4094)

Port: GigabitEthernet1/0/1  »

lterms marked with an asterisk(*) are required

Apply Back

o Type 192.168.1.1 for IP Address.

e Type 00e0-fc01-0000 for MAC Address.

e Select the Advanced Options checkbox.

e Type 100 for VLAN ID.

e Select GigabitEthernet1/0/1 for Port.

o Click Apply to complete the configuration.

Gratuitous ARP

Introduction to gratuitous ARP

In a gratuitous ARP packet, the sender IP address and the target IP address are both the IP address of the
device issuing the packet, the sender MAC address is the MAC address of the device, and the target MAC
address is the broadcast address ff:H:f:ff:ff:ff.

A device implements the following functions by sending gratuitous ARP packets:
e Determining whether its IP address is already used by another device.
*  Informing other devices about the change of its MAC address so that they can update their ARP entries.

A device receiving a gratuitous ARP packet adds the information carried in the packet to its own dynamic
ARP table if it finds no corresponding ARP entry exists in the cache.

An attacker sends spoofed gratuitous ARP packets to hosts on a network. As a result, traffic that the hosts
want to send to the gateway is sent to the attacker instead, and the hosts cannot access external networks.
To prevent such gateway spoofing attacks, you can enable the gateway to send gratuitous ARP packets
periodically. In this way, each host can learn correct gateway address information.

Contiguring gratuitous ARP

Select Network > ARP Management from the navigation tree, and click the Gratuitous ARP tab to enter the
page shown in a.
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a. Gratuitous ARP configuration page

ARF Table

Gratuitous ARP

[] Disahble gratuitous ARP packets learning function

[] Send gratuitous ARP packets when receiving ARP requests from another netwark segments

=Pericdical gratuitous ARF packets sending settings

-------- Sending Interfaces(Period) ————Available Interfaces-————

Vlan-interface999

==

Pericd 2000 ms(200-5000)

Apply

2. Gratuitous ARP configuration items

ltem

Description

Disable gratuitous ARP packets
learning function

Enable or disable learning of ARP entries according to gratuitous ARP
packets.

Enabled by default.

Send gratuitous ARP packets
when receiving ARP requests
from another network segment

Enable the device to send gratuitous ARP packets upon receiving ARP
requests from another network segment.

Disabled by default.

Periodical gratuitous ARP
packets sending settings

Select interfaces for sending gratuitous ARP packets and type the sending
period.
To add an interface to the Sending Interfaces(Period) list box, select the

interface from the Available Interfaces list box, type the sending period, and
click the << button.

To remove an interface from the Sending Interfaces(Period) list box, select the
interface from the list box and click the >> button.

@ IMPORTANT:

o This function takes effect only when the link of the interface goes up and
an IP address has been assigned to the interface.

o If you change the period for sending gratuitous ARP packets, the
configuration is effective at the next sending period.
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ARP attack defense configuration

Although ARP is easy to implement, it provides no security mechanism and thus is prone fo network attacks.
ARP attacks and viruses are threatening LAN security. The device can provide multiple features to detect
and prevent such attacks. This chapter mainly introduces these features.

ARP detection

Introduction to ARP detection

The ARP detection feature allows only the ARP packets of authorized clients to be forwarded, preventing
man-inthe-middle attacks.

Man-in-the-middle attack

According to the ARP design, after receiving an ARP reply, a host adds the IP+o-MAC mapping of the
sender to its ARP mapping table. This design reduces the ARP traffic on the network, but also makes ARP
spoofing possible.

As shown in a, Host A communicates with Host C through a switch. After intercepting the traffic between
Host A and Host C, a hacker (Host B) forwards forged ARP replies to Host A and Host C respectively. Upon
receiving the ARP replies, the two hosts update the MAC address corresponding to the peer IP address in
their ARP tables with the MAC address of Host B (MAC_B). After that, Host B establishes independent
connections with Host A and Host C and relays messages between them, deceiving them into believing that
they are talking directly to each other over a private connection, while the entire conversation is actually
controlled by Host B. Host B may intercept and modify the communication data. Such an attack is called a
man-inthe-middle attack.
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a. Man-in-the-middle attack

Switch

]

|

|

|

|

]

|

|
Host A : Host C
IP_A " IP_C
MAC_A N Vs MAC_C

\ ) ’
N | ’
\ 4
\ | ¢
Forged \\ | ,I Forged
ARP reply ‘ ARP reply

Host B

IP_B

MAC_B

ARP detection mechanism

With ARP detection enabled for a specific VLAN, ARP messages arrived on any interface in the VLAN are
redirected to the CPU to have their MAC and IP addresses checked. ARP messages that pass the check are
forwarded, and other ARP messages are discarded.

Table 95 ARP detection based on DHCP snooping entries/802.1X security entries/static IPto-MAC
bindings

With this feature enabled, the device compares the source IP and MAC addresses of an ARP packet
received from the VLAN against the DHCP snooping entries, 802.1X security entries, or static IPto-MAC
binding entries. You can specify a detection type or types as needed.

After you enable ARP detection based on DHCP snooping entries for a VLAN,

e Upon receiving an ARP packet from an ARP untrusted port, the device compares the ARP packet
against the DHCP snooping entries. If a match is found, that is, the parameters (such as IP address,
MAC addresses, port index, and VLAN ID) are consistent, the ARP packet passes the check; if not, the
ARP packet cannot pass the check.

e Upon receiving an ARP packet from an ARP trusted port, the device does not check the ARP packet.

e If ARP detection is not enabled for the VLAN, the ARP packet is not checked even if it is received from
an ARP untrusted port.

After you enable ARP detection based on 802.1X security entries, the device, upon receiving an ARP packet

from an ARP untrusted port, compares the ARP packet against the 802.1X security entries.

o If an entry with identical source IP and MAC addresses, port index, and VLAN ID is found, the ARP
packet is considered valid.

e If an entry with no matching IP address but with a matching OUI MAC address is found, the ARP
packet is considered valid.

Otherwise, the packet is considered invalid and discarded.
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After you enable ARP detection based on static IPto-MAC bindings, the device, upon receiving an ARP
packet from an ARP trusted/untrusted port, compares the source IP and MAC addresses of the ARP packet
against the static IP4to-MAC bindings.

o If an entry with a matching IP address but a different MAC address is found, the ARP packet is
considered invalid and discarded.

e Ifan entry with both matching IP and MAC addresses is found, the ARP packet is considered valid and
can pass the detection.

e If no match is found, the ARP packet is considered valid and can pass the detection.

If all the detection types are specified, the system uses static IP4to-MAC binding entries first, then DHCP
snooping entries, and then 802.1X security entries. To prevent gateway spoofing, ARP detection based on
IP-to-MAC binding entries is required. Affer passing this type of ARP detection, users that can pass ARP
detection based on DHCP snooping entries or 802.1X security entries are considered to be valid. The last
two detection types are used to prevent user spoofing. You can select detection types according to the
networking environment.

o If all access clients acquire IP addresses through DHCP, HP recommends that you enable DHCP
snooping and ARP detection based on DHCP snooping entries on your access device.

o Ifaccess clients are 802.1X clients and large in number, and most of them use static IP addresses, HP
recommends that you enable 802.1X authentication, upload of client IP addresses, and ARP detection
based on 802.1X security entries on your access device. After that, the access device uses mappings
between IP addresses, MAC addresses, VLAN IDs, and ports of 802.1X authentication clients for ARP
detection.

If all the detection types are specified, the system uses IPto-MAC bindings first, then DHCP snooping entries,
and then 802.1X security entries. If an ARP packet fails to pass ARP detection based on static IP-to-MAC
bindings, it is discarded. If the packet passes this detection, it will be checked against DHCP snooping
entries. If a match is found, the packet is considered to be valid and will not be checked against 802.1X
security entries; otherwise, the packet is checked against 802.1X security entries. If a match is found, the
packet is considered to be valid; otherwise, the packet is discarded.

Table 96 ARP detection based on specified objects

You can also specify objects in ARP packets to be detected. The objects involve:

e srcmac: Checks whether the sender MAC address of an ARP packet is identical to the source MAC
address in the Ethernet header. If they are identical, the packet is forwarded; otherwise, the packet is

discarded.

e dstmac: Checks the target MAC address of ARP replies. If the target MAC address is all-zero, all-one,
or inconsistent with the destination MAC address in the Ethernet header, the packet is considered
invalid and discarded.

e ip: Checks both the source and destination IP addresses in an ARP packet. The all-zero, all-one or
multicast IP addresses are considered invalid and the corresponding packets are discarded. With this
object specified, the source and destination IP addresses of ARP replies, and the source IP address of
ARP requests are checked.

Contiguring ARP detection
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NOTE:

If both the ARP detection based on specified objects and the ARP detection based on static IP-to-MAC
bindings/DHCP snooping entries/802.1X security entries are enabled, the former one applies first, and
then the latter applies.

Select Network > ARP Anti-Attack from the navigation tree to enter the default ARP Detection page shown
in a.

a. ARP Detection configuration page

:-.-LL.H Settings - ) - Trusted Ports -
[ Enabled WVLAN-—| |- Disabled VLAMN-—- [ Trusted Porttg— | ||— Untrusted Ports— Al

55 GigahitEthernet1

i GigahitEthermnat1

= GigahitEthernet1
== & 3

GigahitEthemet1

GigahitEthernet1

GigahitEthemet1

| GigahitEthernet1/0/

User Validation Check

[] Using DHCP Sncoping to validate users

[] Using Dotlx to validate users

[] Using Static-Binding entries to guard against spocfing gateway attack

ARP Packet Validation
[ Ifthe source MAC address of an ARP packetis notidentical to that in the Ethernet header, the ARP packet is discarded
[] Ifthe destination MAC address of an ARP reply is all-zero, all-one, orinconsistent with that in the Ethernet header, the ARP packetis discarded

0O Ifthe source IP address of an ARF request, orthe source IP address or destination IP address of an ARP reply is all-zera, all-cne or an multicast IP
address, the ARP packetis discarded

Apply
Static-Bindings
IP Address: i MAC Address: *(Example: 0010-dc28-a4ed) 4dd
ltems marked with an asterisk(*}) are required
P Search Item:i._":' ¥ |Keywords| | Search
] IP MAC
O .12 00e0-1234-5678

Delete Selected

2. ARP Detection configuration items

ltem Description
Select VLANs on which ARP detection is to be enabled.

To add VLANS to the Enabled VLAN list box, select one or multiple VLANSs from the Disabled
VLAN Settings VLAN list box and click the << button.

To remove VLANS from the Enabled VLAN list box, select one or multiple VLANs from the list
box and click the >> button.
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ltem Description

Select trusted ports.

To add poris to the Trusted Ports list box, select one or multiple ports from the Untrusted
Trusted Ports Ports list box and click the << button.

To remove ports from the Trusted Ports list box, select one or multiple ports from the list box
and click the >> button.

Select user validity check modes, including:

e Using DHCP Snooping to validate users

e Using Dot1x to validate users

o Using Static-Binding entries to guard against spoofing gateway attack: You can

configure static IPto-MAC bindings if you select this mode. For the detailed
configuration, see “Creating a static binding entry”.

If all the detection types are specified, the system uses static IPto-MAC bindings first, then
DHCP snooping entries, and then 802.1X security entries. If an ARP packet fails to pass
ARP detection based on static IPto-MAC bindings, it is discarded. If the packet passes this

User Validation detection, it will be checked against DHCP snooping entries. If a match is found, the packet

Check is considered to be valid and will not be checked against 802.1X security entries;
otherwise, the packet is checked against 802.1X security entries. If a match is found, the
packet is considered to be valid; otherwise, the packet is discarded.

If none of the above is selected, all ARP packets are considered to be invalid.

@ IMPORTANT:

o Before enabling ARP detection based on DHCP snooping entries, make sure that DHCP
snooping is enabled.

o Before enabling ARP detection based on 802.1X security entries, make sure that
802.1X is enabled and the 802.1X clients are configured to upload IP addresses.

Select ARP packet validity check modes, including:

o If the source MAC address of an ARP packet is not identical to that in the Ethernet
header, the ARP packet is discarded

ARP Packet o If the destination MAC address of an ARP reply is all-zero, all-one, or inconsistent with

Vol'dac;'co: that in the Ethernet header, the ARP packet is discarded

idati

o If the source IP address of an ARP request, or the source IP address or destination IP
address of an ARP reply is all-zero, all-one or an multicast IP address, the ARP packet is

discarded

If none of the above is selected, the system does not check the validity of ARP packets.

Creating a static binding entry

If you select Using Static-Binding entries to guard against spoofing gateway attack, you can configure static
IP+o-MAC binding entries.

To create a static binding entry, type an IP address and MAC address in the Static Bindings field, and then
click Add, as shown in a.

NOTE:

If an entry with a matching IP address but a different MAC address is found, the ARP packet is considered
invalid and discarded. If an entry with both matching IP and MAC addresses is found, the ARP packet is
considered valid and can pass the detection.
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802.1X fundamentals

802.1X is a port-based network access control protocol initially proposed by the IEEE 802 LAN/WAN
committee for securing wireless LANs (WLANSs), and it has also been widely used on Ethernet networks for
access control.

802.1X controls network access by authenticating the devices connected to 802.1X-enabled LAN ports.

Architecture of 802.1X

802.1X operates in the client/server model. It comprises three entities: the client (the supplicant), the
network access device (the authenticator), and the authentication server, as shown in a.

a.

Architecture of 802.1X

‘ EAPOL ;Q‘ RADIUS

Client Device Server

The client is a user terminal seeking access to the LAN. It must have 802.1X software to authenticate
to the network access device.

The network access device authenticates the client to control access to the LAN. In a typical 802.1X
environment, the network access device uses an authentication server to perform authentication.

The authentication server is the entity that provides authentication services for the network access
device. It authenticates 802.1X clients by using the data sent from the network access device, and
returns the authentication results for the network access device to make access decisions. The
authentication server is typically a Remote Authentication Dial-in User Service (RADIUS) server. In a
small LAN, you can also use the network access device as the authentication server.

Controlled/uncontrolled port and port authorization

status

802.1X defines two logical ports for the network access port: controlled port and uncontrolled port. Any
packet arriving at the network access port is visible to both logical ports.

The controlled port allows incoming and outgoing traffic to pass through when it is in the authorized
state, and denies incoming and outgoing traffic when it is in the unauthorized state, as shown in a. The
controlled port is set in the authorized state if the client has passed authentication, and in the
unauthorized state, if the client has failed authentication.

The uncontrolled port is always open to receive and transmit EAPOL frames.
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a. Authorized/unauthorized state of a controlled port

Authenticator system 1 Authenticator system 2

Controlled port Uncontrolled port Controlled port Uncontrolled port

A A

l Port unauthorized

|
|
|
|
|
|
|
| Port authorized
|
|
|
|
|
|
|

In the unauthorized state, a controlled port controls traffic in one of the following ways:
e  Performs bidirectional traffic control to deny traffic to and from the client.

e Performs unidirectional traffic control to deny traffic from the client.

NOTE:

The HP devices support only unidirectional traffic control.

802.1X-related protocols

802.1X uses the Extensible Authentication Protocol (EAP) to transport authentication information for the
client, the network access device, and the authentication server. EAP is an authentication framework that
uses the client/server model. It supports a variety of authentication methods, including MD5-Challenge,
EAP-Transport Layer Security (EAP-TLS), and Protected EAP (PEAP).

802.1X defines EAP over LAN (EAPOL) for passing EAP packets between the client and the network access
device over a wired or wireless LAN. Between the network access device and the authentication server,
802.1X delivers authentication information in one of the following methods:

e Encapsulates EAP packets in RADIUS by using EAP over RADIUS (EAPOR), as described in “EAP

relay”.

e Extracts authentication information from the EAP packets and encapsulates the information in standard
RADIUS packets, as described in “EAP termination”.

NOTE:

If an 802.1X client uses EAP, the configuration on username format on the device does not take effect. For
more information about username format configuration, see the chapter "RADIUS configuration"”.

Packet formats

EAP packet format
a shows the EAP packet format.
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a. EAP packet format

0 7 15
Code Identifier 2
Length 4
Data
N

e Code: Type of the EAP packet, which can be Request (1), Response (2), Success (3), or Failure (4).
o |dentifier: Used for matching Responses with Requests.

e length: Length (in bytes) of the EAP packet, which is the sum of the Code, Identifier, Length, and Data
fields.

e Data: Content of the EAP packet. This field appears only in a Request or Response EAP packet. The
field comprises the request type (or the response type) and the type data. Type 1 (Identify) and type 4
(MD5-challenge) are two examples for the type field.

EAPOL frame format
a shows the EAPOL frame format.
a. EAPOL frame format

0 7 15
PAE Ethernet Type 2
Protocol Version Type 4
Length 6

Packet Body

e  PAE Ethernet type: Protocol type. It takes the value Ox888E for EAPOL.
e Protocol version: The EAPOL protocol version used by the EAPOL packet sender.

e Type: Type of the EAPOL packet. 2 lists the types of EAPOL packets that the HP implementation of
802.1X supports.

2. Types of EAPOL packets

Value Type Description

The client and the network access device uses

0x00 EAP-Packet EAP-Packets to transport authentication information.
The client sends an EAPOL-Start message to initiate

0x01 EAPOL-Start 802.1X authentication to the network access device.

0x02 EAPOL-Logoff The client sends an EAPOL-Logoff message to tell the

network access device that it is logging off.

e length: Data length in bytes, or length of the Packet body. If packet type is EAPOL-Start or
EAPOL-Logoft, this field is set to O, and no Packet body field follows.
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e Packet body: Content of the packet. When the EAPOL packet type is EAP-Packet, the Packet body field
contains an EAP packet.

EAP over RADIUS

RADIUS adds two attributes, EAP-Message and Message-Authenticator, for supporting EAP authentication.
For the RADIUS packet format, see the chapter “RADIUS configuration.”

EAP-Message

RADIUS encapsulates EAP packets in the EAP-Message attribute, as shown in a. The Type field takes 79,
and the Value field can be up to 253 bytes. If an EAP packet is longer than 253 bytes, RADIUS encapsulates
it in multiple EAP-Message attributes.

a. EAP-Message attribute format

0 7 15 N

Type Length String

EAP packets

Message-Authenticator

RADIUS includes the Message-Authenticator attribute in all packets that have an EAP-Message attribute to
check their integrity. The packet receiver drops the packet if the calculated packet integrity checksum is
different than the Message-Authenticator attribute value. The Message-Authenticator prevents EAP
authentication packets from being tampered with during EAP authentication.

a. Message-Authenticator atiribute format

0 1 2 18 bytes

Type Length String

Initiating 802.1X authentication

Both the 802.1X client and the access device can initiate 802.1X authentication.

802.1X client as the initiator

The client sends an EAPOL-Start packet to the access device to initiate 802.1X authentication. The
destination MAC address of the packet is the I[EEE 802.1X specified multicast address 01-80-C2-00-00-03
or the broadcast MAC address. If any intermediate device between the client and the authentication server
does not support the multicast address, you must use an 802.1X client, the iNode 802.1X client for example,
that can send broadcast EAPOL-Start packets.

Access device as the initiator

The access device initiates authentication, if a client, the 802.1X client available with Windows XP for
example, cannot send EAPOL-Start packets.
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The access device supports the following modes:

e Multicast trigger mode—The access device multicasts Identity EAP-Request packets periodically (every
30 seconds by default) to initiate 802.1X authentication.

e Unicast trigger mode—Upon receiving a frame with the source MAC address not in the MAC address
table, the access device sends an Identity EAP-Request packet out of the receiving port to the unknown
MAC address. It retransmits the packet if no response has been received within a certain time interval.

802.1X authentication procedures

802.1X authentication has two approaches: EAP relay and EAP termination. You choose either mode
depending on the support of the RADIUS server for EAP packets and EAP authentication methods.

EAP relay is defined in IEEE 802.1X. In this mode, the network device uses EAPoR packets to send
authentication information to the RADIUS server, as shown in a.

a. EAP relay
Client Device RADIUS server
. EAP packets over LAN l‘sg;l EAP packets over RADIUS
| |
I: EAP authentication =:

In EAP termination mode, the network access device terminates the EAP packets received from the client,
encapsulates the client authentication information in standard RADIUS packets, and uses Password
Authentication Protocol (PAP) or Challenge Handshake Authentication Protocol (CHAP) to authenticate to
the RADIUS server, as shown in b.

b. EAP termination

Client Device RADIUS server

. EAP packets over LAN l;g;l RADIUS ‘

:<—EAP authentication—>:<—PAP/CHAP authentication—»{

A comparison of EAP relay and EAP termination

Packet exchange method  Benefits Limitations
* Supports various EAP The RADIUS server must support the
authentication methods. EAP-Message and
EAP relay o The configuration and processing ~ Message-Authenticator attributes,
is simple on the network access and the EAP authentication method
device used by the client.
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Packet exchange method

Benefits

Limitations

EAP termination

Works with any RADIUS server that
supports PAP or CHAP authentication.

Supports only MD5-Challenge
EAP authentication and the
"username + password" EAP
authentication initiated by an
iNode 802.1X client.

The processing is complex on
the network access device.

EAP relay

a shows the basic 802.1X authentication procedure in EAP relay mode, assuming that EAP-MD5 is used.

a. 802.1X authentication procedure in EAP relay mode

Client

EAPOL

Device

N

(1) EAPOL-Start

.
|

=

EAPOR

Authentication server

(2) EAP-Request/Identity

(3) EAP-Response/ldentity

-

(4) RADIUS Access-Request

(EAP-Response/ldentity)

(5) RADIUS Access-Challenge
(EAP-Request/MD5 challenge)

\

(6) EAP-Request/MD5 challenge

A

(7) EAP-Response/MDS5 challenge

(8) RADIUS Access-Request

(10) EAP-Success

(EAP-Response/MD5 challenge)

\

(9) RADIUS Access-Accept
(EAP-Success)

A

(11) EAP-Request/Identity

A

(12) EAP-Response/ldentity

(13) EAPOL-Logoff

\

(14) EAP-Failure

A

Table 97 When a user launches the 802.1X client software and enters a registered username and
password, the 802.1X client software sends an EAPOL-Start packet to the network access device.

Table 98 The network access device responds with an Identity EAP-Request packet to ask for the client

username.

Table 99 In response to the Identity EAP-Request packet, the client sends the username in an Identity
EAP-Response packet to the network access device.
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Table 100 The network access device relays the Identity EAP-Response packet in a RADIUS Access-Request
packet to the authentication server.

Table 101 The authentication server uses the identity information in the RADIUS Access-Request to search its
user database. If a matching entry is found, the server uses a randomly generated challenge
(EAP-Request/MD5 challenge) to encrypt the password in the entry, and sends the challenge in a
RADIUS Access-Challenge packet to the network access device.

Table 102 The network access device relays the EAP-Request/MD5 Challenge packet in a RADIUS
Access-Request packet to the client.

Table 103 The client uses the received challenge to encrypt the password, and sends the encrypted
password in an EAP-Response/MD5 Challenge packet to the network access device.

Table 104 The network access device relays the EAP-Response/MD5 Challenge packet in a RADIUS

Access-Request packet to the authentication server.

Table 105 The authentication server compares the received encrypted password with the one it generated
at step 5. If the two are identical, the authentication server considers the client valid and sends a
RADIUS Access-Accept packet to the network access device.

Table 106 Upon receiving the RADIUS Access-Accept packet, the network access device sends an
EAP-Success packet to the client, and sets the controlled port in the authorized state so the client can
access the network.

Table 107 After the client comes online, the network access device periodically sends handshake requests
to check whether the client is still online. By default, if two consecutive handshake attempts fail, the
device logs off the client.

Table 108 Upon receiving a handshake request, the client returns a response. If the client fails to return a
response affer a certain number of consecutive handshake attempts (two by default), the network
access device logs off the client. This handshake mechanism enables timely release of the network
resources used by 802.1X users that have abnormally gone offline.

Table 109 The client can also send an EAPOL-Logoff packet to ask the network access device for a logoff.
Then

Table 110 In response to the EAPOL-Logoff packet, the network access device changes the status of the
controlled port from authorized to unauthorized and sends an EAP-Failure packet to the client.

NOTE:

In EAP relay mode, the client must use the same authentication method as the RADIUS server. On the
network access device, you only need to configure the EAP relay method.
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EAP termination

a shows the basic 802.1X authentication procedure in EAP termination mode, assuming that CHAP
authentication is used.

a. 802.1X authentication procedure in EAP termination mode

Client Device Authentication server

‘ EAPOL @ RADIUS

(1) EAPOL-Start

\

(2) EAP-Request / Identity

(3) EAP-Response / Identity

\

(4) EAP-Request / MD5 challenge

(5) EAP-Response / MD5 challenge
o (6) RADIUS Access-Request
(CHAP-Response/MD5 challenge)

(7) RADIUS Access-Accept
(CHAP-Success)

(8) EAP-Success

A

(9) EAP-Request/Identity

A

(10) EAP-Response/ldentity

\ 4

(11) EAPOL-Logoff

(14) EAP-Failure

A

In EAP termination mode, it is the network access device rather than the authentication server generates an
MD5 challenge for password encryption (see Step 4). The network access device then sends the MD5
challenge together with the username and encrypted password in a standard RADIUS packet to the RADIUS
server.
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802.1X configuration

HP implementation of 802.1X

This chapter describes how to configure 802.1X on an HP device.

Access control methods

HP implements port-based access control as defined in the 802.1X protocol, and extends the protocol to
support MAC-based access control.

e With port-based access control, once an 802.1X user passes authentication on a port, any subsequent
user can access the network through the port without authentication. When the authenticated user logs
off, all other users are logged off.

e With MAC-based access control, each user is separately authenticated on a port. When a user logs
off, no other online users are affected.

Using 802.1X authentication with other features
VLAN assignment

You can configure the authentication server to assign a VLAN for an 802.1X user that has passed
authentication. The way that the network access device handles VLANs on an 802.1X-enabled port differs
by 802.1X access control mode.

Access control VLAN manipulation

Assigns the VLAN to the port as the default VLAN. All subsequent 802.1X users can

access the default VLAN without authentication.
Port-based ) )
When the user logs off, the previous default VLAN restores, and all other online users

are logged off.

o Ifthe portis a hybrid port with MAC-based VLAN enabled, maps the MAC address
of each user to the VLAN assigned by the authentication server. The default VLAN
of the port does not change. When a user logs off, the MAC+o-VLAN mapping for

MAC-based the user is removed.

o If the port is an access, trunk, or MAC-based VLAN disabled hybrid port, assigns
the first authenticated user's VLAN to the port as the default VLAN. If a different
VLAN is assigned for a subsequent user, the user cannot pass the authentication.

@ IMPORTANT:

e With 802.1X authentication, a hybrid port is always assigned to a VLAN as an untagged member. After the
assignment, do not re-configure the port as a tagged member in the VLAN.

e On a periodic online user re-authentication enabled port, if a user has been online before you enable the
MAC-based VLAN function, the access device does not create a MAC+o-VLAN mapping for the user unless
the user passes re-authentication and the VLAN for the user has changed.
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Guest VLAN

You can configure a guest VLAN on a port o accommodate users that have not performed 802.1X
authentication or have failed 802.1X authentication, so they can access a limited set of network resources,
such as a software server, to download anti-virus software and system patches. After a user in the guest
VLAN passes 802.1X authentication, it is removed from the guest VLAN and can access authorized network
resources.

The device supports guest VLAN on a port that performs port-based access control. The following table
describes the way how the device handles VLANs on such port.

Authentication status VLAN manipulation

Assigns the 802.1X guest VLAN to the port as the default
VLAN. All 802.1X users on this port can access only resources
authentication within 90 seconds after

in the guest VLAN.
802.1X is enabled or the 802.1X user has
failed 802.1X authentication If no 802.1X guest VLAN is configured, the access device does

not perform any VLAN operation.

No 802.1X user has performed

A user in the 802.1X guest VLAN fails The default VLAN on the port is still the 802.1X guest VLAN. All
802.1X authentication users on the port are in the guest VLAN.

o Assigns the VLAN specified for the user to the port as the
default VLAN, and removes the port from the 802.1X guest
VLAN. After the user logs off, the user configured default
VLAN restores.

If the authentication server assigns no VLAN, the user
configured default VLAN applies. The user and all
subsequent 802.1X users are assigned to the
user-configured default VLAN. After the user logs off, the
default VLAN remains unchanged.

A user in the 802.1X guest VLAN passes
802.1X authentication

NOTE:
The device assigns a hybrid port to an 802.1X guest VLAN as an untagged member.

ACL assignment

You can specify an ACL for an 802.1X user to control its access to network resources. After the user passes
802.1X authentication, the authentication server, either the local access device or a RADIUS server, assigns
the ACL to the port to filter the traffic from this user. In either case, you must configure the ACL on the access
device. You can change ACL rules while the user is online.

Contiguring 802.1X

Contiguration prerequisites
e Configure an ISP domain and AAA scheme (local or RADIUS authentication) for 802.1X users.

e If RADIUS authentication is used, create user accounts on the RADIUS server.

e Iflocal authentication is used, create local user accounts on the access device and set the service type
to lan-access.

For how to configure RADIUS client and local EAP authentication, see the chapter “AAA configuration”.
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802.1X configuration task list

1. 802.1X configuration task list

Task Description
Required
Configuring 802.1X globally Enable 802.1X authentication globally and configure the

authentication method and advanced parameters.

By default, 802.1X authentication is disabled globally.

Required
Error! Reference source not Enable 802.1X authentication on specified ports and configure
found. 802.1X parameters for the ports.

By default, 802.1X authentication is disabled on a port.

Contfiguring 802.1X globally

From the navigation tree, select Authentication > 802.1X to enter the 802.1X configuration page. In the
802.1X Configuration area, you can view and configure the 802.1X feature globally.

a. 802.1X configuration page

802.1X Configuration
[ Enabis 60214

Authardcalion Mithod | CHAP -

+Advanced

Ports With 302.1X Enabled

il Eurl Gontral M shakin s Aulhrbcalion Ua‘":':"'" = 1VLAN o Aulh i
[ ClgabnEthermet i MAC Dazed Enahled Dizsdled 156 Digabled Alto o |
Add Dl Barlischnd
2. Basic 802.1X configuration items
ltem Description
Enable 802.1X Enable or disable 802.1X authentication globally.
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ltem

Description

Specify the authentication method for 802.1X users. Options include CHAP,
PAP, and EAP.

e CHAP: Sets the access device to perform EAP termination and use the
CHAP to communicate with the RADIUS server.

o PAP: Sets the access device to perform EAP termination and use the PAP
to communicate with the RADIUS server.

e EAP: Sets the access device to relay EAP packets, and supports any of

Authentication Method the EAP authentication methods to communicate with the RADIUS server.

@ IMPORTANT:

If the client supports only MD5-Challenge EAP authentication, you can use
both EAP termination and EAP relay. To use EAP-TL, PEAP, or any other EAP
authentication methods, you must use EAP relay. When you make your
decision, see "A comparison of EAP relay and EAP termination" for help.

For more information about EAP relay and EAP termination, see "802.1X
authentication procedures".

Click Advanced to expand the advanced 802.1X configuration area. as shown in a.

3. Advanced 802.1X configuration page

802.1X Configuration

[C] Enanle 002.1%

munentication Method | CHAP

—Advanced

Guuiet [ 1 Enable e Guiet Function Quiet Pariod 60 seconde0-120, Detaul = )

Retry Times 4 (110, Defelt=7) T%-Penod 30 soconds(10-120, Def Iy

Handshak Prriod 15 seconds(5-1024, Defauit=15) Rue-Authenlication Pesiod AENOgeconde(G-7 200, Default= JG00)

Supplicart Timeout Time 10 sacons® £(1-120, Dafault = 205 Sarver Timeou Time 100 sacona &1 C0- 300, Dealault = 100y

Appy

Ports With 802.1X Enabled
0 W Por Garial Finde i P — e GuanAvLAN Purt Auhairizibar apatitor
j CigabitEmemett oM MAC Based Enabled Dizabled 256 Disabled Auto @ ﬂ

A Del Selected

4. Advanced 802.1X configuration items

ltem

Description

Quiet

Specify whether to enable the quiet timer.

After an 802.1X user fails to be authenticated, the device will keep quiet for a period of time
defined by Quiet Period. During the quiet period, the device will not perform 802.1X
authentication on the user.

Quiet Period

Specify the value of the quiet timer.

Retry Times

Set the maximum number of authentication request attempts.

The network access device retransmits an authentication request if it receives no response to
the request it has sent to the client within a period of time (specified by using the TX Period
option or the Supplicant Timeout Time option). The network access device stops
retransmitting the request, if it has made the maximum number of request transmission
attempts but still received no response.
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ltem Description

Set the username request timeout timer.

The timer starts when the device sends an EAP-Request/Identity packet to a client in
response to an authentication request. If the device receives no response before this timer

TX-Period o .
ene expires, it refransmits the request.

The timer also sets the interval at which the network device sends multicast
EAP-Request/Identity packets to detect clients that cannot actively request authentication.

Set the handshake timer.

The timer sets the interval at which the access device sends client handshake requests to
Handshake check the online status of a client that has passed authentication. If the device receives no
Period response after sending the maximum number of handshake requests, it considers that the
client has logged off. For information about how to enable the online user handshake
function, see "Configuring 802.1X on a port".

Set the periodic online user re-authentication timer.

Re-Authenticatio  The timer sets the inferval at which the network device periodically re-authenticates online
802.1X users. The change to the periodic re-authentication timer applies to the users that

n Period
have been online only after the old timer expires. For information about how to enable
periodic online user re-authentication on a port, see "Configuring 802.1X on a port".
Set the client timeout timer.

Supplicant The timer starts when the access device sends an Q TIP:

EAP-Request/MD5 Challenge packet to a client. If no
response is received when this timer expires, the
access device retransmits the request to the client.

Timeout Time You can set the client timeout

timer to a high value in a
low-performance network, and

Set the server timeout timer. adjust the server timeout timer to

The timer starts when the access device sends a adapt to the performance of
Server Timeout  RADIUS Access-Request packet to the authentication  different authentication servers. In
Time server. If no response is received when this timer most cases, the default settings

expires, the access device retransmits the requestto the ~ are sufficient.

server.

NOTE:

Do not change the timer parameters of global 802.1X from their default values unless you have
determined that the changes would better the interaction process.

Return to 802.1X configuration task list.

Contiguring 802.1X on a port

From the navigation tree, select Authentication > 802.1X to enter the 802.1X configuration page, as
shown in a. In the Ports With 802.1X Enabled areq, the 802.1X configuration on ports are listed. Click Add
to enter the port 802.1X configuration page, as shown in a.
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a.

802.1X configuration on a port
Apply 80213 Port Configuration
Part :"L;_%-igahitE.tI;ernet 101 v |
Paort Control | MAC Based v
Port Authorization | Auto ¥

Max Mumber of Lisers

Handshake

Re-Authentication

Guest VLAN

-

256 [(1-256, Default = 256)
[¥] Enable Handshake
[l Enable Re-Authentication

[ClEnable Guest VLAM YLAN 1D (1-4094;

[terms marked with an asterisk(*} are required

Apply Cancel
2. Port 802.1X configuration items
ltem Description
Select the port to be enabled with 802.1X authentication. Only 802.1X-disabled
ports are available.
Port @ IMPORTANT:

e Ifthe PVID of a port is the same as a voice VLAN, the 802.1X function cannot
take effect on the port.

e 802.1X is mutually exclusive with link aggregation configuration on a port.

Port Control

Select the access control method for the port, which can be MAC Based or Port
Based.

Port Authorization

Select the port authorization state for 802.1X.
Options include:

e Auto—Places the port initially in the unauthorized state to allow only EAPOL
packets to pass, and after a user passes authentication, sets the port in the
authorized state to allow access to the network. You can use this option in
most scenarios.

o Force-Authorized—Places the port in the authorized state, enabling users on
the port fo access the network without authentication.

e Force-Unauthorized—Places the port in the unauthorized state, denying any
access requests from users on the port.

Max Number of Users

Set the maximum number of concurrent 802.1X users on the port.
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ltem Description

Specify whether to enable the online user handshake function.

The online user handshake function checks the connectivity status of online
802.1X users. The network access device sends handshake messages to online
users at the interval specified by the Handshake Period setting. If no response is
received from an online user after the maximum number of handshake attempts

HandShake (set by the Retry Times setting) has been made, the network access device sets the
user in the offline state. For information about the timers, see 4.

@ IMPORTANT:

If the network has 802.1X clients that cannot exchange handshake packets with
the network access device, disable the online user handshake function to prevent
their connections from being inappropriately torn down.

Specify whether to enable periodic online user re-authentication on the port.

Periodic online user re-authentication tracks the connection status of online users

Enable Re-authentication and updates the authorization attributes assigned by the server, such as the ACL,
and VLAN. The re-authentication interval is specified by the Re-Authentication
Period setting in 4.

Specify an existing VLAN as the guest VLAN. For more information, see

Guest VIAN "Configuring an 802.1X guest VLAN."

Return to 802.1X configuration task list.
Configuring an 802.1X guest VLAN

Table 111 Configuration guidelines
e You can configure only one 802.1X guest VLAN on a port. The 802.1X guest VLANs on different ports

can be different.

e Assign different IDs for the voice VLAN, default VLAN, and 802.1X guest VLAN on a port, so the port
can correctly process incoming VLAN tagged traffic.

e With 802.1X authentication, a hybrid port is always assigned to a VLAN as an untagged member.
After the assignment, do not re-configure the port as a tagged member in the VLAN.

Table 112 Configuration prerequisites

e Create the VLAN to be specified as the 802.1X guest VLAN.

e Onthe 802.1X-enabled port that performs port-based access control, enable 802.1X multicast trigger
at the command line interface. (802.1X multicast trigger is enabled by default.)

Configuration examples

802.1X configuration example

Network requirements

e As shown in g, it is required to perform 802.1X authentication on port GigabitEthernet 1/0/1 to
control user access to the Internet, configure the access control method as MAC address based on the
port, and enable periodic re-authentication of online users on the port, so that the server can
periodically update the authorization information of the users.
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o All users belong to default domain test. RADIUS authentication is performed. If RADIUS accounting
fails, the switch gets the corresponding user offline. The RADIUS servers run iMC.

e Aserver group with two RADIUS servers is connected fo the switch. The IP addresses of the servers are
10.1.1.1 and 10.1.1.2 respectively. Use the former as the primary authentication/secondary
accounting server, and the latter as the secondary authentication/primary accounting server.

o Setthe shared key for the device to exchange packets with the authentication server as name, and that
for the device to exchange packets with the accounting server as money.

e Specily the device to try up to five times at an interval of 5 seconds in transmitting a packet to the
RADIUS server until it receives a response from the server, and to send real time accounting packets to
the accounting server every 15 minutes.

e Specity the device to remove the domain name from the username before passing the username to the

RADIUS server.

a. Network diagram for 802.1X configuration

Vlan-int2
1.1.1.1/24
GE1/0/1

10.1.1.1

10.1.1.2
Supplicant Authenticator Authentication servers
1.1.1.10/24 (Switch) (RADIUS server cluster)

Configuration procedure

NOTE:

The following configuration procedure involves RADIUS client configuration for the switch, while
configurations on the RADIUS servers are omitted. For information about RADIUS configuration, see
chapter "RADIUS configuration."

Table 113 Configure the IP addresses of the interfaces. (omitted)
Table 114 Configure 802.1X.

# Enable 802.1X globally.
e  From the navigation tree, select Authentication > 802.1X to enter the 802.1X configuration page.
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b. Global 802.1X configuration

802.1X Configuration

[] Enable 802.1%

Authentication Method ‘ CHAR v
+Advanced
Apply
Ports With 802.1X Enabled
Part Re- MEE - Guest Part .
[P Port Contral Handshake Sz NLUJ;nehrir of VLAN SuihaiEliEn Operation
Add Del Selected

o Select the check box before Enable 802.1X.
o  Select the authentication method as CHAP.
e Click Apply to finish the operation.
# Enable and configure 802.1X on port GigabitEthernet 1/0/1.
e In the Ports With 802.1X Enabled areq, click Add.
c. 802.1X configuration of GigabitEthernet 1/0/1

Apply 802.1X Port Configuration

Port !_C—iigahitEthernet1.-"[]-"1 ™ |

Port Cantrol | MAC Based |

Fort Authorization i Auto x |

Max Mumber of Users [256 [*(1-256, Default = 256)

Handshake [¥] Enable Handshake

Re-Althentication Enable Re-Authentication

Guest VLAN [CJEnable Guest V&N WLAR ID- (1-4094)

ltems marked with an asterisk(*) are required

Apply Cancel

o Select port GigabitEthernet1/0/1 from the port drop-down list.
e  Select the checkbox before Enable Re-Authentication.

e  Click Apply to finish the operation.
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Table 115 Configure the RADIUS scheme system.

# Configure the RADIUS authentication servers.

e From the navigation tree, select Authentication > RADIUS. The RADIUS server configuration page
appears.

d. RADIUS authentication server configuration

RADIUS Setup

Server Type: |Authenti|:atinn Server V|

Primary Server IF: |1U. 111 i

Frimary Server UDP N )
Bort 1812 1-65535)
Frimary Server Status: | active ¥ |
Secondary Server IP: |1U. 112 *
Secondary Server UDP A .
Port 1812 1-65535)
Secondary Server .

Status: | active v|

[tems marked with an asterisk(®) are required

Apply

o Select Authentication Server as the server type.
o Enter the primary server IP address 10.1.1.1.

o Select active as the primary server’s status.

e  Enter the secondary server IP address 10.1.1.2.
o Select active as the secondary server’s status.

e Click Apply.

# Configure the RADIUS accounting servers.

e. RADIUS accounting server configuration

RADIUS Setup

Server Type: |A|:|:|:|L|ming Server ¥ |
Frimary Server IP: |10.1.1.2 |
Frimary Server LDP )
Do 11813 H1-65535)
Primary Server Status: | active v |

Secondary Server IP: |1EJ.1.1.1 |

Secondary Server LIDP

Port 11813 H1-65525)
Secondary Server -
Status: ‘ active = |

lterms marked with an asterisk(*) are required

Apply

e Select Accounting Server as the server type.
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Enter the primary server IP address 10.1.1.2.

Select active as the primary server’s status.

Enter the secondary server IP address 10.1.1.1.

Select active as the secondary server's status.

Click Apply to finish the operation.

# Configure the scheme used for communication between the device and the RADIUS servers.

f.

Select the RADIUS Setup tab to enter the RADIUS parameter configuration page.

RADIUS parameter configuration

RADIUS Server

Server Type: extended

¥ Authentication Server Shared Key: oo (1-64 Chars.)
Confirm Authentication Shared Key: seee

#Accounting Server Shared Key: eevee (1-64 Chars.)
Confirm Accounting Shared Key: eonee

NAS-IP:

Timeout Interval: 5 “seconds(1-10)

Timeout Retransmission Times: 5 “(1-20)

Realtime-Accounting Interval: 15 “minutes(0-60, Must be a multiple of 3)

Realtime-Accounting Packet Retransmission Times: 5 “(1-255)

Stop-Accounting Buffer: enable

Stop-Accounting Packet Retransmission Times: 500 “(10-65535)

Quiet Interval: 5 “minutes(1-255)

Username Format: with-domain

Unit of Data Flows: byte

Unit of Packets: packet

ltems marked with an asterisk(*) are required

Select extended as the server type.

Select the Authentication Server Shared Key checkbox, and enter name in the textbox.

Enter name again in the Confirm Authentication Shared Key textbox.

Select the Accounting Server Shared Key checkbox, and enter money in the textbox.

Enter money again in the Confirm Accounting Shared Key textbox.

Enter 5 in the Timeout Interval textbox

Enter 5 in the Timeout Retransmission Times textbox.

Enter 15 in the Realtime-Accounting Interval textbox.

Click Apply to finish the operation.

Table 116 Configure AAA

# Create an ISP domain.

From the navigation tree, select Authentication > AAA. The domain setup page appears.
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g. Create an ISP domain

Authentication Authorization Accounting
ISP Domain
Damain Mame |test % (1 - 24 Chars)
Default Domain | Enable ]
Apply

Flease selectthe ISP domainis)

Dormain Mame

e  Enter test in the Domain Name textbox.

o Select Enable to use the domain as the default domain.

e  Click Apply to finish the operation.

# Configure the AAA authentication method for the ISP domain.
e  Select the Authentication tab.

h. Configure the AAA authentication method for the ISP domain

Domain Setup Autharization Accounting

Authentication Configuration of AAA

Default Dormain

Select an ISP domain test v

Default Authi RADIUS | MName |system v Secondary Method

CJLaM-access Authil Marne Secondary Method

[ Login AuthiM MName Secondary Mathod
FPP Authi Marme Secondary Method
Fortal Autht Marme

e  Select the domain name test.
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Select the Default AuthN checkbox and then select RADIUS as the authentication mode.

Select system from the Name drop-down list to use it as the authentication scheme.

Click Apply. A configuration progress dialog box appears, as shown in i.

Configuration progress dialog box

Current Configuration

Setting Default Authh - Kl

100%

Close

After the configuration process is complete, click Close.

# Configure the AAA authorization method for the ISP domain.

Select the Authorization tab.

Configure the AAA authorization method for the ISP domain

Domain Setup Authentication Accounting
Autharization Configuration of ARA
Select an ISP domain
Default AuthZ RADIUS ~| Mame | system
CJLAN-access AuthZ Mame
(] Login AuthZ Marne
PPP AuthZ Marne
Fortal AuthZ Mame
Command AuthZ Mame

Select the domain name test.

Select the Default AuthZ checkbox and then select RADIUS as the authorization mode.

Secondary hethod
Secondary Method
Secaondary Method
Secondary Method

Select system from the Name drop-down list to use it as the authorization scheme.

Click Apply. A configuration progress dialog box appears.

After the configuration process is complete, click Close.

# Configure the AAA accounting method for the ISP domain.

Select the Accounting tab.
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k. Configure the AAA accounting method for the ISP domain

Darmain Setup Althentication Autharization

Accounting Configuration of A&A

Select an 15P domain

DAccnunting Optional

[v] Default Accounting RADIIS | Mame |system w | | Secondary Method

[JL&N-access Accounting Marne Secondary Method

[] Login Accounting Mame Secondary Mathod
PPP Accounting Mame Secondary Method
Portal Accounting Marne

ARply

o Select the domain name fest.

o Select the Default Accounting checkbox and then select RADIUS as the accounting mode.
o Select system from the Name drop-down list to use it as the accounting scheme.

e Click Apply. A configuration progress dialog box appears.

o After the configuration process is complete, click Close.

ACL assignment configuration example

Network requirements

As shown in g, the switch and the RADIUS authentication servers (iMC servers) work together to authenticate
the host that is to access the Internet. An FTP server is on the Internet, and its IP address is 10.0.0.1.

e Configure the authentication server to assign ACL 3000.
e  Enable 802.1X on port GigabitEthernet 1/0/1 and configure ACL 3000 on the switch.

After a user passes 802.1X authentication, the authentication server assigns ACL 3000. At this time, ACL
3000 takes effect on GigabitEthernet 1/0/1, allowing the host to access the Internet but not the FTP server.

a. Network diagram for ACL assignment

Authentication servers
5 (RADIUS server cluster)

el 10.1.1.1

10.1.1.2

Vlan-int2
192.168.1.1/24
N Internet
GE1/0/1

Host Switch FTP server
192.168.1.10 10.0.0.1
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Configuration procedure

Table 117 Configure the IP addresses of the interfaces. (Omitted)
Table 118 Configure the RADIUS scheme system

# Configure the RADIUS authentication server.

e  From the navigation tree, select Authentication > RADIUS. The RADIUS server configuration page
appears.

b. RADIUS authentication server configuration

RADIUS Setup

Server Type: |Authenticatinn Server V|

Primary Server IP: |1U.1. 1.1 B

Primary Server UDP Port: |1B1.’2 “(1-65539)
Frimary Server Status: | active hd |
Secondary Server IF: |[].U.E].U -
Secondary Server UDP Part: | 1812 *(1-65535)
Secondary Server Status: | hlock V|

ltems marked with an asterisk(*} are required

Apply

o Select Authentication Server as the server type.

o Enter the primary server IP address 10.1.1.1.

e Enter the primary server UDP port number 1812.
o Select active as the primary server status.

o Click Apply.

# Configure the RADIUS accounting server.

c. RADIUS accounting server configuration

RADIUE Setup

Server Type: |Accuunting Server ¥ |
Primary Server IP: |1EI. 1.1.2 &
Primary Server LUDP Port: |1813 “(1-65535)
Primary Server Status: | active b |
Secondary Server |P: |U.U.U.U :
Secondary Server UDF Port | 1513 *(1-65535)
Secondary Server Status: |h|nck w |
ltems marked with an asterisk(*) are required
Apply
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Select Accounting Server as the server type.

Enter the primary server IP address 10.1.1.2.
Enter the primary server UDP port number 1813.

Select active as the primary server status.

Click Apply to finish the operation.

# Configure the scheme to be used for communication between the switch and the RADIUS servers.

d.

Select the RADIUS Setup tab to enter the RADIUS parameter configuration page.

RADIUS parameter configuration

RADIUS Server

Server Type: extended

7 Authentication Server Shared Key: se (1-64 Chars.)
Confirm Authentication Shared Key: eoe

#Accounting Server Shared Key: eoe (1-64 Chars.)
Confirm Accounting Shared Key: soe

NAS-IP:

Timeout Interval: 3 “seconds(1-10})

Timeout Retransmission Times: 3 “(1-20)

Realtime-Accounting Interval: 12 “minutes(0-60, Must be a multiple of 3)

Realtime-Accounting Packet Retransmission Times: 5 “(1-255)

Stop-Accounting Buffer: enable

Stop-Accounting Packet Retransmission Times: 500 “(10-65535)

Quiet Interval:

Username Format:

without-domain

“‘minutes(1-255)

Unit of Data Flows: byte
Unit of Packets: packet
Iltems marked with an asterisk(*) are required

Select extended as the server type.

Select the Authentication Server Shared Key checkbox, and enter abc in the textbox.

Enter abe again in the Confirm Authentication Shared Key textbox.

Select the Accounting Server Shared Key checkbox, and enter abe in the textbox.

Enter abc again in the Confirm Accounting Shared Key textbox.

Select without-domain as the username format.

Click Apply to finish the operation.

Table 119 Configure AAA

# Create an ISP domain.

From the navigation tree, select Authentication > AAA. The domain setup page appears.
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e. Create an ISP domain

Authentication Authorization Accounting
ISP Domain
Damain Mame |test % (1 - 24 Chars)
Default Domain | Enable ]
Apply

Flease selectthe ISP domainis)

Dormain Mame

e  Enter test in the Domain Name textbox.

e Select Enable to use the domain the default domain.

e  Click Apply to finish the operation.

# Configure the AAA authentication method for the ISP domain.
e  Select the Authentication tab.

f.  Configure the AAA authentication method for the ISP domain

Domain Setup Autharization Accounting

Authentication Configuration of AAA

Default Dormain

Select an ISP domain test v

Default Authi RADIUS | MName |system v Secondary Method

CJLaM-access Authil Marne Secondary Method

[ Login AuthiM MName Secondary Mathod
FPP Authi Marme Secondary Method
Fortal Autht Marme

e  Select the domain name test.
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Select the Default AuthN checkbox and then select RADIUS as the authentication mode.

Select system from the Name drop-down list to use it as the authentication scheme.

Click Apply. A configuration progress dialog box appears, as shown in g.

Configuration progress dialog box

Current Configuration

=etting Default AuthM - OKI

100%

Close

Atter the configuration process is complete, click Close.

# Configure the AAA authorization method for the ISP domain.

h.

Configure the AAA authorization method for the ISP domain

Domain Setup Authentication Accounting
Autharization Configuration of ASA

Select an 5P domain
Diefault AuthZ RADIUS ~ | Mame | system v
[JLAN-access AuthZ Marme
O Lagin AuthZ Marme

PPP AuthZ Mame

Faortal AuthZ Mame

Command AuthZ Mame

Select the Authorization tab.

Select the domain name test.

Select the Default AuthZ checkbox and then select RADIUS as the authorization mode.

Secondary Method
Secaondary Method
Secondary Method
Secondary Method

Select system from the Name drop-down list to use it as the authorization scheme.

Click Apply. A configuration progress dialog box appears.

After the configuration process is complete, click Close.

# Configure the AAA accounting method for the ISP domain, and enable accounting optional.

Select the Accounting tab.
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i.  Configure the AAA accounting method for the ISP domain

Domain Setup Authentication Autharization

Accounting Canfiquration of Al

Select an ISP domain test w
[¥] Accounting Optional Enable v
[] Default Accounting RADIUS | MName |system ~ || Secondary Method w
[ LAN-access Accounting Marme Secondary Method
[J Login Accounting Mame Secondary Method
PPP Accounting Mame Secondary Method
Fortal Accounting Mame

o Select the domain name fest.

o Select the Accounting Optional checkbox, and then select Enable for this parameter.

o Select the Default Accounting checkbox and then select RADIUS as the accounting mode.
o Select system from the Name drop-down list to use it as the accounting scheme.

e Click Apply. A configuration progress dialog box appears.

o After the configuration process is complete, click Close.

Table 120 Configure an ACL.

# Create ACL 3000 that denies packets with destination IP address 10.0.0.1.

e  From the navigation tree, select QoS > ACL IPv4 to enter the IPv4 ACL configuration page, and then
select the Create tab.

i- Create ACL 3000
Summary Basic Setup Advanced Setup Link Layer Setup Remaowe
ACL Mumber 3000 2000-2959 for basic ACLs.
3000-3999 for advanced ACLs.
4000-4939 for Ethernet frame header ACLS.
Match Order Config »
Apply
ACL Mumber Type Humber of Rules Match Qrder
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e Enter 3000 as the ACL number.
e  Click Apply to finish the operation.

# Configure the ACL to deny packets with destination IP address 10.0.0.1.
e Select the Advanced Setup tab.

k. ACL rule configuration

Summary Create Basic Setup Link Layer Setup Remaove

ACL | 3000 W Help

Configure an Advanced ACL

Rule ID 0 0-65534, ITno 1D is entered, the system will specify one)
Artion Demy W
[ ron-first Fragments Only [ Logging

IP Address Filter

[Jsource IP Address Source Wildcard
[“] Destination IP Address | 10.0.0.1 Destination Wildcard [0.0.0.0
Protocol | IP A

ICMWP Type

ICHP Message

ICHMP Type (0-255) ICWMP Code (0-255)

TCPIUDP Port
TCF Connection

Estahlished
Source: Qperatar Fart -
Destination: Dperatar Fart -

(Range of Partis 0-65535)

Frecedence Filter

DSCP | Mot Check “
TOE Mot Check - Precedence | Mot Check -

Time Range | Mot Check
Add

Rule ID Operation Diescription Time Range

e Select 3000 from the Select Access Control List{ACL) drop-down list.
e  Select the Rule ID check box, and enter O as the rule ID.
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e Select Deny as the operation action.

e Inthe IP Address Filter areq, select the Destination IP Address check box, and enter 10.0.0.1 in the text
box.

e  Enter 0.0.0.0 in the Destination Wildcard text box.

e Click Add to finish the operation.

Table 121 Configure the 802.1X feature.

# Enable the 802.1X feature globally.

e From the navigation tree, select Authentication > 802.1X to enter the 802.1X configuration page.

I.  Global 802.1X globally

8021 Canfiguration
[] Enable 802.1%

Authentication Method | CHAF v
+Advanced
Apply
Ports With 802 13X Enabled
[IE=FY

Re- Guest Faort .

Fl Faort Fort Cantral - Handshake Euisrleelan Nﬂr;nebrzrnf WLAN PUTETREE Qperatian
Add Del Selected

e  Select the check box before Enable 802.1X.

o Select the authentication method as CHAP.

e Click Apply to finish the operation.

# Enable 802.1X on port GigabitEthernet 1/0/1.

e In the Ports With 802.1X Enabled areq, click Add.

348



m. 802.1X configuration of GigabitEthernet 1/0/1

Apply 802.1X Port Configuration

Port I GigabitEthernat1/01 » |
Part Control ‘ MAC Based b !
Part Authorization | Auto X |

WMax Mumber of Users |256 [*(1-256, Default = 256)

Handshake Enable Handshake
Re-Authentication ] Enable Re-Authentication
Guest VLAR [l Enahle Guest VLM WLAMN ID. (1-4004)

[tems marked with an asterisk(*} are required

Apply Cancel

e Select GigabitEthernet1/0/1 from the port list.
o Click Apply to finish the operation.

Configuration verification

# After the user passes authentication and gets online, use the ping command to test whether ACL 3000
takes effect.

e  From the navigation tree, select Network > Diagnostic Tools. The ping page appears.
o Enter the destination IP address 10.0.0.1.
o Click Start to start the ping operation.

e ashows the ping operation summary.
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a. Ping operation summary

Summany

PING 10.0.0.1:
Fequeszt tine
Request time
Request time
Request tine
Requezt tine

a6

out
out
out
out
ot

data bytes

---10.0.0.1 ping statistics ---
5 packetis) transmitted
0 packetis) received
100.00% packet loss
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AAA contiguration

Overview

Introduction to AAA

Authentication, Authorization, and Accounting (AAA) provides a uniform framework for implementing
network access management. It can provide the following security functions:

e  Authentication—Identifies users and determines whether a user is valid.

e Authorization—Grants different users different rights and controls their access to resources and
services. For example, a user who has successtully logged in to the device can be granted read and
print permissions to the files on the device.

e Accounting—Records all network service usage information of users, including the service type, start
time, and traffic. The accounting function not only provides the information required for charging, but
also allows for network security surveillance.

AAA usually uses a client/server model. The client runs on the network access server (NAS), which is also
referred to as the access device. The server maintains user information centrally. In an AAA network, a NAS
is a server for users but a client for the AAA servers. See a.

a. Network diagram for AAA

5 A
=

< Internet
NAS RADIUS server 1

RADIUS server 2

When a user tries to log in to the NAS, use the network resources, or access other networks, the NAS
authenticates the user. The NAS can transparently pass the user’s authentication, authorization, and
accounting information to the servers. The RADIUS protocol define how a NAS and a remote server
exchange user information between them.

In the network shown in a, there are two RADIUS servers. You can choose different servers for different
security functions. For example, you can use RADIUS server 1 for authentication and authorization, and
RADIUS server 2 for accounting.

You can choose the three security functions provided by AAA as required. For example, if your company
only wants employees to be authenticated before they access specific resources, you only need to configure
an authentication server. If network usage information is needed, you must also configure an accounting
server.
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AAA can be implemented through multiple protocols. The switch supports using RADIUS, which is the most
commonly used protocol in practice. For more information, see the chapter “RADIUS configuration.”

Domain-based user management

On a NAS, each user belongs to one Internet service provider (ISP) domain. A NAS determines the ISP
domain a user belongs to by the username entered by the user at login, and controls access of the user
based on the AAA methods configured for the domain. If no specific AAA methods are configured for the
domain, the default methods are used. See a.

a. Determine the ISP domain of a user by the username

NAS

A user enters the username in
. se the AAA methods an
the form of Username contains ) -
. . ) attributes of domain
userid@domain-name @domain-name? .
or userid domain-name for the user,

Use the AAA methods and attributes
of the default domain for the user

Configuring AAA

Configuration prerequisites

To implement local user authentication, authorization, and accounting, you must create local users and
configure user attributes on the switch. See the chapter “User configuration”.

To implement remote authentication, authorization, or accounting, you must create the RADIUS schemes to
be referenced. For RADIUS scheme configuration information, see the chapter “RADIUS configuration”.

Configuro’rion task list

Task Remarks

Optional

Configuring an ISP domain Create ISP domains and specify one of them as the default ISP domain.

By default, there is a system predefined ISP domain named system, which is the
default ISP domain.
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Task Remarks

Optional

Configuring authentication  Configure authentication methods for various types of
methods for the ISP domain  users. AAA user types

Lo include LAN users
By default, all types of users use local authentication. (such as 802.1X

Optional authentication users
and MAC
authentication users),

login users (such as
By default, all types of users use local authorization.  SSH, Telnet, FTP,

Configuring authorization Specify the authorization methods for various types of
methods for the ISP domain  users.

terminal access
users), and command
users.

Required

Configuring accounting Specify the accounting methods for various types of
methods for the ISP domain  users.

By default, all types of users use local accounting.

Configuring an ISP domain

Select Authentication > AAA from the navigation tree. The Domain Setup page appears, as shown in a.

a. Domain Setup page

Authentication Autharization Accounting
ISP Domain
Damain Mame M (1-24 Charg.)
Default Domain | Disable b

Flease selectthe ISP domaings)

Diomain Mame Diefault Domain
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2. ISP domain configuration items

ltem Description

Type the ISP domain name, which is for identifying the domain.

Domain Name You can type a new domain name to create a domain, or specify an existing domain
to change its status (whether it is the default domain).

Specify whether to use the ISP domain as the default domain.
e Enable: Uses the domain as the default domain.
Detfault Domain e Disable: Uses the domain as a non-default domain.

There can only be one default domain at a time. If you specify a second domain as
the default domain, the original default domain becomes a non-default domain.

Return to Configuration task list.

Contiguring authentication methods for the ISP domain

Select Authentication > AAA from the navigation tree and then select the Authentication tab to enter the
authentication method configuration page, as shown in a.

a. Authentication method configuration page

Domain Setup Autharization Accounting

Authentication Configuration of AdA

Selact an ISP domain system ¥

[ Default Authrl Mame Secandary Method

CLaM-access Authi Marme Secondary Method

[ Login Authi Mame Secondary Method
PPP Authh Mame Secondary Method
Portal Authi Marne

2.  Authentication method configuration items

ltem Description

Select an ISP . . . .

domain Select the ISP domain for which you want to specify authentication methods.

Default AuthN Configure the default authentication method and secondary authentication method for all
types of users.
Options include:

Name

e Local—Performs local authentication.

e None—All users are trusted and no authentication is performed. Generally, this
mode is not recommended.

Secondary Method ® RADIUS—Performs RADIUS authentication. You must specify the RADIUS scheme to
be used.

e Not Set—Restore the default, that is, local authentication.
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ltem Description

LAN-access AuthN  Configure the authentication method and secondary authentication method for LAN
users.

Name Options include:

e Local—Performs local authentication.

e None—All users are trusted and no authentication is performed. For security, do not
use this mode whenever possible.
Secondary Method  ,  RADIUS —Performs RADIUS authentication. You must specify the RADIUS scheme to
be used.

e Not Set—Uses the default authentication methods.

Configure the authentication method and secondary authentication method for login
users.

Login AuthN

Options include:

Name
e local—Performs local authentication.

e None—All users are trusted and no authentication is performed. Generally, this
mode is not recommended.

Secondary Method ~ ® RADIUS—Performs RADIUS authentication. You must specify the RADIUS scheme to
be used.

e Not Set—Uses the default authentication methods.

Return to Configuration task list.

Contfiguring authorization methods for the ISP domain

Select Authentication > AAA from the navigation tree and then select the Authorization tab to enter the
authorization method configuration page, as shown in a.

a. Authorization method configuration page

Domain Setup Authentication Accounting

Autharization Configuration of ARA

Select an ISP darmain system ¥
[JDefault AuthZ Mame Secondary Method
[JLAN-access AuthZ Marme Secondary Method
[ Login Authz Mame Secondary Method
PFP AuthZ Mame Secandary Method
Fartal AuthZ Mame
Cammand AuthZ Mame
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2. Authorization method configuration items

ltem Description
Select an ISP . . . -
domain Select the ISP domain for which you want to specify authentication methods.
Default AuthZ Configure the default authorization method and secondary authorization method for all
types of users.
Options include:
Name N
e Local—Performs local authorization.
e None—All users are trusted and authorized. A user gets the corresponding default
rights of the system.
'i\ectinjﬂry o RADIUS —Performs RADIUS authorization. You must specify the RADIUS scheme to be
etho

used.

e Not Set—Restore the default, that is, local authorization.

LAN-access Authz ~ Configure the authorization method and secondary authorization method for LAN access
users.

Name Options include:

e Local—Performs local authorization.

e None—All users are trusted and authorized. A user gets the corresponding default
rights of the system.

Secondary
Method o RADIUS —Performs RADIUS authorization. You must specify the RADIUS scheme to be
used.
o Not Set—Uses the default authorization method.
Login AuthZ Configure the authorization method and secondary authorization method for login users.
Options include:
N o local—Performs local authorization.
ame
e None—All users are trusted and authorized. A user gets the corresponding default
Secondary rights of the system.
Method o RADIUS —Performs RADIUS authorization. You must specify the RADIUS scheme to be
used.
Name

e Not Set—Uses the default authorization methods.

Return to Configuration task list.

Contfiguring accounting methods for the ISP domain

Select Authentication > AAA from the navigation tree and then select the Accounting tab to enter the
accounting method configuration page, as shown in a.
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a. Accounting method configuration page

Domain Setup Authentication Authorization

Accounting Configuration of AR&

Select an ISP domain system ¥

DAcwunting Optianal

[ ] Default Accounting Mame Secondary Method

[ LAM-access Accounting Marne Secondary Method

[ Login Accounting Marme Secandary Methad
PPP Accounting Mame Secondary Method
Paortal Accounting Marre

2. Accounting method configuration items

ltem Description
Select an ISP . . . "
di::]i:n Select the ISP domain for which you want to specify authentication methods.
Specify whether to enable the accounting optional feature.
Accounting When no accounting server is available or communication with the accounting servers
Optional fails, this feature allows users to use network resources and stops the switch from sending

realtime accounting updates for the users.

Default Accounting

Configure the default accounting method and secondary accounting method for all types
of users.

Options include:

N
ame o local—Performs local accounting.
e None—Performs no accounting.
Secondary e RADIUS—Performs RADIUS accounting. You must specify the RADIUS scheme to be
Method used.
e Not Set—Restore the default, that is, local accounting.
LAN-access Configure the accounting method and secondary accounting method for LAN access
Accounting users.
Name Options include:
e local—Performs local accounting.
e None—Performs no accounting.
Secondary e RADIUS—Performs RADIUS accounting. You must specify the RADIUS scheme to be
Method used.

o Not Set—Uses the default accounting methods.

Login Accounting

Name

Configure the accounting method and secondary accounting method for login users.
Options include:

o local—Performs local accounting.
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ltem Description
e None—Performs no accounting.
Secondary e RADIUS—Performs RADIUS accounting. You must specify the RADIUS scheme to be

Method used.
o Not Set—Uses the default accounting methods.

Return to Configuration task list.

AAA configuration example

Network requirements
As shown in a, configure the switch to perform local authentication, authorization, and accounting for

Telnet users.

a. Network diagram for AAA configuration example

Vlan-int2
192.168.1.1/24 (_§_,
GE1/0/11

Telnet user Switch
192.168.1.12/24

Internet

Configuration procedure

NOTE:
Enable the Telnet server function on the switch and configure the switch to use AAA for Telnet users. The

configuration steps are omitted.

# Configure IP addresses for the interfaces. (Omitted)

# Configure a local user.
e Select Device > Users from the navigation tree and then select the Create tab, as shown in a.
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a. Configure a local user
Summary Super Password M odify Rermaowe Switch To Management
Create User
Usernarme telnet (1-55 Chars) ACCess Level Management +
Confirm

Fassward [T1T1] (1-B3 Chars) Faocevard [TTT]

Fassward .

Display Mode Simple v

Service Type [ 1FTP Service! [#] Telnet Service

Apply

Summary

Username Locess Level Serwvice Type

admin Management Telnet
Note: Username cannot include characters ™/, ™, ™", ™[, "@", ™, "7, ™™, "<" or "=",

Enter telnet as the username.

Select Management as the access level.
Enter abed as the password.

Enter abed to confirm the password.
Select Telnet Service as the service type.
Click Apply.

# Configure ISP domain test.

Select Authentication > AAA from the navigation tree. The domain configuration page appears, as
shown in b.
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b. Configure ISP domain test

Authentication Autharization Accounting
ISP Damain
Darmain Mame [test ¥ (1 - 24 Chars)
Default Domain | Disable b

Flease selectthe ISP damainis)

Daomain MName Default Domain

e Enter test as the domain name.
o Click Apply.
# Configure the ISP domain to use local authentication.

o Select Authentication > AAA from the navigation tree and then select the Authentication tab, as shown
inc.

c.  Configure the ISP domain to use local authentication

Comain Setup Authorization Accounting

Authentication Configuration of A%4%

‘ Selectan ISP domain  |test v ‘
[ Default Authi Mame Secondary Method
[ LAM-access Authi Marme Secondary Method
‘ [#] Login Autht Local hd | Marne Secondary Method
PPF AuthM Mame Secondary Method
Partal Auth Mame

o Select the domain test.
e Select the Login AuthN check box and select the authentication method Local.

o Click Apply. A configuration progress dialog box appears, as shown in d.
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d. Configuration progress dialog box

Current Configuration
Setting Login Authi - OK!

100%

Close

o After the configuration process is complete, click Close.

# Configure the ISP domain to use local authorization.

o Select Authentication > AAA from the navigation tree and then select the Authorization tab, as shown
ine.

e. Configure the ISP domain to use local authorization

Diarnain Setup Authentication Accounting

Authorization Configuration of AA%

Select an ISP domain

I Default AuthZ Mame Secondary Method
[ LaM-access AuthZ Mame Secondary Method
[¥] Login AuthZ ‘ Marme Secondary Method
FFP AuthZ Mame Secondary Method
Fartal AuthZ Mame
Command AuthZ Marme

Apply

e Select the domain test.
o Select the Login AuthZ check box and select the authorization method Local.
e Click Apply. A configuration progress dialog box appears.

o After the configuration progress is complete, click Close.

# Configure the ISP domain to use local accounting.

o Select Authentication > AAA from the navigation tree and then select the Accounting tab, as shown in

f.
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f.  Configure the ISP domain to use local accounting

Ciomain Setup Authentication Authorization

Accounting Configuration of AR

Select an ISP damain test hd

[ accounting Optional

[ Default Accounting MName Secondary Method

[JLAN-access Accounting Mame Secondary Method

[¥] Login Accounting Local ~ ‘ Mame Secondary Method
PPP Accounting Mame Secondary Method
Partal Accounting Mame

Apply

o Select the domain test.
e Select the Login Accounting check box and select the accounting method Local.
o Click Apply. A configuration progress dialog box appears.

o After the configuration process is complete, click Close.

Now, if you telnet to the switch and enter username telnet@test and password abed, you should be serviced
as a user in domain test.
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RADIUS configuration

Introduction to RADIUS

The Remote Authentication Dial-In User Service (RADIUS) protocol implements Authentication, Authorization,
and Accounting (AAA). For more information, see the chapter “AAA configuration”.

RADIUS uses the client/server model. It can protect networks against unauthorized access and is often used
in network environments where both high security and remote user access are required. RADIUS defines the
packet format and message transfer mechanism, and uses UDP as the transport layer protocol for
encapsulating RADIUS packets. It uses UDP port 1812 for authentication and UDP port 1813 for
accounting.

RADIUS was originally designed for dial-in user access. With the addition of new access methods, RADIUS
has been extended to support additional access methods, for example, Ethernet and ADSL. RADIUS
provides access authentication and authorization services, and its accounting function collects and records
network resource usage information.

Client/server model

e  Client—Generally, the RADIUS client runs on the NASs located throughout the network. It passes user
information to designated RADIUS servers and acts on the responses (for example, rejects or accepts
user access requests).

o Server—Generally, the RADIUS server runs on the computer or workstation at the network center and
maintains information related to user authentication and network service access. It listens to
connection requests, authenticates users, and returns the processing results (for example, rejecting or
accepting the user access request) to the clients.

In general, the RADIUS server maintains the databases: Users, Clients, and Dictionary, as shown in a.

a. RADIUS server components

RADIUS servers

Users Clients Dictionary

e Users—Stores user information such as the usernames, passwords, applied protocols, and IP
addresses.

o  Clients—Stores information about RADIUS clients, such as the shared keys and IP addresses.

e Dictionary—Stores RADIUS protocol attributes and their values.

Security and authentication mechanisms

Information exchanged between a RADIUS client and the RADIUS server is authenticated with a shared key,
which is never transmitted over the network. This enhances the information exchange security. In addition,



to prevent user passwords from being intercepted on insecure networks, RADIUS encrypts passwords before
transmitting them.

A RADIUS server supports multiple user authentication methods. Moreover, a RADIUS server can act as the
client of another AAA server to provide authentication proxy services.

Basic message exchange process of RADIUS

a illustrates the interaction of the host, the RADIUS client, and the RADIUS server.
a. Basic message exchange process of RADIUS

Host RADIUS client RADIUS server

S =

1) Username and password

\

2) Access-Request

\

3) Access-Accept/Reject

A

4) Accounting-Request (start)

\4

5) Accounting-Response

-t
-

<J 6) The host accesses the resources

7) Accounting-Request (stop)

\

8) Accounting-Response

A

9) Notification of access termination

-
|

RADIUS operates in the following manner:

Table 122 The host initiates a connection request that carries the user’s username and password to the
RADIUS client.

Table 123 After receiving the username and password, the RADIUS client sends an authentication request
(Access-Request) to the RADIUS server, with the user password encrypted by using the Message-Digest
5 (MD5) algorithm and the shared key.

Table 124 The RADIUS server authenticates the username and password. If the authentication succeeds, the
server sends back an Access-Accept message containing the user’s authorization information. If the
authentication fails, the server returns an Access-Reject message.

Table 125 The RADIUS client permits or denies the user according to the returned authentication result. If it
permits the user, it sends a start-accounting request (Accounting-Request) to the RADIUS server.

Table 126 The RADIUS server returns a start-accounting response (Accounting-Response) and starts
accounting.

Table 127 The user accesses the network resources.

Table 128 The host requests the RADIUS client to tear down the connection and the RADIUS client sends a
stop-accounting request (Accounting-Request) to the RADIUS server.



Table 129 The RADIUS server returns a stop-accounting response (Accounting-Response) and stops
accounting for the user.

Table 130 The user stops access to network resources.

RADIUS packet format

RADIUS uses UDP to transmit messages. It ensures the smooth message exchange between the RADIUS
server and the client through a series of mechanisms, including the timer management mechanism,
retransmission mechanism, and slave server mechanism.

a. RADIUS packet format

0 7 15 31

Code Identifier Length

Authenticator (16bytes)

Attribute

Descriptions of the fields are as follows:
Table 131 The Code field (1-byte long) indicates the type of the RADIUS packet.

2.  Main values of the Code field

Code Packet type Description

From the client to the server. A packet of this type carries user
information for the server to authenticate the user. It must contain the
User-Name attribute and can optionally contain the attributes of
NAS-IP-Address, User-Password, and NAS-Port.

1 Access-Request

From the server fo the client. If all the afiribute values carried in the
2 Access-Accept Access-Request are acceptable, that is, the authentication succeeds,
the server sends an Access-Accept response.

From the server fo the client. If any aftribute value carried in the
3 Access-Reject Access-Request is unacceptable, the server rejects the user and sends
an Access-Reject response.

From the client to the server. A packet of this type carries user
information for the server to start/stop accounting for the user. It
contains the Acct-Status-Type attribute, which indicates whether the
server is requested to start the accounting or fo end the accounting.

4 Accounting-Request

From the server to the client. The server sends to the client a packet of
5 Accounting-Response this type to notify that it has received the Accounting-Request and has
correctly started recording the accounting information.




Table 132 The Identifier field (1 byte long) is used to match request packets and response packets and to
detect duplicate request packets. Request and response packets of the same type have the same
identifier.

Table 133 The Length field (2 byte long) indicates the length of the entire packet, including the Code,
Identifier, Length, Authenticator, and Attribute fields. Bytes beyond this length are considered padding
and are neglected upon reception. If the length of a received packet is less than this length, the packet
is dropped. The value of this field is in the range 20 to 4096.

Table 134 The Authenticator field (16 byte long) is used to authenticate replies from the RADIUS server and
to encrypt user passwords. There are two types of authenticators: request authenticator and response
authenticator.

Table 135 The Attributes field, variable in length, carries the specific authentication, authorization, and
accounting information that defines the configuration details of the request or response. This field may
contain multiple attributes, each with three sub-ields: Type, Length, and Value.

e Type (1 byte long)—Indicates the type of the attribute. It is in the range 1 to 255. Commonly used
attributes for RADIUS authentication, authorization and accounting are listed in 3.

e Llength (1 byte long)—Indicates the length of the attribute in bytes, including the Type, Length, and
Value fields.

e Value (up to 253 bytes)—Value of the attribute. Its format and content depend on the Type and Length
fields.

3. RADIUS attributes

No. Attribute No. Attribute

1 User-Name 45 Acct-Authentic

2 User-Password 46 Acct-Session-Time

3 CHAP-Password 47 Acct-Input-Packets

4 NAS-IP-Address 48 Acct-Output-Packets

5 NAS-Port 49 Acct-Terminate-Cause
6 Service-Type 50 Acct-Multi-Session-Id
7 Framed-Protocol 51 Acctlink-Count

8 Framed-IP-Address 52 AcctInput-Gigawords
9 Framed-IP-Netmask 53 Acct-Output-Gigawords
10 Framed-Routing 54 (unassigned)

11 Filter-ID 55 Event-Timestamp

12 Framed-MTU 56-59 (unassigned)

13 Framed-Compression 60 CHAP-Challenge

14 Login-IP-Host 61 NAS-Port-Type

15 Login-Service 62 Port-Limit

16 Login-TCP-Port 63 Login-LAT-Port

17 (unassigned) 64 Tunnel-Type

18 Reply_Message 65 Tunnel-Medium-Type




No. Attribute No. Attribute

19 Callback-Number 66 Tunnel-Client-Endpoint

20 Callback-ID 67 Tunnel-Server-Endpoint

21 (unassigned) 68 AcctTunnel-Connection

22 Framed-Route 69 Tunnel-Password

23 Framed-IPX-Network 70 ARAP-Password

24 State 71 ARAP-Features

25 Class 72 ARAP-Zone-Access

26 Vendor-Specific 73 ARAP-Security

27 Session-Timeout 74 ARAP-Security-Data

28 Idle-Timeout 75 Password-Retry

29 Termination-Action 76 Prompt

30 Called-Station-Id 77 Connectnfo

31 Calling-Station-ld 78 Configuration-Token

32 NAS-Identifier 79 EAP-Message

33 Proxy-State 80 Message-Authenticator

34 Login-LAT-Service 81 Tunnel-Private-Group-id

35 Login-LAT-Node 82 Tunnel-Assignment-id

36 Login-LAT-Group 83 Tunnel-Preference

37 Framed-AppleTalk-Link 84 ARAP-Challenge-Response

38 Framed-AppleTalk-Network 85 Acct-Interim-Interval

39 Framed-AppleTalk-Zone 86 Acct-Tunnel-Packets-Lost

40 Acct-Status-Type 87 NAS-Port-ld

41 Acct-Delay-Time 88 Framed-Pool

42 Acct-Input-Octets 89 (unassigned)

43 Acct-Output-Octets 90 Tunnel-Client-Auth-id

44 Acct-Session-ld 91 Tunnel-Server-Auth-id
NOTE:

The atiribute types listed in 3 are defined by RFC 2865, RFC 2866, RFC 2867, and RFC 2868.

Extended RADIUS attributes

The RADIUS protocol features excellent extensibility. Attribute 26 (Vender-Specific), an attribute defined by
RFC 2865 allows a vender to define extended attributes to implement functions that the standard RADIUS
protocol does not provide.



A vendor can encapsulate multiple sub-attributes in the type-length-value (TLV) format in RADIUS packets for
extension of applications. As shown in a, a sub-attribute that can be encapsulated in Attribute 26 consists
of the following parts:

e VendorID—Indicates the ID of the vendor. Its most significant byte is O; the other three bytes contains
a code that is compliant to RFC 1700.

e Vendor-Type—Indicates the type of the sub-aftribute.

e Vendor-length—Indicates the length of the sub-attribute.

e Vendor-Data—Indicates the contents of the sub-attribute.

a. Segment of a RADIUS packet containing an extended attribute

0 7 15 23 31
Type Length Vendor-ID

Vendor-ID (continued) Vendor-Type Vendor-Length

Vendor-Data
(Specified attribute value--+--+ )

Protocols and standards
e  RFC 2865, Remote Authentication Dial In User Service (RADIUS)
e RFC 2866, RADIUS Accounting
e RFC 2867, RADIUS Accounting Modifications for Tunnel Protocol Support
e RFC 2868, RADIUS Atiributes for Tunnel Protocol Support
e RFC 2869, RADIUS Extensions

Contiguring RADIUS

Configuration task list

NOTE:
The RADIUS scheme configured through the web interface is named system.

If there is no RADIUS scheme named system in the system, when you select Authentication - RADIUS
to enter the RADIUS module, a scheme named system is created automatically.

1. RADIUS configuration task list

Task Description

Required For more
Configuring RADIUS Configure the information related to the primary and information, see
authentication servers  secondary RADIUS authentication servers. “Configuring

By default, no RADIUS authentication server is configured. RADIUS servers.”




Task Description

Optional

Configuring RADIUS Configure the information related to the primary and
accounting servers secondary RADIUS accounting servers.

By default, no RADIUS accounting server is configured.

Required
Configuring RADIUS

parameters Configure the parameters that are necessary for information exchange between the

device and RADIUS servers.

Configuring RADIUS servers

From the navigation tree, select Authentication > RADIUS. The RADIUS server configuration page appears,
as shown in a.

a. RADIUS server configuration

RADIUS Setup

Server Type: Authentication Server |

Primary Server IP: 0000 £

Primary Server UOF Port: 1812 *(1-65535)
Primary Server Status: hlock v

Secondary Server IP: 0.0.00

Secondary Server UDP Part: 1812 “(1-55525)
Secondary Server Status: hlock v

[tems marked with an asterisk(*} are required

2. RADIUS server configuration

ltem Description

Specify the type of the server to be configured, which can be Authentication

Server Type Server and Accounting Sever.

Specify the IP address of the primary server.
If no primary server is specified, the text box displays 0.0.0.0.

To remove the previously configured primary server, enter 0.0.0.0 in the text

Primary Server IP
box.

The specified IP address of the primary server cannot be the same as that of the
secondary server.

Specify the UDP port of the primary server.

If the IP address of the primary server is not specified or the specified IP address
is to be removed, the port number is 1812 for authentication or 1813 for
accounting.

Primary Server UDP Port




ltem

Description

Primary Server Status

Set the status of the primary server, including:
e active: The server is working normally.
o blocked: The server is down.

If the IP address of the primary server is not specified or the specified IP address
is to be removed, the status is blocked.

Secondary Server IP

Specify the IP address of the secondary server.
If no secondary server is specified, the text box displays 0.0.0.0.

To remove the previously configured secondary server, enter 0.0.0.0 in the text
box.

The specified IP address of the secondary server cannot be the same as that of
the primary server.

Secondary Server UDP Port

Specify the UDP port of the secondary server.

If the IP address of the secondary server is not specified or the specified IP
address is to be removed, the port number is 1812 for authentication or 1813
for accounting.

Secondary Server Status

Status of the secondary server, including:
e active: The server is working normally.

e blocked: The server is down.

If the IP address of the secondary server is not specified or the specified IP
address is to be removed, the status is blocked.

Return to RADIUS configuration task list.

Contiguring RADIUS parameters

From the navigation tree, select Authentication > RADIUS and then select the RADIUS Setup tab to enter the

RADIUS parameter configuration page, as shown in a.



a.

RADIUS parameter configuration

RADIUS Server

Server Type: standard &
[JAuthentication Server Shared Key: (1-64 Chars.)
Confirm Authentication Shared Key:
[JAccounting Server Shared Key: (1-64 Chars)
Confirm Accounting Shared Key:
AS-IP:
Timeaut Interval: 3 Fgaconds(1-10)
Timeout Retransmission Times: 3 F(1-20)
Realtirne-Accounting Interval: 12 Fminutes(0-60, Must be a multiple of 3)
Realtime-Accounting Packet Retransmission Times: =3 *(1-255)
Stop-Accounting Buffer: enable A
Stop-Accounting Packet Retransmission Times: 500 *(10-65535)
Quiet Interval: 5 Fminutes(1-255)
Username Format: with-darmain b
Unit of Data Flows: byte hd
Unit of Packets: packet hd
ltermns marked with an asterisk(*) are required
Apply

2. RADIUS parameters
ltem Description
Specify the type of the RADIUS server supported by the device,
including:
e extended: Specifies an extended RADIUS server (usually a
CAMS or iMC server). That is, the RADIUS client and RADIUS
Server Type server communicate using the proprietary RADIUS protocol and

packet format.

e standard: Specifies a standard RADIUS server. That is, the
RADIUS client and RADIUS server communicate using the
standard RADIUS protocol and packet format defined in RFC
2138/2139 or later.

Authentication Server Shared Key

Confirm Authentication Shared Key

Specify and confirm the shared key for the authentication server.
These two parameters must have the same values.

Accounting Server Shared Key

Confirm Accounting Shared Key

Specify and confirm the shared key for the accounting server. These
two parameters must have the same values.

NAS-IP

Specify the source IP address for the device to use in RADIUS packets
to be sent to the RADIUS server. It is recommended to use a loopback
interface address instead of a physical interface address as the
source IP address, because if the physical interface is down, the
response packets from the server cannot reach the device.

Timeout Interval

Set the RADIUS server response timeout.




ltem

Description

Timeout Retransmission Times

Set the maximum number of transmission attempts.

The product of the timeout value and the number of retransmission
attempts cannot exceed 75.

Realtime-Accounting Inferval

Set the realtime accounting interval, whose value must be n times 3
(n is an integer).

To implement real4ime accounting on users, it is necessary to set the
realtime accounting interval. After this parameter is specified, the
device will send the accounting information of online users fo the
RADIUS server every the specified inferval.

The value of the realtime accounting inferval is related to the
requirement on the performance of the NAS and RADIUS server. The
smaller the value, the higher the requirement. It is recommended to
set a large value if the number of users is equal to or larger than
1000. 3 shows the relationship between the interval value and the
number of users.

Realtime-Accounting Packet
Retransmission Times

Set the maximum number of real4ime accounting request
retfransmission times.

Stop-Accounting Buffer

Enable or disable buffering stop-accounting requests without
responses in the device.

Stop-Accounting Packet Retransmission
Times

Set the maximum number of transmission attempts if no response is
received for the stop-accounting packet.

Quiet Interval

Specify the interval the primary server has to wait before being
active

Username Format

Set the format of username sent to the RADIUS server.

A username is generally in the format of userid@isp-name, of which
isp-name is used by the device to determine the ISP domain to which
a user belongs. If a RADIUS server does not accept a username
including an ISP domain name, you can configure the device to
remove the domain name of a username before sending it o the

RADIUS server.

without-domain: Specifies to remove the domain name of a
username that is to be sent to the RADIUS server.

with-domain: Specifies to keep the domain name of a username that
is o be sent to the RADIUS server.

Unit of Data Flows

Specify the unit for data flows sent to the RADIUS server, which can
be:

e byte
o kilobyte
* mega-byte

e gigabyte




ltem Description

Specify the unit for data packets sent to the RADIUS server, which
can be
e one-packet
Unit of Packets .
o kilo-packet
e mega-packet

o giga-packet

3. Relationship between the real-time accounting interval and the number of users

Number of users Real-time accounting interval (in minutes)
11099 3

100 to 499 6

500 to 999 12

#1000 715

Return to RADIUS configuration task list.

RADIUS configuration example

Network requirements

As shown in a, configure the switch to let the RADIUS server authenticate and keep accounts on the user
(record the online duration of the Telnet user).

On the RADIUS server (a CAMS or iMC server, using the default port for authentication and accounting), the
Telnet user’'s username and password and the shared key expert have been configured for packet
exchange with the switch.

On the switch, it is required to configure the shared key for packet exchange with the RADIUS server as
expert, and configure the system to remove the domain name of a username before sending it to the
RADIUS server.

a. Network diagram for RADIUS server configuration

Vlan-int2
192.168.1.1/24

GE1/0/1

Telnet user Switch RADIUS server
192.168.1.10/24 10.110.91.146/24

Configuration procedure

NOTE:

Enable the Telnet server function, and configure the switch to use AAA for authentication, authorization
and accounting of Telnet users.Detailed configuration steps are omitted here.

Table 136 Configure IP addresses for the interfaces. Detailed configuration steps are omitted here.
Table 137 Configure RADIUS scheme system



# Configure the RADIUS authentication server.

e From the navigation tree, select Authentication > RADIUS. The RADIUS server configuration page
appears.

b. Configure the RADIUS authentication server

RADIUS Setup

Server Type: |AL|thenticatinn Server V|
Primary Server P; |1[]. 110.91.146 G
Primary Server UDP Port: |1E12 |‘[1-55535j:
Frimary Server Status: | active hd |
Secondary Server IP: |[].U.U.U |
Secondary Server UDP Port: | 1612 “[1-65535)
Secondary Server Status: | hlock W |

Items marked with an asterisk(*} are required

Apply

o Select Authentication Server as the server type.

e Enter 10.110.91.146 as the IP address of the primary authentication server
o Enter 1812 as the UDP port of the primary authentication server.

o Select active as the primary server status.

o Click Apply.

# Configure the RADIUS accounting server.

c. Configure the RADIUS accounting server

RADIUS Setup

Server Type: |Au:c:u:uunting Server V|
Primary Server IP: ‘1[]. 110.91.146 *
Primary Server UDP Port: 1813 (1-85535)
Primary Server Status: | active hd |
Secondary Server IP: ‘[].[].U.U 5
Secondary Server UDP Port 11313 “(1-65525)
Secondary Server Status: | hlock A |
lterms marked with an asterisk(*) are required
Apply

o Select Accounting Server as the server type.
e  Enter 10.110.91.146 as the IP address of the primary accounting server.

e  Entfer 1813 as the UDP port of the primary accounting server.



e  Select active as the primary server status.

e  Click Apply.

# Configure the parameters for communication between the switch and the RADIUS servers.

e Select the RADIUS Setup tab.
d. Configure RADIUS parameters

RADIUS Server

Server Type: extended

[ Authentication Server Shared Key: ssssee (1-64 Chars.)
Confirm Authentication Shared Key: eesene

FAccounting Server Shared Key: sessee (1-64 Chars.)
Confirm Accounting Shared Key: eesene

NAS-1P:

Timeout Interval: 3 “seconds(1-10)

Timeout Retransmission Times: 3 “(1-20)

Realtime-Accounting Interval: 12 “minutes(0-60, Must be a multiple of 3)

Realtime-Accounting Packet Retransmission Times: 5 “(1-255)

Stop-Accounting Buffer: enable

Stop-Accounting Packet Retransmission Times: 500 “(10-65535)

Quiet Interval:

| Username Format:

without-domain

“minutes(1-255)

Unit of Data Flows: byte
Unit of Packets: packet
Items marked with an asterisk(*) are required

e Select extended as the server type.

e Select the Authentication Server Shared Key check box and enter expert in the text box.

e Enter expert in the Confirm Authentication Shared Key text box.

e Select the Accounting Server Shared Key check box and enter expert in the text box.

e  Enter expert in the Confirm Accounting Shared Key text box.

e  Select without-domain for Username Format.

e Click Apply
Table 138 Configure AAA
# Create an ISP domain.

e From the navigation tree, select Authentication > AAA. The domain setup page appears.



e. Create an ISP domain

Althentication Authorization Accounting
IEF Domain
Damain Name  test M1 - 24 Chars)
Default Domain | Enable b

Apply

Please selectthe ISP domain(s)

Daomain Marme Default Damain

e  Enter test in the Domain Name textbox.

e Select Enable to use the domain as the default domain.

o Click Apply.

# Configure the AAA authentication method for the ISP domain.

e  Select the Authentication tab.

f.  Configure the AAA authentication method for the ISP domain

Domain Setup Authorization Accounting

Authentication Configuration of AdA

Select an ISP domain test v
[¥] Default Authi RADIUS v | Mame |system v
[ LAN-access Authi Name
[ Login Authi Mame
PPP Authi Marne
Portal Authi MName

Apply

e  Select the domain name test.

e  Select the Default AuthN checkbox and then select RADIUS as the authentication mode.

o Select system from the Name drop-down list to use it as the authentication scheme.

Secondary Method
Secondary Method
Secondary Method
Secandary Method

o  Click Apply. A configuration progress dialog box appears, as shown in g.



g. Configuration progress dialog box

Current Configuration
Setting Default Authi - KR!

100%

Close

e After the configuration process is complete, click Close.

# Configure the AAA authorization method for the ISP domain.

e  Select the Authorization tab.

h. Configure the AAA authorization method for the ISP domain

Dormain Setup Authentication Accounting

Autharization Configuration of AR

Selectan ISP domain
[¥] Default AuthZ RADIUS v| Mame |system v Secondary Method

[ Lan-access AuthZ Mame Secondary Method
[JLogin AuthZ MName Secondary Method
FPF AuthZ MName Secondary Method
Fortal AuthZ MName
Command AuthZ Mame

e  Select the domain name test.

e Select the Default AuthZ checkbox and then select RADIUS as the authorization mode.

o Select system from the Name drop-down list to use it as the authorization scheme.

e Click Apply. A configuration progress dialog box appears.

o After the configuration process is complete, click Close.

# Configure the AAA accounting method for the ISP domain, and enable accounting optional.

o Select the Accounting tab.



Configure the AAA accounting method for the ISP domain

Darnain Setup Authentication Autharization

Accounting Configuration of AA%

Selectan ISP damain test hd
[¥] accounting Optional Enable v
[¥] Default Accounting RADILIS | Mame |gystem w || Secondary Method ~
CJLan-access Accounting Mame Secondary Method
[ Login Accounting Marme Secondary Method
PFP Accounting Mame Secondary Method
Fortal Accounting RELl=

Select the domain name test.

Select the Accounting Optional checkbox and then select Enable.

Select the Default Accounting checkbox and then select RADIUS as the accounting mode.
Select system from the Name drop-down list to use it as the accounting scheme.

Click Apply. A configuration progress dialog box appears.

Atter the configuration process is complete, click Close.

Configuration guidelines

When you configure the RADIUS client, note the following guidelines:

When you modify the parameters of the RADIUS scheme, the system does not check whether the
scheme is being used by users.

After accounting starts, update-accounting and stop-accounting packets will be sent to the designated
server, and no primary/secondary server switchover will take place even if the designated server fails.
Such a switchover can take place only during AAA session establishment.

If an AAA server has active TCP connections, it cannot be removed.
RADIUS does not support accounting for FTP users.

If the CAMS/IiMC server is used as the RADIUS server, it is necessary to configure accounting as
optional for users in the ISP domain because the CAMS/iMC server does not respond to accounting
packets.



Users

This module allows you to configure local users and user groups.
Local user

A local user represents a set of user attributes configured on a device (such as the user password, service
type, and authorization attribute), and is uniquely identified by the username. For a user requesting a
network service to pass local authentication, you must add an entry as required in the local user database
of the device. For more information about local authentication, see the chapter “AAA configuration”.

User group

A user group consists of a group of local users and has a set of local user attributes. You can configure local
user attributes for a user group to implement centralized management of user attributes for the local users in
the group. All local users in a user group inherit the user attributes of the group, but if you configure user
attributes for a local user, the settings of the local user take precedence over the settings for the user group.

By default, every newly added local user belongs to a user group named system, which is automatically
created by the system.

Contiguring users

Contfiguring a local user

Select Authentication > Users from the navigation tree. The Local User page appears, displaying all local
users, as shown in a. Click Add to enter the local user configuration page.

a. Local user list
Llzer Graup

b Search ltern:| User Mame % | Keywwords: Search

Lzer Mame Service Type Lewvel WLAR ACL User Profile Llser Group Expire Time  Operation
admin Telnet; Management system m

Add
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b. Local user configuration page

Add Local Liser

Uzernarne:
Password:
Canfirm:
Group:
Senvice-type:
Expire-time:
Level:
WLARN:

ACL

Lzser-praofile:

ger Group
*1-549)
(1-63
(1-63
system v
ClrTP I Telnet Cliar-Access [s5H
(From 2000 to 2035, HH:Mb: S S-S i WiDDo
Yisitar w

(1-4094)
(2000-4999)

(1-32)

[tems marked with an asterisk(™) are required

Apply Cancel

2. Local user configuration items

ltem Description
Username Specify a name for the local user.
Password Specify and confirm the password of the local user. The settings of these two fields must
Confirm be the same.
Select a user group for the local user.
Group

For more information about user group configuration, see “Configuring a user group.”

Servicetype

Select the service types for the local user to use, including FTP, Telnet, LAN access
(accessing through the Ethernet, such as 802.1x users), and SSH.

@ IMPORTANT:

If you do not specify any service type for a local user who uses local authentication, the
user cannot pass authentication and therefore cannot log in.

Specify an expiration time for the local user, in the format HH:MM:SS-YYYY/MM/DD.

When authenticating a local user with the expiration time argument configured, the

Expire-time
access device checks whether the expiration time has elapsed. If not, the device permits
the user to log in.
Select an authorization level for the local user, which
Level can be Visitor, Monitor, Configure, or Management, in @ IMPORTANT:
ascending order of priority. Every authorization attribute
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ltem Description

has its definite application
environments and purposes.
When configuring
Specify the ACL to be used by the access device to authorization attributes for a
ACL restrict the access of the local user after the user passes  local user, determine what
authentication. attributes are needed first.

Specify the VLAN to be authorized to the local user

VIAN N
after the user passes authentication.

Specify the user profile for the local user.
NOTE:

HP V1910 Switch Series does not support user-profile
configuration.

User-profile

Configuring a user group

Select Authentication > Users from the navigation tree, and then select the User Group tab to display the
existing user groups, as shown in a. Then, click Add to enter the user group configuration page, as shown

in b.

a. User group list

Local Lser
P Search ltem:| Group Mame % keywards: Search
NGarr?nuep Level WLAR AL Iser Profile Cperation
system Wistor @ m
Add
b. User group configuration page
Local User
Add User Group
Group-narne: *(1-32)
Lewvel: Yistor b
WLAMN: (1-4094)
ACL: (2000-49993)
User-profile (1-32)

tems marked with an asterisk(™ are regquired

Ppply Cancel
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2.

User group configuration items

ltem

Description

Group-name

Specify a name for the user group.

Select an authorization level for the user group, which can be Visitor, Monitor,

Level Configure, or Management, in ascending order of priority.
Specify the VLAN to be authorized to users of the user group after the users pass
VIAN S
authentication.
ACL Specify the ACL to be used by the access device to control the access of users of the
user group affer the users pass authentication.
Specify the user profile for the user group.
User-profile NOTE:

HP V1910 Switch Series does not support user-profile configuration.
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PKI configuration

PKI| overview

The Public Key Infrastructure (PKI) is a hierarchical framework designed for providing information security
through public key technologies and digital certificates and verifying the identities of the digital certificate
owners.

PKI employs digital certificates, which are bindings of certificate owner identity information and public keys.
It allows users to obtain certificates, use certificates, and revoke certificates. By leveraging digital
certificates and relevant services like certificate distribution and blacklist publication, PKI supports
authenticating the entities involved in communication, and thus guaranteeing the confidentiality, integrity
and non-repudiation of data.

PKI terms

Digital certificate

CRL

A digital certificate is a file signed by a certificate authority (CA) that contains a public key and the related
user identity information. A simplest digital certificate contains a public key, an entity name, and a digital
signature from the CA. Generally, a digital certificate also includes the validity period of the key, the name
of the CA and the sequence number of the certificate. A digital certificate must comply with the international
standard of ITU-T_X.509. This document involves local certificate and CA certificate. A local certificate is a
digital certificate signed by a CA for an entity. A CA certificate, also known as a “root certificate”, is signed
by the CA for itself.

An existing certificate may need to be revoked when, for example, the user name changes, the private key
leaks, or the user stops the business. Revoking a certificate is to remove the binding of the public key with
the user identity information. In PKI, the revocation is made through certificate revocation lists (CRLs).
Whenever a certificate is revoked, the CA publishes one or more CRLs to show all certificates that have
been revoked. The CRLs contain the serial numbers of all revoked certificates and provide an effective way
for checking the validity of certificates.

A CA might publish multiple CRLs when the number of revoked certificates is so large that publishing them
in a single CRL might degrade network performance.

CA policy

A CA policy is a set of criteria that a CA follows in processing certificate requests, issuing and revoking
certificates, and publishing CRLs. Usually, a CA advertises its policy in the form of certification practice
statement (CPS). A CA policy can be acquired through out-of-band means such as phone, disk, and email.
As different CAs may use different methods to check the binding of a public key with an entity, make sure
that you understand the CA policy before selecting a trusted CA for certificate request.

Architecture of PK]

A PKI system consists of entities, a CA, a registration authority (RA) and a PKI repository, as shown in a.
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Entity

CA

RA

a. PKl architecture

< Entity
e}
@
=
= PKI user
Q
C | e — NP A
9
= PKI
3 management
B authorities
Z e RA <
3 Issue a

certificat y
< CA
Issue a certificate/CRL

An entity is an end user of PKI products or services, such as a person, an organization, a device like a router
or a switch, or a process running on a computer.

A certificate authority (CA) is a trusted authority responsible for issuing and managing digital certificates. A
CA issues certificates, specifies the validity periods of certificates, and revokes certificates as needed by

publishing CRLs.

A registration authority (RA) is an extended part of a CA or an independent authority. An RA can implement
functions including identity authentication, CRL management, key pair generation and key pair backup. It
only examines the qualifications of users; it does not sign certificates. Sometimes, a CA assumes the
registration management responsibility and no independent RA exists. The PKI standard recommends that
an independent RA be used for registration management to achieve higher security of application systems.

PKI repository

A PKI repository can be a Lightweight Directory Access Protocol (LDAP) server or a common database. It
stores and manages information like certificate requests, certificates, keys, CRLs and logs, and it provides
a simple query function.

LDAP is a protocol for accessing and managing PKl information. An LDAP server stores user information and
digital certificates from the RA server and provides directory navigation service. From an LDAP server, an
entity can retrieve digital certificates of its own and other entities.

Applications of PKI

VPN

The PKl technology can satisfy the security requirements of online transactions. As an infrastructure, PKI has
a wide range of applications. Here are some application examples.

A virtual private network (VPN) is a private data communication network built on the public communication
infrastructure. A VPN can leverage network layer security protocols (for instance, IPSec) in conjunction with
PKl-based encryption and digital signature technologies to achieve confidentiality.
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Secure email

Emails require confidentiality, integrity, authentication, and non-repudiation. PKI can address these needs.
The secure e-mail protocol that is developing rapidly is Secure/Multipurpose Internet Mail Extensions
(S/MIME), which is based on PKI and allows for transfer of encrypted mails with signature.

Web security

For Web security, two peers can establish a Secure Sockets Layer (SSL) connection first for transparent and
secure communications at the application layer. With PKI, SSL enables encrypted communications between
a browser and a server. Both the communication parties can verify the identity of each other through digital
certificates.

Operation of PKI

In a PKl-enabled network, an entity can request a local certificate from the CA and the device can check the
validity of certificate. The following describes how it works:

Table 139 An entity submits a certificate request to the CA.

Table 140 The RA verifies the identity of the entity and then sends the identity information and the public key
with a digital signature to the CA.

Table 141 The CA verifies the digital signature, approves the application, and issues a certificate.

Table 142 The RA receives the certificate from the CA, sends it to the LDAP server to provide directory
navigation service, and notifies the entity that the certificate is successfully issued.

Table 143 The entity retrieves the certificate. With the certificate, the entity can communicate with other
entities safely through encryption and digital signature.

Table 144 The entity makes a request to the CA when it needs to revoke its certificate. The CA approves the
request, updates the CRLs and publishes the CRLs on the LDAP server.

Contiguring PKI

Configuration task list

The device supports the following PKI certificate request modes:

e Manual—In manual mode, you need to retrieve a CA certificate, generate a local RSA key pair, and
submit a local certificate request for an entity.

e Auto—In auto mode, an entity automatically requests a certificate through the Simple Certification
Enrollment Protocol (SCEP) when it has no local certificate or the present certificate is about to expire.

You can specity the PKI certificate request mode for a PKI domain. Different PKI certificate request modes
require different configurations:

Requesting a certificate manually

Perform the tasks in 1 to request a certificate manually.
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1. Configuration task list for requesting a certificate manually

Task

Remarks

Creating a PKI entity

Required
Create a PKI entity and configure the identity information.

A certificate is the binding of a public key and an entity, where an entity is the
collection of the identity information of a user. A CA identifies a certificate applicant by
entity.

@ IMPORTANT:

The identity seftings of an entity must be compliant to the CA certificate issue policy.
Otherwise, the certificate request may be rejected.

Creating a PKI

domain

Required
Create a PKI domain, setting the certificate request mode to Manual.

Before requesting a PKI certificate, an entity needs to be configured with some
enrollment information, which is referred to as a PKI domain.

A PKI domain is intended only for convenience of reference by other applications like
SSL, and has only local significance.

Generating an RSA
key pair

Required
Generate a local RSA key pair.
By default, no local RSA key pair exists.

Generating an RSA key pair is an important step in certificate request. The key pair
includes a public key and a private key. The private key is kept by the user, and the
public key is transferred to the CA along with some other information.

@ IMPORTANT:

If a local certificate already exists, you must remove the certificate before generating a
new key pair, so as to keep the consistency between the key pair and the local certificate.

Retrieving a
certificate

Required
Certificate retrieval serves two purposes:

e Locally store the certificates associated with the local security domain for improved
query efficiency and reduced query count,

e Prepare for certificate verification.

@ IMPORTANT:

If a local CA certificate already exists, you cannot perform the CA certificate retrieval
operation. This will avoid possible mismatch between certificates and registration
information resulting from relevant changes. To retrieve the CA certificate, you need to
remove the CA certificate and local certificate first.
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Task

Remarks

Requesting a local
certificate

Required

When requesting a certificate, an entity introduces itself to the CA by providing its

identity information and public key, which will be the major components of the

certificate.

A certificate request can be submitted to a CA in two ways: online and offline.

¢ In online mode, if the request is granted, the local certificate will be retrieved to the
local system automatically.

¢ In offline mode, you need to retrieve the local certificate by an out-of-band means.

@ IMPORTANT:

If a local certificate already exists, you cannot perform the local certificate retrieval
operation. This is fo avoid possible mismatch between the local certificate and registration
information resulting from relevant changes. To retrieve a new local certificate, you need
to remove the CA certificate and local certificate first.

Optional

Destroying the RSA  Destroy the existing RSA key pair and the corresponding local certificate.

key pair I the certificate to be retrieved contains an RSA key pair, you need to destroy the
existing key pair. Otherwise, the retrieving operation will fail.

Retrieving a Optional

certificate

Retrieve an existing certificate.

Retrieving and
displaying a CRL

Optional

Retrieve a CRL and display its contents.

Requesting a Certificate Automatically

Perform the tasks in 1 to configure the PKI system to request a certificate automatically.

1. Configuration task list for requesting a certificate automatically

Task

Remarks

Creating a PKI entity

Required
Create a PKI entity and configure the identity information.

A certificate is the binding of a public key and an entity, where an entity is the
collection of the identity information of a user. A CA identifies a certificate applicant by
entity.

The identity seftings of an entity must be compliant to the CA certificate issue policy.
Otherwise, the certificate request may be rejected.

Creating a PKI

domain

Required
Create a PKI domain, setting the certificate request mode to Auto.

Before requesting a PKI certificate, an entity needs to be configured with some
enrollment information, which is referred to as a PKI domain.

A PKI domain is intended only for convenience of reference by other applications like
SSL, and has only local significance.
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Task Remarks

Optional

Destroying the RSA  Destroy the existing RSA key pair and the corresponding local certificate.

key pair If the certificate to be retrieved contains an RSA key pair, you need to destroy the
existing key pair. Otherwise, the retrieving operation will fail.

Retrieving a Optional

certificate Retrieve an existing certificate.

Retrieving and Optional

displaying a CRL Retrieve a CRL and display its contents.

Creating a PKI entity

Select Authentication > PKI from the navigation tree. The PKI entity list page is displayed by default, as
shown in a. Click Add on the page to enter the PKI entity configuration page, as shown in b.

a. PKl entity list

Darmain Cedificate CRL

Entity Comman CountryRegian Qrganization IF

Mame  Marne FGDm code State  Locality Organization Unit Address Operation
entityl  aaa 1.1.1.10 m
Add
b. PKl entity configuration page
Domain Cerificate CRL

Add PKI Entity

Entity Mame: *(1-15 Chars.)

Commoan Name: *(1-31 Chars.)

IP Address:

FQDM: (1-127 Chars.)

(CountryRegion name symbal, two characters

Country/Region Code: - '
compliantto SO 3166 standard.)

State: (1-31 Chars.)
Locality: (1-31 Chars.)
Crganization: (1-31 Chars.)
Crganization Unit: (1-31 Chars.)

ltems marked with an asteriski*} are required

Apply Cancel
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2.  PKl entity configuration items

ltem Description

Entity Name Type the name for the PKI entity.
Common Name Type the common name for the entity.
IP Address Type the IP address of the entity.

Type the fully qualified domain name (FQDN) for the entity.

FQDN An FQDN is a unique identifier of an entity on the network. It consists of a host name and
a domain name and can be resolved to an IP address. For example, www.whatever.com
is an FQDN, where www indicates the host name and whatever.com the domain name.

Country/Region Type the country or region code for the entity.

Code

State Type the state or province for the entity.
Locality Type the locality for the entity.
Organization Type the organization name for the entity.

Organization Unit  Type the unit name for the entity.

Return to Configuration task list for requesting a certificate manually.

Return to Configuration task list for requesting a certificate automatically.

Creating a PKI domain

Select Authentication > PKI from the navigation tree, and then select the Domain tab to enter the page
displaying existing PKI domains, as shown in a. Then, click Add to enter the PKI domain configuration page,
and click Display Advanced Config to display the advanced configuration items, as shown in b.

a. PKl domain list

Entity Certificate CRL
Domain Mame CA ldentifier Entity Mame RequestMode  Operation
abcd entity1 Manual ﬂ
Add
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b. PKI domain conf

iguration page

Entity Certificate CRL
Add PKI Domain
Domain Mame: *{1-15 Chars.)
CA ldentifier: (1-63 Chars.)
Entity Mame: w
Institution: CA w
Requesting URL: 127 Chars, (-
LDAP IP: Port: | 389 Version; | 2 ¥
Request Mode: IManual |+
Hash: MD5  w
Fingerprint: (32 Hex)
Hide Advanced Config
Folling Count; 50 (1-100, Default = 50}
Paolling Interval: 20 minutes(5-168, Default = 20}
Enable CRL Checking
ponL Jpdste hours(1-720)
CRLURL 127 Chars.) v

ltems marked with an asteriski(*} are required

Apply Cancel

2.  PKI domain configuration items

ltem

Description

Domain Name

Type the name for the PKI domain.

CA Identifier

Type the identifier of the trusted CA.

An entity requests a certificate from a trusted CA. The trusted CA takes the responsibility
of certificate registration, distribution, and revocation, and query.

In offline mode, this item is optional; while in other modes, this item is required.

Entity Name

Select the local PKI entity.

When submitting a certificate request to a CA, an entity needs to show its identity
information.

Available PKI entities are those that have been configured.

Institution

Select the authority for certificate request.
e CA: Indicates that the entity requests a certificate from a CA.
e RA: Indicates that the entity requests a certificate from an RA.

RA is recommended.
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ltem

Description

Requesting URL

Type the URL of the RA.

The entity will submit the certificate request to the server at this URL through the SCEP
protocol. The SCEP protocol is intended for communication between an entity and an
authentication authority.

In offline mode, this item is optional; while in other modes, this item is required.

@ IMPORTANT:

This item does not support domain name resolution.

LDAP IP Type the IP address, port number and version of the LDAP server.

Port In a PKI system, the storage of certificates and CRLs is a crucial problem, which is usually
Version addressed by deploying an LDAP server.

Request Mode Select the online certificate request mode, which can be auto or manual.

Password Encrypt

Select this check box to display the password in cipher text.

This check box is available only when the certificate request mode is set to Auto.

Password

Type the password for certificate revocation.

This item is available only when the certificate request mode is set to Auto.

Hash

Fingerprint

Specify the hash algorithm and fingerprint for verification of the CA root certificate.

Upon receiving the root certificate of the CA, an entity needs to verify the fingerprint of
the root certificate, namely, the hash value of the root certificate content. This hash value
is unique to every certificate. If the fingerprint of the root certificate does not match the
one configured for the PKI domain, the entity will reject the root certificate.

@ IMPORTANT:

The fingerprint of the CA root certificate is required when the certificate request mode is
Auto, and can be omitted when the certificate request mode is Manual. When it is omitted,
no CA root certificate verification occurs automatically and you need to verify the CA server
by yourself.

Polling Count

Polling Interval

Set the polling interval and attempt limit for querying the certificate request status.

After an entity makes a certificate request, the CA may need a long period of time if it

verifies the certificate request in manual mode. During this period, the applicant needs to
query the status of the request periodically to get the certificate as soon as possible after
the certificate is signed.

Enable CRL
Checking

Select this box to specify that CRL checking is required during certificate verification.

CRL Update Period

Type the CRL update period, that is, the interval at which the PKI entity downloads the
latest CRLs.

This item is available when the Enable CRL Checking check box is selected.
By default, the CRL update period depends on the next update field in the CRL file.

CRL URL

Type the URL of the CRL distribution point.
This item is available when the Enable CRL Checking check box is selected.

Note that when the URL of the CRL distribution point is not set, you should acquire the CA
certificate and a local certificate, and then acquire a CRL through SCEP.

@ IMPORTANT:

This item does not support domain name resolution.
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Return to Configuration task list for requesting a certificate manually.

Return to Configuration task list for requesting a certificate automatically.

Generating an RSA key pair

Select Authentication > PKI from the navigation tree, and then select the Certificate tab to enter the page

displaying existing PKI certificates, as shown in a. Then, click Create Key to enter RSA key pair parameter
configuration page, as shown in b.

a. Certificate configuration page

Semner

Entity Domain CRL
Domain | o Subject Certllﬂcate Operation
Marne Type
CM=CA . -, ) 5 it e i et T s e e et
abed o CN=CAsenver CA [Delete the certificate][View the certificate]
CN=CA : _ —e O 1=fa (= = —fd = ; i
abcd emailAddress=fs, CN=syy,OU=fs, O=fsd, L=fds 5T=fd C=CMN Local [Delete the certificate][View the certificate]

Create Key Destroy Key Retrieve Cernt Request Cert

» There are two ways for requesting and retrieving a cerificate manually: anline and offline.
# Toreguest a certificate online, you must get the root cerificate from the CA server first.

= When you request a cerificate offline, the requested information will be displayed on the page first. Flease copy itto the
CA server to produce the cerificate file offline, and then retrieve the file.

# When you delete the CA cerificate, the relevant local certificate will also be deleted.

b. Key pair parameter configuration page

Entity Diamain CRL
Add Key
Key Length: 1024 *{512-2048, Default = 1024)

Ifthere is already a key, overwrite it.
[tems marked with an asterisk(*) are required

Apply Cancel

2. Configuration item for generating an RSA key pair

ltem Description

Key Length Type the length of the RSA keys.

Return to Configuration task list for requesting a certificate manually.

Destroying the RSA key pair

Select Authentication > PKI from the navigation tree, and then select the Certificate tab to enter the page
displaying existing PKl certificates, as shown in a. Click Destroy Key to enter RSA key pair destruction page,
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as shown in a. Then, click Apply to destroy the existing RSA key pair and the corresponding local
certificate.

a. Key pair destruction page

Entity Domain CRL

Destroy Key

This operation will destroy the key, and corresponding local certificate.

Apply Cancel

Return to Configuration task list for requesting a certificate manually.

Return to Configuration task list for requesting a certificate automatically.

Retrieving a certificate

You can download an existing CA certificate or local certificate from the CA server and save it locally. To
do so, you can use two ways: online and offline. In offline mode, you need to retrieve a certificate by an
out-of-band means like FTP, disk, e-mail and then import it into the local PKI system.

Select Authentication - PKI from the navigation tree, and then select the Certificate tab to enter the page

displaying existing PK| certificates, as shown in a. Click Retrieve Cert to enter PK| certificate retrieval page,
as shown in a.

a. PKl certificate retrieval page

Entity Damain CRL

Retrieve Cerificate

Domain Mame: abcd v
Certificate Type: ChA W

[ Enable Offine
Mode
termns marked with an asteriski*} are required

Apply Cancel

2. Configuration items for retrieving a PKI certificate

ltem Description
Domain Name Select the PKI domain for the certificate.
Certificate Type Select the type of the certificate to be retrieved, which can be CA or local.

Select this check box to retrieve a certificate in offline mode (that is, by an out-ofband
means like FTP, disk, or e-mail) and then import the certificate into the local PKI system.

Enable Offline

Mode

The following configuration items are displayed if this check box is selected.
Get File From . " )
Device Specify the path and name of the certificate file.
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ltem Description

o |f the certificate file is saved on the device, select Get File From Device and then
specify the path of the file on the device.

Get File From PC o If the certificate file is saved on a local PC, select Get File From PC and. then specify

the path to the file and select the partition of the device for saving the file.

Enter the password for protecting the private key, which was specified when the

P d o[
asswor certificate was exported.

After refrieving a certificate, you can click View Cert corresponding to the certificate from the PKI certificates
list to display the contents of the certificate, as shown in a.

a. Certificate details

Entity Domain CRL -

View Cerificate Details

Versiocn: 3 (0x2)
Serial Numbker:
0&4BED12 2&2858R7

Signature Rlgorithm: shalWithRSAEncrypticon

06:15:18 2008 GMT
06:24:43 2013 GMT
ey Info:
fey Algorithm: rsaEncrypticn
R34 Fublic Key: (2048 birc)

Modulus (2048 kit):
D3EQOQ33D 0OF12D1E3

TTT7T293F C
033BF4D8
CEEBT17C

F205F73E

S5EZ24B353

Fymamant* ASSIT Mw1NA0TY

Return to Configuration task list for requesting a certificate manually.

Return to Configuration task list for requesting a certificate automatically.
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Requesting a local certificate

Select Authentication - PKI from the navigation tree, and then select the Certificate tab to enter the page
displaying existing PKI certificates, as shown in a. Click Request Cert to enter the local certificate request
page, as shown in a.

a. Local certificate request page

Entity Diomain CRL

Request Cerificate

Domain Mame:

@ Paszsword: (1-31 Chars.)

) Enable Offline Mode
[tems marked with an asterisk(*} are required

Apply Cancel

2. Configuration items for requesting a local certificate

ltem Description
Domain Name Select the PKI domain for the certificate.
Password Type the password for certificate revocation.

Select this check box to request a certificate in offline mode, that is, by an

Enable Offline Mode out-of-band means like FTP, disk, or e-mail.

If you select the offline mode and click Apply, the offline certificate request information page appears, as
shown in a. Submit the information to the CA to request a local certificate.

a. Offline certificate request information page

Entity Domain CRL

QOffline Cerificate Request Information

SIb3DQEBLQULLAGHADCEL QKB
ILAh¥ztclGiTghhMudh
EdulPogMalb0dc/b

ndrkKi4i+z3

X5chji+al vHH902281ibTHaga rulBX CFYS5nL
Unbf¥iRud4dcEvy nzFESFC1bAfpTubkfxgPathQL3I9e0LViI2FFg/bLwCbE20
————— END CERTIFICRIE REQUEST-----

Back

Return to Configuration task list for requesting a certificate manually.
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Retrieving and displaying a CRL

Select Authentication - PKI from the navigation tree, and then select the CRL tab to enter the page
displaying CRLs, as shown in a.

a. CRL page
Entity Daomain Cerificate
Daomain Mame Qperation
abcd [Retrieve CRL][View CRL]

o Click Retrieve CRL to retrieve the CRL of a domain.
o Then, click View CRL for the domain to display the contents of the CRL, as shown in b.

b. CRL details

Entity Domain Cerificate

Wiew CRL Details

Certificate Revoca
Versicn 2
Signature Algorithm: shalWithR3AEncrypticn
Izsuer:

C=cn

Ol=cl
Cl=c
Last Update: Oct 25 07:34:16 2007 GMT
Next Update: NONE
CEL extensions:
X509v3 CRL Number:
X509v3 Authority Hey Identifier:
keyid:BD5D0565 E744R219 ER41A2EE G9BES9AS Fe2EACL0

: shalWithRSAFncryption
8E 84C25849 4E15995C
Rl10 B4

760EF

[ FOF1
8356BBTD 2EF341F3

D217744% €DCEC2ZED
Back

2. Description about some fields of the CRL details

Field Description

Version CRL version number

Signature Algorithm Signature algorithm that the CRL uses
Issuer CA that issued the CRL
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Field Description

Identifier of the CA that issued the certificate and the certificate version

X509v3 Authority Key Identifier (X509v3).

Pubic key identifier

keyid A CA may have multiple key pairs, and this field identifies which key
pair is used for the CRL signature.

Return to Configuration task list for requesting a certificate manually.

Return to Configuration task list for requesting a certificate automatically.

PKI configuration example

Configuring a PKI entity to request a certificate from a CA

Network requirements

As shown in a, configure the Switch working as the PKI entity, so that:
e The Switch submits a local certificate request to the CA server, which runs the RSA Keon software.

o The Switch acquires CRLs for certificate verification.

a. Network diagram for configuring a PKI entity to request a certificate from a CA

PKI entity
Host Switch CA server

Configuration procedure
Table 145 Configure the CA server

# Create a CA server named myca.

In this example, you need to configure the basic attributes of Nickname and Subject DN on the CA server

at first:

e Nickname: Name of the trusted CA.

e Subject DN: DN information of the CA, including the Common Name (CN),
e Organization Unit (OU),

e Organization (O), and

e Country (C).

The other attributes may use the default values.

# Configure extended attributes

After configuring the basic attributes, you need to perform configuration on the Jurisdiction Configuration
page of the CA server. This includes selecting the proper extension profiles, enabling the SCEP autovetting

function, and adding the IP address list for SCEP autovetting.
# Configure the CRL publishing behavior
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After completing the above configuration, you need to perform CRL related configurations.

In this example, select the local CRL publishing mode of HTTP and set the HTTP URL to
http://4.4.4.133:447 /myca.crl.

Atter the above configuration, make sure that the system clock of the Switch is synchronous to that of the CA,
so that the Switch can request certificates and retrieve CRLs properly.

Table 146 Configure Switch

# Create a PKI entity.

o Select Authentication > PKI from the navigation tree. The PKI entity list page is displayed by default.
Click Add on the page, as shown in b, and then perform the following configurations as shown in c.

b. PKI entity list

Damain Certificate CRL

Entity Comman Qrganization IFP

,  CountryRegion o N )
Name Name FQDM Code State Locality Qrganization Unit Address Cperation
Add
c. Configure a PKI entity
Comain Cerlificate CRL
Add PKI Entity
Entity Mame: aaa *{1-15 Chars.}
Commaoan Mame: ac *(1-31 Chars.}
IP Address:
FQDM: (1-127 Chars.)

(Country/Region name symhal, two characters

Country/Region Code: - '
compliant to 120 3166 standard.)

State: (1-31 Chars.)
Locality: {1-31 Chars.)
Qrganization: (1-31 Chars.}
Qrganization Unit: (1-31 Chars.}

terms marked with an asterisk(*) are required

Apply Cancel

e Type aaa as the PKI entity name.
e  Type ac as the common name.

o Click Apply.

# Create a PKI domain.

o Select the Domain tab, and then click Add, as shown in d, and then perform the following
configurations as shown in e.

398



d. PKI domain list

Entity Cerificate CRL
Domain Name CA ldentifier Entity Mame Request Mode  Operation
Add

e. Configure a PKI domain

Entity Cerificate CRL

Add PKI Domain

Domain Mame: torsa *(1-15 Chars.)
CA ldentifier: myca (1-63 Chars.)
Entity Mame:
Institution: CA w
hitp://d 4.4 132:446/c95e970M822d27bede8chfB0e971d90439293337 1-

Requesting URL:

127 Chars.)

LDAP IF: Port: 'v"ersinn:
Request Mode:

Hash: MDs

Fingerprint: (32 Hex)

Hide Advanced Config

)]
o

Polling Count: (1-100, Default = 50)

=]
=)

Polling Interval: minutes{5-168, Default = 20}

| Enable CRL Checking
CRL Update Periad: hours(1-720)

hitp:/id. 4.4 133:447/myca.crl (1-
127 Chars.)
ltems marked with an asterisk(*) are required

CRL URL:

Apply Zancel

Type torsa as the PKI domain name.

e Type myca as the CA identifier.

e Select aaa as the local entity.

e Select CA as the authority for certificate request.

o Type htip://4.4.4.133:446/c95e970f632d27be5e8cbf80e971d9c4a9a93337 as the URL for
certificate request. The URL must be in the format of http://host:port/Issuing Jurisdiction ID, where
Issuing Jurisdiction ID is the hexadecimal string generated on the CA.

o Select Manual as the certificate request mode.

o  Click Display Advanced Config to display the advanced configuration items.

o Select the Enable CRL Checking check box.
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o Type http://4.4.4.133:447 /myca.crl as the CRL URL.

o  Click Apply. A dialog box appears, asking “Fingerprint of the root certificate not specified. No root
certificate validation will occur. Continue?” Click OK.

# Generate an RSA key pair.

o Select the Certificate tab, and then click Create Key, as shown in f, and perform the configuration as
shown in g.

f.  Certificate list

Entity Damain CRL

Domain Mame lssuer Subject Cerificate Type Cperation

Create Key Destroy Key Retrieve Cert Request Cert

e There are two ways for requesting and retrieving a certificate manually: online and offline.
& Torequest a cerificate online, you must get the root cerificate from the CA server first.

« Whenyou request a cerificate offline, the requested information will be displayed on the page first.
Flease copy itto the CA server o produce the cedificate file offline, and then retrieve the file.

« Whenvyou delete the CA cerificate, the relevant local cerificate will also he deleted.

g. Generate an RSA key pair

Entity Diomain CRL
Add Key
Key Length: 1024 *{312-2048, Default = 1024}

Ifthere is already a key, overawrite it.
ltems marked with an asterisk(*) are required

Apply Zancel

o  Click Apply to generate an RSA key pair.
# Retrieve the CA certificate.

o Select the Certificate tab, and then click Retrieve Cert, as shown in h, and then perform the following
configurations as shown in i.
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h. Certificate list

Entity Damain CRL

Daomain Mame lssuer Subject Certificate Type Operation

Create Key Destroy Key Retrieve Cert Request Cert

e There are two ways for requesting and retrieving a certificate manually: online and offline.
¢ Torequest a cerificate online, yau must get the root cerificate from the CA server first.

# YWhenyou request a cerificate offline, the requested information will be displayed on the page first.
Flease copy itto the CA server to produce the cerificate file offline, and then retrieve the file.

» Whenvyou delete the CA cerificate, the relevant local cerificate will also he deleted.
i.  Retrieve the CA certificate

Entity Daomain CRL

Retrieve Cerificate

Damain Mame:

Certificate Type: CA | »

[]Enable offline Made
tems marked with an asterisk(*} are required

Apply Zancel

e Select torsa as the PKI domain.
o Select CA as the certificate type.
o Click Apply.

# Request a local certificate.

o Select the Certificate tab, and then click Request Cert, as shown in |, and then perform the following
configurations as shown in k.

i Certificate list

Entity Domain CRL
LoTET Issuer Subject SEIEE Operatian
Mame Type
tarsa Ch=CA server Ch=CA server CA [Delete the certificate][View the certificate]
Create Key Destroy Key Retrieve Cert Request Cert

o There are two ways for requesting and retrieving a cerificate manually: onling and offline.
o Torequest a certificate onling, you must get the root cerificate from the CA server first,

+ When vou request a cerificate offline, the requested information will be displayed on the page first.
Please copy itto the CA server to produce the cerificate file offline, and then retrieval the file.

+ When vou delete the CA cerificate, the relevant local cerificate will also be deleted.
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k. Request a local certificate

Entity Domain CRL

Request Certificate

Domain Mame: torsa ¥

& Password: challenge-word (1-31 Chars )

(O Enable Offling Mode
Iltems marked with an asterisk(*) are required

Apply Cancel

Select torsa as the PKI domain.

o
e Select Password and then type challenge-word as the password.
o Click Apply.

# Retrieve the CRL.

o After refrieving a local certificate, select the CRL tab.

e  Click Retrieve CRL of the PKI domain of torsa, as shown in |.
I.  Retrieve the CRL
Entity Domain Certificate
Domain Name Operation
torsa [Retrieve CRL]|view CRL]

Configuration guidelines

When you configure PKI, note the following guidelines:

e Make sure the clocks of entities and the CA are synchronous. Otherwise, the validity period of
certificates will be abnormal.

e The Windows 2000 CA server has some restrictions on the data length of a certificate request. If the
PKI entity identity information in a certificate request goes beyond a certain limit, the server will not
respond to the certificate request.

e The SCEP plug-in is required when you use the Windows Server as the CA. In this case, you need to
specify RA as the authority for certificate request when configuring the PKI domain.

e The SCEP plug-in is not required when you use the RSA Keon software as the CA. In this case, you need
to specify CA as the authority for certificate request when configuring the PKI domain.
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Port isolation group configuration

Overview

Usually, Layer 2 traffic isolation is achieved by assigning ports to different VLANs. To save VLAN resources,
port isolation is introduced to isolate ports within a VLAN, allowing for great flexibility and security.

HP V1910 Switch Series supports only one isolation group that is created automatically by the system as
isolation group 1. You can neither remove the isolation group nor create other isolation groups on such
devices.

There is no restriction on the number of ports assigned to an isolation group.

Usually, Layer 2 traffic cannot be forwarded between ports from different VLANs. However, Layer 2 data
transmission between ports within and outside the isolation group is supported.

Contiguring a port isolation group

Select Security - Port Isolate Group from the navigation tree and in the page that appears, click the Modify
tab to enter the page shown in a.

a. Configure a port isolation group

Summary

lsalate group 1D Select group ¥
Config type le’.lsolate port DUpIink—port

Select pork(s)

Select Al Select Mone

Apply

Isaolate port Uplink-part
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2. Port isolation group configuration items

ltem Description
Specify the role of the port or ports in the isolation group.
o Isolate port: Assign the port or ports to the isolation group as an isolated port or
ports.
Config type o Uplink-port: Assign the port to the isolation group as the uplink port.

@ IMPORTANT:
The uplink port is not supported on HP V1910 Switch Series.

Select port(s)

Select the port(s) you want to assign fo the isolation group.

You can click ports on the chassis front panel for selection; if aggregation interfaces
are configured, they will be listed under the chassis panel for selection.

Port isolation group configuration example

Network requirements

e Campus network users Host A, Host B, and Host C are connected to GigabitEthernet 1/0/2,
GigabitEthernet 1/0/3, and GigabitEthernet 1/0/4 of Switch.

e Switch is connected to the Internet through GigabitEthernet 1/0/1.

e  GigabitEthernet 1/0/1, GigabitEthernet 1/0/2, GigabitEthernet 1/0/3, and GigabitEthernet
1/0/4 belong to the same VLAN.

Configure Host A, Host B, and Host C to access the Internet and isolate them from each other.

a. Networking diagram for port isolation group configuration

Host A Host B

Configuration procedure

Host C

# Assign GigabitEthernet 1/0/2, GigabitEthernet 1/0/3, and GigabitEthernet 1/0/4 to an isolation

group as isolated ports.

Select Security -> Port Isolate Group from the navigation tree and in the page that appears, click the Modify
tab to enter the page shown in a.
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a. Configure isolated poris for an isolation group

Summary

Config type @.Isolate port DUpIink—port

Select ports)

HP 1810-24G-Pa...

Waggregation ports
BAGG]

Select All Select Mane

Apply

|solate part Uplink-port
GE1/0i2-GE1/0i4

e Select Isolate port for the port type.

o Select GigabitEthernet 1/0/2, GigabitEthernet 1/0/3, and GigabitEthernet 1/0/4 on the chassis
front panel.

e Click Apply. A configuration progress dialog box appears.

e After the configuration process is complete, click Close in the dialog box.
# View information about the isolation group.

Click Summary. The page shown in b appears.

b. Information about port isolation group 1

Modify

Isolate group
D Uplink-part I |solate part

GE1/D/2-GE1D

Fort type Uplink—por‘D Izolate por.

Wggregation pors
BAGGT

As shown on the page, port isolation group 1 contains these isolated ports: GigabitEthernet 1/0/2,
GigabitEthernet 1/0/3, and GigabitEthernet 1/0/4.
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Authorized IP configuration

Overview

The authorized IP function is to associate the HTTP or Telnet service with an ACL to filter the requests of
clients. Only the clients that pass the ACL filtering can access the device.

Contiguring authorized IP

Select Security > Authorized IP from the navigation tree, and then click the Setup tab to enter the authorized
IP configuration page, as shown in a.

a. Authorized IP configuration page

Summary
Telnet
IPvd ACL : MoChange IPvE ACL :
Web(HTTP)
IPvd ACL : MoChange
Rule ID Operation Description Time Range

2. Authorized IP configuration items

ltem Description

Associate the Telnet service with an IPv4 ACL.

IPv4 ACL
You can configure the IPv4 ACL to be selected by selecting QoS > ACL IPv4.
fehnet IPv6 ACL( Not  Associate the Telnet service with an IPv6 ACL.
Supported ) You can configure the IPv6 ACL to be selected by selecting QoS = ACL IPvé.
Web Pud ACL Associate the HTTP service with an IPv4 ACL.
(HTTP) You can configure the IPv4 ACL to be selected by selecting QoS = ACL IPv4.
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Authorized IP configuration example

Authorized IP configuration example

Network requirements

In a, configure Switch to deny Telnet and HTTP requests from Host A, and permit Telnet and HTTP requests
from Host B.

a. Network diagram for authorized IP

Host A ’_
10.1.1.2124 10.1.1.1/24 @

Host B ' Switch

10.1.1.3/24

Configuration procedure

# Create an ACL.

o Select QoS > ACL IPv4 from the navigation tree and then click the Create tab to enter the ACL
configuration page shown in a.

Type 2001 for ACL Number.
Click Apply.
a. Create an ACL

Summary Basic Setup Advanced Setup Link Setup Remove

ACL Mumber |2[][]1 2000-29949 for Basic ACL.
2000-39949 for Advanced ACL.
4000-4999 for Ethernet frame header ACL.

Watch Order
Apply

ACL Mumber Type Mumber of Rules Match Order

# Configure an ACL rule to permit Host B.
o Click the Basic Setup tab to enter the page shown in b.
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e Select 2001 from the Select Access Control List (ACL) drop-down list.
e  Select Permit from the Operation drop-down list.

e Select the Source IP Address check box and then type 10.1.1.3.

e  Type 0.0.0.0 in the Source Wildcard text box.

e  Click Add.

b. Configure an ACL rule to permit Host B
Summary Create Advanced Setup Link Setup Remaove
Select Access Control List(acL) | 2001 b

Configure a Basic ACL

Orule D (0-55534 If no ID is entered, the system will specify one. |
Operation FPermit
[Jcheck Fragment [Jcheck Legaing
Source IP Address 10.1.1.3 Source Wildcard 0000
Time Range Mot Check | »
Add
Rule ID Operation Description Time Range

# Configure authorized IP.

o Select Security > Authorized IP from the navigation tree and then click the Setup tab to enter the
authorized IP configuration page shown in c.

e  Select 2001 for IPv4 ACL in the Telnet field.
e  Select 2001 for IPv4 ACL in the Web(HTTP) field.
o Click Apply.
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c. Configure authorized IP

Summary Em

Telnet

IPvd ACL - | 2001 ﬂ IPvE ACL - MaChange Lj
Web(HTTP)

Pyt ACL- [ 2001 v

Rule 1D Operation Description Time Range
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ACL configuration

ACL overview

With the growth of network scale and network traffic, network security and bandwidth allocation become
more and more critical to network management. Packet filtering can be used to efficiently prevent illegal
access fo networks and to control network traffic and save network resources. One way to implement packet
filtering is to use access control lists (ACLs).

An AClL is a set of rules (or a set of permit or deny statements) for determining which packets can pass and
which ones should be rejected based on match criteria such as source address, destination address, and
port number. ACLs are widely used with technologies such as QoS, where traffic identification is desired.

Introduction to IPv4 ACL

IPv4 ACL classification

IPv4 ACLs, identified by ACL numbers, fall into the following categories, as shown in 1.
1. IPv4 ACL categories

Category ACL number Match criteria
Basic IPv4 ACL 2000 to 2999 Source IP address

Source IP address, destination IP address, protocol
Advanced IPv4 ACL 3000 to 3999 carried over IP, and other Layer 3 or Layer 4 protocol
header information

Layer 2 protocol header fields such as source MAC
Ethernet frame header ACL 4000 to 4999 address, destination MAC address, 802.1p
precedence, and link layer protocol type

IPv4 ACL match order

An ACL may consist of multiple rules, which specify different match criteria. These match criteria may have
overlapping or conflicting parts. The match order determines how packets should be matched against the
rules. The comparison of a packet against ACL rules stops immediately after a match is found. The packet
is then processed as per the rule.

The following types of IPv4 ACL match orders are available:
o config—Compares packets against ACL rules in the order that the rules are configured.

e auto—Compares packets against ACL rules in the depth-first match order.

The term depth-first match has different meanings for different types of IPv4 ACLs.
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1. Depth-first match for IPv4 ACLs

IPv4 ACL category Depth-first match procedure

1.
Basic IPv4 ACL

Sort rules by source IP address wildcard mask and compare
packets against the rule configured with more zeros in the source
IP address wildcard mask.

In case of a tie, compare packets against the rule configured first.

Advanced IPv4 ACL

Sort rules by the protocol carried over IP. A rule with no limit to the
protocol type (that is, configured with the ip keyword) has the
lowest precedence. Rules each of which has a single specified
protocol type are of the same precedence level.

If the protocol types have the same precedence, look at the source
IP address wildcard mask. Then, compare packets against the rule
configured with more zeros in the source IP address wildcard
mask.

If the numbers of zeros in the source IP address wildcard masks
are the same, look at their destination IP address wildcard masks.
Then, compare packets against the rule configured with more
zeros in the destination IP address wildcard mask.

If the numbers of zeros in the destination IP address wildcard
masks are the same, look at the Layer 4 port number ranges,
namely the TCP/UDP port number ranges. Then compare packets
against the rule configured with the smaller port number range.
If the port number ranges are the same, compare packets against
the rule configured first.

Ethernet frame header ACL

10.

Sort rules by source MAC address mask first and compare packets
against the rule configured with more ones in the source MAC
address mask.

If two rules are present with the same number of ones in their
source MAC address masks, look at the destination MAC address
masks. Then, compare packets against the rule configured with
more ones in the destination MAC address mask.

If the numbers of ones in the destination MAC address masks are
the same, compare packets against the one configured first.

Fragments filtering with IPv4 ACLs

Traditional packet filtering performs match operation on only the first fragments. All subsequent non-first
fragments are handled in the way the first fragments are handled. This results in security risks, because

attackers may exploit this vulnerability to fabricate non-first fragments to attack your network.

As for the configuration of a rule of an IPv4 ACL, you can specify that the rule applies to non-irst fragment
packets only, and does not apply fo non-fragment packets or the first fragment packets. ACL rules that do not

contain this keyword are applicable to both non-fragment packets and fragment packets.

Effective period of an ACL

You can control when a rule can take effect by referencing a time range in the rule.

A referenced time range can be one that has not been created yet. The rule, however, can take effect only

after the time range is defined and becomes active.
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ACL step

NOTE:
The Web interface does not support ACL step configuration.

Meaning of the step

The step defines the difference between two neighboring numbers that are automatically assigned to ACL
rules by the device. For example, with a step of 5, rules are automatically numbered O, 5, 10, 15, and so
on. By default, the step is 5.

Whenever the step changes, the rules are renumbered, starting from 0. For example, if four rules are
numbered O, 5, 10, and 15 respectively, changing the step from 5 to 2 will cause the rules to be
renumbered O, 2, 4, and 6.

Benefits of using the step

With the step and rule numbering/renumbering mechanism, you do not need to assign numbers to rules
when defining them. The system will assign a newly defined rule a number that is the smallest multiple of the
step bigger than the current biggest number. For example, with a step of five, if the biggest number is 28,
the newly defined rule will get a number of 30. If the ACL has no rule defined already, the first defined rule
will get a number of 0.

Another benefit of using the step is that it allows you to insert new rules between existing ones as needed.
For example, after creating four rules numbered 0, 5, 10, and 15 in an ACL with a step of five, you can
insert a rule numbered 1.

Contiguring an ACL

Configuration task list

Configuring an IPv4 ACL
Perform the tasks in 1 to configure an IPv4 ACL.
1. IPv4 ACL configuration task list

Task Remarks
Optional
Configuring a time range A rule referencing a time range takes effect only

during the specified time range.

Required

Creating an IPv4 ACL The category of the created ACL depends on the ACL
number that you specify.

Contfiguring a rule for a basic IPv4 ACL Required

Configuring a rule for an advanced IPv4 ACL Complete one of the three tasks according to the ACL
category.

Contfiguring a rule for an Ethernet frame header ACL
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Configuring a time range

Select QoS > Time Range from the navigation tree and then select the Create tab to enter the time range
configuration page, as shown in a.

a. The page for creating a time range

Summary Remaove
Time Range Mame (1-32 Chars.)
[ Periadic Time Range
Start Time : End Time
2un Man Tue Wed Thu Fri Sat
[ absolute Time Range
From :
To :
Apply
Summary

2 describes the configuration items for creating a time range.

2. Time range configuration items

ltem Description

Time Range Name Set the name for the time range.

Start Time  Set the start time of the periodic time range. )
You can define

Set the end time of the periodic time range. The end time must ~ both a periodic

Periodic End Time be greater than the start time. time range and
an absolute
Time R .
ime Range  Sun, Mon, Select the day or days of the week on which the periodic time ~ fime range fo
Tue, Wed Y 4 p
Th ! Eri " range is valid. You can select any combination of the days of ~ create a
v the week. compound time
and Sat. range. This
Absolute Set the start time and date of the absolute time range. The time compound time
Time Range From of the day is in the hh:mm format (24-hour clock), and the date  "@nge recurs on
' 9 is in the MM/DD/YYYY format. the day or days
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ltem Description

Set the end time and date of the absolute time range. The time of the week

of the day is in the hh:mm format (24-hour clock), and the date only _V‘_’”hin the
is in the MM/DD/YYYY format. The end time must be greater spe'cnﬂed
than the start time. period.

To

Return to IPv4 ACL configuration task list.

Creating an IPv4 ACL

Select QoS > ACL IPv4 from the navigation tree and then select the Create tab to enter the IPv4 ACL
configuration page, as shown in a.

a. The page for creating an IPv4 ACL
summary Basic Setup Advanced Setup Link Setup Remaove
ACL Mumber 2000-2998 for Basic ACL.

3000-3998 for Advanced ACL.
4000-4998 for Ethernet frame header ACL.

Match Order Config »
Apply
ACL Number Type Mumber of Rules Match Order
Basic 0 Config
3105 Advanced 0 Auto

2 describes the configuration items for creating an IPv4 ACL.

2. IPv4 ACL configuration items

ltem Description
ACL Number Set the number of the IPv4 ACL.

Set the match order of the ACL. Available values are:

e Config—Compare packets against ACL rules in the order that the rules are

Match Order )
configured.

o Auto—Compares packets against ACL rules in the depth-first match order.

Return to IPv4 ACL configuration task list.

Contiguring a rule for a basic IPv4 ACL

Select QoS > ACL IPv4 from the navigation tree and then select the Basic Setup tab to enter the rule
configuration page for a basic IPv4 ACL, as shown in a.
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a. The page for configuring an basic IPv4 ACL

Summary Create

Advanced Setup Link Setup Remave

Select Access Control ListiaCL) | Selectan ACL (v

Configure a Basic ACL

rRule 1D (0-65534 Ifno 1D is entered, the system will specify one. )
Operation Fermit «
[Jcheck Fragment CJcheck Logging

[Isource IP Address

Time Range Mot Check  w

Rule 1D Operation

Source Wildcard

Description Time Range

2 describes the configuration items for creating a rule for a basic IPv4 ACL.

2. Configuration items for a basic IPv4 ACL rule

ltem

Description

Select Access Control List (ACL)

Select the basic IPv4 ACL for which you want to configure rules.
Available ACLs are basic IPv4 ACLs that have been configured.

Select the Rule ID option and type a number for the rule.

Rule ID If you do not specify the rule number, the system will assign one
automatically.
Select the operation to be performed for IPv4 packets matching the
rule.

Operation

e Permit—Allows matched packets to pass.

e Deny—Drops matched packets.

Check Fragment

Select this option to apply the rule to only non-irst fragments.

If you do no select this option, the rule applies to all fragments and
non-{fragments.

Check Logging

Select this option to keep a log of matched IPv4 packets.

A log entry contains the ACL rule number, operation for the matched
packets, protocol that IP carries, source/destination address,
source/destination port number, and number of matched packets.

Source IP Address

Select the Source IP Address option and type a source IPv4 address
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ltem Description
Source Wildcard and a wildcard mask, in dotted decimal notation.

Select the time range during which the rule takes effect.

Time Range .
Available time ranges are those that have been configured.

Return to IPv4 ACL configuration fask list.

Contiguring a rule for an advanced IPv4 ACL

Select QoS > ACL IPv4 from the navigation tree and then select the Advanced Setup tab to enter the rule
configuration page for an advanced IPv4 ACL, as shown in a.
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a. The page for configuring an advanced IPv4 ACL

Summary Create Basic Setup Link Setup Remove

Select Access Control List(ACL) | Select an ACL w

Help

Configure an Advanced ACL

CIRule ID |

|(U—55534-. Ifno 1D is entered, the system will specify one.)

Operation

[Jcheck Fragment

IF Address Filter

[ Check Logaing

[ source IF Address |

| Source Wildcard | |

[J Destination IP Address |

| Destination Wildcard | |

Protacal | IP w

ICMP Type
Mamed ICMP Type

ICMP Type

0-255;  ICMF Code (0-255)

TCRIUDF Port

Check
Estahlished

Source: Operator

Destination: Operatar

=] |
art

[} |
FPort

Port |

F'ort|

(Range of Portis 0-625358)

Frecedence Filter

DSCP | Not Check

TOS | Mot Check

Time Range | Mot Check «

Precedence | Not Check v |

Rule 1D Operation

Description Time Range

2 describes the configuration items for creating a rule for an advanced IPv4 ACL.
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2.

Configuration items for an advanced IPv4 ACL rule

ltem

Description

Select Access Control List (ACL)

Select the advanced IPv4 ACL for which you want to
configure rules.

Available ACLs are advanced IPv4 AClLs that have been
configured.

Select the Rule ID option and type a number for the rule.

Rule ID If you do not specify the rule number, the system will
assign one automatically.
Select the operation to be performed for packets matching
the rule.

Operation

e Permit—Allows matched packets to pass.

e Deny—Drops matched packets.

Check Fragment

Select this option to apply the rule to only non-first
fragments.

If you do no select this option, the rule applies to all
fragments and non-fragments.

Check Logging

Select this option to keep a log of matched packets.

A log entry contains the ACL rule number, operation for
the matched packets, protocol that IP carries,
source/destination address, source/destination port
number, and number of matched packets.

Source IP Address

Source Wildcard

Select the Source IP Address option and type a source [Pv4
address and a source wildcard mask, in dotted decimal
notation.

IP Address Filter
Destination IP Address

Destination Wildcard

Select the Source IP Address option and type a source IP
address and a source wildcard mask, in dotted decimal
notation.

Protocol

Select the protocol to be carried by IP.

If you select 1 ICMP, you can configure the ICMP message
type and code; if you select 6 TCP or 17 UDP, you can
configure the TCP or UDP port.

Named ICMP Type

ICMP Type

ICMP Type

ICMP Code

Specify the ICMP message type and code.

These items are available only when you select 1 ICMP
from the Protocol drop-down box.

If you select Other from the Named ICMP Type drop-down
box, you need to type values in the ICMP Type and ICMP
Code fields. Otherwise, the two fields will take the default
values, which cannot be changed.

Check Established
TCP/UDP Port

Select this option to make the rule match packets used for
establishing and maintaining TCP connections.

These items are available only when you select 6 TCP from
the Protocol drop-down box.

Source
Port

Operator

Select the operators and type the source port numbers and
destination port numbers as required.
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ltem Description

To Port These items are available only when you select 6 TCP or
17 UDP from the Protocol drop-down box.

Operator
P Different operators have different configuration

Port requirements for the port number fields:

o Not Check—The following port number fields cannot

Destination be configured.

o Range—The following port number fields must be

To Port configured to define a port range.

e Other values—The first port number field must be
configured and the second must not.

DSCP Specify the DSCP priority. (1) MPORTANT:
105 Specify the ToS If you specify the ToS

precedence. precedence or IP
precedence when you
specify the DSCP
Precedence Specify the IP precedence.  precedence, the specified
ToS or IP precedence does
not take effect.

Precedence
Filter

Select the time range during which the rule takes effect.

Time Range Available time ranges are those that have been
configured.

Return to IPv4 ACL configuration task list.

Configuring a rule for an Ethernet frame header ACL

Select QoS > ACL IPv4 from the navigation tree and then select the Link Setup tab to enter the rule
configuration page for an Ethernet frame header IPv4 ACL, as shown in a.
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a. The page for configuring a rule for an Ethernet frame header ACL

Summary

Select Access Control List{ACL)

Create Basic Setup Advanced Setup Remaove

Configure 3 Link ACL

JRule ID

Operation

Fermit

MAC Address Filter

[ source MAC Address

[JDestination MAC Address

COS(802.1p priority)| Mot Check

Type Filter

[CJL=AP Type

O rrotocal Type

Time Range | Mot Check |+

Rule ID

Operation

Selectan ACL Help

(0-65534 Ifno 1D is entered, the system will specify one. )

Source Mask
Destination Mask

Format of MAC address and Mask is "H-H-H

{0-FFFF} LEAP Mask {0-FFFF)
(0-FFFF} Frotocol Mask (0-FFFF)
Description Time Range

2 describes the configuration items for creating a rule for an Ethernet frame header IPv4 ACL.

2. Configuration items for an Ethernet frame header IPv4 ACL rule

ltem

Description

Select Access Control List (ACL)

Select the Ethernet frame header IPv4 ACL for which you want to configure
rules.

Available ACLs are Ethernet frame header IPv4 ACLs that have been
configured.

Select the Rule ID option and type a number for the rule.

Rule ID If you do not specify the rule number, the system will assign one
automatically.
Select the operation to be performed for packets matching the rule.
Operation e Permit—Allows matched packets to pass.
e Deny—Drops matched packets.
Source MAC
Address Select the Source MAC Address option and type a source MAC address and
MAC a mask.
Address Source Mask
Filter

Destination MAC
Address

Select the Destination MAC Address option and type a destination MAC
address and a mask.
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ltem Description

Destination Mask

COS(802.1p precedence) Specify the 802.1p precedence for the rule.

LSAP Type Select the LSAP Type option and specify the DSAP and SSAP fields in the LLC
encapsulation by configuring the following items:

o LSAP Type—Indicates the frame encapsulation format.

LSAP Mask o LSAP Mask—Indicates the LSAP mask.
Type Filter
Select the Protocol Type option and specify the link layer protocol type by
Protocol Type fiquri T
configuring the following items:
o Protocol Type—Indicates the frame type. It corresponds to the type-code
field of Ethernet_II and Ethernet_SNAP frames.
Protocol Mask .
e Protocol Mask—Indicates the protocol mask.
Select the time range during which the rule takes effect.
Time Range

Available time ranges are those that have been configured.

Return to IPv4 ACL configuration task ist.

Configuration guidelines

When configuring an ACL, follow these guidelines:

Table 147 When defining rules in an ACL, you do not necessarily assign them numbers; the system can do
this automatically. For more information, see ACL step.

Table 148 You cannot create a rule with, or modify a rule, to have the same permit/deny statement as an
existing rule in the ACL.

Table 149 You can only modify the existing rules of an ACL that uses the match order of config. When
modifying a rule of such an ACL, you may choose to change just some of the settings, in which case
the other settings remain the same.
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QoS configuration

Introduction to QoS

Quality of Service (QoS) reflects the ability of a network to meet customer needs. In an Internet, QoS
evaluates the ability of the network to forward packets of different services.

The evaluation can be based on different criteria because the network may provide various services.
Generally, QoS performance is measured with respect to bandwidth, delay, jitter, and packet loss ratio
during packet forwarding process.

Networks without QoS guarantee

On traditional IP networks without QoS guarantee, devices treat all packets equally and handle them using
the first in first out (FIFO) policy. All packets share the resources of the network and devices. How many
resources the packets can obtain completely depends on the time they arrive. This service is called
best-effort. It delivers packets to their destinations as possibly as it can, without any guarantee for delay,
jitter, packet loss ratio, and so on.

This service policy is only suitable for applications insensitive to bandwidth and delay, such as Word Wide
Web (WWW) and E-Mail.

QoS requirements of new applications

The Internet has been growing along with the fast development of networking technologies.

Besides traditional applications such as WWW, E-Mail and FTP, network users are experiencing new
services, such as tele-education, telemedicine, video telephone, videoconference and Video-on-Demand
(VoD). Enterprise users expect fo connect their regional branches together with VPN technologies to carry
out operational applications, for instance, to access the database of the company or to monitor remote
devices through Telnet.

These new applications have one thing in common, that is, they all have special requirements for bandwidth,
delay, and jitter. For example, videoconference and VoD require high bandwidth, low delay and jitter. As
for mission-critical applications, such as transactions and Telnet, they may not require high bandwidth but
do require low delay and preferential service during congestion.

The emerging applications demand higher service performance of IP networks. Better network services
during packets forwarding are required, such as providing dedicated bandwidth, reducing packet loss
ratio, managing and avoiding congestion, and regulating network traffic. To meet these requirements,
networks must provide more improved services.

Congestion: causes, impacts, and countermeasures

Causes

Network congestion is a major factor contributed to service quality degrading on a traditional network.
Congestion is a situation where the forwarding rate decreases due to insufficient resources, resulting in
extra delay.

Congestion easily occurs in complex packet switching circumstances in the Internet. The following figure
shows two common cases:
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a. Traffic congestion causes

100Ml
100M 10M 10M 100M
— — — —

100M > 10M T
50M

(100M + 10M + 50M) > 100M
(™ @)

o The traffic enters a device from a high speed link and is forwarded over a low speed link.
o The packet flows enter a device from several incoming interfaces and are forwarded out an outgoing
inferface, whose rate is smaller than the total rate of these incoming interfaces.

When traffic arrives at the line speed, a bottleneck is created at the outgoing interface causing congestion.

Besides bandwidth bottlenecks, congestion can be caused by resource shortage in various forms such as
insufficient processor time, buffer, and memory, and by network resource exhaustion resulting from
excessive arriving traffic in certain periods.

Impacts
Congestion may bring these negative results:
e Increased delay and jitter during packet transmission
o Decreased network throughput and resource use efficiency
e Network resource (memory in particular) exhaustion and even system breakdown
It is obvious that congestion hinders resource assignment for traffic and degrades service performance.
Congestion is unavoidable in switched networks and multi-user application environments. To improve the
service performance of your network, you must address the congestion issues.
Countermeasures

A simple solution for congestion is fo increase network bandwidth, however, it cannot solve all the problems
that cause congestion because you cannot increase network bandwidth infinitely.

A more effective solution is to provide differentiated services for different applications through traffic control
and resource allocation. In this way, resources can be used more efficiently. During resource allocation and
traffic control, the direct or indirect factors that might cause network congestion should be controlled to
reduce the probability of congestion. Once congestion occurs, resource allocation should be performed
according to the characteristics and demands of applications to minimize the effects of congestion.
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End-to-end QoS

a. End-to-end QoS model

Traffic classification

Traffic policing Traffic classification

Traffic policing

Traffic policing Traffic policing

) Congestion management Congestion management Congestion management  Congestion management
Congestion avoidance Congestion avoidance Congestion avoidance Congestion avoidance
Traffic shaping Traffic shaping Traffic shaping Traffic shaping

As shown in q, traffic classification, traffic policing, traffic shaping, congestion management, and
congestion avoidance are the foundations for a network to provide differentiated services. Mainly they
implement the following functions:

o Traffic classification uses certain match criteria to organize packets with different characteristics into
different classes. Traffic classification is usually applied in the inbound direction of a port.

e Traffic policing polices particular flows entering or leaving a device according to configured
specifications and can be applied in both inbound and outbound directions of a port. When a flow
exceeds the specification, some restrictive measures can be taken to prevent overconsumption of
network resources.

e Traffic shaping proactively adjusts the output rate of traffic to adapt traffic to the network resources of
the downstream device and avoid unnecessary packet drop and congestion. Traffic shaping is usually
applied in the outbound direction of a port.

e  Congestion management provides a resource scheduling policy to arrange the forwarding sequence
of packets when congestion occurs. Congestion management is usually applied in the outbound
direction of a port.

e  Congestion avoidance monitors the usage status of network resources and is usually applied in the
outbound direction of a port. As congestion becomes worse, it actively reduces the amount of traffic by
dropping packets.

Among these QoS technologies, traffic classification is the basis for providing differentiated services. Traffic
policing, traffic shaping, congestion management, and congestion avoidance manage network traffic and
resources in different ways to realize differentiated services.

Traffic classification

When defining match criteria for classifying traffic, you can use IP precedence bits in the type of service
(ToS) field of the IP packet header, or other header information such as IP addresses, MAC addresses, IP
protocol field and port numbers. You can define a class for packets with the same quintuple (source address,
source port number, protocol number, destination address and destination port number for example), or for
all packets to a certain network segment.

When packets are classified on the network boundary, the precedence bits in the ToS field of the IP packet
header are generally re-set. In this way, IP precedence can be directly adopted to classify the packets in the
network. IP precedence can also be used in queuing to prioritize traffic. The downstream network can either
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adopt the classification results from its upstream network or classify the packets again according fo its own
criteria.

To provide differentiated services, traffic classes must be associated with certain traffic control actions or
resource allocation actions. What traffic control actions to adopt depends on the current phase and the
resources of the network. For example, CAR is adopted to police packets when they enter the network; GTS
is performed on packets when they flow out of the node; queue scheduling is performed when congestion
happens; congestion avoidance measures are taken when the congestion deteriorates.

Packet precedences

This section introduces IP precedence, ToS precedence, differentiated services codepoint (DSCP) values,
and 802.1p precedence.

Table 150 IP precedence, ToS precedence, and DSCP values
b. DS field and ToS bytes

Bits: 0 1 2 3 4 56 7 Bits: 0 1 2 3 4 56 7
M
IPva Tos | " reced gype.“ B DS-Field DSCP cu
byte ence evice |z (for IPv4,ToS
octet,and for
ﬁl IPv6, Traffic
~ Must  Classoctet) |Class Selector Currently
RFC 1122 RFC 1349 | ge codepoints Unused
Zero
IP Type of Service (ToS) Differentiated Services
RFC 791 Codepoint (DSCP)
RFC 2474

As shown in b, the ToS field of the IP header contains eight bits: the first three bits (O to 2) represent IP
precedence from O to 7; the subsequent four bits (3 to 6) represent a ToS value from 0 to 15. According to
RFC 2474, the ToS field of the IP header is redefined as the differentiated services (DS) field, where a DSCP
value is represented by the first six bits (O to 5) and is in the range O to 63. The remaining two bits (6 and
7) are reserved.

2. Description on IP Precedence

IP Precedence (decimal) IP Precedence (binary) Description
0 000 Routine

1 001 priority

2 010 immediate

3 011 flash

4 100 flash-override
5 101 critical

6 110 internet

7 111 network

In a network in the Diff-Serve model, traffic is grouped into the following four classes, and packets are
processed according to their DSCP values.

o Expedited Forwarding (EF) class: In this class, packets are forwarded regardless of link share of other
traffic. The class is suitable for preferential services requiring low delay, low packet loss, low jitter, and

high bandwidth.
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e Assured forwarding (AF) class: This class is divided into four subclasses (AF 1 to AF 4), each
containing three drop priorities for more granular classification. The QoS level of the AF class is lower
than that of the EF class.

o Class selector (CS) class: This class is derived from the IP ToS field and includes eight subclasses;

o Best effort (BE) class: This class is a special CS class that does not provide any assurance. AF traffic
exceeding the limit is degraded to the BE class. All IP network traffic belongs to this class by default.

3. Description on DSCP values

DSCP value (decimal) DSCP value (binary) Description
46 101110 ef
10 001010 af11
12 001100 af12
14 001110 af13
18 010010 af21
20 010100 af22
22 010110 af23
26 011010 af31
28 011100 af32
30 011110 af33
34 100010 af41
36 100100 af42
38 100110 af43
8 001000 csl
16 010000 cs?
24 011000 cs3
32 100000 cs4
40 101000 csh
48 110000 csb
56 111000 cs/
0 000000 be (default)

Table 151 802.1p precedence

802.1p precedence lies in Layer 2 packet headers and is applicable to occasions where Layer 3 header
analysis is not needed and QoS must be assured at Layer 2.

b. An Ethernet frame with an 802.1Q tag header

802.1Q
inati header F
ST Source Length/Type Data ( CRgSS 2)
Address -
Address TPID | TCI
6 bytes 6 bytes 4 bytes 2 bytes 46 to 1500 bytes 4 bytes
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As shown in b, the 4-byte 802.1Q tag header consists of the tag protocol identifier (TPID, two bytes in
length), whose value is 0x8100, and the tag control information (TCl, two bytes in length). c presents the
format of the 802.1Q tag header.

c. 802.1Q tag header

Byte 1 Byte 2 Byte 3 Byte 4

TPID (Tag protocol identifier) TCI (Tag control information)

¢ CFI

1{0j0jo0jOjOfO|1]OfjO|O|O|O|O|O]|O] Priority VLAN ID

76543210765 432107654321076%543210

The priority in the 802.1Q tag header is called 802.1p precedence, because its use is defined in IEEE
802.1p. 4 presents the values for 802.1p precedence.

4. Description on 802.1p precedence

802.1p precedence (decimal)  802.1p precedence (binary) Description

0 000 best-effort

1 001 background

2 010 spare

3 011 excellent-effort

4 100 controlled-load

5 101 video

6 110 voice

7 111 network-management

Queue scheduling

In general, congestion management adopts queuing technology. The system uses a certain queuing
algorithm for traffic classification, and then uses a certain precedence algorithm to send the traffic. Each
queuing algorithm is used to handle a particular network traffic problem and has significant impacts on
bandwidth resource assignment, delay, and jitter.

In this section, two common hardware queue scheduling algorithms Strict Priority (SP) queuing and
Weighted Round Robin (WRR) queuing are introduced.

SP queuing

SP queuing is specially designed for mission-critical applications, which require preferential service to
reduce response delay when congestion occurs.
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a. Schematic diagram for SP queuing
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A typical switch provides eight queues per port. As shown in o, SP queuing classifies eight queues on a port
into eight classes, numbered 7 to O in descending priority order.

SP queuing schedules the eight queues strictly according to the descending order of priority. It sends packets
in the queue with the highest priority first. When the queue with the highest priority is empty, it sends packets
in the queue with the second highest priority, and so on. You can assign mission-critical packets to the high
priority queue to ensure that they are always served first and common service (such as Email) packets to the
low priority queues to be transmitted when the high priority queues are empty.

The disadvantage of SP queuing is that packets in the lower priority queues cannot be transmitted if there
are packets in the higher priority queues. This may cause lower priority traffic to never be transmitted.

WRR queuing

WRR queuing schedules all the queues in turn to ensure that every queue can be served for a certain time,
as shown in a.

a. Schematic diagram for WRR queuing
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A typical switch provides eight output queues per port. WRR assigns each queue a weight value
(represented by w7, wé, w5, w4, w3, w2, w1, or wO) to decide the proportion of resources assigned fo the
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queue. On a 100 Mbps port, you can set the weight values of WRR queuing to 50, 30, 10, 10, 50, 30, 10,
and 10 (corresponding to w7, w6, w5, w4, w3, w2, w1, and wO respectively). In this way, the queue with
the lowest priority is assured of at least 5 Mbps of bandwidth, avoiding the disadvantage of SP queuing that
packets in low-priority queues may fail to be served for a long time.

Another advantage of WRR queuing is that while the queues are scheduled in turn, the service time for each
queue is not fixed, that is, if a queue is empty, the next queue will be scheduled immediately. This improves
bandwidth resource use efficiency.

You can assign the output queues to WRR priority queue group 1 and WRR priority queue group 2. Round
robin queue scheduling is performed for group 1 first. If group 1 is empty, round robin queue scheduling is
performed for group 2.

NOTE:

You can implement SP+WRR queue scheduling on a port by assigning some queues on the port to the SP
scheduling group when configuring WRR. Packets in the SP scheduling group are scheduled preferentially
by SP. When the SP scheduling group is empty, the other queues are scheduled by WRR.

Line rate

Line rate is a traffic control method using token buckets. The line rate of a physical interface specifies the
maximum rate for forwarding packets (including critical packets). Line rate can limit all the packets passing
a physical interface.

Traffic evaluation and token bucket

A token bucket can be considered as a container holding a certain number of tokens. The system puts fokens
into the bucket at a set rate. When the token bucket is full, the extra tokens will cause the token bucket to
overflow.

a. Evaluate traffic with the token bucket

Tokens are put into the

Packets to be sent bucket at the set rate

through this interface

00
() ‘) Packets sent

COO000 OO0
() ‘) ngket_ h 4
D D classification oen

bucket

(} D Packets dropped
000

The evaluation for the traffic specification is based on whether the number of tokens in the bucket can meet
the need of packet forwarding. If the number of tokens in the bucket is enough to forward the packets
(generally, one token is associated with a 1-bit forwarding authority), the traffic conforms to the
specification, and the traffic is called conforming traffic; otherwise, the traffic does not conform to the
specification, and the traffic is called excess traffic.

A token bucket has the following configurable parameters:
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e Mean rate—The rate at which tokens are put into the bucket (the permitted average rate of traffic). It
is usually set to the committed information rate (CIR).

o Burst size—The capacity of the token bucket (the maximum traffic size that is permitted in each burst).
It is usually set to the committed burst size (CBS). The set burst size must be greater than the maximum
packet size.

One evaluation is performed on each arriving packet. In each evaluation, if the number of tokens in the
bucket is enough, the traffic conforms to the specification and the corresponding tokens for forwarding the
packet are taken away; if the number of tokens in the bucket is not enough, it means that too many tokens
have been used and the traffic is excessive.

How line rate works

With line rate configured on an interface, all packets to be sent out the interface are firstly handled by the
token bucket of line rate. If enough tokens are available in the token bucket, packets can be forwarded;
otherwise, packets are put into QoS queues for congestion management. In this way, the traffic passing the
physical inferface is controlled.

a. Line rate implementation

Put tokens into the token
bucket at the set rate

()() Ijjﬂ Packets sent
(0] ¢ b

OO0 @@ 000
(:) D Token

(0]

Queuing bucket

(] ¢ ¢ \E/
~—
Buffer queue

With a token bucket used for traffic control, when tokens are available in the token bucket, the bursty
packets can be transmitted; if no tokens are available, packets cannot be transmitted until new tokens are
generated in the token bucket. In this way, the traffic rate is restricted to the rate for generating tokens,
limiting traffic rate and allowing bursty traffic.

Priority mapping
What is priority mapping
When a packet enters a network, it is marked with a certain priority to indicate its scheduling weight or

forwarding priority. Then, the intermediate nodes in the network process the packet according to the
priority.

When a packet enters a device, the device assigns to the packet a set of predefined parameters (including
the 802.1p precedence, DSCP values, IP precedence, and local precedence).

e  For more information about 802.1p precedence, DSCP values, and IP precedence, see Packet
precedences.

e Llocal precedence is a locally significant precedence that the device assigns to a packet. A local
precedence value corresponds to an output queue. Packets with the highest local precedence are
processed preferentially.
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The device provides the following priority trust modes on a port:

Trust packet priority—The device assigns to the packet the priority parameters corresponding to the
packet’s priority from the mapping table.

Trust port priority—The device assigns a priority to a packet by mapping the priority of the receiving
port.

You can select one priority trust mode as needed. a shows the process of priority mapping on a device.

a.

T

Priority mapping process

! Assign to a packet the
! priority parameters
]
|

corresponding to the
packet priority from the
mapping table

Trust packet
priority

Assign local precedence to
packets by mapping the
priority of the receiving port

Packets

]
|
Receiving i
interface ]

Introduction to priority mapping tables

The device provides various types of priority mapping table, as listed below:

CoS to DSCP: 802.1p-to-DSCP priority mapping table.
CoS to Queue: 802.1p-to-local priority mapping table.
DSCP to CoS: DSCP-+0-802.1p priority mapping table, which is applicable to only IP packets.
DSCP to DSCP: DSCP-to-DSCP priority mapping table, which is applicable to only IP packets.
DSCP to Queue: DSCP-to-local priority mapping table, which is applicable to only IP packets.

through 2 list the default priority mapping tables.

The default CoS to DSCP/CoS to Queue mapping table

Input CoS value Local precedence (Queue) DSCP
0 2 0

1 0 8

2 1 16

3 3 24

4 4 32

5 5 40

6 6 48

7 7 56
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2. The default DSCP to CoS/DSCP to Queue mapping table

Input DSCP value Local precedence (Queue) CoS
Oto7 0 0
810 15 1 1
16 to 23 2 2
24 t0 31 3 3
3210 39 4 4
40 to 47 5 5
48 to 55 6 6
56 t0 63 7 7
NOTE:

In the default DSCP to DSCP mapping table, an input value yields a target value equal to it.

QoS configuration

Contiguration task lists
Configuring a QoS policy

A QoS policy defines the shaping, policing, or other QoS actions to take on different classes of traffic. It is
a set of class-behavior associations.

A class is a set of match criteria for identifying traffic, and it uses the AND or OR operator:
o If the operator is AND, a packet must match all the criteria to match the class.
e If the operator is OR, a packet matches the class if it matches any of the criteria in the class.

A traffic behavior defines a set of QoS actions to take on packets, such as priority marking and redirect.

By associating a traffic behavior with a class in a QoS policy, you apply the specific set of QoS actions to
the class of traffic. You can apply a QoS policy to a port to regulate the incoming traffic of the port. A QoS
policy can be applied to multiple ports. Only one policy can be applied in inbound direction of a port.

Perform the tasks in 1 to configure a QoS policy:

1. QoS policy configuration task list

Task Remarks
Required
. Creating a class Create a class and specify the operator for
Configure a the match criteria in the class.

class
Required
Configuring match criteria

Configure match criteria for the class.
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Task Remarks
Required
Creating a traffic behavior
Create a traffic behavior.
Configuring traffic
Configure a mirroring and traffic
traffic o . redirecting for a Use either approach
behavior Configuring actions  t,4ffic behavior . . . '
for a behavior Configure various actions for the traffic
Contfiguring other behavior.
actions for a traffic
behavior
) _ Required
Creating a policy
Create a policy.
Required
. Associate the traffic behavior with the class
Configure a . .
i in the QoS policy.
policy - o . -
Conflgurln'g classifier-behavior associations A (Jass can be associated with only one
for the policy traffic behavior in a QoS policy. Associating
a class that is already associated with a
traffic behavior will overwrite the old
association.
Required
ApP|y the Applying a policy to a port a
policy Apply the QoS policy to a port.

Configuring queue scheduling

Perform the task in 1 to configure queue scheduling.

1. Queue scheduling configuration task list

Task

Remarks

Optional

Configuring queue scheduling on a port

Configure the queue scheduling mode for a port.

Configuring line rate

Perform the task in 1 to configure line rate.

1. Line rate configuration task list

Task

Remarks

Contiguring line rate on a port

Required

Limit the rate of incoming packets or outgoing packets

of a physical port.

Configuring the priority mapping tables

Perform the task in 1 to configure the priority mapping tables:
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1. Priority mapping table configuration task list

Task Remarks

Required
Contfiguring priority mapping tables
Set priority mapping tables.

Configuring priority trust mode
Perform the task in 1 to configure priority trust mode:

1. Priority trust mode configuration task list

Task Remarks

Required
Contfiguring priority trust mode on a port o
Set the priority trust mode of a port.

Creating a class

Select QoS > Classifier from the navigation tree and click Create to enter the page for creating a class, as
shown in a.

a. The page for creating a class

Summary Setup Remove
Classifier Mame (1-31 Chars.)
Operator And w
Create
Classifier Mame Operator Rule Count
class And 0

2 shows the configuration items of creating a class.

2. Configuration items of creating a class

ltem Description

Classifier Name Specify a name for the classifier to be created.

Specify the operator for the match criteria of the classifier.
Operator e and—A packet must match all the criteria to match the class.

e or—A packet matches the class if it matches any of the criteria in the class.
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Return to QoS policy configuration task list.

Contiguring match criteria

Select QoS > Classifier from the navigation tree and click Setup to enter the page for setting a class, as
shown in a.

a. The page for configuring match criteria

Summary Create Remaove

Please select a clagsifier |Se|ect a classifier V|

[ &ny

[losce | ‘[EI—EE.}'DLI can input 8 entries, for example, 3, 5-7)

C1IF Precedence | ‘[U—?.'T'DLI can input 8 entries, for example, 3, 5-7)
Classifier | | (1-31 Chars.)

Inbound Interface

RTF Port fr|:|m| |tu| |[2IZIIZIEI—55535}
Dat1p
Service 802.1p | | [ Customer 802.1p | |
{0-7, you can input 8 entries, for example, 3, 5-7)
MAC
Osourcemac | | [ Destination MAC | |
(Format of MAC is "H-H-H™)
WLAMN
1-4094, input a range such as 3-20 or up to 8 entries
[senice vLAN | gty g P
like 3, 5-7)
1-4094, input a range such as 3-20 orup to 8 entries
[ Customer VLAN | g " g g
like 3, 5-7}
ACL
[ ACL IPva | || (2000-4999)
Fule Type Rule Value

2 shows the configuration items of configuring match criteria.

2. Configuration items of configuring match criteria

ltem Description

Please select a classifier Select an existing classifier in the drop-down list.

A Define a match criterion to match all packets.
ny

Select the option to match all packets.
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ltem Description
Define a match criterion to match DSCP values.
If multiple such match criteria are configured for a class, the new configuration
does not overwrite the previous one.

DSCP

You can configure up to eight DSCP values each time. If multiple identical DSCP
values are specified, the system considers them as one. The relationship
between different DSCP values is OR. After such configurations, all the DSCP
values are automatically arranged in ascending order.

IP Precedence

Define a match criterion to match IP precedence values.

If multiple such match criteria are configured for a class, the new configuration
does not overwrite the previous one.

You can configure up to eight IP precedence values each time. If multiple
identical IP precedence values are specified, the system considers them as one.
The relationship between different IP precedence values is OR. After such
configurations, all the IP precedence values are automatically arranged in
ascending order.

Customer 802.1p

Define a match criterion to match the customer 802.1p precedence values.

If multiple such match criteria are configured for a class, the new configuration
does not overwrite the previous one.

You can configure up to eight 802.1p precedence values each time. If multiple
identical 802.1p precedence values are specified, the system considers them
as one. The relationship between different 802.1p precedence values is OR.
Atter such configurations, all the 802.1p precedence values are automatically
arranged in ascending order.

MAC

Source MAC

Define a match criterion to match a source MAC address.

If multiple such match criteria are configured for a class, the new configuration
does not overwrite the previous one.

A source MAC address match criterion is significant only to Ethernet interfaces.

Destination MAC

Define a match criterion to match a destination MAC address.

If multiple such match criteria are configured for a class, the new configuration
does not overwrite the previous one.

A destination MAC address match criterion is significant only to Ethernet
interfaces.

VLIAN

Service VLAN

Define a match criterion to match service VLAN [Ds.

If multiple such match criteria are configured for a class, the new configuration
does not overwrite the previous one.

You can configure multiple VLAN IDs each time. If the same VLAN ID is
specified multiple times, the system considers them as one. The relationship
between different VLAN IDs is logical OR. After such a configuration. You can
specify VLAN IDs in two ways:

e Enfer arange of VLAN IDs, such as 10-500. The number of VLAN IDs in the
range is not limited.

e Specify a combination of individual VLAN IDs and VLAN ID ranges, such as
3, 5-7, 10. You can specify up to eight VLAN IDs in this way.
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ltem Description

Define a match criterion to match customer VLAN IDs.

If multiple such match criteria are configured for a class, the new configuration

does not overwrite the previous one.

You can configure multiple VLAN IDs each time. If the same VLAN ID is

specified multiple times, the system considers them as one. The relationship

Customer VIAN  between different VLAN IDs is logical OR. You can specify VLAN IDs in two

ways:

o Enfer a range of VLAN IDs, such as 10-500. The number of VLAN IDs in the
range is not limited.

e Specify a combination of individual VLAN IDs and VLAN ID ranges, such as
3, 5-7, 10. You can specify up to eight VLAN IDs in this way.

Define an IPv4 ACL-based match criterion.
ACL IPv4
The ACLs available for selection are existing IPv4 ACLs.

Return to QoS policy configuration task list.

Creating a traftic behavior

Select QoS > Behavior from the navigation tree and click the Create tab to enter the page for creating a
traffic behavior, as shown in a.

a. The page for creating a traffic behavior

summary Setup Fort Setup Remuove
Behavior Name (1-31 Chars )
Create

2 describes the configuration items of creating a behavior.

2. Configuration items of creating a behavior

ltem Description

Behavior name Specify a name for the behavior to be created.

Return to QoS policy configuration task ist.
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Configuring traffic mirroring and traffic redirecting for a tratfic
behavior

Select QoS > Behavior from the navigation tree and click Port Setup to enter the port setup page for a traffic
behavior, as shown in a.

a. Port setup page for a traffic behavior

Summary Create Setup Remave
Please select a behavior | Select a hehavior -
Wirror To O redirect

Flease selecta port

EEEE DRER HP V1910-166 Sw.
TGN NN 1 I N I I (A R R Y

Behavior Detail

2 describes the traffic mirroring and traffic redirecting configuration items.

2. Traffic mirroring and traffic redirecting configuration items

ltem Description
Please select a behavior Select an existing behavior in the drop-down list.
Redirect Set the action of redirecting traffic to the specified destination port.

Specify the port fo be configured as the destination port of traffic mirroring or

PI lect t e .
ease selecta por traffic directing on the chassis front panel.

Return to QoS policy configuration task list.
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Configuring other actions for a traffic behavior

Select QoS > Behavior from the navigation tree and click Setup to enter the page for setting a traffic
behavior, as shown in a.

a. The page for setting a traffic behavior

summary Create Port Setup Remaove
Please select a behavior | Select a behavior v
CAR
Enahble Disahle
CIR | | kbps(0-4294967294)
CBS | |nyte(u-429495?294}
Red Digcard Pass
Remark
IP Precedence Dot1p
Local Precedence DsCP
Queus
EF Max Bandwidth | |I(bps(8-‘1UUDDDU}
CBS | |by1e(32-2uuuuum
Percent | %(1-100)
CBS-Ratio | |%(25—SUD}-
AF WMax Bandwidth | |kbps(8—1UUDDDU}
Percent | %(1-100)
WFQ | |[1 G6-4096)
Orilter Accounting

Behavior Detail

2 describes the configuration items of configuring other actions for a traffic behavior.

2. Configuration items of configuring other actions for a traffic behavior

ltem Description

Please select a behavior Select an existing behavior in the drop-down list.

Configure the packet filtering action.

After selecting the Filter option, select one item in the following drop-down
list:
Filt
et o Permit—Forwards the packet.
o Deny—Drops the packet.

o Not Set—Cancels the packet filtering action.

Return to QoS policy configuration task list.
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Creating a policy

Select QoS > QoS Policy from the navigation tree and click Create to enter the page for creating a policy,
as shown in a.

a. The page for creating a policy

Summary Setup Remaove

Palicy Mame (1-31 Chars.)

gos

2 describes the configuration items of creating a policy.

2. Configuration items of creating a policy

ltem Description

Policy Name Specify a name for the policy to be created.

Return to QoS policy configuration task list.

Contiguring classitier-behavior associations for the policy

Select QoS = QoS Policy from the navigation tree and click Setup to enter the page for setting a policy, as
shown in a.
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a. The page for setting a policy
Summary Create Remove

Please select a policy | Select a policy

Classifier Mame "9-:[1-31 Chars.)

Behavior Mame "9-:[1-31 Chars.)

Classifier Behavior

2 describes the configuration items of configuring classifier-behavior associations for the policy.

2. Configuration items of configuring classifier-behavior associations for the policy

ltem Description

Please select a policy Select a created policy in the drop-down list.

Select an existing classifier in the drop-down list.

Classifier Name The classifiers available for selection are created on the page for creating a
classifier.

Select an existing behavior in the drop-down list.

Behavior Name The behaviors available for selection are created on the page for creating a
behavior.

Return to QoS policy configuration task list.

Applying a policy to a port

Select QoS - Port Policy from the navigation tree and click Setup to enter the page for applying a policy
to a port, as shown in a.
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a. The page for applying a policy to a port
Summary Remave

Please selecta policy | Select a policy =
Direction Inbound -

Flease select port(s)

HP V1910-16G Sw.

Select All Select None

2 describes the configuration items of applying a policy to a port.

2. Configuration items of applying a policy to a port

ltem Description

Please select a policy Select a created policy in the drop-down list.

Direct Set the direction in which the policy is to be applied.
irection
Inbound—Applies the policy to the incoming packets of the specified ports.

Click to select ports to which the QoS policy is to be applied on the chassis front

Please select port(s
port(s) panel.

Return to QoS policy configuration task list.

Configuring queue scheduling on a port

Select QoS > Queue from the navigation tree and click Setup to enter the queue scheduling configuration
page, as shown in a.

a. The page for configuring queue scheduling

summary

& WRR Setup
WRR Enable h
CQlgle MNo Change ~ Group YWeight

Flease select port(s)

HP V1910-16G Sw...

KK G 1 A ) A X

Select All Select Mane

Cancel
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2 describes the configuration items of configuring queue scheduling on a port.

2. Configuration items of configuring queue scheduling on a port

ltem Description

Enable or disable the WRR queue scheduling mechanism on selected ports. Two

options are available:

WRR e Enable—Enables WRR on selected ports.

o Not Set—Restores the default queuing algorithm on selected ports.

Select the queue to be configured.

Queve lts value range is O to 7, but only O to 3 is user configurable and 4 to 7 are
reserved.

WRR

Setup Specify the group the current queue is to be assigned to.

This drop-down list is available after you select a queue ID. The following groups
are available for selection:
Group e SP—Assigns a queue to the SP group.
e 1—Assigns a queue to WRR group 1.

e 2—Assigns a queue to WRR group 2.

) Set a weight for the current queue.
Weight
This option is available when group 1 or group 2 is selected.

Please select port(s) Click to select ports to be configured with queuing on the chassis front panel.

Return to Queue scheduling configuration task list.

Configuring line rate on a port

Select QoS - Line rate from the navigation tree and click the Setup tab to enter the line rate configuration
page, as shown in a.
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a. The page for configuring line rate on a port

Summary

Please select aninterface type | GigabitEthemet{L2) |+

Rate Limit | Enable v Direction | Inkound w
CIR khps (64-1000000, it must be a multiple of 64}

CBS

EBS

Please select port(s)

GigabitEthernet1/0/1 -
GigahitEthernet1/0/2
GigabitEthernet1/0/3
GigabitEthernet1/0/4
GigabitEthernet1/0/5
GigahitEthernet1/0/6
GigabitEthernet 11007
GigabitEthernet1/0/8
GigabitEthernet1/0/9
GigahitEthernet1/0/10 hd

Select All

2 describes the configuration items of configuring line rate on a port.

2. Configuration items of configuring line rate on a port

ltem Description
Select the types of interfaces to be configured with line rate.
Please select an interface type The interface types available for selection depend on your device
model.
Rate Limit Enable or disable line rate on the specified port.

Select a direction in which the line rate is to be applied.
¢ Inbound—Limits the rate of packets received on the specified port.
Direction o Outbound—Limits the rate of packets sent by the specified port.

o Both—Limits the rate of packets received on and sent by the
specified port.

CIR Set the committed information rate (CIR), the average traffic rate.

Specify the ports to be configured with line rate

Please select port(s) Click the ports to be configured with line rate in the port list. You can
select one or more ports.

Return fo Line rate configuration task list.

Configuring priority mapping tables

Select QoS - Priority Mapping from the navigation tree to enter the page shown in a.
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a. The page for configuring priority mapping tables

Wapping Type CoS to DSCP v

Input Value Output Value Inputvalue Output Value Input Value Output Value Input Yalue Output Value
0 1 2 B v 3 1 v
4 32 v 8 40 v i 48 v 7 56 v
Restore Apply Cancel

2 describes the configuration items of configuring priority mapping tables.

2. Configuration items of configuring priority mapping tables

ltem Description

Select the priority mapping table to be configured, which can be CoS
to DSCP, CoS to Queue, DSCP to CoS, DSCP to DSCP, or DSCP to
Queue. For example, select DSCP to DSCP mapping type to enter the
page shown in 2.

Mapping Type

Input Priority Value

Set the output priority value for an input priority value.
Output Priority Value

Click Restore to display the default settings of the current priority
Restore mapping table on the page.

To restore the priority mapping table to the default, click Apply.

a. The page for configuring DSCP to DSCP mapping table

Mapping Type DSCP to DSCP hd

Input value Qutput value Input value Cutput value Input Yalue Output Walue Input Value Cutput value
1 v 5 6 7

12 v 13 14 15

18 17 18 19

36 a7 7|~ a8 B\ v 29 /v
44 15 FER 48 4 v a7 7 v
52 53 55w 54 54 v 55 8 v
80 B0 v 1 B v 62 62 v 53 63 v

A
@
&,
S
T

Apply Cancel

Return to Priority mapping table configuration task list.

Contiguring priority trust mode on a port

Select QoS > Port Priority from the navigation tree to enter the page shown in a. Click the % icon
corresponding fo a port fo enter the page shown in b.
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a. The page for configuring port priority

P Search ltem: | Interface Mame LJ KE:;‘-;'.,‘grdS:i Search
Interface Mame Priority Trust Mode Qperation
GigahitEthernet1/0/1 0 LIntrust @
GigakitEthernet1/0/2 0 Lntrust
GigabitEthernet1/0/3 ] LIntrust
GigahitEthernet1/0/4 0 LIntrust @
GigakitEthernet1/0/5 0 LIntrust @
GigakitEthernet 11016 0 LIntrust
GigakitEthernet /07 0 LIntrust
GigabitEthernet1/0/8 0 Intrust @
GigakitEthernet1/0/9 0 LIntrust @
GigakitEthernet /010 0 LIntrust
GigahitEthernet1/0/11 0 LIntrust
GigahitEthernet1/0/12 0 LIntrust @
GigabitEthernet1/0/13 ] LIntrust @
GigakitEthernet1/0/14 0 LIntrust
GigahitEthernet1/0M15 0 LIntrust
20 records,| 19 ™| perpage | page /2, record 1-15 | Mext Last 1 '
b. The page for modifying port priority
Interface : _ i
Mame e |
Priarity |0 v |
Trust Mode Lintrust _v-i
Restore Apply Cancel
2 describes the port priority configuration items.
2. Port priority configuration items
ltem Description
Interface The interface fo be configured.
Priority Set a local precedence value for the port.
Select a priority trust mode for the port:
o Untrust—Not trusts the packet priority.
Trust Mode o CoS—Trusts the 802.1p precedence of the incoming packets and uses it for priority

mapping.

e DSCP—Trusts the DSCP precedence of the incoming packets and uses it for priority

mapping.
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Return toPriority trust mode configuration task list.

Contiguration guidelines

When an ACL is referenced to implement QoS, the actions defined in the ACL rules, deny or permit, do not
take effect; actions to be taken on packets matching the ACL depend on the traffic behavior definition in
QoS.
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ACL/QoS configuration examples

ACL/QoS contiguration example

Network requirements

As shown in b, in the network, the FTP server at IP address 10.1.1.1/24 is connected to the Switch, and the
clients access the FTP server through GigabitEthernet 1/0/1 of the Switch.

Configure an ACL and a QoS policy as follows to prevent the hosts from accessing the FTP server from 8:00
to 18:00 every day:

Table 152 Create an ACL to prohibit the hosts from accessing the FTP server from 8:00 to 18:00 every day.
Table 153 Configure a QoS policy to drop the packets matching the ACL.

Table 154 Apply the QoS policy in the inbound direction of GigabitEthernet 1/0/1.

b. Network diagram for ACL/QoS configuration

' 10.1.1.1/24

GE1/0/1 g;

Switch FTP server

Configuration procedure
Table 155 Configure the time range

# Define a time range covering the time range from 8:00 to 18:00 every day.

e Select QoS > Time Range from the navigation tree and click Create.
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b. Define a time range covering 8:00 to 18:00 every day

Summary Remaove

Time Range Mame |teat-time |[‘I—32 Chars.}
Periodic Time Range

statTime[8_v| [0 v] End Time 18 v|:[0_[v]
2un Maon Tue Wed Thu Fri Sat
[ Absalute Time Range

Fram : I I

To : ! !

Apply

Summary

e Type the time range name test-time.

e Select the Periodic Time Range option, set the Start Time to 8:00 and the End Time to 18:00, and then
select the checkboxes Sun through Sat.

e Click Apply.

Table 156 Define an IPv4 ACL for traffic to the FTP server.

# Create an advanced IPv4 ACL.

o Select QoS > ACL IPv4 from the navigation tree and click Create.
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c. Create an advanced IPv4 ACL

Summary

Basic Setup Advanced

ACL Mumber

13000

Match Order

ACL Mumber

Setup Link Setup Remove

2000-2999 for Basic ACL.
3000-3998 for Advanced ACL.

4000-4998 for Ethernet frame header ACL.

Type Mumber of Rules Match Order

o Type the ACL number 3000.
o Click Apply.
# Define an ACL rule for traffic to the FTP server.
e Click Advanced Setup.
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d. Define an ACL rule for traffic to the FTP server

Summary Create Basic Setup Link Setup Remave

Select Access Control List(ACL) | 2000 v Help

Configure an Advanced ACL

Rule ID |2 |[E|-55534. Ifno D is entered, the system will specify one.)
Operation
[Jcheck Fragment CJcheck Logging

IP Address Filter

[ source IP Address | | Source Wildcard | |
[ Destination IP Address | 10.1.1.1 | Destination Wildcard [0.0.0.0 |
Protacal | IP W
ICMP Type
Mamed ICMP Type
ICMP Type (0-255) ICMP Code (0-255)
TCPIUDF Port
Check
Estahlished
. To
Source: Cperator F'Drt| Fart |
o To
Destination: Operator F'nrt| Port |

(Range of Portis 0-62535)

Frecedence Filter

DSCP | Not Check v |

TOS |NotCheu:I-t b Precedence | Mot Check v|

Add

Rule ID Operation Description Time Range

e Select ACL 3000 in the drop-down list.
e Select the Rule ID option, and type rule ID 2.
o Select Permit in the Operation drop-down list.

e  Select the Destination IP Address option, and type IP address 10.1.1.1 and destination wildcard mask
0.0.0.0.

o Select test-time in the Time Range drop-down list.
e  Click Add.
Table 157 Configure a QoS policy
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# Create a class.

o Select QoS > Classifier from the navigation tree and click Create.

e. Create a class

sSummary Setup Remove
Classifier Mame ||:Iass1 |
Cperator |f-‘md 4 |
Create

Classifier Name

o Type the class name class1.
e  Click Create.

# Define match criteria.

o Click Setup.
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f.  Define match criteria

Summary Create Remuaove
Flease select a classifier | class i |
[ any
Closcr | |[EI—53. you can input 8 entries, for example, 3, 5-7)
C]IP Precedence | |[EI—?. you can input 8 entries, for example, 3, 5-7)
Classifier | | (131 Chars.)

Inbound Interface

RTF Port frnm| ‘tn| |[2EIEIEI—55535}
Dot1p
Senvice 802.1p ‘ | []Customer 802.1p | |
{0-7, yvou can input 8 entries, for example, 3, 5-7)
MAC
Clsource MAC | | O Destination MAC | |
(Format of MAC is "H-H-H™)
WLAM
1-4094, input a range such as 3-20 or up to 8 entries
[senice VLAN | s g g
like 3, B-7)
1-4084, input a range such as 3-20 orup to 8 entries
[ Customer VLAN ‘ g . -.p g g
like 3, 5-7)
ACL
[FlACL IPv4 13000 [] [c2000-4999)
Apply
Rule Type Rule Value

o Select the class name class1 in the drop-down list.
o Select the ACL IPv4 option, and select ACL 3000 in the following drop-down list.
o Click Apply. A configuration progress dialog box appears, as shown in g.
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g. Configuration progress dialog box

Current Configuration
Setting ACL IPvd - OK!

100%

Close

o After the configuration is complete, click Close on the dialog box.

# Create a traffic behavior.

o Select QoS > Behavior from the navigation tree and click Create.

h. Create a traffic behavior

Summary Setup Port Setup Femove
Behavior Mame |hehavinr1 (1-31 Chars.}
Create

e Type the behavior name behavior1.
e  Click Create.

# Configure actions for the traffic behavior.
o Click Setup.
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i.  Configure actions for the behavior

Summary Create Part Setup Remaove
Flease select a hehaviaor | hehavior w |
— [ CAR
Enahle Dizahle
CIR | | kbps(0-4294967294)
CBS | |m-'te(D—4294-95?294-}
Red Discard Pass
— Remark
IP Precedence : Dot1p
Local Precedence | [ DECP
— Clueue
EF [Max Bandwidth | |khps(8—'1EIDEIEIEID}
CBS= | |h}-'te(32—2EIEIDEIEIEI}
Percent | 9(1-100)
CB3-Ratio | |%[25—5EIEI}
AF [Max Bandwidth | |khps[8—'1EIDEIEIEID}
Percent | %(1-100)
WEC | |(1 A-408a)
Filter Accounting E
Apply

Behavior Detail

User Defined Behavior Infarmation:
Behavior: hehaviorl
-none-

e Select behavior1 in the drop-down list.

o Select the Filter option, and then select Deny in the following drop-down list.
e Click Apply. A configuration progress dialog box appears.

o After the configuration is complete, click Close on the dialog box.

# Create a policy.

e Select QoS > QoS Policy from the navigation tree and click the Create tab.
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i Create a policy

summary Setup Femove
Palicy Name|F'D|iCEr'1 (1-31 Chars.)
Create

o Type the policy name policy1.
o Click Create.

# Configure classifier-behavior associations for the policy.
o Click Setup.

k. Configure classifier-behavior associations for the policy

Summary Create Remove
Flease selecta policy | policy1 N
Classifier Mame |class1 |Vi[1-31 Chars.)
Behavior Name |hehaviur1 |Vi[1-31 Chars.)
Apply
Classifier Behavior

e Select policyl.

o Select class1 in the Classifier Name drop-down list.

e  Select behavior1 in the Behavior Name drop-down list.

o Click Apply.

# Apply the QoS policy in the inbound direction of GigabitEthernet 1/0/1.

e Select QoS > Port Policy from the navigation tree and click the Setup tab.
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I.  Apply the QoS policy in the inbound direction of GigabitEthernet 1/0/1

Summary Remove

Please selecta policy |policyl -
Direction Inbound -

Flease select port(s)

ﬂ - ﬂ ﬁ HF ¥1910-16G Sw.
[olefufej[@]e]w]a]

Select All Select None

4

Apply

o Select policy1 in the Please select a policy drop-down list.

e Select Inbound in the Direction drop-down list.

e Select port GigabitEthernet 1/0/1.

o Click Apply. A configuration progress dialog box appears.

o After the configuration is complete, click Close on the dialog box.
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PoE configuration

NOTE:

Only HP V1910-24G-PoE (365W) Switch JEOO7A and HP V1910-24G-PoE (170W) Switch JEOO8A
support the PoE function.

PoE overview

Power over Ethernet (PoE) means that power sourcing equipment (PSE) supplies power to powered devices
(PDs) from Ethernet interfaces through twisted pair cables.

Advantages

o Reliable—Power is supplied in a centralized way so that it is very convenient to provide a backup
power supply.
e Easy to connect—A network terminal requires no external power supply but only an Ethernet cable.

e Standard—In compliance with IEEE 802.3af, and a globally uniform power interface is adopted.

e Promising—It can be applied to IP telephones, wireless LAN access points (APs), portable chargers,
card readers, web cameras, and data collectors.

Composition
As shown in o, a PoE system consists of PoE power, PSE, power interface (Pl), and PD.

a. PoE system diagram

PoE power PD

PoE power
The whole PoE system is powered by the PoE power.
PSE

A PSE is a device supplying power for PDs. A PSE can be built-in (Endpoint) or external (Midspan). A built-in
PSE is integrated in a switch or router, and an external PSE is independent from a switch or router.

The HP PSEs are built in, and can be classified into two types:

e Device with a single PSE—Only one PSE is available on the device; so the whole device is considered
as a PSE.
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Pl

PD

e Device with multiple PSEs—For a device with multiple PSEs, an interface card with the PoE power
supply capability is a PSE. The system uses PSE IDs to identify different PSEs.

NOTE:

HP V1910-24G-PoE (365W) Switch JEOO7A and HP V1910-24G-PoE (170W) Switch JEOO8A are
devices with a single PSE, so this document describes the device with a single PSE only.

A PSE can examine the Ethernet cables connected to PoE interfaces, search for PDs, classify them, and
supply power to them. When detecting that a PD is unplugged, the PSE stops supplying power to the PD.

An Ethernet interface with the PoE capability is called PoE interface. A PoE interface can be an FE or GE
interface.

The PSE supplies power for a PoE interface in the following two modes:

e Over signal wires—The PSE uses the pairs (1, 2, 3, 6) for transmitting data in a category 3/5 twisted
pair cable to supply DC power while transmitting data to PDs.

e Over spare wires—The PSE uses the pairs (4, 5, 7, 8) not transmitting data in a category 3/5 twisted
pair cable to supply DC power to PDs.

NOTE:

HP V1910-24G-PoE (365W) Switch JEOO7A and HP V1910-24G-PoE (170W) Switch JEOO8A only
support the signal mode.

A PD is a device accepting power from the PSE, including IP phones, wireless APs, chargers of portable
devices, POS, and web cameras.

The PD that is being powered by the PSE can be connected to another power supply unit for redundancy
power backup.

Protocol specification

The protocol specification related to PoE is I[EEE 802.3af.

Configuring PoE

/\ CAUTION:

Before configuring PoE, make sure that the PoE power supply and PSE are operating properly; otherwise,
you cannot configure PoE or the configured PoE function does not take effect.

Configuring PoE ports

Select PoE > PoE from the navigation tree and click the Port Setup tab, as shown in a.
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a. port setup page

Summary PSE Setup

Select Port:

Select Al Select Mane Mote: The "Select Al and the "Select None" are only applied to current unit.

O e B, B e 0
- Selected Supplied Power Enabled Disablad Mot Supported Powver Fault
Powier State:

O Power max | | ¢1000-30000 milliwatts, step = 100)

Power Prarity:

Selected Ports:

Cancel

2.  PoE port configuration items

ltem Description

Click to select ports to be configured and they will be displayed in the

lect Port
Select Por Selected Ports list box.

Enable or disable PoE on the selected ports.

e The system does not supply power to or reserve power for the PD
connected to a PoE port if the PoE port is not enabled with the PoE
function.

¢ You are allowed to enable PoE for a PoE port if the PoE port will not

result in PoE power overload; otherwise, you are not allowed to enable
Power State PoE for the PoE port.

By default, PoE is disabled on a PoE port.
@ IMPORTANT:

PSE power overload—When the sum of the power consumption of all ports
exceeds the maximum power of PSE, the system considers the PSE is
overloaded.

Set the maximum power for the PoE port.

The maximum PoE port power is the maximum power that the PoE port can
Power Max provide to the connected PD. If the power required by the PD is larger than
the maximum PoE port power, the PoE port will not supply power to the PD.

By default, the maximum power of a PoE port is 30000 milliwatts.
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ltem Description

Set the power supply priority for a PoE port. The priority levels of a PoE port
include low, high, and critical in ascending order.

o When the PoE power is insufficient, power is first supplied to PoE ports
with a higher priority level.

e When the PSE power is overloaded, the PoE port with a lower priority
is first disconnected to guarantee the power supply to the PD with a
higher priority.

e If you set the priority of a PoE port to critical, the system compares the
guaranteed remaining PSE power (the maximum PSE power minus the
maximum power allocated to the existing critical PoE port, regardless
of whether PoE is enabled for the PoE port) with the maximum power of
this PoE port. If the former is greater than the latter, you can succeed in
setting the priority to critical, and this PoE port will preempt the power
of other PoE ports with a lower priority level; otherwise, you will fail to
set the PoE port fo critical. In the former case, the PoE ports whose

Power Priority power is preempted will be powered off, but their configurations will
remain unchanged. When you change the priority of a PoE port from
critical fo a lower level, the PDs connecting to other PoE ports will have
an opportunity of being powered.

By default, the power priority of a PoE port is low.
@ IMPORTANT:

e 19 watts guard band is reserved for each PoE port on the device to
prevent a PD from being powered off because of a sudden increase of
the PD power. When the remaining power of the PSE is lower than 19
watts, the port with a higher priority can preempt the power of the port
with a lower priority to ensure the normal working of the higher priority
port.

o If the sudden increase of the PD power results in PSE power overload,

power supply to the PD on the PoE interface with a lower priority is
stopped to ensure the power supply to the PD with a higher priority.

Contiguring non-standard PD detection

PDs include standard PDs and nonstandard PDs. Standard PDs are those conforming to the IEEE 802.3af
standard. Usually, the PSE can detect only standard PDs and supply power to them. The PSE can detect
nonstandard PDs and supply power to them only after the PSE is enabled to detect nonstandard PDs.

Select PoE > PoE from the navigation tree and click the PSE Setup tab to enter the page shown in a. The
page displays the location of all PSEs, and the status of the non-standard PD detection function.

a. PSE setup
Summary Fort Setup
FSEID Location Mon-Standard PD Compatibility
1 subslot0 Digable

Anply Enable All Disahle All

e To enable the non-standard PD detection function of a PSE, find the PSE ID, select Enable in the
corresponding Non-Standard PD Compatibility column, and then click Apply.

e To disable the non-standard PD detection function of a PSE, find the PSE ID, select Disable in the
corresponding Non-Standard PD Compatibility column, and then click Apply.

e  To enable the non-standard PD detection for all PSEs, click Enable All.
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e To disable the non-standard PD detection for all PSEs, click Disable All.

Displaying information about PSE and PoE ports

Select PoE -> PoE from the navigation tree to enter the page of the Summary tab. The upper part of the page
displays the PSE summary. Click a port on the chassis front panel, and the configuration and power
information are displayed in the lower part of the page, as shown in a.

a. PoE summary (with GigabitEthernet 1/0/1 selected)

FSE Setup Fort Setup
PSE Summary:
Average Power Pealk Power  Available Fower
PSEID Location State  Max Power (W) (W) W) (W)
1 subslot 0 off 370 0 0 370

Forts Power Display:

P awier P awer Power
DSuppIied Enabled Disabled B ot supportea ([l Power Faut
Part Power State:
Average Power Peak Power Free Power
Port  State  Priorty  Max Power{mA) (midy) () ()
GE1/0/1 enable Low 30000 0 0 30000

PoE configuration example

Network requirements
e Asshown in o, GigabitEthernet 1/0/1 and GigabitEthernet 1/0/2 are connected to IP telephones.
e  GigabitEthernet 1/0/11 is connected to the AP whose maximum power does not exceed 9000
milliwatts.

e The IP telephones have a higher power supply priority than the AP, so the PSE supplies power to IP
telephones first when the PSE power is overloaded.
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a. Network diagram for PoE

<

GE1/0/11
AP

Configuration procedure
# Enable PoE on GigabitEthernet 1/0/1 and GigabitEthernet 1/0/2, and set their power supply priority to
critical.
o Select PoE > PoE from the navigation tree and click the Setup tab to perform the following

configurations, as shown in a.

a. Configure the PoE ports supplying power to the IP telephones

Summany FEE Setup
Select Port:
HE E E HFI .III.II-] g ] I:I_24I:1_FII:I

Select All Select Mone Mote: The "Select All" and the "Select Mone" are anly applied to current unit.

e L] B O
- Selected Supplied Fower Enabled Disabled Mot Supported Power Fault
| Power state: [Enable o]

Ol Power Max: | |(1 000-30000 millivwatts, step = 100)

| Powear Profity, | Critical |« |

Selected Parts:
GETI0M-GE1INZ

Apply Cancel

o Click to select ports GigabitEthernet 1/0/1 and GigabitEthernet 1/0/2 from the chassis front panel.
o Select Enable from the Power State drop-down list.

e Select Critical from the Power Priority drop-down list.

o Click Apply.

# Enable PoE on GigabitEthernet 1/0/11 and configure the maximum power of the port to 9000 milliwatts.

e Click the Setup tab and perform the following configurations, as shown in b.
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b. Configure the PoE port supplying power to AP

Summary PSE Setup

Select Port:

Select All Select Maone Mote: The "Select All" and the "Select Mone" are only applied to current unit.
e L B []
. Selected Supplied Power Enabled Disabled Mot Supparted Poweer Fault

Power State:
Power May; | 9000 (1000-30000 milliwatts, step = 100)
Pawer Prority:

Selected Ports:
GE10M

Apply Cancel

o Click to select port GigabitEthernet 1/0/11 from the chassis front panel.
o Select Enable from the Power State drop-down list.

e Select the check box before Power Max and type 9000.

o Click Apply.

Atter the configuration takes effect, the IP telephones and AP are powered and can work properly.
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Support and other resources

Contacting HP

For worldwide technical support information, see the HP support website:

http:

www.hp.com/support

Before contacting HP, collect the following information:

Product model names and numbers

Technical support registration number (if applicable)

Product serial numbers

Error messages

Operating system type and revision level

Detailed questions

Related information

To find related documents, go to the Manuals page of the HP Business Support Center website:

http:

www.hp.com/support/manuals

Conventions

This section describes the conventions used in this documentation.

Command conventions

Convention Description

Boldface Bold text represents commands and keywords that you enter literally as shown.

italic Italic text represents arguments that you replace with actual values.

[ Square brackets enclose syntax choices (keywords or arguments) that are optional.

X1yl .} Braces enclose a set of required syntax choices separated by vertical bars, from which
v you select one.

(X 1y . Square brackets enclose a set of optional syntax choices separated by vertical bars, from
Yl which you select one or none.

Ix1y |} Asterisk marked braces enclose a set of required syntax choices separated by vertical
v bars, from which you select at least one.

[x[y|..]* Asterisk marked square brackets enclose optional syntax choices separated by vertical
Yol bars, from which you select one choice, multiple choices, or none.

&<ln> The argument or keyword and argument combination before the ampersand (&) sign can

be entered 1 to n times.
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Convention Description

# A line that starts with a pound (#) sign is comments.

GUI conventions

Convention Description
Window names, button names, field names, and menu items are in Boldface. For
Boldface . .
example, the New User window appears; click OK.
> Multi-level menus are separated by angle brackets. For example, File > Create - Folder.
Symbols
Convention Description
A An alert that calls attention o important information that if not understood or followed can
WARNING result in personal injury.
A An alert that calls attention to important information that if not understood or followed can
CAUTION

result in data loss, data corruption, or damage to hardware or software.

@ IMPORTANT An alert that calls attention to essential information.

NOTE An alert that contains additional or supplementary information.

Q TIP An alert that provides helpful information.

Network topology icons

Represents a generic network device, such as a router, switch, or firewall.

Represents a routing-capable device, such as a router or Layer 3 switch.

Represents a generic switch, such as a Layer 2 or Layer 3 switch, or a router that supports
Layer 2 forwarding and other Layer 2 features.

©00

Port numbering in examples

The port numbers in this document are for illustration only and might be unavailable on your device.

Subscription service

HP recommends that you register your product at the Subscriber's Choice for Business website:

http://www.hp.com/qo/e-updates

After registering, you will receive e-mail notification of product enhancements, new driver versions,
firmware updates, and other product resources.
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